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About This Guide

CAUTION! ABBREVIATED SAFETY ALERTS. Hazard symbols and hazard
types specified in procedures may be abbreviated in this document. For the
complete safety information, see the “Safety” appendix in this document.

IMPORTANT! Before using this product, read and understand the information the
“Safety” appendix in this document.

Revision history

Revision Date Description
A March 2012 New document
Purpose

The QuantStudio™ 12K Flex Real-Time PCR System Multi-Well Plates and Array Card
Experiments User Guide Binder functions as both a tutorial and as a guide for
performing your own experiments using the 384-Well, 96-Well (01.ml and 0.2ml), and
the Array Card consumables on the QuantStudio™ 12K Flex System.

Prerequisites

This user guide is intended for personnel who have been specifically trained by Life
Technologies. The manufacturer is not liable for damage or injury that results from use
of this manual by unauthorized or untrained parties.

This guide uses conventions and terminology that assume a working knowledge of the
Microsoft® Windows® operating system, the Internet, and Internet-based browsers.

Note: First-time users of the QuantStudio™ 12K Flex System, please read this booklet,
Getting Started with QuantStudio™ 12K Flex System 96-Well, 384-Well, and Array Card
Experiments thoroughly. The booklet provides information and general instructions
that are applicable to all the experiments described in this binder.

Getting Started with QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments 5



About This Guide

How to use these booklets as tutorials

How to use these booklets as tutorials

Each booklet in this guide provides a tutorial for running an example experiment

™

using QuantStudio "~ 12K Flex Software and the example data provided on the
installation CD. The following booklets are provided:

Getting Started with QuantStudio™ 12K Flex System 96-Well, 384-Well, and Array
Card Experiments — introductory information and experiment workflow common
to all experiments.

Running Standard Curve Experiments — designing, running, and analyzing a
Standard Curve experiment.

Running Relative Standard Curve and Comparative Ct Experiments — designing,
running, and analyzing Relative Standard Curve and Comparative Cp
experiments.

Running Genotyping Experiments — designing, running, and analyzing a
Genotyping experiment.

Running Presence/Absence Experiments — designing, running, and analyzing a
Presence/Absence experiment.

Running Melt Curve Experiments — designing, running, and analyzing a Melt Curve

experiment.
™

QuantStudio 12K Flex System Multi-Well Plates and Array Card Experiments -
Appendixes — common information such as ordering information, additional
documentation, and glossary.

Note: In all booklets, the term “experiment” refers to the entire process of
performing an experiment, including setup, run, and analysis.

How to use the guides with your own experiments

Assumptions

Each booklet contains instructions specific to an example experiment provided on the
installation CD. However, you can use the booklets as guides for your own
experiments; tips for running your own experiments are provided at various points in
each booklet.

This guide assumes that you have access to the example experiments provided with
the software.

Getting Started with QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments
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How to use the guides with your own experiments

How to access an Start the QuantStudio™ 12K Flex Software

Y |

example Double-click = (QuantStudio™ 12K Flex Software shortcut) to access the Home

experiment screen, shown below.

Note: You can customize the Home screen by importing an image of your choice. The
image is displayed on the right hand side of the screen.

To personalize the Home screen, go to Tools » Select Welcome Image. Browse to the
image of your choice and click OK.

.’.. QuantStudio™ 12K Flex Software v1.0
Fle Edt Instument Analysis Tools Help

[ New Experiment ~ | 5 open... [l [ L 2 a

'A% applied
AB b‘i)gsystemS"

OpenArray ® Sample Tracker Open OpenArray® ExpressionSuite Software
T 5 o
Instrument Console Create 96/384/Array Cards TaaMan Genotyper Software
G § Q G
Readifpp Create From Template DigitalSuite Software
g =l
@9 — ke

[
technologies

Note: The icons in the Analyze menu appear active only if you've downloaded the
ExpressionSuite Software, TagMan® Genotyper Software and DigitalSuite Software on
your computer.

¢a) Home | [ 384-wel Fast...ve Example.ads x | @ Instrument Console x | @ FOSMIRAIS1L02 - Monitor x | [ x000.eds x

( ]

Open an example experiment
From the Home screen, click Open, to navigate to the experiments folder (default):

C:\Program Files\ Applied Biosystems\QuantStudio 12K Flex Software\ examples,
and open the example experiment file.

Data files in the * Gene Expression
Examples folder - Comparative Cy
— Relative Standard Curve

* Genotyping
* Melt Curve

e Presence Absence

Getting Started with QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments 7
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User attention words

User attention

e Standard Curve

In addition to the above, the examples folder also contains the User Sample Files
folder:

¢ BarCode Template.txt

¢ Custom Sample Properties Example.xls

words

Five user attention words may appear in this document. Each word implies a
particular level of observation or action as described below:

Note: Provides information that may be of interest or help but is not critical to the use
of the product.

IMPORTANT! Provides information that is necessary for proper instrument operation
or accurate chemistry kit use.

CAUTION! Indicates a potentially hazardous situation that, if not avoided, may
result in minor or moderate injury. It may also be used to alert against unsafe
practices.

WARNING! Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

DANGER! Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury.

Except for IMPORTANTS, the safety alert words in user documentation appear with an
open triangle figure that contains a hazard symbol. These hazard symbols are identical
to the hazard symbols that are affixed to the instrument. See the “Safety” appendix for
descriptions of the symbols.

Getting Started with QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments
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Chapter 1 General Information and Instructions

Set up an experiment

To display an expanded view of a plotorwells ............................ 53
To edit plot properties. ....... ... 53
To save current settingsasdefault ............... ... ... . ... ... 54
To publish the analyzed data............. ... i 54
Exportanexperiment ........... .. .. i 54
About exporting an experiment ............ ... . i 54
Export procedure....... ... ... ... . ... 55

Note: For more information about any of the topics discussed in this guide, access the
Help from within QuantStudio'" Software by pressing F1, clicking ) in the toolbar, or
selecting Help » QuantStudio™ 12K Flex Software Help.

Set up an experiment

Define experiment
properties

Define experiment
name and type

10

All experiments require the same general setup tasks; individual booklets supply
specific parameters. The following procedures outline general steps to take to set up an
experiment.

Access QuantStudio" 12K Flex Software and from the Experiment menu, click the
Create icon. Click Experiment Properties to access the Experiment Properties screen.

Enter a unique experiment name in the Experiment Name field. The default is a
date and time stamp, which you can change. For example, 2011-12-08 123517.

* Enter a name that is descriptive and easy to remember. You can enter up to
100 characters.

* You can only use the alpha-numeric, period (.), hyphen (-), underscore ( _)
and spaces () characters.

Note: Make sure each experiment name is unique. If you have named two
different experiments with the same name, you cannot run them on the same
instrument. You will receive the following error message:

Failed to Start Ru x|

@ Unable ta start the run,
The experiment already exists, Delete the experiment before starting the run,

If you do not want to delete the existing experiment, rename the duplicate
experiment and then proceed to the run.

(Optional) Enter or scan the barcode on the reaction plate. You can enter up to 100
characters in the Barcode field.

(Optional) Enter a user name to identify the owner of the experiment. You can
enter up to 100 characters in the User Name field.

(Optional) Enter comments to describe the experiment.

Select the block type you are using to run the experiment
o 384-Well
¢ Array Card

Getting Started with QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments
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Set up an experiment

e 96-Well (0.2mL)
e Fast 96-Well (0.1mL)

Select the experiment type:
¢ Standard Curve
* Relative Standard Curve
* Comparative Cp (AACy)
* Melt Curve
¢ Genotyping

e Presence/Absence

Select the reagent  Select the reagent you are using to detect the target sequence:

Define the 1.
instrument run
properties
2.
3.

Getting Started with QuantStudio™

TagMan® Reagents
SYBR® Green Reagents
Other

Note: If you select SYBR® Green as the reagent, then you have the option of
including a melt curve for that experiment.

Select the ramp speed for the experiment:

e Standard

¢ TFast
For Genotyping and Presence/Absence experiments, select the options for the
data collection to include in the experiment run:

* Pre-PCR Read - to include data before amplification occurs. Use the data
collected during pre-PCR read to normalize florescence data collected
during post-PCR read.

e Amplification - to include real-time data.

* Post-PCR Read - to include data after amplification has taken place.
(Optional) For real-time data collection, you can change the default analysis
settings in the Preferences for the following:

* Automatic analysis

¢ Automatic save

¢ Baseline settings
Go to Tools » Preferences. Click the Experiment tab. Select the Auto Analysis

and Auto Save check boxes for the QuantStudio™ 12K Flex Software to
automatically analyze and save experiment results. You can also edit the

following default baseline settings:

Field Entry
Start Cycle Number 3 (default)
End Cycle Number 15 (default)

Note: By default, the Auto Analysis and Auto Save check boxes are selected.

12K Flex System Multi-Well Plates and Array Card Experiments 1



1 Chapter 1 General Information and Instructions
Set up an experiment

4. For the Melt Curve experiment, select the Include PCR check box, to include PCR.

5. Save the experiment. The default file name ( .eds extension) is the experiment
name that you entered when you set up the experiment and saved it for the first
time. Changes to the experiment name after the first save do not update the file
name. To change the file name, select File » Save As.

The Experiment Properties screen for a Standard Curve experiment is shown in the
following graphic:

How do you want to identify this experiment?

* Experiment Name: |384-Well Fast Standard Curve Example.eds Comments: |Standard Curve example ~
Barcode:

User Name: s

Which block are you using to run the experiment?

I 384-Well | [ Array Card ] { 96-Well (0.2mL) ] [ Fast 96-Well (0.1mL) ]

What type of experiment do you want to set up?

‘ v Standard Curve ‘ [ Relative Standard Curve ] { Comparative Ct (AACT) ] [ Melt Curve ]

{ Genotyping ] [ Presence/Absence ]

Which reagents do you want to use to detect the target sequence?

v TagMan@® Reagents | [ SYBR® Green Reagents ] [ Other ]

What properties do you want for the instrument run?

[ Standard ] | v Fast |
Define ta rgets, Use the Define screen to define targets, samples and biological replicates for your
samples, and experiment. For Genotyping experiments, use this screen to specify the number of SNP
biological replicate assays to include in the experiment.
groups Note: You can start a run without these definitions, but there will be no real-time data
in the amplification plots (the amplification plots can be seen only after you have set
up the plate).

1. Click Define to access the Define screen.

2. Define targets.
a. Click New to add targets and define them.

b. In the target table, click a cell in the Target Name column for the target, then
enter your target name. The default name is Target 1.

c. Select the Reporter and Quencher from the respective drop-down menu.

Note: The default reporter and quencher dyes used depend on the reagent
selected during experiment setup. For example, if TagqMan® is the selected
reagent, the default reporter FAM and default quencher is NFQ-MGB.

d. Select the target Color from the drop-down menu.

e. (Optional) Click Save to Library to save the newly added or existing edited
targets to the target library.

Note: Use the targets from the Target Library to avoid re-entering the
information. See “(Optional) Use libraries when designing your own
experiments” on page 19 for information on target libraries.

2 Getting Started with QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments
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Chapter 1 General Information and Instructions 1
Set up an experiment

f. Click Import from Library to add targets from the target library.

3. Define samples.
a. Click New to add samples and name them.

b. In the samples table, click a cell in the Sample Name column for the sample
to define and enter your sample name. The default sample name is Sample 1.

c. Select the sample Color from the drop-down menu.

d. (Optional) Click Save to Library to save the newly added or existing edited
samples to the sample library.

Note: Use the samples from the Sample Library to avoid re-entering the
information. See “(Optional) Use libraries when designing your own
experiments” on page 19 for information on sample libraries.

e. Click Import from Library to add samples from the sample library.

4. Define biological replicates.

a. In the Define Biological Replicates Groups table, click New to add biological
replicate group and name them. You can enter up to 100 characters in this
field.

b. Select the Color from the drop-down menu.
c. Click in the Comments column to add comments for that biological replicate
group.

5. Select the Passive Reference from the drop-down menu.

The Define screen for a Standard Curve experiment is shown in the following
graphic:

Target Name Reporter Quencher Color Sample Name Color
RNzseP FAM ~ NFQ-MGB v‘. v‘ Pop1 ‘ -
Popz ‘. v

Biological Replicate Groups

Mew

Biological Group Name Color Comments

Passive Reference

ROX v
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Set up an experiment

Assign targets, Use the Assign screen to assign targets, samples, and biological replicate groups to
samples, and wells in the reaction plate. For Genotyping experiments, use this screen to assign SNP
biological replicate =~ 2%5%Y%

groups Note: You can start a run without these assignments, but there will be no real-time

data in the amplification plots (the amplification plots can be seen only after you have
set up the plate).

1. Click Assign to access the Assign screen.
2. Assign targets.

a. Select wells using the plate layout or the well table on the Assign screen.

b. Select a target and assign its task, in the plate, from the drop-down menu.
Depending on the experiment type, options are:

Experiment type Legend Tasks
Standard Curve U Unknown
S Standard
N Negative Control
Relative Standard Curve u Unknown
S Standard
N Negative Control
Comparative CT u Unknown
N Negative Control
Genotyping u Unknown
1/ Positive Control Allele 1/ Allele 1
2/2 Positive Control Allele 2/ Allele 2
1/2 Positive Control Allele 1/ Allele 2
N No Template Control
Presence/ Absence U Unknown
| Internal Positive Control
N Negative Control
& Blocked Internal Positive Control
Melt Curve U Unknown
Negative Control

3. Assign Samples.

14 Getting Started with QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments
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Set up an experiment

a. Select wells using the plate layout or the well table on the Assign screen.
b. Select the check box next to the sample to assign to the selected wells.

Note: You can assign only one sample to a well.

4. Assign Biological Replicate Groups.
a. Select wells using the plate layout or the well table on the Assign screen.

b. Select the check box next to the biological replicate group to assign to the
selected wells.

The Assign screen for a Standard Curve experiment is shown in the following
graphic:

., Define and Set Up Standards Well Table

Targets

[] RN aseP 1 2 3 [+« [ s [ e [ 7 & [ e [w [ [z 13 [1e [15 [1e 17 [ [1s [0z [2z ]|z [ |
alo |8 B8 @ @ B & e me e e e s e e e e e | s
slm B B @ 8 B & E A me e e e s e e e | e e | s
a8 8 @8 8 |8 & a ar e m e e e s o s e e e | s
tlm 8 8 @ 8 B & ar A m e e s o e e e e | e
S — P = = =T = R T R g R T A A A
B -0 o o o o o & a A A A A A s s sy sy s s s s s s s
EIEZE; }:Em B B B |8 B |avar e ar e e e lae o om ay ay E o o o
Tl 8 8 8 8 B & a0 a0 o oo o e m ompomy omomm e | e
g 8 8 @ 8 |8 & & ar e a e mr o om om om m e m pm em s
sl B B BB B ar A e a e m s o s o o e e s
Klm B8 8 @ 8B & e Al a e e m mr om om om m e m m em w
e —— e T e R R R N A A A A A A A A A A A A A
W?m ERERCEER R I I G I A I A A I A A A A A
Wlma B8 B B 8 B & a A a e m s o e o e e e s
g B8 8 B 8B & A e a e m s o e o e e s e s
rla 8 8 @ 8 |8 & aar e a e mr s o m om m e m pm em sw
wels: [T 288 [£] 80 [] 16 0 Empty
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Assign targets, As shown in the following graphics, you can also paste assignment information from
samples, and an *.xIs file into the plate layout of the QuantStudio™™ 12K Flex Software for wells with

biological replicate ~ Single targets.

groups - Alternate  Note: You must select the header, and the Well Number and Well Position columns
procedure while copying information from the *.xls file.

Note: Any of the columns not copied are treated as NULL values for those columns.

a1 - fe | well
A B C D E F G H
1 well Sample  iiological Grou Target Task Dyes Quantity Comments
2 Al 5K RNaseP UNKNOWN  FAM-NFQ-MGB
3 A2 5K RNaseP UNKNOWN  FAM-NFQ-MGB
4 A3 5K RNaseP UNKNOWN  FAM-NFQ-MGB
5 Ad 5K RNaseP UNKNOWN  FAM-NFQ-MGB
6 AS 5K RNaseP UNKNOWN  FAM-NFQ-MGB
7 AB 5K RNaseP UNKNOWN  FAM-NFQ-MGB
8 AT 5K RNaseP UNKNOWN  FAM-NFQ-MGB
9 AB 5K RNaseP UNKNOWN  FAM-NFQ-MGB
10 A9 5K RNaseP UNKNOWN  FAM-NFQ-MGB
11 Al0D 5K RNaseP UNKNOWN  FAM-NFQ-MGB
12 All SK RNaseP UNKNOWN  FAM-NFQ-MGB
13 Al2 5K RNaseP UNKNOWN  FAM-NFQ-MGB
14 Al3 5K RNaseP UNKNOWN  FAM-NFQ-MGB
15 Ala 5K RNaseP UNKNOWN  FAM-NFQ-MGB
16 AlS 5K RNaseP UNKNOWN  FAM-NFQ-MGB

Copy and paste the selected information

| ™. Define and Set Up Standards

Targets
[ [ ]
!
0 rgei | | # Well | Sample Biclogic... | Target Task Dyes Quantity | Comme...
Riasep ] 11 m 5K RMaseP  UNKNOWN FAM-NFQ-..
2 A2 5K RlaseP UNKNOWN  FAM-NFQ-..
3 A3 5K RiaseP UNKNOWN  FAM-NFQ-..
4 A4 5K RlaseP UNKNOWN  FAM-NFG-...
5 A5 5K RiasaP UNKNOWN  FAM-NFGQ-..
6 A6 5K RiaseP UNKNOWN  FAM-NFQ-..
7 A7 5K RiaseP UNKNOWN  FAM-NFQ-...
8 As 5K RiaseP UNKNOWN  FAM-NFQ-..
9 A9 5K RiaseP UNKNOWN  FAM-NFQ-..
10 A10 5K RlaseP UNKNOWN  FAM-NFQ-..
Samples —— (4 1 A1l 5K RiaseP UNKNOWHN  FAM-NFQ-...
12 A12 5K RiaseP UNKHOWN  FAM-NFG-..
13 A13 5K RiaseP UNKNOWN  FAM-NFQ-..
14 Al4 5K RiaseP UNKNOWN  FAM-NFQ-..
Clilsamole 1 I 15 ais 5K RiaseP UNKHOWH  FAM-NFQ-...
16 Al6
17 A17
18 A18
19 A19
20 A20
21 A1
22 A2
23 A23
24 A4
Biological Groups ————— [T 55 Bl
. Biological Group 26 B2
27 83
28 84
29 85
30 86
31 87
32 88
33 B9
34 810
35 Bl
36 B12
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Define the run Use the Run Method screen to set up the run method for your own experiments in the
method QuantStudio™ 12K Flex Software.
1. Click Run Method to access the Run Method screen.

Note: You can save multiple run methods to the Run Method Library for later
use. See “(Optional) Use libraries when designing your own experiments” on
page 19 for information on run method libraries.

2. Enter a number from 1 to 20 for the reaction volume per well. The QuantStudio™"
12K Flex Instrument supports the following maximum reaction volumes for the
consumables listed below:

* MicroAmp® Optical 384-Well Reaction Plate - 30 uL

* Applied Biosystems Array Card - 1 uL

* MicroAmp® Optical 96-Well Reaction Plate (0.2 mL)- 200 uL

o MicroAmp® Optical 96-Well Reaction Plate (0.1 mL)- 100 pL

e MicroAmp® Optical 8-Tube Strip with cap (0.2 uL)- 200 uL

e MicroAmp® Fast 8-Tube Strip with cap(0.1 uL)- 100 pL

* MicroAmp® Optical Reaction Tube without cap (0.2 pL)- 200 uL
e MicroAmp® Fast Reaction Tube without cap (0.1 uL)- 100 uL

3. In the Graphical View tab, review and, if necessary, edit the run method.
* Make sure that the thermal profile is appropriate for your reagents.

¢ Edit the default run method or replace it with one from the run method
library included in the QuantStudio™ 12K Flex Software.

¢ Enable data collection by clicking [7g) -

Note: Enabling data collection is especially useful when you later need to
analyze data collected in real-time during the various stages.

¢ Edit the ramp rate. You can increase or decrease the ramp rate for a stage.

Note: Ramp rates are decimal numbers from 0.015—3.4.
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¢ Edit the PCR Stage.
¢ Change the Number of Cycles for the PCR stage.

e Select the Enable AutoDelta check box, to increase or decrease the
temperature and/or hold time for each subsequent cycle or to change the
Starting Cycle for AutoDelta. Enabling AutoDelta displays the & icon.
Click the AutoDelta Off 2 icon to change the AutoDelta settings for the
cycling stage in the AutoDelta Settings dialog box. Then, click Save Setting
to display the AutoDelta On 4 icon.

|l AutoDelta Settings =

AutoDelta Settings For Cycling Stage

AutoDelta Temperature: |+ 'l II 0.01 3:

Walid AutoDelta Temperature Range: -2.27 to 0,12

autoDelta Time: I + 'l FEH

Starting Cycle: 1

Save Setting W

Note: If you selected SYBR® Green as the reagent, the Melt Curve stage
automatically appears in the Run Method screen. If you delete the Melt
Curve Stage section from the protocol, then the melt curve is active in the
Add Stage drop-down menu.

4. Complete the tasks on the Optical Filters tab:

By default, the Optical Filters tab is not visible. To show the Optical Filters tab, go
to Tools » Preferences, and select the Show optical filters for run method check
box under the Non-OpenArray tab.

Display Format T SMTP Settings ]
Startup ]

references
Experiment T Prink T Export T

OpenArray® Block Run

Non-OpenArray Global Notification Settings

@ Select the default folders, the default block type, and whether to show optical filters in the run method.

Browse

Browse

Data Folder: 1 Biosystems\QuantStudio 12K Flex Software\User Files\experiments

Import Folder: 1 Biosystems\QuantStudio 12K Flex Software\User Files\experiments

Block Type: 384-well Block vl
Decimal Places to Show: 3 |

Show optical fiters for run method

D

¢ To add a new filter set to the filter set library, click Save.

e Toload a saved filter set, click Load.
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e To go back to the original filter set combinations, click Revert to Defaults.

Run Method

Reaction Volume per Wel: 20] pL

Graphical Vien

PCR Filter =

Emission Filcer
m1(520+15) m2(558+11) m3(586+10) ma(623=14) ms5(682+14) m6(711+12)

x1(470£15)

x2(520£10)

¥3(550+11)

Excitation Filter

x4(58010)

¥5(640£10)

x6(662+10)

Melt Curve Filter g

Emission Fllcer
m1(520+15) m2(558+11) m3(586+10) ma(623+14) m5(682+14) m6(711+12)

XL(47015)

x2(520£10)

x3(550£11)

Excitation Fiter

¥4(580+10)

x5(64010)

X6(662£10)

Note: Select the filter set that matches the profile of the dye you have added to the
plate. Refer to the Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System
Maintenance and Administration Guide for information on the emission spectrum
for each dye, and the filter at which each dye is read.

The QuantStudio™ 12K Flex Software allows you to save information to libraries, so
you can easily use the information again when setting up an experiment. The libraries
include:

o Targets library

* Samples library

* SNP Assay library (only available for Genotyping experiments)
* Run Method library

Target, Sample, and SNP Assay libraries

You can access the Targets, Samples, and SNP Assay libraries from the Tools menu to
add, edit, delete, and import or export items. You can also access a library by clicking
Import from Library in the Define screen when you are setting up an experiment.

Run Method library

You can use the Run Method library from the Run Method screen to:
* Save a new run method for later use.
¢ To select an existing run method for an experiment.

To add a run method to the Run Method Library:

1. Click Save Run Method in the toolbar of the Graphical View tab on the Run
Method screen.
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2. Enter a name and description (optional) for the run method, then click Save.

To select a run method from the Run Method Library

Click Open Run Method on the Run Method screen, and select one from the saved run
methods.

Prepare reactions

The QuantStudio" 12K Flex Instrument is optimized for Applied Biosystems

Supported
consumables consumables. These can be ordered from the Life Technologies website. Use the
consumables appropriate for the sample block of your instrument.
Maximum
Samble reaction Recommended
blo!:)k Consumable volume reaction
(pL) volume (pL)
supported
384-Well Notched corner e MicroAmp® Optical 30 5-20
Plate 384-Well Reaction Plate
e MicroAmp® Optical
Adhesive Film
Array (AA . Applied Biosystems Array 1 1
Card A Card
A1 ey
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Maximum
reaction Recommended
Sample .
block Consumable volume reaction
(uL) volume (pL)
supported

96-Well MicroAmp® Optical 96- 200 10-100
Plate Well Reaction Plate
(0.2 mL] MicroAmp® Optical

Adhesive Film

MicroAmp® 96-Well

Support Base (only

used during sample

preparation)

QuantStudio™ 12K Flex

System 96-Well Plate

Adaptor
Fast 96- MicroAmp® Fast Optical 100 10-30
Well 96-Well Reaction Plate
Plate MicroAmp® Optical
(0.1 mL) Adhesive Film

MicroAmp® 96-Well
Support Base (only
used during sample
preparation)
QuantStudio™ 12K Flex

System Fast 96-Well
Plate Adaptor

Getting Started with QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments
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Maximum
reaction Recommended
Sample .
block Consumable volume reaction
(uL) volume (pL)
supported
96-Well e MicroAmp® Optical 8- e 100 for e 10-30 for
Plate Cap Strip Fast 96- Fast 96-well
(0.2 L) e MicroAmp® Optical 8- well plate
and Tube Strip (0.2 uL)/ plate * 10-100 for
Fast MicroAmp® Fast 8- e 200 for 96-well plate
76-Well Tube Strip (0.1 pL) 96-well
'[%lite U e MicroAmp® 96-Well plate
K Tray/ Retainer Set
(Blue) (0.2 pL)/
MicroAmp® 96-Well
Tray (Black) (0.1 pL)
o MicroAmp® 96-Well
Support Base (only
used during sample
preparation)
* QuantStudio™ 12K Flex
System 96-Well Tube
Adaptor/QuantStudio™
12K Flex System Fast
96-Well Tube Adaptor
96-Well e MicroAmp® Optical e 100 for e 10-30 for
Plate Tube without cap (0.2 Fast 96- Fast 96-well
(0.2 pL) S L)/ MicroAmp® Fast well plate
and = ) Reaction Tube without plate e 10-100 for
Fast == Cap (0.1 L) . 200 for 96-well plate
96-Well @ e MicroAmp® Optical 8- 96-well
plate — Cap Strip plate
(0.1 p e MicroAmp® 94-Well
Support Base (only
used during sample
preparation)
e MicroAmp® 96-Well
Tray/ Retainer Set
(Blue) (0.2 pL)/
MicroAmp® 96-Well
Tray (Black) (0.1 pL)
e QuantStudio™ 12K Flex
System 96-Well Tube
Adaptor/ QuantStudio™
12K Flex System Fast
96-Well Tube Adaptor

WARNING! Make sure that you use the flat caps for 0.2 pL tubes and 0.1 pL tubes. Use of rounded caps damages

the heated cover.

22
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Supported Life Technologies supports the reagents listed below for experiments performed on the
reagents QuantStudio™ 12K Flex System.
Experiment Reagent
Standard Curve  Applied Biosystems TagMan® Reagents

 Applied Biosystems SYBR® Green reagents
e Other reagents

Relative Standard Curve * Applied Biosystems TagMan® Reagents
* Applied Biosystems SYBR® Green reagents
e Other reagents

Comparative Ct (AACy) * Applied Biosystems TagMan® Reagents
o Applied Biosystems SYBR® Green reagents
e Other reagents

Melt Curve e Applied Biosystems SYBR® Green reagents
e Other reagents

Genotyping * Applied Biosystems TagMan® Reagents

e Other reagents

Presence/Absence * Applied Biosystems TagMan® Reagents

e Other reagents

Note: Fast Universal Master Mix is not recommended to be used with the 96-well (0.2
uL) reaction plates or reaction tubes and tube strips sealed with caps.

Reagent detection  Applied Biosystems TagMan® Reagents
process Description

TagMan® reagents use a fluorogenic probe to enable detection of a specific PCR
product as it accumulates during PCR cycles.

Advantages

* Increased signal specificity with the addition of a fluorogenic probe.
e Multiplex capability.

* Optional preformulated assays, optimized to run under universal thermal cycling
conditions, are available.

* Can be used for either 1- or 2-step RT-PCR.

Limitations

Require synthesis of a unique fluorogenic probe.
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TagMan® Reagents detection process

PCR and detection of cDNA

a. Assay components

'ﬁ Probe ) Reverse primer

Wi
ININIRINTNINI
A

Forward primer
3' 5'

% cDNA template 4

s T T e e e e fro e v e
==

% ~— cDNA

3 5

~ g

b. Denatured template and annealing of assay components

N 5 X
%WWWWWWWW—W_WWW% Reverse primer
- T
MG
R Probe /
T @T‘rrrrrr uunn\'@
Forward primer \ /

D s

LEGEND

3' 5
c. Signal generation
3 5
k‘l\\\\\\\\\\\\\\\\\\HIHHHHHHHHHHHHH ‘”HHHH““H HHHHIIH%
.--;----.?
N 4 P everse primer
) Forward primer t/* S = )\MGB

5 W R — 3
,,,,,,,,, [T | UjUDUUUg,r,r,r,r,r,r,r,
3 .

5

&’ FAM™ dye
@ Quencher

MGB
o

v

Minor groove
binder

AmpliTag Gold®
DNA Polymerase

Probe

Primer

Template

Extended primer

Applied Biosystems SYBR® Green reagents
Description

SYBR Green reagents use SYBR® Green I dye, a double-stranded DNA binding dye, to
detect PCR products as they accumulate during PCR cycles.

Advantages

* Economical (no probe needed).

e Allow for melt curve analysis to measure the Tm of all PCR products.

¢ Can be used for either 1- or 2-step RT-PCR.

Limitations

Bind nonspecifically to all double-stranded DNA sequences. To avoid erroneous
information signals, check for nonspecific product formation using melt curve or gel
analysis.
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SYBR® Green detection process

Step 1: Reaction setup

The SYBR® Green | dye
fluoresces when bound to
double-stranded DNA.

® ) Step 2: Denaturation
] ® When the DNA is denatured into
single-stranded DNA, the
SYBR® Green | dye is released and
the fluorescence is drastically reduced.
FORMER ° Step 3: Polymerization
-@- During extension, primers
o e | anneal and PCR product
® -@- is generated.
REVERSE
PRIMER
- o o 0 o Step 4: Polymerization completed
1 1 1 1 1 SYBR® Green | dye binds to the
o~ 6 6 6 o double-stranded product,
resulting in a net increase in
fluorescence detected by the
instrument.
Precautions while * Make sure that you do not prepare the reactions on a wet table. Wet surfaces lead
preparing to contamination of your reactions.
reactions * Wear appropriate protective eyewear, clothing, and powder-free gloves.
* Make sure that you use the appropriate consumables. The quality of pipettors and
tips and the care used in measuring and mixing dilutions affect data accuracy.
* Make sure that you perform dilutions exactly as instructed. Mistakes or
inaccuracies in making the dilutions directly affect the quality of results.
¢ Use a permanent marker or pen to mark a tube and the side of a plate or array
card. Do not use fluorescent markers.
* Make sure that the arrangement of the PCR reactions matches the plate layout
displayed in the QuantStudio ™" 12K Flex Software.
Materials required e DI water or DEPC water
while preparing the * Microcentrifuge tubes
dilutions e Pipettors
* DPipette tips

Getting Started with QuantStudio™

Vortex mixer
Centrifuge
Sample stock
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Guidelines for
preparing the
dilutions, reaction
mix, and plate

Seal the reaction
plate

26

Standard stock
Reaction mix components

Plate or array card

Include excess volume in your calculations to provide excess volume for the loss
that occurs during reagent transfers.

Use TE buffer or water to dilute the standards and samples.
Prepare the reagents according to the manufacturer’s instructions.

Keep the dilutions and assay mix protected from light, in the freezer, until you are
ready to use it. Excessive exposure to light may affect the fluorescent probes or
dyes.

Prior to use:
— Mix the master mix thoroughly by swirling the bottle.
— Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

— Thaw any frozen samples by placing them on ice. When thawed, resuspend
the samples by vortexing, then centrifuge the tubes briefly

Do not allow the bottom of the reaction plate to become dirty. Fluids and other
contaminants that adhere to the bottom of the reaction plate can contaminate the
sample block(s) and cause an abnormally high background signal.

Correct Incorrect

Liquid is at the bottom of Not centrifuged with enough force
the well. or

Not centrifuged for enough time

¢ For Genotyping experiments, prepare the reactions for each SNP separately.

¢ Place the reaction plate or array card at 4°C and in the dark until you are ready to

load it into the instrument

If you use optical adhesive film to seal your reaction plates, seal each reaction plate as
follows:

Note: The sealing instructions are applicable to 384-well and 96-well reaction plates.

1.

Load the reaction plate using the plate layout described in “Assign targets,
samples, and biological replicate groups” on page 14.

Note: For 96-well reaction plates, place the reaction plate onto the center of the
96-well base, then perform this step. Be sure that the reaction plate is flush with
the top surface of the 96-well base.
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Note: You can also use the MicroAmp® Optical 8-Cap Strip to seal the 96-well
reaction plates.

. Remove a single optical adhesive film from the box. Bend both end-tabs upward.
Hold the film backing side up.

. In one swift movement, peel back the white
protective backing from the center sealing
surface. Do not touch the center sealing
surface.

IMPORTANT! Improper peeling of the optical

adhesive film may result in haziness, but it

will not affect results. Haziness disappears when the film comes into contact with
the heated cover in the instrument.

. Holding the film by the end-tabs, lower the film onto the reaction plate (adhesive
side facing the reaction plate). Make sure that the film completely covers all wells
of the reaction plate.

. Applying firm pressure, move the applicator slowly across the film, horizontally
and vertically, to ensure good contact between the film and the entire surface of
the reaction plate.
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. To ensure a tight, evaporation-free seal,

6. Using the applicator to hold the edge of the film in place, grasp one end of the

end-tab and pull up and away sharply. Repeat for the other end-tab.

Note: Ensure clean removal of both end-
tabs from the dotted line. Improper peeling
of the end-tab can cause sticking of plate on
the heated cover assembly.

repeat Applying firm pressure, move the
applicator slowly across the film,
horizontally and vertically, to ensure good
contact between the film and the entire surface of the reaction plate.step 5.
Applying firm pressure, run the edge of the applicator along all four sides of the
outside border of the film.

Note: Optical adhesive films do not adhere on contact. The films require the
application of pressure to ensure a tight, evaporation-free seal.

. Inspect the reaction plate to be sure that all wells are sealed. You should see an

imprint of all wells on the surface of the film. Check for the perforated tab to be
completely torn off to avoid plates from sticking to the instrument after a run.

IMPORTANT! Remove all excess adhesive from the perimeter of the optical adhesive
cover. When the film is applied, the glue from the optical adhesive cover can adhere to
the edges of the plate. If the excess glue is not removed, the plate may adhere to the
gripper of the Twister® Robot or to the sample block of the QuantStudio™™ 12K Flex
Instrument.
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Fill and spin the array card

IMPORTANT! Wear powder-free gloves while preparing the Arrays.

1. Remove an array card from its box and place it on a clean, dry surface.
2. Using a permanent marker, mark the side of the empty array cards.
3. Transfer the experiment-related chemistries and solutions into the port of the

array card.

For each transfer:
a. Place the array card on a lab bench, with the foil side down.
b. Load 100 pL of fluid into a pipette.

c. Hold the pipette in an angled position (~45 degrees) and place the tip into the
fill port. There is a fill port on the left arm of each fill reservoir — it is the
larger of the two holes.

Do not allow the tip to contact and possibly damage the coated foil beneath
the fill port.

Fill Vent
port | port

d. Dispense the fluid so that it sweeps in and
around the fill reservoir toward the vent port.

Pipette fluid into the fill reservoir, but do not go T
past the first stop of pipettor plunger when @(‘g@%@ NS
pipetting the reagents into the array card, or you ¢ Wﬁ&ﬁ\g .
may blow the solution out of the port. %}@ﬁ\@{

A QYA YA

IMPORTANT! Do not allow the tip to contact and possibly damage the coated
foil beneath the fill port.
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. Place the filled array card(s) into a centrifuge array card

. Place the filled carrier clips into the centrifuge buckets.

—Filled array
carrier clip and place empty array card(s) in the —Empty
remaining slots. Make sure that the labels on the
buckets and clips face the same way.

array

IMPORTANT! Make sure to balance the loads in opposite buckets in the centrifuge.

Make sure that the array-card fill reservoirs and bucket
and clip labels face outward when loaded into the
centrifuge. Balance the loads in opposite buckets.

IMPORTANT! You must run the centrifuge with all four buckets in place and each
of the two carriers filled with the array card. Place empty array cards (4-pack PN
4334812 and 1-pack PN 4351471) into unfilled slots.

. Close the centrifuge cover, then spin the array card(s) for 1 minute at 1200 rpm.

. When the run is finished, stop the centrifuge, then spin the array card(s) again for

1 minute at 1200 rpm.

IMPORTANT! Do not try to save time by doing one spin for 2 minutes. The two
sets of ramps are important for a good fill into the array card.

. When the second run is finished, open the centrifuge and check that the fluid

levels in the reservoirs of each array card have decreased by the same amount.
Also, check for the formation of bubbles in all wells and note possible problems.

Correct Incorrect

1.8 3 &4 5 8 T B i 2 3 4 8 8 7 8 | I 2 3 4 B 8 7 8
@ @ @ @ e @

. If necessary, centrifuge the array card(s) for an additional minute to fill any

unfilled wells. Do not exceed three 1-minute runs or centrifuge the array card for
longer than 1 minute at a time.

Note: Visit the Life Technologies website, log on to store, and view an online
video of loading, centrifuging, and sealing an array card.
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Seal the array card(s)

1. With the carriage (roller assembly) of the TaqgMan® Array Micro Fluidic Card
Sealer in the Start position, place a filled array card into the fixture with the foil
side up so that the fill reservoirs are the farthest away from the carriage.

2. Press down on all four corners of the array card
to ensure that it is fully seated within the
fixture.

3. Use the two alignment pins in the fixture to position
the array card correctly.

Alignment pins

4. Seal the array card by running the carriage slowly over it, in one direction only.
Do not apply downward force on the carriage as you move it forward over the
card.

5. Remove the sealed array card from the fixture and trim the fill reservoirs from the
array card assembly using scissors. Trim the foil array card so that the edge is
even with the plastic carrier.
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Capping and
uncapping the 96-
well reaction tubes
and tube strips

32

IMPORTANT! Completely remove the fill reservoirs from the array card so that the
edge is free of residual plastic. The plastic from the fill reservoirs that extends beyond
the edge of the card can prevent the card from seating properly on the sample block
and affect amplification.

Correct Incorrect

@ @ | 7 @ @

IMPORTANT! As you seal the remaining filled array cards, store them in a dark place
until you are ready to use them. The fluorescent dyes in the array card are
photosensitive. Prolonged exposure to light can diminish the fluorescence of the dye.

Note: Make sure that you secure the caps on the tubes and tube-strips tightly to avoid
sample evaporation.

If you use the 96-well MicroAmp® Optical 8-Tube Strips or MicroAmp® Optical Tubes
without Cap, use the MicroAmp® Cap Installing Tool (PN 4330015) and follow the
instructions below for:

* Applying the MicroAmp® Optical 8-Cap Strip or MicroAmp® Optical Tubes
without Cap to the tubes

* Removing a cap string from a plate
Required materials:
e MicroAmp® Cap Installing Tool
* MicroAmp® Optical 8-Tube Strips or MicroAmp® Optical Tubes without cap
* MicroAmp® Optical 8-Cap Strip

Grooved side for flat
cap strips
Recessed cups I |
for rounded
cap strips
"1

\\waﬂﬁk

MicroAmp® Cap Installing Tool

Apply the MicroAmp® Optical 8-Cap Strip (flat)

1. Grasp the Cap Installing Tool so that the grooved side is exposed.
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2. Hold the strip of caps over the tube strip or the row of tubes.

3. Use the grooved side (shown) of the Cap
Installing Tool to push and seat each cap firmly
in place. Use a rocking motion to properly seat
each cap.

Remove a cap string from a plate

The MicroAmp® Cap Installing Tool is also used for
removing the MicroAmp® Optical 8-Cap Strip from
the 96-well optical plates and tray/retainer
assemblies. To remove the cap or cap strip:

1. Insert the small protrusions on the side of the
Cap Installing Tool under the webbing
between the caps on a cap strip.

2. Slowly pry the strip from the plate or Tray/
Retainer assembly.

Start the experiment

To start an experiment:
1. Access the Instrument Console.
2. Load the reaction plate or array card into the instrument, as shown on page 37.

3. Run the experiment as shown on page 39.

Getting Started with QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments
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Instrument The Instrument Console displays all the QuantStudio™ 12K Flex Instruments
Console discovered on a network.

Refresh ~ Remove fram Manage Instrument Close Door < o o @ FosmirAIS1LO2 [ 2]

My Inctruments <

splay Group: v Instrument Status: READY
Display Group: [INelsl¥+I ~ ERSIEIELEEE Al States v Ron Statue:

My Instruments (1) Group: My Instruments

N calibration Status ————— [T
B ROI 05-01-201... [GUEST Expired
FOSMIRAIS1LO2 Backgr... [09-01-201... |[ADMINIST... Expired
READY Uniform...[09-01-201... |[ADMINIST... Expired
Dye
On the Network (4) Normali...
RiizseP Not Cali...
Maintenance Info —mm—————___["a)
ﬂ ﬂ ﬂ ﬂ —
) ) ) ) LED Life
255380002 255550026 SGAGUSANK1DO1 spyder0ng Total Cycles for Block o ‘
OMNLINE ONLINE ONLINE ONLINE Total Degrees for Block 0 |
Instrument Properties ————— (&
Instrument Label ruo
Serial Number FOSMIRAIS1LOZ
Instrument Firmware Ver...
1P Address 172.28.1.136
Block Type 384-well Block

Controller Firmware Version [0.20.2
Optics Firmware Version 65535
Thermal Block Firmware ... [255

Heated Cover Firmware ... |255

@ 1nstrument Con.sc

C—
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Left panel

The features on the left panel of the Instrument Console allow:

* Instrument access: Open and close the QuantStudio™ 12K Flex Instrument door

from the QuantStudio™ 12K Flex Software user interface.
¢ Group management:
— Create, rename, and delete groups and assign instruments to the groups.
— Add and remove instruments to and from My Instruments.

Note: To add instruments, select the icon of the QuantStudio™ 12K Flex
Instrument that you want to add to the My Instruments list. Then click Add
to My Instruments. Similarly, click Remove from My Instruments to
remove an instrument from the My Instruments list. You can also drag and
drop the instrument icon into My Instruments or into the group created by
you.

— Display instrument groups from the Display Group drop-down menu.
according to their activity. Select the status from the Filtered By drop-down
menu. For more information on the status of an instrument, see “Monitor the
experiment” on page 40.

¢ Instrument management:

— Monitor experiments (check the run status or monitor a temperature plot or
amplification plot during a run). For more information on monitoring
experiments, see “Monitor the experiment” on page 40.

— Maintain instruments (check the calibration status of instruments and
perform different calibrations). For more information on Instrument
maintenance, refer to Applied Biosystems QuantStudio™ 12K Flex Real-Time
PCR System Maintenance and Administration Guide.

— Manage files (upload setup files; download completed experiments; and
create, rename, and delete experiment files and plate setup folders).

Note: Completed experiments are downloaded into the default folder
Completed Experiments.

Note: To manage files, click Manage Instrument.

Use the File Manager to create, rename or delete folders for holding setup
files for starting a run or completed experiments for analysis.

To move setup files from one folder to the other, click Move and select the
setup folder you want to shift the setup file into.

IMPORTANT! To Manage and Monitor, you must move instruments from On
the Network to My Instruments or a custom group. You can start a run and
calibrate instruments present only in the My Instruments group or the
custom group(s) that you created.

Right panel

The right panel of the Instrument Console displays:
¢ The name of the instrument whose instrument icon is selected.

¢ The run status of the selected instrument.
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¢ The group the instrument belongs to.
* The calibration status, maintenance reminders and instrument properties of the
selected instrument.

The calibration status is indicated by the & icon. The icon appears in the Status
column of the Calibration Status table after the last reminder date before the
calibration expires.

Status icons

You can monitor the instrument status and view calibration and other information in
the Instrument Console.

QuantStudio™ 12K Flex Instrument status icon

The status of an instrument is represented by an icon in the top-right corner of the
thumbnail representation of the instrument on the Instrument Console. An instrument
displays the status when you place the instrument icon under My Instruments or
under the Group(s) that you created.

To monitor the instrument status:

1. On the Home tab ( ﬁ ), select Instrument Console. If you do not see an
instrument, click Refresh in the instrument console toolbar.

2. If needed, move the instrument from the On the Network group to a group which
can be monitored:

a. Click the instrument of interest, then click Assign to Group in the
instrument console toolbar.

b. Select the My Instruments or a personal group in the drop-down list. The
instrument is now monitored.

Icon Instrument status
Ready
mSHImSlLDZ
READY
(no icon) Available on the network but cannot be

monitored because that instrument is not
under My Instruments or a group you created.

Run in process
(The time remaining for the run is shown to the
left of the icon.)

Unavailable

Incompatible firmware version

No longer connected to the network

R xEE
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Icon Instrument status

° Error occurred during run

Load the reaction C CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the
plate or array card temperature of the sample block(s) can exceed 100 °C. Keep your hands away
into the instrument until the sample block(s) reaches room temperature.

Sample block

IMPORTANT! Wear powder-free gloves when you handle the reaction plate or array
card.

IMPORTANT! Plates and array cards should be loaded and unloaded by operators who
have been warned of the moving parts hazard and have been adequately trained.

1. Touch E on the QuantStudio™ 12K Flex Instrument touchscreen or click Open
Door in the Instrument Console screen of the QuantStudio™ 12K Flex Software to
allow the plate adapter to come out from the instrument side.
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Enable or change
the Notification
Settings

38

2. Place the reaction plate or array card on the plate adapter. Ensure that the reaction
plate or array card is properly aligned in the holder.

* Make sure the well Al is positioned at the top-left of the tray for any of the
plate formats.

* Make sure the barcode (for any of the plate formats) is facing the front of the
instrument.

003000000000000000000000

J §58858858568060060000000_LIME

¢ If using reaction tubes or tube strips, make sure you use adaptors. The
adaptors are attached to the plate transport arm. The tray containing the
tubes or tube strips must be placed on the adaptor and not into the sample
block directly.

IMPORTANT! For optimal performance with partial loads, load at least 16
tubes and arrange them in:

Adjacent columns of 8 tubes, using rows A through H. For example, use
wells in columns 6 and 7 (rows A through H).

Or

Adjacent rows of 8 tubes, using columns 3 through 10. For example, use
wells in row D (columns 3 through 10) and row E (columns 3 through 10).

C WARNING! Make sure that you use the flat caps for the 0.2uL tubes
and 0.1uL tubes. Use of rounded caps damages the heated cover.

3. Touch E on the QuantStudio™ 12K Flex Instrument touchscreen or click Close
Door in the Instrument Console screen of the QuantStudio™ 12K Flex Software to
retract the plate adapter back into the instrument.

You can configure the QuantStudio™™ 12K Flex Software to alert you by email when the
QuantStudio™ 12K Flex Instrument begins and completes a run, or if an error occurs
during a run.

Note: For details on using the Notification Settings feature, refer to the Applied
Biosystems QuantStudio'" 12K Flex Real-Time PCR System Maintenance and Administration
Guide.
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Run the You can run the experiment in either of the following two ways:
experiment e From the QuantStudio™ 12K Flex Software

e From the QuantStudio™" 12K Flex Instrument touchscreen

Note: The example experiments in each of the getting started guide booklets start a
run from the QuantStudio™ 12K Flex Software.

IMPORTANT! Make sure that instrument calibration is up-to-date. If a calibration has

expired, you will get a warning when you start a run. For information on calibrating

the QuantStudio'" 12K Flex Instrument, refer to Applied Biosystems QuantStudio™ 12K
Flex Real-Time PCR System Maintenance and Administration Guide.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the QuantStudio™ 12K Flex Instrument is in operation.

From the QuantStudio™ 12K Flex Software

y a RuU
1. In the QuantStudio™ 12K Flex Software, click m Run in the navigation
pane.

2. Click START RUN. Select the instrument for the run from the drop-down menu
of the instruments placed under My Instruments.

IMPORTANT! Make sure that the instrument to run the experiment on is in My
Instruments or the custom group, and that it is ready to run an experiment. If the
preferred instrument is not present under My Instruments or the custom group,
or if it is unavailable, clicking START RUN does not display instrument names in
the drop-down menu.

Run Status

' START RUM ¥

Fosmirajs1i01

SGEAGUSANKIDOL

enggd

From the QuantStudio™ 12K Flex Instrument touchscreen

1. Touch the QuantStudio™ 12K Flex Instrument touchscreen to awaken it.

Note: If the touchscreen is not at the Main Menu screen, touch n
2. In the Main Menu screen, touch Browse Experiments.

3. Inthe Browse screen, touch Wl  Folders, to display the folders containing the
experiment setup files.

4. Touch any of the folder names to display the experiments in that folder.
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5.

In the Experiments screen, select the desired experiment, then touch
View/Edit to view or edit the experiment before starting the run.

Note: You can start a run immediately by clicking M Start Run, then go
to In the Start Run screen, touch each field as needed to modify the associated
parameter, then touch Start Run Now to start the experiment.step 8.

(Optional) Modify the experiment parameters as needed. You can use the:

. Add and Delete buttons to add and delete a stage or step to
the thermal profile.

. Add Melt Curve button to add a melt curve to the thermal
profile.

. Save button to save the experiment you modify.

In the Save Experiment screen, touch each field to edit the:

¢ Experiment name

¢ Folder to save the experiment

* Reaction volume

* Barcode Number

¢ Notes
When finished, touch M Save & Start Run to start the experiment.
In the Start Run screen, touch each field as needed to modify the associated
parameter, then touch M Start Run Now to start the experiment.

Note: When the run is complete, touch to unload the plate from the
instrument. You can download the results of the experiment from a computer if
the instrument is connected to a network, or copy the data to a USB device as
explained in “Transfer experiment results” on page 47.

Monitor the Note: If there is loss of connection during an experiment, remove and then add the
experiment instrument to the My Instruments list. You may then resume monitoring the
experiment.

You can monitor an experiment run in three ways:

e From the QuantStudio " 12K Flex Instrument touchscreen, in the same way that

you run the experiment (see “From the QuantStudio'" 12K Flex Instrument

touchscreen” on page 39).

From the Run screen of the QuantStudio " 12K Flex Software, while the
experiment is in progress, as shown below.

From the Instrument Console of the QuantStudio'" 12K Flex Software (to monitor
an experiment started from another computer or from the QuantStudio™ 12K
Flex Instrument touchscreen) as described in “From the QuantStudio™" 12K Flex
Software Instrument Console” on page 41.

From the QuantStudio™ 12K Flex Software Run screen

1.

Click Amplification Plot from the Run Experiment Menu to monitor the
amplification plot of the experiment you are running,.

Note: For Melt Curve experiments, click Melt Curve Plot from the Run
Experiment Menu.

40 Getting Started with QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments



Chapter 1 General Information and Instructions 1
Start the experiment

2. Click Temperature Plot from the Run Experiment Menu to monitor the
temperature plot of the experiment you are running,.

From the QuantStudio™ 12K Flex Software Instrument Console

1. In the Instrument Console screen, select the icon of the instrument that you are
using to run the experiment.

2. Click Manage Instrument.

3. On the Instrument Manager screen, click Monitor Running Instrument.

You can view the progress of the run in real time from the Run screen. During the run,
periodically view the Amplification Plot, Temperature Plot and Run Method (see page
42) available from the QuantStudio™" 12K Flex Software for potential problems.

To...

Action

Stop the run

¢ In the QuantStudio™ 12K Flex Software, click STOP
RUN.

¢ In the Stop Run dialog, click one of the following:
- Stop Immediately to stop the run immediately.
- Cancel to continue the run.

View amplification data
in real time

View temperature data
for the run in real time

Select Amplification Plot.
See “To monitor the Amplification Plot” on page 42.
Select Temperature Plot.

See “To monitor the Temperature Plot” on page 42.

View progress of the run
in the Run Method
screen

Select Run Method.
See “To monitor the Run Method” on page 43.

Enable/disable the
Notification Settings

Select or deselect Enable Notifications.

See “Enable or change the Notification Settings” on page 38.

Note: The individual experiment booklets provide illustrations of the different

experiments in real time.

Note: For Melt Curve experiments, click Melt Curve Plot from the Run Experiment

Menu.
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The Run screen for a Standard Curve experiment run looks like this:

STOR RUM

Run Status:

L4 Estimated Time Remaining:3 min 11 sec

L Runnindi

Instrument Name: FOSMIRAJS1102

Temperature Plot Current Temperatures

Temperature

J- R -I- ‘fiI“ LE] Cover 105°C
- W sarmple 60°C
- Block 60°C

[

Temperature Plot

Temperature Plot

00:04:10

00:08:20

00:12:30 00:16:40 00:20:50 00:25:00 00:28:10 00:33:20 00:37:30 00:41:40 00:45:50 00:50:00 00:54:10 00:58:20

View 1 Hour -
Fixed View []

Time
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To monitor the Amplification Plot

To view data in the Amplification Plot, click Amplification Plot from the Run
Experiment Menu, select the Plate Layout tab, then select the wells to view.

The Amplification Plot screen allows you to view sample amplification as your
instrument collects fluorescence data during a run. If a method is set up to collect real-
time data, the Amplification Plot screen displays the data for the wells selected in the
Plate Layout tab. The plot contrasts normalized dye fluorescence (ARn) and cycle
number.

The Amplification Plot screen is useful for identifying and examining abnormal
amplification, including;:

* Increased fluorescence in negative control wells.

* Absence of detectable fluorescence at an expected cycle (determined from
previous similar experiments run using the same reagents under the same
conditions).

Note: If you notice abnormal amplification or a complete absence of signal,
troubleshoot the error as explained in the QuantStudio™" 12K Flex Software Help
(click €) or press F1).

To monitor the Temperature Plot

To view data in the Temperature Plot screen, click Temperature Plot from the Run
Experiment Menu.
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During a run, the Temperature Plot screen displays the temperatures of the sample
block(s), the heated cover, and samples (calculated) in real-time.

To...

Action

Add or remove temperature plots

Select Cover or Sample Block to
view the presence of the
associated data in the plot.

Change the time to display in the plot

Display a fixed time window during the instrument
run

If the entire plot does not fit in the screen, the
screen is not updated as the run progresses. For
example, if you select 10 minutes from the View
drop-down menu, the plot will show data for 10
minutes. If the Fixed View is:

¢ Deselected, the plot updates as the run
progresses even after 10 minutes.

e Selected, the plot does not update as the run
progresses even after 10 minutes.

From the View drop-down menu,
select the amount of time to
display in the plot.

' Select Fixed View.

The Temperature Plot screen can be useful for identifying hardware failures. When
monitoring the Temperature Plot screen, observe the Sample and Block plots for

abnormal behavior.

® The Sample and Block plots should mirror each other approximately. A
significant deviation of the plots may indicate a problem.

* The Cover plot should maintain the constant temperature specified in the
method. A departure from the constant temperature may indicate a problem.

Note: If you notice abnormal temperature plot, troubleshoot the error as
explained in the QuantStudio " 12K Flex Software Help (click €2 or press F1).

To monitor the Run Method

To view data in the Run Method screen, click Run Method from the Run Experiment

Menu.

The Run Method screen displays the run method selected for the run in progress. The
software updates the Run Status field throughout the run.

To...

Action

Change the number of cycles In the Adjust # of Cycles field, enter the number

of cycles to apply to the Cycling Stage.

Add a melt curve stage tothe end | Select Add Melt Curve Stage to End.

of the run

Add a Hold stage to the end of the | Select Add Holding Stage to End.

run
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To...

Action

Add an indefinite hold to the end
of the run

Select Add Infinite Hold to End

Apply your changes

Click Send to Instrument.

If an alert appears, click the error for more information and troubleshoot the problem

Run Data Report

Experiment Name:
Start Time:

Stop Time:

Run Duration:

User Name:
Instrurnent Name:
Firmware \ersion:
Software Version:
Instrurnent Serial Murnber:
Sarmple Volurme:
Cover Termperature:

Block Type:

Errors Encountered:

as explained in the QuantStudio™" 12K Flex Software Help (click €) or press F1).

To view the run data

After a run is complete, you can view a run report by clicking View Run Data. The
View Run Data screen displays information about the completed run, as in the
following example from a Standard Curve experiment:

384-Well Fast Standard Curve Example
08-06-2011 12:33:30 SGT
08-06-2011 13:15:47 SGT

42 minutes 17 seconds

DEFAULT

QuantstudioDemo

0.13.1

Quantstudio 12K Flex Software v1.0
QuantstudioDemo

20.0

105.0

384-wel Block
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The run report data helps in:
¢ Comparing two experiments of the same type run on two different instruments.

e Troubleshooting. For example, after a firmware upgrade, you can compare an
experiment run before and after the upgrade to determine if the upgrade affected
performance.

From the QuantStudio™ 12K Flex Instrument touchscreen

The touchscreen displays the method for the experiment, the date and time at which
the run started, the time remaining in the run, and other information.

To... Action

Display a graphical
view of the run

Touch Experiment View.

Show the Amplification
Plot for the run

Touch the Plot View, then touch Experiment View to
return to the Run Method screen.
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To... Action
Display the time Touch the @ Time View tab, then touch Experiment
elapsed and the time View tab to return to the Run Method screen.
remaining in the run
Stop the run Touch @ STOP to stop the protocol run immediately.
View the Events Log Touch the status bar to display the events log.

The run method on the QuantStudio™ 12K Flex Instrument touchscreen is shown in
the following graphics:

Experiment View

@ Time Yiew Plot View |  Experiment View
Run Started: December 08 2011 - 12:05AM Sample: 95.0 °C
Reaction Volume: 20 pL Heated Cover (Set Point): 105.0 °C (105.0 °C)
Time Remaining: 01:27:04
%
Stage 1 Stage 2
10f1 X 40
95.0°C 95.0 °C

J— 7:14 0:15 \, 40.0 °C
- 1:00
/7 2:00 5

December 08 2011 - 12:054M o

Heated cover reached target temperature.

Getting Started with QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments

45



Chapter 1 General Information and Instructions

Start the experiment

Time View
@ Time View Plot View ]  Experiment View
Run Started: December 08 2011 - 12:05AM Sample: 59.5 °C
Reaction Volume: 20 pL Heated Cover (Set Point): 105.0 °C (105.0 °C]
Stage /Step /Cycle: 2/2/5
@ Remaining Time o Elapsed Time
December 08 2011 - 12:06AM o
Error occurred during run. Details: Holdtime 60 s exceeded. Actual Holdtim...
Plot View
#]  Experiment View @ Time View Plot View
Fast 96-Well Tagman ¥V ARn V¥

0.001

December 08 2011 - 12:07AM

o

Heated cover reached target temperature.

The Plot View displays the Amplification Plot in real time. You can change the plot
using the drop-down menus present below the Plot View tab.

Touch... To...

Change the data displayed on the y axis. Select either Rn (normalized
Rn W reporter) or ARn (baseline-corrected normalized reporter).
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Touch... To...

FAM v

Change the reporter dye displayed in the plot. Only dyes used in your
experiment are shown.

View the run events that occurred during the run. Touch @ again
to close the event list..

™

Unload the When your QuantStudio = 12K Flex Instrument displays the Main Menu screen,
instrument unload the reaction plate from the instrument and transfer the experiment data to the
computer for analysis.

Unload the reaction plate or array card

C CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the

temperature of the sample block(s) can exceed 100 °C. Keep your hands away
until the sample block(s) reaches room temperature.

1.

Touch gl on the QuantStudio™ 12K Flex Instrument touchscreen or click Open
Door in the Instrument Console screen of the QuantStudio'" 12K Flex Software.

Remove the reaction plate or array card from the plate adapter.

Touch H or click Close Door to retract the plate adapter back into the
instrument.

If the QuantStudio™™ 12K Flex Instrument does not eject the plate, remove the
plate as follows:

a. Power off the QuantStudio™ 12K Flex Instrument.

b. Wait for 15 minutes, then power on the QuantStudio™ 12K Flex Instrument
and eject the plate.

™

c. If the plate does not eject, power off and unplug the QuantStudio = 12K Flex
Instrument, then open the access door.

d. Wearing powder-free gloves, reach into the QuantStudio™ 12K Flex
Instrument and remove the plate from the heated cover, then close the access
door.

e. Perform a background calibration to confirm that the sample block has not
been contaminated.

Transfer You can transfer the experiment results in either of the following two ways:

experiment results

Download the experiment from the QuantStudio™ 12K Flex Instrument over the

network
1. In the QuantStudio™ 12K Flex Software, select Instrument » Instrument
Console.
2. Select the instrument icon of the QuantStudio'" 12K Flex Instrument you just
used to run the experiment from the My Instruments list.
3. Click Manage Instrument to open the Instrument Manager.
4. In the Instrument Manager, click Manage Files.
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5.
6.

In the Experiments panel, select the experiment to download. Click Download.

In the Save dialog box, select the folder to hold the experiment results and click
Save. The experiments folder is located at:

<drive>:\ Applied Biosystems\ QuantStudio 12K Flex Software\ experiments\

where, <drive> is the computer hard drive on which the QuantStudio™ 12K Flex
Software is installed. The default installation drive for the software is the C: drive.

Transfer the experiment from the QuantStudio™ 12K Flex Instrument to the
computer via a USB drive:

1.

o M DN

If not already connected to the instrument, connect a USB drive to the USB port.

@

Touch the QuantStudio™ 12K Flex Instrument touchscreen to awaken it.
If the touchscreen is not at the Main Menu screen, touch n
In the Main Menu, touch Collect Results to save the data to the USB drive.

Select one or multiple experiments (by touching them). Then touch [gZd Save to
USB to copy selected experiments to the USB drive.

Note: If your instrument cannot find the USB drive, remove the USB drive, then
try again. If the instrument still does not recognize the USB drive, try another USB
drive.

. Touch n to return to the Main Menu.

Remove the USB drive from your instrument, then connect it to one of the USB
ports on your computer.

In the computer desktop, use the Windows explorer to open the USB drive.

Copy the example experiment file to:
<drive>:\ Applied Biosystems\ QuantStudio 12K Flex Software\ experiments\
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where <drive> is the computer hard drive on which the QuantStudio™ 12K Flex
Software is installed. The default installation drive for the software is the C: drive.
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Review experiment results

About analysis
results

About the Analysis
Settings Library

Immediately after a run, the QuantStudio™" 12K Flex Software automatically analyzes
the data using the default analysis settings, then displays the Amplification Plot
screen.

Note: For auto-analysis of data, after a run, go to Tools » Preferences » Experiment
and select the Auto Analysis check box.

Note: For Genotyping experiments, the QuantStudio'" 12K Flex Software displays the
Allelic Discrimination Plot screen.

To reanalyze the data, select all the wells in the plate layout, then click Analyze.

Analysis Settings are different for each experiment type. If the default analysis settings
in the QuantStudio™" 12K Flex Software are not suitable for your own experiment, you
can change the settings in the Analysis Settings dialog box, then reanalyze your
experiment.

You can save the changed analysis settings to the Analysis Settings Library so that you
can use them in other experiments.

In the Analysis Settings Library dialog box you can apply a filter to reduce the number
of settings protocols displayed.

You can access the Analysis Settings Library from the Tools menu. The Analysis
Settings Library dialog box looks like this:

Ana s Se g ibra
Analysis Settings Library

Select analysis settings or delete analysis settings. Apply a filter to reduce the number of analysis settings displayed. tj

Enter a filker query, then dick "Apply Fitter.”

IF |Analysis Settings v/ |=

| [ coct riter Y

Dalcle Celate Al

Analysis Settings Experiment Type Comments Created On Last Modified
SC-22 Standard Curve 12-08-2011 16:32:14 5GT (12-08-2011 16:32:22 SGT
GT-36 Standard Curve 12-08-2011 16:32:31 56T |12-08-2011 16:32:41 5GT

Ezit Analysis Settings Library
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To change the analysis settings and to save them to the Analysis Settings Library:

1. From the Experiment Menu pane, select Analysis.

Getting Started with QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments



To override
calibration

Chapter 1 General Information and Instructions 1
Review experiment results

On the Analysis screen, click Analysis Settings to open the Analysis Settings
dialog box.

Change the analysis settings as per your requirement.

Click Save to Library to save the changes you have made to the Analysis Settings
Library.

You can import the analysis settings you have previously saved to the Analysis
Settings Library, by clicking Load from Library in the Analysis Settings dialog box.

Each experiment file (.eds) stores the calibration data from the QuantStudio™" 12K Flex
Instrument it was run on. The calibration data can affect the analysis results of an
experiment.

If you have run multiple experiments on different QuantStudio™" 12K Flex Instruments
and prefer the analysis results from a particular instrument, then you can choose to use
the calibration data from another QuantStudio™ 12K Flex Instrument.

To use the calibration data of another experiment

1.

Open the experiment file (.eds), in which you want to import the calibration data
from another QuantStudio™™ 12K Flex Instrument, in the QuantStudio™ 12K Flex
Software.

Go to Analysis » Override Calibration » Use Calibration From Another File....

File Edit Instrument | Analysis | Tools  Help
Analysis Settings...

I Cose -—F Impart... = &% Create Slide..

Analyze

Cwverride Calbration »

e Calibration From Another File...

0

Browse to experiment file (.eds) from which you want to use the calibration data.

Revert To Criginal Calibration ll

Note: You can choose to override the calibration data in an experiment with the
calibration data of only the same experiment type.

4. Click Open.

To revert to the original calibration data

1.

Open the experiment file (.eds), in which you want to import the original
calibration data, in the QuantStudio™ 12K Flex Software.

Go to Analysis » Override Calibration » Revert To Original Calibration.

_ File Edit Instrument | Analysis | Tools  Help

ialv=Eleetino=2y I Cose -—F Impart... = &% Create Slide..

Analyze

Cwverride Calbration »

e Calibration From Another File...

0

The experiment file will display analysis results as per the calibration data of the
QuantStudio™ 12K Flex Instrument that the experiment was run on.

| Revert To Criginal Calibration |

Getting Started with QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments 51



1 Chapter 1 General Information and Instructions
Review experiment results

To display wells To display specific wells in the analysis plots, select the wells in the Plate Layout tab:

¢ To select wells of a specific type, use the Select Wells drop-down menus: Select
Sample, Target, or Task, then select the sample, target, or task name.

¢ To select a single well, click the well in the plate layout.

¢ To select multiple wells, click and drag over the desired wells, press Ctrl-click, or
press Shift-click in the plate layout.

e To select all the wells, click the upper left corner of the plate layout.

The plate layout for a Standard Curve experiment is shown in the following graphic:

bl Plate Lavout ‘Well Table
-
1 2 3 4 5 ] 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24
Papl Papl Pool Pool Papl Papl Pool Pool Papl Popl?
a ) @ 5] 5] 1 5] 5] mb mhk mk mbk mk mhk mk mk mk mk
Popl Popl Popl Popl Popl Popl Popl Popl Popl Popl
g | & 5] 8 5] 5] 5] mp m mh mh mb mb me mb mP mt m#
D E E E E E Papl Papl Popl Pool Papl Papl Popl Pool Papl Fap? Pop2 Pop? Papl Fap? Pop2 Pop? Papl Fop?
€ m m m m m m m m m mh mk e b mh mk e b mb
D E E E E E Papl Papl Pool Pool Papl Papl Pool Pool Papl PopZ Pop2 Pop2 PgopZ PopZ Pop2 Pop2 PgopZ PopZ
D m m m m m m m m m mk mk mk b mk mk mk b mk
D E E E E E Paol Paopl Pool Pool Paol Paopl Pool Pool Paol Papl Pop2 Pool Papl Papl Pop2 Pool Papl Popl
E m m m m m m m m m mh mk b b mh mk b b mb
l] E E E E E Papl Papl Pooi Pool Papl Papl Pooi Pool Papl Pap? Pop2 Pop2 PapZ Pap? Pop2 Pop2 PapZ Popl
F m m m m m m m m m mk b b b mk b b b mb
Papl Papl Pool Pool Papl Papl Pool Pool Papl Papl Paopl
| d 5] 5] B 5] 5] m m me mt it mt me mt i Jras s
Papl Papl Pool Pool Papl Papl Pool Pool Papl Pap? Pop?
Hi @ a8 8 5] a a8 mb mh mh mt mh mh mh mh mh m#
Popl Popl Popl Popl Popl Popl Popl Popl Popl Popl
1| O 5] 5] B 5] 5] m mP mP ik ik me A mP b mb
D E E E E Papl Papl Popl Pool Papl Papl Popl Pool Papl Fap? Pop2 Pop? Papl Fap? Pop2 Pop? Papl Fop?
Bl 1 m m m m m m m m m mk ik ik ik mk ik ik ik mb
D E E E E E Papl Paopl Pool Pool Papl Paopl Pool Pool Papl Pop2 Pop2 Pop2 PgpZ Pop2 Pop2 Pop2 PgpZ PopZ
K m m m m m m m m m mk mk b ik mk mk b ik mb
D E E E E E Paol Paopl Pool Pool Paol Paopl Pool Pool Paol Papl Pop2 Pool Papl Papl Pop2 Pool Papl FPopl
L m m m m m m m m m mh b b b mh b b b mb
Pool Pool Pool Pool Pool Pool Pool Pool Pool Pop2 Pop2 Poo2 Pap2 Pop2 Pop2 Poo2 Pap2 Pop2
m| & a8 a8 5] ] a8 m m m m m m m m m mk mf mk  mf _mf mf mf mf | mb
Paol Papl Pool Pool Paol Papl Pool Pool Paol Pop2 Popl
n| @ 5] A 5] 5] 5] m me mt mt mt me mt i e s
Papl Papl Pooi Pool Papl Papl Pooi Pool Papl Pop2 Popl
of @ a8 8 5] a a8 mb m mh mb mb mb mh mb mk mh m#
D E E E E E Papl Papl Pool Pool Papl Papl Pool Pool Papl Papl Pop2 Pool Papl Papl Pop2 Pool Papl Popl
P m m m m m m m m m m# e e e m# e e e mb
wels: [T 288 £ 80 [ 16 0 Empty
well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 4 Omitted by Anatysis: () Omitted Manualy: ( Samples Used: 2 Targets Used: 1

To di spl_ay mul_tipl_e Use the Multiple Plots View screen to display up to four plots simultaneously. To
plots navigate within the Multiple Plots View screen, from the Experiment Menu pane,
select Analysis » Multiple Plots View.

e To display four plots, click 55 Show plots in a 2 X 2 matrix.

* Similarly, to display two plots in rows, click = Show plots in two rows. and to
display two plots vertically, click [|[| Show plots in two columns.

e To display a specific plot, select the plot from the drop-down menu above each
plot display.
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The Multiple Plots View screen for a Standard Curve experiment is shown in the
following graphic:

Multiple Plots View <
o) =
E—
IAmpIiﬁcatinn Plot - Rn vs Cycle LI IAmpIiﬁcation Plot - ARn vs Cycle LI
AP A B g E PP a B g E
Amplification Plot Amplification Plot
10
, M
F o
001
0.001
2 4 L] L] 0 12 14 16 |\ oM B M X M ki 2 ) 3 I
Cycle
Amplification Plot - C1 vs Well Number ﬂ Multicomponent Plot LI
£ oOp A E A L B g =
i . Multicomponent Plot
Amplification Plot 500,000
100
[ T + 4 4 Y & 3 400,000
£
10 & 300000
@
=)
S 200,000
=
— i
o 1 100.000
o+
01 a
Lagerd
0.01 W FAM M ROX
Well Number
well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 0 Onmitted by Analysis: 0 Critted Manually: O Samples Used: 2 Targets Used: 1

To display an
expanded view of a
plot or wells

To edit plot
properties

Getting Started with QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments

e Click 2 to expand the view of a plot, displayed on the left-hand side of the screen.

o Click & to expand the view of the Plate Layout or Well Table displayed on the
right-hand side of the screen.

Use the Plot Properties dialog box on the Analysis screen to edit plot settings such as
the font and color of the plot text, and the labels on the X axis and Y Axis.

~
1. Click on the Analyze screen (the icon appears above the plot) to open the Plot
Properties dialog box

2. Edit the settings under the General, X Axis, and Y Axis tab.

* C(lick the General tab to edit the plot title text, font, or color. You can also

select whether to show the plot title.

Click the X Axis tab to edit the x axis label text, font, or color; select the tick
marks and tick mark labels to display; and select the range to display.

Click the Y Axis tab to edit the y axis label text, font, or color; select the tick
marks and tick mark labels to display; and select the range to display.

3. Click OK.
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To save current You can change the Plot Settings for the different analysis plots, and save them as

settings as default  defaults.

Select the Save current settings as the default check box on the respective plot screens

under the Analysis Exp

Plot Settings

eriment Menu.

Flot Type: |£\Rn s Cycle 'I Graph Type: ILDg vl Plot Color: |We|| 'I

||_ Sawe current settings as the default |

To publish the

analyzed data To...

Click

Save a plot as an image

Print a plot

file

[&] [#]

Copy a plot to the clipboard

=)

Print a report

b Prit Repart..,,

Export data

I [r
|
[1

To...

Go to

Then

Print the plate layout

File » Print...

Select the background color; and
click Print

Create slides

Print a report

File » Send to PowerPoint...

File » Print Report...

Select the slides for your
presentation, and click Create

Slides

Select data for the report, and
click Print Report

Export an experiment

About exporting an  The Export feature of QuantStudio™ 12K Flex Software allows you to export:

experiment * Plate setup files for future experiments.

Plate setup files contain setup information such as the well number, sample name,
sample color, target name, dyes, and other reaction plate contents.

¢ Analyzed data in different formats for further analysis.
The data can be exported in the QuantStudio 12K Flex format, the 7900 SDS
format, and the RDML format.

The 7900 format is applicable only to Standard Curve, Relative Standard Curve,
Genotyping, Presence/Absence, and Melt Curve experiments.

The RDML export format is applicable only to Standard Curve, Relative Standard
Curve, Comparative Cp, and Melt Curve experiments. The RDML format is

available only in a

single file format.
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Export an experiment

For Standard Curve experiments, you can also export the analyzed data from the
QuantStudio™ 12K Flex Software to the external application, CopyCaller®

Software if it is installed on your computer before the QuantStudio™ 12K Flex

Software is installed. The application appears in the Tools menu.

* Gene Expression studies to carry out a comparative analysis.

Export procedure Note: If you choose the Auto Export option during experiment setup or before
running an experiment, the data is automatically exported to the location you
specified. If you did not set the Auto Export option, the analyzed data is not exported
automatically.

1. Open the experiment file that contains the data to export, and from the
Experiment Menu, click E Export.
2. Select the format for exported data:
* QuantStudio 12k Flex format (supports .txt, .xls, and .xIsx data).

¢ 7900 format - Single experiments are exported in the SDS 2.4 detector centric
export format of the 7900 Sequence Detecting System.
The 7900 format supports only the .txt type of data.

* RDML format - Real Time Data Markup Language (supports only .xml type
of data).
3. Select to export all data in one file or in separate files for each data type.
¢ One File - All data types are exported in one file.
— If you select the *.xIs format, a worksheet is created for each data type.
— If you select the *.txt format, the data are grouped by data type.

* Separate Files - Each data type is exported in a separate file. For example, if
you select three different data types Results, Amplification, and
Multicomponent to export, three separate files (one each for Results,
Amplification, and Multicomponent) are created. You can select the type of
file (*.xIs, *.xlsx or *.txt) to export from the File Type drop-down menu.

Note: You cannot use an exported *.xIs or an *.xIsx file when importing plate
setup information.

4. (Optional) Select the Open file(s) when export is complete check box to
automatically open the file when export is complete.

5. Enter a file name and location.

a. Enter a name for the export file in the Export File Name field.
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Export an experiment

b. Enter the Export File Location. Click Browse if you do not want to save the
export file in the default export folder.

Note: To set up the Export File Location, go to Tools » Preferences, and
select the Export tab. You can select the Use Last File Location or Use
Default Folder check box.

B Preferences

( Non-OpenArray T OpenArray® Block Run T Global MNatification Settings T Startup

Experiment Print Display Format SMTP Settings

(O Use Last File Location

(%) Use Default Folder ms\QuantStudio 12K Flex Software\User Files\experiments _

Restore Defaults m
8

6. Select the data to export:

Select... To export...

Sample setup Well, sample name, sample color, and target name of
samples in the plate

Raw data Raw fluorescence data for each filter, for each cycle
Amplification data Amplification results, such as Cy values, Rn, or ARn
Multicomponent data Fluorescence data for each dye, for each cycle
Results Results information, such as Ct values, Rn, or calls
Technical Replicate Technical replicates information, such as Sample name,
Results (Tech. Rep. Target name, Task, or RQ
Results)
Biological Replicate Biological replicates information, such as Biogroup

Results (Bio. Rep. Results) | name, Target name, Task, or RQ

Note: Results data are not available for export until the run status is complete and
the data are analyzed.

Note: The Technical Replicate Results and Biological Replicates Results are
available only in Relative Standard Curve and Comparative Cp experiments.

Getting Started with QuantStudio™ 12K Flex System Multi-Well Plates and Array Card Experiments



[ Auto Export

Chapter 1 General Information and Instructions 1
Export an experiment

7. (Optional) For Standard Curve experiments, select the external application,
CopyCaller® Software if the Software is installed on your computer.

8. (Optional) After you have defined the export properties or after moving the table
headings order, you can save those export settings as an export set by clicking
Save Export Set As. Later you can import the heading order into another file by
clicking Load Export Set. You can also delete export settings by clicking Delete
Export Set.

Note: It is advisable to keep the default order of the table headings if you are
using the external Applied Biosystems application, CopyCaller® Software for
further analysis.

9. Click Start Export.

The Export screen for a Standard Curve experiment is shown in the following
graphic:

Format : [QuantStudio12KFlex ~ Export Data To: & One File (& Separate Files Open file(s) when export is complete

Export File Location: |C:\Applied Biosystems\QuantStudio 12K Flex Software - Export File Mame: | 284-well Fast Standard Curve Example_Qua File Type: |3] (=.xis) ~

Sample Setup [] Raw Data

kip Omitted ¥

Amplification [ Multicompanent

Select Content

All Fields

well

‘Well Position
Sample Name
Target Name

Task

Reporter
Quencher

cT

Ct Mean

Ct 5D

Quantity

Quantity Mean
Quantity SD
Automatic Ct Threshold
Ct Threshold
Automatic Baseline

Baseline Start

well Well Position Sample Name | Target Name Task Reporter Quencher c
1a1 RMaseP NTC FAM NFQ-MGE -~
2 A2 RMaseP STANDARD FAM NFQ-MGE 29
2 a3 RMaseP STANDARD FAM NFQ-MGE 28
4 A4 RMNaseP STANDARD FAM NFQ-MGE 26
5AS RMNaseP STANDARD FAM NFQ-MGE 25
6 A6 RMaseP STANDARD FAM NFQ-MGE 24
7 A7 Popl RMaseP UNKNOWVH FAM NFQ-MGE 27
8 A8 Popl RMNaseP UNKNOWWH FAM NFQ-MGE 27
9 A9 Popl RMNaseP UNKNOWWH FAM NFQ-MGE 26

10 A10 Popl RMaseP UNKNOWVH FAM NFQ-MGE 27
11 411 Popl RMNaseP UNKNOWWH FAM NFQ-MGE 26
12 A12 Popl RMaseP UNKNOWWH FAM NFQ-MGE 26
13 A13 Popl RMaseP UNKNOWVH FAM NFQ-MGE 26
14 Al4 Popl RMNaseP UNKNOWWH FAM NFQ-MGE 27
15 A1S Popl RMNaseP UNKNOWWH FAM NFQ-MGE 26
16 A16 Pop2 RMaseP UNKNOWVH FAM NFQ-MGE 25
17 A17 Pop2 RMNaseP UNKNOWWH FAM NFQ-MGE 25
18 A18 Pop2 RMaseP UNKNOWWHN FAM NFQ-MGB 26
19 Al9 Pop2 RMNaseP UNKNOWWH FAM NFQ-MGE 26
20 A20 Pop2 RMaseP UNKNOWVH FAM NFQ-MGE 25
21 A21 Pop2 RMNaseP UNKNOWWH FAM NFQ-MGE 25
22 A22 Pop2 RMaseP UNKNOWWH FAM NFQ-MGE 26
23 A23 Pop2 RMaseP UNKNOWVH FAM NFQ-MGE 25
24 A24 Pop2 RMNaseP UNKNOWWH FAM NFQ-MGE 26
25B1 RMNaseP NTC FAM NFQ-MGB
26 B2 RMaseP STANDARD FAM NFQ-MGE 28
27 B3 RMNaseP STANDARD FAM NFQ-MGE 28
28 B4 RMaseP STANDARD FAM NFQ-MGE 27
2985 RMaseP STANDARD FAM NFQ-MGE 25
30 B6 RMaseP STANDARD FAM NFQ-MGE 25
< >

Start Export | Save Export Set As | Load Export Set || Delete Export Set
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The exported file when opened in Notepad appears as shown in the following
graphic:

[C. 384-Well Fast Standard Curve Fxample_QuantStudio_export.txt - Notej
File Edit Format Wiew Help

Barcode = NA
Block Type = 384-well Block

calibration Background is expired = No

calibration Background performed on = 2011-08-05 01:46:18 AM SGT
calibration FaM s expired = No

calibration Fam performed on = 2011-08-05 02:04:58 AM SGT
calibration ROI is expired = No

calibration ROI performed on = 2011-08-04 11:42:31 AM SGT
calibration rOx is expired = No

calibration ROX performed on = 2011-08-05 02:23:30 AM SGT
calibration Uniformity is expired = No

calibration uniformity performed on = 2011-08-05 01:56:21 AM SGT
calibration VIC is expired = No

calibration vic performed on = 2011-08-05 02:15:08 AM SGT
Chemistry = TAQMAN

Comment = NA

pate created = 1970-01-01 07:30:00 AM SGT

Exp1er7‘mgnt File Name = C:\Program Files‘aApplied Biosystems‘\Quantstudiol2kFlex‘examples\standard cCurve'384-well Fast standard Curve
xample. eds

Experiment Name = 384-well Fast standard curve Example
Experiment Run End Time = 2011-08-06 13:15:47 PM SGT
Experiment Type = Standard Curve

INSTrument Name = QuantstudiobDemo

Instrument Serial Number = QuantstudiobDemo

Instrument Type = QuantStudio 12K Flex

passive Reference = ROX

quantification cycle method = ct

Ssignal smoothing on = true

stage/ Cycle where Analysis is performed = stage 2, step 2
User Name = MA

% ® B K & B K F E K KM X & K X F E K B E F K K K & X X B X

[sample setup]

well well Position  Sample Name Sample Color Biogroup Name Biogroup Color Target Name Target Color Task Reporter
qQuencher Quantity Comments

a1l Al RNaseP "RGB(176,23,31)" NTC FAM NFQ-MGB

2 A2 RNaseP "RGB(176,23,31)" STANDARD FAM NFQ-MGB "1,250.000"
3 a3 RNaseP "RGB(176,23,31)" STANDARD FAM NFQ-MGB "2, 500.000"
4 Ad RNaseP "RGB(176,23,31)" STANDARD FAM NFQ-MGB "5,000.000"
5 AS RNaseP "RGB(176,23,31)" STANDARD FAM NFQ-MGB "10, 000.000"
6 AB RNaseP "RGB(176,23,31)" STANDARD FAM NFQ-MGB "20,000.000"
% A7 Popl "RGB(0,255,0)" RNaseP 'RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

8 AB Popl "RGB (0, 255,0)" RNaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

9 A9 Popl "RGB (0, 255,0)" RNaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

10 ALD Popl "RGB(0,255,0)" RNaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

11 all Popl "RGB (0, 255,0)" RNaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

12 al2 Popl "RGB (0, 255,0)" RNaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

1.3 Al3 Popl "RGB(0,255,0)" RNaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

14 ald Popl RNaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

15 Al5 Popl RNaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

16 ALG PoOp2 RNaseP 'RGB(176,23,31)" UNKNOWN FAM NFQ-MGE

17 Aal7 Pop2 RNaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

18 AlB POp2 RNaseP "RGB(176,23,31 UNKNOWN FAM NFQ-MGB

19 Al9 PoOp2 "RGB(255,102,0)" RNaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGE

E3
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Experiment Shortcuts

This chapter provides you with shortcuts to use in the QuantStudio™ 12K Flex
Software after you have learned experiment basics.

You can reuse experiment settings and plate setup information by: directly importing
and editing a template, using the QuickStart feature with a template, importing
experiment setup information, or importing a sample definition file; you can also
prepare several experiments at once or create a new experiment using the ReadiApp
feature.

Create an experiment from atemplate ................ ... L. 59
QuickStart an experiment . ........... .. i 60
Import plate setup for an experiment . ........ ... ... ... .. il 62
Import sample information. ........... ... .. i 63
Use a template to create a batch of experiments ........................... 66
Create an experiment using ReadiApp.................. ... ... ... 68

Create an experiment from a template

To create a
template

To create a new
experiment using a
template

You can use a template to create a new experiment. Templates are useful when you
want to create many experiments with the same experiment parameters.

You can create an experiment from a template from the QuantStudio'™ 12K Flex
Software and from the QuantStudio™ 12K Flex Instrument touchscreen.

Note: To access the QuantStudio™" 12K Flex Software example templates, navigate to
the templates folder located at <drive>:\ Program Files\ Applied
Biosystems\ QuantStudio12KFlex\ templates.

1. Log in to the QuantStudio'" 12K Flex Software and, from the Home screen, open
an existing experiment, or create a new experiment.

Note: To create a new experiment using the Experiment Setup, see “Set up an
experiment” on page 10.

2. Select File » Save As Template.

3. Enter a file name, select a location for the template, then click Save and = Close.

You can use that experiment as a template for similar experiments.

1. From the Home screen, click d,_.f Create From Template.

2. Locate and select the template file, then click Open.
A new experiment is created using the setup information from the template.
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QuickStart an experiment

3. Edit the experiment properties, plate definitions, plate assignments, and run

method before you prepare the reactions and run the experiment.

4. Proceed to preparing reactions, running the experiment, and analyzing the data.

To create an You can run experiments using templates from the QuantStudio"" 12K Flex Instrument
experiment using a touchscreen by importing the templates from the QuantStudio™ 12K Flex Software
template on the instrument console or a USB drive. You can also modify the experiment parameters in

QuantStudio™ 12K the templates as per your requirement.

Flex Instrument
touchscreen

To run a pre-existing template

1. Touch View Template on the Home screen of the QuantStudio™™ 12K Flex

Instrument touchscreen.

Select a pre-existing template from the templates list on the View Templates
screen.

Touch E View to see the run profile before you start a run.

After confirming the template setup is correct, touch ‘ to go back to View
Template screen. Touch Start Run.

To edit a template before running the experiment

1.

Touch New on the View Templates screen to create a new experiment from
the existing template.

Note: Select a template before you touch New.
Edit the experiment parameters in the Create New Experiment screen.

Touch E Save & Exit to save and exit the experiment or touch h Save &
Start Run to save and start an experiment run.

QuickStart an experiment

You can use a template to run an experiment with the QuantStudio™ 12K Flex
Software Quickstart feature:

QuickStart from 1.

the QuantStudio™
12K Flex Software

Prepare the reactions.

2. Login to the QuantStudio™ 12K Flex Software and, from the Home screen,

click ) 96/384/Array Cards to access the Run 96/384/Array Cards dialog box.

In the QuickStart dialog box, enter or select the:
a. Instrument icon of the instrument to perform the run on.
b. Experiment name.
c. Experiment location.
d. Experiment template file.

e. (Optional) Barcode, User Name, and Comments for the experiment.
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QuickStart an experiment

4. (Optional) To review the experiment or to make changes to any of the experiment
parameters, click Experiment Setup.

The 96/384/Array Cards dialog box looks like this:

FOSMIRAJS1L02Z

READY ;|
Enter Experiment Name and Location
* Experiment Name: [2011-12-08 175832 | Locztion: [e\User Files\experiments\2011-12-08 175832.eds|
Barcode (Optional): | |Comment; (Optional): ~
User Mame (Dptlnnal):| | v

Select Experiment Template
* Experiment Template File:| v|

Samples

Sample
=

You rmay import a plate setup file or a sample definition text file. Alternatively, you may
directly edit the sample names in the table to the left, or copy and paste sample names
from a spreadsheet,

| Experiment Setup l START RUM _

5. Proceed to running the experiment and analyzing the data.

QuickStart from You can QuickStart an experiment from the QuantStudio™ 12K Flex Instrument
the QuantStudio™ touchscreen in the following ways:

12K Flex e Start an experiment using a pre-defined template.

Instrument e Start an experiment with a pre-defined short-cut button.

touchscreen

Start an experiment using a pre-defined template

You can use a pre-existing template from the default experiments folder or use a
custom template from another folder to start a run.

Start an experiment with a pre-defined short-cut button

The QuantStudio™" 12K Flex Instrument touchscreen displays up to 18 shortcut buttons
to templates or folders that contain experiments to be run. The shortcut buttons are
present under My Shortcuts on the Home screen. To start a run, touch any of the pre-
defined experiment or folder buttons.

To create a shortcut button for a preferred experiment or a folder that contains
experiments:
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1. Touch Settings to open the Settings Menu.
2. Touch Set Up Shortcuts to list the Shortcut Targets.

3. On the Shortcut Targets list screen, select an existing template Shortcut Target
button or an unused button.

4. Touch Set Shortcut. If you selected an unused button, then touching Set Shortcut
will list out the templates and folders to set the shortcut for.

5. Under the ™ From Templates tab, select the templates for which you are
creating the shortcut button.

6. (Optional) Create a shortcut button to show the templates or experiments in a
particular folder for quick access, from those listed under the From Folders tab.
You can touch Edit to create or edit shortcut buttons.

Import plate setup for an experiment

62

You can import the plate setup for a new experiment from an exported file with one of
the following formats:

e *itxt- Text format

e *xml - XML format

* *.csv - Comma separated values format

e *sdt- Sequence detecting system (sds) template files format
e *sds-7900 v2.3 format

IMPORTANT! Make sure the file you select contains only plate setup data and that the
experiment types match.

Note: For instructions on exporting an experiment, see “Export an experiment” on
page 54.

To Import the plate setup data:
1. Create a new experiment or open an existing experiment.

2. In the Experiment Setup screen, select File » Import Plate Setup or access the
Import drop-down menu in the toolbar and select Import Plate Setup.

3. Click Browse, locate and select the file to import, then click Select.

Import Plate Setup x|

Select the plate setup file ta import, then click Start Import. 9/,

Select File:
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Import sample information

4. Click Start Import. The setup data from the exported text file is imported into the

open experiment.

Note: If your experiment already contains plate setup information, the software
asks if you want to replace the plate setup with the data from the import file. Click
Yes to replace the plate setup.

. After importing plate setup information, use Experiment Setup to set up your

experiment, and then run the experiment.

Note: You can import plate setup information from a 96-well plate into a 384-well

plate, provided that the file you are importing the information from is a .txt file.

Import sample information

Create a sample
definition file

You can import sample information from a sample definition file to include in the plate
setup for your experiment. A sample definition file is a comma-delimited file (*.csv) or
a tab-delimited text file (*.txt) that contains the following setup information: well
number, sample name, and custom sample properties.

Note: Make sure that the sample definition file you select contains only sample
information.

Open a text editing program such as Notepad.

Enter the following column headers in the first row (press the Tab key between
each entry if you are saving the file as *.txt or enter a comma between each entry if
you are saving the file as *.csv):

e Well
* Sample Name

* (Optional) Column header names for up to six user-defined custom fields (for
example, Custom 1, Custom 2, etc.)

. For each subsequent row, enter the well number, press the Tab key or enter a

comma, then enter the sample name. Optionally, press the Tab key, then enter the
custom properties for the sample.

Save the file with the .txt or .csv file extension.
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An example sample definition, saved with the .csv extension, file looks like this:

A B | E | ©
1 el Sample Mame Sex HairCaolar | Smaoker
2| 1 Zample 1 1 22 Female 25 black es
3| 2 Sample 2 2 25 Male 26 brawn Mo
4 3 Sample 3 3 45 Female S0 blonde  Yes
48| 4 Sample 4 4 31 Male 33 red es
B 5 Sample 5 5 29 Female 46 grey Mo
7 G Sample & g 26 Male 35 black Mo
8 | 7 Sample 7 7 31 Female 33 black es
9 g Sample 3 g 32 Male 67 black Mo
1o 9 Sample 9 9 32 Female 55 brawn es
AN 10 Sample 10 10 33 Male 44 blonde  Yes
12 11 Sample 11 11 34 Female 25 red Mo
13 12 Sample 12 12 34 Male 26 grey Mo
14 13 Sample 13 13 35 Female a0 black es
15 14 Sample 14 14 35 Male 33 black Mo
= 15 Sample 15 14 36 Female 46 black es
17 16 Sample 16 16 36 Male 35 brawn es
=l 17 Sample 17 17 37 Female 33 blonde Mo
18 18 Sample 18 13 37 Male 67 red Mo
a0 19 Sample 19 19 38 Female 55 grey Yes
21 20 Sample 20 20 358 Male 44 black Mo

Import sample
information from a
sample definition
file

64

1. Create a new experiment or open the experiment to receive the setup data (select
File » Open, select the file to open, then click Open).

N

From the open experiment, select File » Import Plate Setup.

3. Click Browse to browse your computer for a sample definition text file (*.csv).
After you locate the file and select it, click Select.

4. Click Start Import.

5. If your experiment already contains plate setup information, the software asks
you if you want to replace the plate setup with the data from the file. Click Yes to
replace the plate setup information.

The samples appear in the Samples table for the experiment. All samples and well
assignments in the experiment are replaced with those in the file. If defined, the
custom sample properties also appear in the Well Table of the Analysis Section, and
also in the Plate Layout tooltips in both the Setup and Analysis screens. The custom
fields can be exported with the results data.

Note: You cannot edit the custom sample properties from within the Well Table. To
modify this information, edit the custom fields in the sample definition file and import
the file again. All of the sample information in the experiment is replaced with the
information in the new file.
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The Assign screen with information from the above sample definition file looks like
this:

| ™. Define and Set Up Standards

Targets

: I .

Sample: Sample 1

5 Custom Property:
ID: 1
Age: 22

Samples ————— &1 | | Sex: Female

Weight: 25
HairColor: black

C Smoker: Yes o

]
| [gampe 10 =]
Biological Groups —————————— Ca) £
E
1 | _’l_l
wels: [ o [EHo [Jo 364 Emoty

The Well Table in the Analysis section looks like this:

Collspsz Al

# | Well | | cT CT Mean CT SD | Quantity |Quant\ty mlouantity ...| Comments D Age Sex Weight | HairColor | Smoker

1 AL 1 22 Fernale 25 black es =

2 A2 2 25 Male 26 brawin Mo

3 A2 2 45 Fernale 50 blonde Yes

4 A4 4 31 Male x] red Yes

5 AS 5 29 Fernale 46 grey Mo

6 A6 & 26 Male 35 black Mo

7 A7 7 31 Fernale 32 black Yes

2 A2 2 32 Male 67 black Mo

9 A0 a 32 Fernale B brawin Yes

10 AlD 10 x] Male 44 blonde Yes

11 ALl 11 34 Fernale 25 red Mo

12 412 12 34 Male 26 arey Mo

12 A13 13 35 Fernale 50 black Yes

14 Al4 14 i) Male 32 black Mo

15 AlS 15 ] Fernale 45 black Yes

16 AlS 16 ] Male 35 brawin Yes

17 A7 17 37 Fernale 32 blonde Mo

12 Al8 13 37 Male 67 red Mo

19 419 19 38 Fernale 55 arey Yes

20 A20 20 ) Male 44 black Mo

21 A2l

22 A2z

23 A23

24 A24

25 Bl

26 B2

27 B3

28 B4

29 EBS

30 BS

31 E7

32 BB

32 B9

34 BIO

35 Bll =

T A o™
well Summary: In Flste: 384 St Up: 384 Analyzed: 384 Flagged: 0 Crvitted by Analysis: 0 Ormitted Manually: O Samples Used: 384 Targets Used: 0
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Use a template to create a batch of experiments

Use a template to create a batch of experiments

Use the batch experiment utility to create multiple experiment files from the same
template without using Experiment Setup.

1. In the menu bar, select Tools » Batch Experiment Setup.The Batch Experiment
Setup Utility dialog box looks like this:

Batch Experiment Setup Utility

Provide input files; select the barcode, file naming convention, and export location; then click Create Experiments. t‘.
- For multi-well plate experiments, array card experiments, or experiments that use sample integration, select an *.edt file. -
- For OpenArray® experiments, select an *.edt file or the folder that contains *.spf or *.tpf files.
- Optionally, select additional input files (*.aif, *.tdt).

1. Input Files

* Experiment Template File (*.edt): | | -

or

* Setup File Folder (*.spf,*.tpf): | |-
Assay Information File (*.aif): | | -
Plate Setup File (*.bxt): | |

2. Barcode(s) and Naming Convention

Create Experiment Files Using: O Barcode: | | :]
(® Specify number of files:

File Name Format: | Attribute Include Custom Name Field: | |
Customn Name Field

Ip['Jate Barcode w File Mame Preview: Custom Name Field_ID
Filename from SPF/TPF
-

3. Sample Files Folder:

| Browse

Expected Sample File Name: Custom Mame Field_ID.csv -

4, Export Location

* Export setup files to: |
Create Experiments W

2. Select the file(s) to use to create the new experiments:

a. For multi-well plate, array card experiments, or experiments that use sample
integration, click Browse in the Experiment Template File field.

b. Locate an *.edt file to import, then click Select.

c. For OpenArray experiments, click Browse in the Experiment Template File
field or in the Setup File Folder field.

d. Locate either an *.edt (template) or an *.spf/ *.tpf file to import, then click
Select.

e. (Optional) Repeat steps 2a and 2b for the remaining setup file types to import
Assay Information File (*.aif), Plate Setup File (*.txt)).
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Use a template to create a batch of experiments

3. Select the option to create experiment files. The selected option determines the
number of experiment files created:

¢ Specify Number of Files - Enter a number from 1 to 100.

* Barcode - Click Browse and select a Barcode File (*.txt) to import. The
software automatically adds the Plate Barcode attribute to the file name
format. The number of experiments created equals the number of barcodes
present in the barcode file.

Note: A Barcode File contains one barcode per line. An example Barcode File

looks like this:

!& BarCode_Template 384Wb.txt - Notepad M =] B3
File Edit Format Wiew Help

Barcode (384W) =]
AI03EYWT

AZ035YWU

AZ03EYWY

ASOSEYIAN

AZ03EYIK
AZ03EYWY
AZ03EYWE
AZ035YXD
AZ035YXL
AZ035YXZ
AZ03EYIN
AZ03EYW]
AZ03EYIWE
AZ03EYWL
AZ03EYIM
A303EYWO
AZ03EYWR
AZ03EYIWR
AZ035YWS
AZ035YIWH
AZ035YWG
AZ03EYWE
A3035YWD
AZ03EYWC

[

4. (Optional) Edit the file name format. Use the File Name Preview to verify your
settings.

¢ Select the check box to include or exclude the Custom Name Field_Plate
Barcode attribute from the file name. If included, click the Custom Name
Field and enter up to 100 letters and/or numbers to identify the batch of
experiments.

Note: The file name can contain a total of 100 characters, including all file
name attributes.

* C(Click Move Up or Move Down to change the order of the selected file name
attributes.

5. Select the Sample Files Folder:

a. Click Browse, then locate and select a folder.

Refer to the Expected Sample File Name for an example of a file name.

b. Click Validate to visually check that experiment files are matched to sample
files. If they do not match then the “matching sample file’ shows the missing
file as “not found” in red.

6. Select the location for the experiment files to be created:

a. Click Browse in the Export Setup Files to: field.
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Create an experiment using ReadiApp

b. Review the location for the experiment files. Navigate to a new location if
you do not want to export the experiment files to that folder, then click
Select.

7. Click Create Experiments. A confirmation message appears when the batch of
experiments has been created.

Create an experiment using ReadiApp

You can use the ReadiApp feature to set up an experiment in the QuantStudio™™ 12K
Flex Software. The ReadiApp feature provides a shortcut to create experiments for the
assays purchased from Life Technologies.

The default ReadiApp templates available in the QuantStudio'" 12K Flex Software
include:

e TagMan® Gene Signature Array Cards

e Custom TaqMan® Array Cards

» TagMan® Gene Expression Assays

e TagMan® Drug Metabolism Assays

* TagMan® array MicroRNA Cards

* TagMan® Copy Number Assays (CNV)

e TagMan® SNP Genotyping Assays

1. Log in to the QuantStudio™™ 12K Flex Software and, from the Tools menu on the
Home screen, click ReadiApp.

2. Click the assay to use to set up an experiment.

Note: Click Cancel to exit the ReadiApp dialog box.

i | ReadiApp

Select your Experiment:

[ TagMan® Array MicroRNA Cards ] [ TagMan® Gene Signature Array Cards ]
[ TagMan® Copy Number Assays (CNV) ] [ Custom TagMan® Array Cards ]
[ TagMan® SNP Genotyping Assays ] [ TagMan® Gene Expression Assavsv{b_]

[ TagMan® Drug Metabolism Assays ]

=3

A new experiment is created using the setup information from the template.

3. (Optional) Edit the experiment properties.

4. Proceed to preparing reactions, running the experiment, and analyzing the data.
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About Standard Curve Experiments

This chapter covers:
Before youbegin. . .......... 5

About the example experiment .............. ... ... i il 6

™

IMPORTANT! First-time users of the QuantStudio = 12K Flex System please read
Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array
Card Experiments and Booklet 7, QuantStudio™ 12K Flex System Multi-Well Plate and
Array Card Experiments - Appendixes of this binder thoroughly. The booklets provide
information and general instructions that are applicable to all the experiments
described in this binder

Note: For more information about any of the topics discussed in this guide, access the
Help from within QuantStudio™" 12K Flex Software by pressing F1, clicking @ in the
toolbar, or selecting Help » QuantStudio™ 12K Flex Software Help.

Before you begin

Assemble required
components

PCR Options

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card

The Standard Curve method is used for determining absolute target quantity in
samples. With the standard curve method, the software measures amplification of the
target in samples and in a standard dilution series. Data from the standard dilution
series are used to generate the standard curve. Using the standard curve, the software
interpolates the absolute quantity of target in the samples.

¢ Sample - The tissue group that you are testing for a target gene.

e Standard — A sample that contains known quantities of the target; used in
quantification experiments to generate standard curves.

¢ Standard dilution series — A set of standards containing a range of known
quantities. The standard dilution series is prepared by serially diluting standards.

* Replicates — The total number of identical reactions containing identical samples,
components, and volumes.

* Negative Controls — Wells that contain water or buffer instead of sample
template. No amplification of the target should occur in negative control wells.

When performing real-time PCR, choose between:
¢ Singleplex and multiplex PCR (page 6)
and
¢ 1-step and 2-step RT-PCR (page 6)

Experiments User Guide for Standard Curve Experiments
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About the example experiment

Singleplex and Multiplex PCR

You can perform a PCR reaction using either:

Singleplex PCR - In singleplex PCR a single primer set is present in the reaction
tube or well. Only one target or endogenous control can be amplified per reaction.

or

Multiplex PCR - In multiplex PCR, two or more primer sets are present in the
reaction tube or well. Each set amplifies a specific target or endogenous control.
Typically, a probe labeled with FAM™ dye detects the target and a probe labeled
with VIC® dye detects the endogenous control.

IMPORTANT! SYBR® Green reagents cannot be used for multiplex PCR.

= O aE [ Target Primer Set
| @)
) e 00 (O Endogenous Control
7 Primer Set
. ~-~ cDNA
Singleplex PCR Multiplex PCR

1- and 2-Step RT-PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in
separate reactions (2-step). The reagent configuration you use depends on whether
you are performing 1- or 2-step RT-PCR:

1-step RT-PCR- In 1-step RT-PCR, RT and PCR take place in one buffer system.
Using one buffer system provides the convenience of a single-tube preparation
for RT and PCR amplification. However, you cannot use Fast PCR master mix or
the carryover prevention enzyme, AmpErase® UNG (uracil-N-glycosylase), to
perform 1-step RT-PCR.

2-step RT-PCR - 2-step RT-PCR is performed in two separate reactions: First, total
RNA is reverse-transcribed into cDNA, then the cDNA is amplified by PCR. This
method is useful for detecting multiple transcripts from a single cDNA template
or for storing cDNA aliquots for later use. The AmpErase® UNG enzyme can be
used to prevent carryover contamination.

Note: The Standard Curve example experiment is designed for singleplex PCR,
where every well contains a primer/probe set for a single target; the reactions are
set up for a 2-step RT-PCR.

About the example experiment

To illustrate how to perform Standard Curve experiments, this guide leads you
through the process of designing and performing an example experiment. The
example experiment represents a typical setup that you can use to quickly familiarize
yourself with the QuantStudio™ 12K Flex System.

The objective of the Standard Curve example experiment is to determine the quantity
of the RNase P gene in two populations.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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About the example experiment

In the standard curve example experiment:

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card

The samples are genomic DNA isolated from two populations.
The target is the RNase P gene.

One standard curve is set up for the RNase P gene (target). The standard used for
the standard dilution series contains known quantities of the RNase P gene.
Because a single target is being studied, only one standard curve is required.

Note: In experiments where multiple targets are being studied, a standard curve
is required for each target.

The Standard Curve is a five-point dilution with 16 technical replicates per point.

The experiment is designed for singleplex PCR, where every well contains a
primer/probe set for a single target.

Reactions are set up for 2-step RT-PCR.
Primer/probe sets are from Life Technologies RNase P assay.

Note: The human RNase P FAM"™ dye-labeled MGB probe is not available as a
TagMan® Gene Expression Assay. It can be ordered as a Custom TagMan® Gene
Expression Assay (PN 4331348).

Experiments User Guide for Standard Curve Experiments
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About the example experiment
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Design the Experiment

This chapter explains how to design the example experiment from the Experiment
Setup menu.

This chapter covers:

Define the experiment properties. . ......... ... 9
Define targets, samples, and biological replicates. ......................... 10
Assign targets, samples, and biological groups...................... ..o 11
Setuptherunmethod ...... ... ... ... . 13
For more information........... ... i 15

Note: To automatically export the analyzed data to a specified location, select the Auto
Export task from the Export screen, before running the experiment. For more
information on Auto Export, refer to Chapter 1 in Booklet 1, Getting Started with
QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments.

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the
QuantStudio™ 12K Flex Software. Enter:

Field or selection Entry
Experiment Name 384-Well Fast Standard Curve Example
Barcode Leave field empty
User Name . Example User
Comments | Standard Curve example
Block | 384-Well
Experiment Type Standard Curve
Reagents TagMan® Reagents
Ramp speed Fast

Save the experiment.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 9
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Define targets, samples, and biological replicates

Your Experiment Properties screen should look like this:

How do you want to identify this experiment?

* Experiment Name: |384-Well Fast Standard Curve Example Comments: |Standard Curve example o’
Barcode:

User Mame: |Example User ~

‘Which block are you using to run the experiment?

| 384-Well | [ Array Card ] [ 96-Well (0.2mL) ] { Fast 96-Well (0.1mL) }

| s Standard Curve | [ Relative Standard Curve ] [ Comparative Ct (AACT) ] [ Melt Curve }

[ Genotyping ] [ Presence/Absence ]

Which reagents do you want to use to detect the target sequence?

| s TagMan® Reagents | [ SYBR® Green Reagents ] [ Other ]

What properties do you want for the instrument run?

[ Standard ] | Fast ‘

Define targets, samples, and biological replicates

Click Define to access the Define screen. Enter:

1. Targets

Target name Reporter Quencher Color

RNaseP FAM NFQ-MGB [

2. Samples

Sample name Color

Pop1

Pop2 [

3. Dye to be used as a Passive Reference
ROX

10 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Assign targets, samples, and biological groups

Your Define screen should look like this:

Target Name Reporter Quencher Color Sample Name Color
RNaseP FAM v |NFQ7MGE 4 |. v| Popl ‘ '
Pop2 ‘. v

Biological Replicate Groups

Mesw

Biological Group Name Color Comments

Passive Reference

ROX -

Note: This example experiment does not define biological replicate groups. Leave
Biological Replicate Groups blank.

Assign targets, samples, and biological groups

Click Assign to access the Assign screen.

1. Define and set up standards.
a. Click Define and Set Up Standards on the Assign screen.
b. Select a target.

Field Select

Select a target for this standard curve RNaseP

c. Define the standard curve.

Field Enter
# of Points 5
# of Replicates 16
Starting Quantity 1250.0
Serial Factor 2x
Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 1
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Assign targets, samples, and biological groups

d. Select and arrange wells for the standards.

Field

Select

Use Wells

Let Me Select Wells

e. Click Apply, and then Close.

Your Define and Set Up Standards dialog box should look like this:

B pefin

Select a target

* Select the target for this standard curve:

\ Select a target from the list of targets in the reaction plate, Define the standard curve, select wells for the standards, then dick Apply. Repeat for each standard curve in the reaction plate, then dick Close to return to plate setup. Qj

= Required

Define the standard curve

* # of Points: |5 (5 Recommended)

* # of Replicates: |16

* Starting Quantity: [1250.0

* Serial Factor: |2><

| (3 Recommended)

| (Enter the highest or lowest standard quantity for the standard curve.)

vl (Select 2 value from 1:10 to 10x.)

= Required | Standard Curve Preview

5 Points X 16 Replicates = 80 Required Wells

Use Wells: O Automatically Select Wells for Me

Select and arrange wells for the standards

Arrange standards in: O Columns &) Rows

(@ Let Me Select Wells

7 |8 o [10]u[12[13]14[15 1617 [18 [10 20 |21 [22 [23 24 |

|vozg-—xu»—~1mmmommr

80 Required Wells / 80 Selected Wells

A2,A3,A4,A5,.A6,B2,B3,84,B5,B6,C2,C3,C4,C5,C6,02,D03,D4,D5,D6,E2,E3,E4,E5,E6,F2,F3,F4,F5,F6,G2,
G3,G4,G5,66,H2,H3,H4,H5,H6,12,13,14,15,16,12,13,14,15,16,K2,K3,K4,K5,K6,1.2,L3,14,L5,16,M2, M3, M4,
M5,M8,MN2,N3,N4,N5,N6,02,03,04,05,06,P2,P3,P4,P5,P5

12

2. Assign targets and samples.

Target Well Task Quantity Sample
name number name
RNaseP | A1 -P1 Negative None None
(column 1)
RNaseP A2 - P2 Standard 1250 None
(column 2)
RNaseP | A3 - P3 Standard 2500 None
(column 3)
RNaseP | A4 - P4 Standard 5000 None
(column 4)
RNaseP | A5 - P5 Standard 10000 None
(column 5)

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Targets

Chapter 2 Design the Experiment
Set up the run method

Target Well Task Quantity Sample
name number name

RNaseP | A6 - P6 Standard 20000 None
(column 6)

RNaseP | A7 - P15 Unknown Determined Pop1
(columns by run
7 -15)

RNaseP | A16 - P24 | Unknown Determined Pop2
(columns1 by run
6 - 24)

Your Assign screen should look like this:

Well Table

ne
|

z 3 [+ [s5[e[7[s s w[ulw]

[14 [15s J1e [ 17 [ 18 [ 19 |

ERERERE

EN

Samples — [fan)

O |Pop1 ‘
O Pop2 ‘

Biological Groups — (&)

mlef=lEl-[~[=]-]=zf]a]l~[r[=]n]®=

B B | B BE| B E BH|B|H B B BH H| BB

o

Popl Popl Popl Popl Popl Popl Popl
8 8 8 8 @ m o m oo o

Popl | Popl Popl Popl Popl Popl Popl
m(mm mtmt mt | m

Popl | Popl Popl Popl  Popl Popl | Popl

Popl | Popl Popl Popl Popl Popl Popl
m' m m mtm m | m

Popl | Popl Popl Popl Popl Popl Popl
m(mm mtmt mt | m

Popl  Popl Popl Popl Popl Popl Popl
m(mm mtmt mt | m

Popl | Popl Popl Popl Popl Popl Popl
Popl Popl Popl Popl Popl Popl Paopl
Popl Popl Popl Popl Popl Popl Popl
Popl | Popl Popl Popl Popl Popl Popl
Popl Popl Popl Popl Popl Popl Paopl
Popl Popl Popl Popl Popl Popl Popl
Popl | Popl Popl Popl Popl Popl Popl

m' m m mtm m | m

Popl | Popl Popl Popl Popl Popl Popl
m(mm mtmt mt | m

Popl  Popl Popl Popl Popl Popl Popl
m(mm mtmt mt | m
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wels: [ 288 [ s0 [ 16

0 Empty

Set up the run method

Click Run Method to access the Run Method screen.

Graphical View tab. Enter:

Reaction Volume Per Well: 20 pL
Thermal Profile

Set the thermal profile under the

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Chapter 2 Design the Experiment
Set up the run method

Stage Step Ramp rate | Temperature Time
Hold Stage Step 1 1.9°C/s 95°C 20 seconds
PCR Stage Step 1 1.9°C/s 95°C 1 second
Number of Cycles: 40 | Step 2 1.6°C/s 60°C 20 seconds
(default)

Enable AutoDelta:
Unchecked (default)

Starting Cycle:
Disabled when Enable
AutoDelta is unchecked

Your Run Method screen should look like this:

Run Method

Reaction Volume per Well: uL

Graphical View Optical Filters

Hold Stage PCR Stage

MNumber of Cycles:
Starting Cydle:

Stept Step1 Step2
< >
Legend
Data Collection On ™ =/ Data Collection Off A AutoDefta On A AutoDetra O
14 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Chapter 2 Design the Experiment
For more information

For more information

For more information on... Refer to... Part number
Consumables Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050
System Multi-Well Plate and Array Card Experiments
Appendix A in Booklet 7, QuantStudio™ 12K Flex System Multi-Well
Plate and Array Card Experiments - Appendixes
Using other quantification Booklet 3, Running Relative Standard Curve and Comparative Cy 4470050
methods Experiments.
Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays 127AP05-03
Application Note
Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050

Using alternative setup

System Multi-Well Plate and Array Card Experiments

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
Experiments User Guide for Standard Curve Experiments
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Chapter 2 Design the Experiment

For more information
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Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Standard Curve
example experiment.

This chapter covers:

Assemble required materials ........ ... 17
Prepare the sample dilutions ............... ... ... . o il 17
Prepare the standard dilutionseries ................... ... ... .. oo 18
Prepare the reaction mix (“cocktail mix”)........... ... ... .. L. 19
Prepare the reactionplate . ....... ... ... ... .. 19
For more information.......... ... . i 22

Assemble required materials

Items listed in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-
Well Plate and Array Card Experiments.

Samples - Human Raji cell line-derived cDNA samples (100 ng/uL)
Example experiment reaction mix components:

— TaqMan® Fast Universal PCR Master Mix

— RNase P Assay Mix (20X) (PN 4316831)

Prepare the sample dilutions

To determine the quantity of the RNase P gene in the example experiment, dilute the
samples (as directed below) before adding the samples to the final reaction mix.

The stock concentration of each sample is 100 ng/uL. After dilution, the sample Popl
has a concentration of 6.6 ng/uL and Pop 2 has a concentration of 3.3 ng/uL. Add 2uL
to each reaction.

Use this table for sample dilution volumes for the example experiment.

Samole Stock Sample Diluent | Totalvolume
nanfe concentration volume volume of diluted
(ng/pL) (uL) (pL) sample (pL)
Pop1 100.0 25 355 380
Pop2 100.0 12.5 3675 380

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Chapter 3 Prepare the Reactions

Prepare the standard dilution series

Note: For your own experiment, adjust the input amounts of the template depending
on the template type and target abundance.

1. Label a separate microcentrifuge tube for each diluted sample:
* Popl
e Pop2

2. Add the required volume of water (diluent) to each empty tube:

Tube Sample name Diluent volume
(pL)
1 Pop 1 355
2 | Pop2 367.5

3. Add the required volume of sample stock to each tube:

Tube Sample name Sample volume
(pL)
1 Pop 1 25
2 | Pop2 12.5

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the standard dilution series

The standard concentration in stock is 20,000 copies/uL:

I Source Diluent Total Standard
Standard name Dilution R
(labeled tube) point Source volume volume volume conce_ntratlon
(L) (wL) (uL) (copies/pL)

RNase P Std. 1 1 (20,000) Stock 18 18 36 10,000
RNase P Std. 1 2 (10,000) Dilution 1 18 18 36 5,000
RNase P Std. 1 3 (5,000) Dilution 2 18 18 36 2,500
RNase P Std. 1 4 (2500) Dilution 3 18 18 36 1250
RNase P Std. 1 5 (1250) Dilution 4 18 18 36 625

1. Prepare five standard dilutions:

Note: For dilution 1, first vortex the stock for 3 to 5 seconds, then centrifuge the
RNase P Std. 1 tube briefly before pipetting stock into the tube.

For each dilution:

18 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Chapter 3 Prepare the Reactions

Prepare the reaction mix (“cocktail mix”)

a. Use a new pipette tip to add 18 pL of source to the tube containing the

standard.

b. Vortex the tube for 3 to 5 seconds, then centrifuge the tube briefly.

2. Place the standards on ice until you prepare the reaction plate.

Prepare the reaction mix (“cocktail mix”)

For the RNase P assay (Standard Curve example experiment), the following table lists
the universal assay conditions (volume and final concentration) for using the TagMan®
Fast Universal PCR Master Mix.

Volume for 1

Reaction component reaction [pL]

Volume for 384

reactions + 10% excess

(pL)
TagMan® Fast Universal PCR Master Mix Kit 5 2112
RNase P Assay (20X) 05 211.2
Water 35 1478.4
Total reaction mix volume 9 3801.6
1. Label an appropriately sized tube for the reaction mix: RNase P Reaction Mix.
2. Add the required volumes of each cocktail mix component to the tube.
Note: Do not add the sample or standard at this time.
3. Mix the cocktail thoroughly by gently pipetting up and down several times, then
cap the tube.
4. Centrifuge the tube briefly to remove air bubbles.
5. Place the cocktail mix on ice until you prepare the reaction plate.

Note: You can separately add the sample to the reaction plate, as opposed to preparing
individual reaction mixes for each sample.

Prepare the reaction plate

Example The reaction plate for the Standard Curve example experiment contains:
experiment e A MicroAmp® Optical 384-Well Reaction Plate

reaction plate e Reaction volume: 10 uL/well

components 288 Unknown wells [

80 Standard wells £
16 Negative Control wells |

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
Experiments User Guide for Standard Curve Experiments
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Chapter 3 Prepare the Reactions

Prepare the reaction plate

The plate layout looks like this:

A ERERERERE Ittt It it it i
ERCR R RN e e e e e e e e e e e I e e e
o (e 8 8 e e (SR |8 SR AR AR AR AR |SE S S SF AR OGESE S S
blm (= (= @ = = [&R|&R S AF AR AR AR |SP S SF SF AR R SE S SFF
o B 8 B e e A |AR AR AE A AR AR |SE S S SF AR R SF OO F
Flo (e e 8 e e (SR |aR SR AR AR AR AR |SR S S SF AR OGRSE S
@ (= (= @ e m AR [AR SR AF AP AR AR SRS SF SF AR R SESE
Wo e e B le e AR |AR SR AR AF AR AR SRS SF SF AR R SR OO ¥ ¥
o (e (8 8 e e (SR |8 SR AR AR AR AR |SE S S SF AR OGESE S
bla (m (m @ e a (&[S SF AF &P AR AR SR S SR SF AR R SR S ¥
fo B 8 B e e A |AR AR AR A AR AR SR SFSF SF AR R SR OO F ¥
o (e 8 8 o (o (SR |a SR SR AR AR AR |SE S S SF AR ORISR S
wlo = e (B (o (o (8RR AR AR AR AR 2% 2F 2R 2R aOF 2F (2F 2R 0F R 2% oF
vo B e B e e AR |AR SR AR AF AR AR SR SF S SF AR R SR OO ¥ ¥
ol (8 (8 8 o @ [SR|& SR SR AY AR AR |SE S S SF AR OGRS S
Pla (m m @ e a (AR [aR SR AR AR AR AR SP S SF SF AR AR SR O S OF F
:fells:mzaaﬂauljm 0 Empty
To prepare the 1. Prepare the negative control reactions for the target:
reaction plate a. To an appropriately sized tube, add the volumes of reaction mix and water
components listed below.
_ _ 5:::10:[:3( Wate!'volume
Tube Reaction mix . (uL) (includes
lincludes 10% excess)
10% excess)
RNase P reaction mix 157.5 17.5
b. Mix the reaction by gently pipetting up and down, then cap the tube.
c. Centrifuge the tube briefly to remove air bubbles.
d. Add 10 pL of the negative control reaction to the appropriate wells in the
reaction plate.
2. For each replicate group, prepare the standard reactions:
a. To appropriately sized tubes, add the volumes of reaction mix and standard
listed below.
20 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Chapter 3 Prepare the Reactions 3
Prepare the reaction plate

Reaction mix Standard
Standard | Reaction volume (pL)
Tube . i . Standard volume
reaction mix (includes (uL)
10% excess) H
1 RNase P RNase P 157.5 RNase P 17.5
Std 1 reaction Std 1
mix
2 RNase P RNase P 157.5 RNase P 17.5
Std 2 reaction Std 2
mix
3 RNase P RNase P 157.5 RNase P 17.5
Std 3 reaction Std 3
mix
4 RNase P RNase P 157.5 RNase P 17.5
Std 4 reaction Std 4
mix
5 RNase P RNase P 157.5 RNase P 17.5
Std 5 reaction Std 5
mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.
c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 10 pL of the standard reaction to the appropriate wells in the reaction
plate.

3. For each replicate group, prepare the reactions for the unknowns:

a. To appropriately sized tubes, add the volumes of reaction mix and sample
listed below.

Reaction
mix
. volume Sample
Unknown Reaction
Tube . . (pL) Sample volume
reaction mix .
(includes (uL)
10%
excess)
1 RNase P RNase P 1422 pop] 158
pop1 reaction mix
2 RNase P RNase P 1422 pop2 158
pop2 reaction mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.
c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 10 pL of the unknown (sample) reaction to the appropriate wells in the
reaction plate.

4. Seal the reaction plate with optical adhesive film.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 21
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Chapter 3 Prepare the Reactions

For more information

5. Centrifuge the reaction plate briefly to remove air bubbles.

6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of
time.

7. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

For more information

For more information on... Refer to... Part number

Assigning the reaction plate Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K 4470050

components Flex System Multi-Well Plate and Array Card Experiments

Sealing the reaction plate Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K 4470050
Flex System Multi-Well Plate and Array Card Experiments
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Start the run

Run the Experiment

This chapter explains how to run the example experiment on the QuantStudio™ 12K
Flex Instrument.

This chapter covers:
Start the FUN. . . ..o 23
Monitor the run. . . ... .. 23

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the QuantStudio™ 12K Flex Instrument is in operation.

1. Open the Standard Curve example file that you created using instructions in
Chapter 2.

2. Load the reaction plate into the instrument.

3. Start the run.

Monitor the run

From the
Instrument
Console of the
QuantStudio™ 12K
Flex Software

Monitor the example experiment run:

e From the QuantStudio’ 12K Flex Software using the Run screen, while the
experiment is in progress.

e From the Instrument Console of the QuantStudio™" 12K Flex Software (to monitor

an experiment started from another computer or from the QuantStudio™ 12K
Flex Instrument touchscreen).

e From the QuantStudio™ 12K Flex Instrument touchscreen.

1. In the Instrument Console screen, select the instrument icon.
Click Manage Instrument or double-click on the instrument icon.

3. On the Manage Instrument screen, click Monitor Running Experiment to access
the Run screen.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 23
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Chapter 4 Run the Experiment
Monitor the run

View the Amplification Plot

You can view the progress of the run in real time. During the run, periodically view all
the three plots available from the QuantStudio™ 12K Flex Software for potential
problems.

Click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab,
then select the wells to view.

The figure below shows the Amplification Plot screen as it appears at the end of the
example experiment.

Amplification Plot <

2P B R E

=
N
=
=
5
=
I
N
]

71 22 23 24

Amplification Plot

4P | 4P | =P | 4P | 4P | =P =P | =P =P | =P | 4P | =P [ =P | =P
4P | 4P | =P 4P | 4P | =P =P | =P | =P | =P | 4P | =P [ =P | =P
S | 4P (=P 4P | HP | SP P | &P =P =P 4P | =P [ =P | HP
4P | 4P (=P 4P | HP | SP P | &P =P =P 4P | HP [ =P | HP

4P | 4P 4P | 4P | AP 4P | 4P [ 4P | 4P | 4P =P | 4P | 4P | 4P | &4P | 4P | o
4F | =P 4P | 4P | 4P 4P | 4P [ 4P | 4P | 4P =P | 4P | 4P | 4P =P | 4P o

4P | =P [ 4P | 4P (=P 4P | P | SF P | 4P P =P 4P | 4P [ uF | =P
=P | =P 4P | 4P | =P | 4P | 4P =P =P | =P | =P | =P | 4P | =P [ =P | =P
SF | P [ 4P | 4P (=P 4P | SR | SF AP | &P 4P =P | 4P | 4P [ =P | 4P
4P | P [ 4P | 4P (=P 4P | 4P | SF AP | &P P =P | 4P | 4P [ =P | 4P
P | =P =P | 4P | =P | 4P | =P =P =P | =P =P | =P | 4P | 4P [ =P | =P

SF | P 4P | 4P (=P 4P | 4P | SP P | &P SR =P | 4P | P [ =P | HP
4P | =P [ 4P | 4P | =P | 4P | 4P | 4P P | 4P | 4P | =P | 4P | 4P [ =P | 4P

m: me mc WD
777777 o
E NF NG HH A ERERERSRERERIE

View the Temperature Plot
Click Temperature Plot from the Run Experiment Menu.

The figure below shows the Temperature Plot screen as it appears during the example
experiment.

Temperature Plot Current Temperatures

2 90 & B 0y & [ Wl cover
» L W = & Wl sarple
Block
Temperature Plot

Temperature

Temperature Plot

0
00:00:00 00:04:10 00:08:20 00:12:30 00:16:40 00:20:50 00:25:00 00:29:10 00:3%:20 00:37:30 00:41:40 004550 00:50:00 00:54:10 00:58:20
Time

Fixed View (]
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Chapter 4 Run the Experiment
Monitor the run

estimated value.

View the Run Method
Click Run Method from the Run Experiment Menu.

The figure below shows the Run Method screen as it appears in the example

experiment.
Run Method
Hold Stage PCR Stage
Number of Cycles:
starting Cycle:
Stept Stepl Step?
<
Legend
{ Data Colection On = Data Collection Off A AutoDefta On A AutoDelt Off

View the run data

Click View Run Data from the Run Experiment Menu.

The figure below shows the View Run Data screen as it appears in the example

experiment.

Run Data Report

Expariment Name:
Start Time:

Stop Time:

Run Duration:

User Name:
Instrument Name:
Firmware Version:
Software Version:
Instrument Serial Number:
Sample Volume:
Cover Temperature:

Block Type:

Errors Encountered:

384-Well Fast Standard Curve Example
08-06-2011 12:33:30 SGT
08-06-2011 13:15:47 SGT

42 minutes 17 seconds

DEFAULT

QuantstudioDemo

0.13.1

QuantStudio 12K Flex Software v1.0
QuantStudioDemo

20.0

105.0

384-Wel Block

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Chapter 4 Run the Experiment

Monitor the run

From the You can also view the progress of the run from the touchscreen of the QuantStudio™
QuantStudio™ 12K 12K Flex Instrument.

Flex Instrument The Run Method screen on the QuantStudio™ 12K Flex Instrument touchscreen looks
touchscreen like this:

Experiment View

®© Time View Plot View W]  Experiment View
Run Started: December 08 2011 - 12:05AM Sample: 95.0 °C
Reaction Volume: 20 pL Heated Cover (Set Point): 105.0 °C (105.0 °C)
Time Remaining: 01:27:04
2
Stage 1 Stage 2
10f1 X 40
95.0 °C 95.0 °C

7:14 0:15
50.0 °C / \__60.0 °C
- 1:00
2:00 e

December 08 2011 - 12:05AM o

Heated cover reached target temperature.

Note: The above screenshot is for visual representation only. Actual results will vary
with the experiment.

Time View
© Time View Plot View ]  Experiment View
Run Started: December 08 2011 - 12:05AM Sample: 59.5 °C
Reaction Volume: 20 pL Heated Cover (Set Pointl: 105.0 °C [105.0 °C)

Stage / Step /Cycle: 2/2/5

01:11:22

@ Remaining Time . Elapsed Time

December 08 2011 - 12:06AM o

Error occurred during run. Details: Holdtime 60 s exceeded. Actual Holdtim...
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Chapter 4 Run the Experiment
Monitor the run

Plot View
[ ExperimentViewl ®© Time View Plot View
Fast 96-Well Tagman ¥V ARn W

December 08 2011 - 12:07AM 0

Heated cover reached target temperature.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Chapter 4 Run the Experiment
Monitor the run
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Review Results and Adjust
Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis
screens and publish the data. Section 5.2 of this chapter walks you through the process
of modifying experiment parameters to troubleshoot problems with experiment
results before rerunning an experiment.

This chapter covers:

Section 5.1 Review Results ........ooiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiin, 31
Analyze the example experiment. .............. ... 31
View the Standard Curve Plot ......... ... ... .. ... . i 31
Assess amplification results using the Amplification Plot................... 33
Identify well problems using the Well Table .............................. 40
Confirm accurate dye signal using the Multicomponent Plot................ 43
Determine signal accuracy using the Raw DataPlot ....................... 45
Review the flags in the QC Summary ...................... i, 47
For more information........ ... ... ... . 48

Section 5.2 Adjust parameters for re-analysis of your own experiments. ........ 49
Adjust analysis settings . ....... ... 49
Improve Cy precision by omittingwells................ ... ... .o o 53
For more information. . . ......... ... . 54
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poas e sxomols mperiment
Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.

2. Click Analyze. The software analyzes the data using the default analysis settings.

Note: You can also access the experiment to analyze from the Home screen.

View the Standard Curve Plot

The Standard Curve Plot screen displays the standard curve for samples designated as
standards. The QuantStudio" 12K Flex Software calculates the quantity of an
unknown target from the standard curve.

Purpose The purpose of viewing the standard curve for the example experiment is to identify:
¢ Slope and amplification efficiency
e R2value (correlation coefficient)

e Cyvalues

To view and assess 1. From the Experiment Menu pane, select Analysis » Standard Curve.
the Standard Curve Note: If no data are displayed, click Analyze.
Plot
2. Display all 384 wells in the Standard Curve Plot screen by clicking the upper left
corner of the plate layout in the Plate Layout tab.
3. Enter the Plot Settings:
Menu Selection
Target All
Plot Color Target
E Check (default]
(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)
4. View the values displayed below the standard curve.
Menu Selection
Slope -3.372
R2 0.994
Amplification efficiency 97.944%
Error 0.03
Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 31
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Chapter 5 Review Results and Adjust Experiment Parameters
View the Standard Curve Plot

5. Check that all samples are within the standard curve. In the example experiment,
as shown below, all samples (blue dots) are within the standard curve (red dots).

Standard Curve <

Plot Settings >
Targer [al ~|  Plot color [Target v
7 8 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24
[] save current settings as the defaul: - - -
1
a|| D) 5] 5| 5| By
R Lo ‘ -
A =il siE s
. B
Standard Curve c|0HE 888 H
2078 P e Pau Pur Pue B
n
g NEEEEEEE
2025 b o Pu. P.
2000 B EEEEEER o o e
2875
B . e B B B
2850 B EEEEEER ol o]
2825 . T
j?: AEEEEEES 3G
n P, P.. P R,
2780 :
= AECEEEEE
2700 B B B B P B
2075 NEEGEEEER
0 = =
1
2028 1|05/ 5EE 8 g nnn oo o nn
2800 - 3
2575 AEEEEEER
2550 . .
2o L| 088 8 8 Bm)m
P Pur Pus Puw P Pun P
2475
il wm 1000 10000 100000 MDEEEEE
Quantity 1 P, Pus Puw P Pu. P,
v| 0 8] 8 8| B O00ooo
Target: All P.. B P.. Pu. P.. P.. P.. P.
o| T 8] 8] 8] 8] Bjim)im Oooooo
B B P P B P P B Bu B
= p|DEEEE 8, g
Ml riiasep
wels: [I] 288 [ 80 [ 16 0 Empty
‘Well Summary: In Plte: 384 Set Up: 384 Anzhyzed: 384 Flagged: 4 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 2 Targets Used: 1

6. Check the Cy values:
a. Click the Well Table tab.
b. From the Group By menu, select Replicate.
c. Look at the values in the Ct column. In the example experiment, the Cy

values fall within the expected range (>8 and < 35).

Plate Layout

Show in Table W Graup by ¥ Expand Al 8 ollapse Al
# well | omit Flag sample .| Target .. Task Dyes cr CT Mean | CT SD Quantity | Quantit... | Quantit... | NOISE ou

=
7 A7 O Popl RiaseP UNKNOWN 27.096 0.140 5,015.352 5,090.081 565.712
8 A8 O Popl RHaseP UNKNOWN 27.096 0.140 5387.923 5,090.081 565.712
9 A9 O Popl RNaseP UNKNOWN 27.096 0.140 5,645.138 5,090.081 565.712
10 A10 O Popl RiaseP UNKNOWN 27.096 0.140 5,181.675 5,090.081 565.712
1 A1l O Popl RHaseP UNKNOWN 27.096 0.140 5708.598 5,090.081 565.712
12 A12 O Popl RNaseP UNKNOWN 27.096 0.140 5412.582 5,090.081 565.712
13 A13 0O Pop1 RiaseP UNKNOWN 27.096 0140 5584.070 5000.081 565712
14 A14 O Popl RNaseP UNKNOWN 27.096 0.140 5,284.767 5,090.081 565.712
15 Al O Popl RiaseP UNKNOWN 27.096 0.140  6,041.067 5,090.081 565.712
31 87 O Popl RHaseP UNKNOWN 27.096 0.140 5,124.039 5,090.081 565.712
32 B8 O Popl RNaseP UNKNOWN 27.096 0.140 4,824.094  5,090.081 565.712
33 B9 O Popl RiaseP UNKNOWN 27.096 0.140 5,200.990 5,090.081 565.712
34 Bi0 O Popl RHaseP UNKNOWN 27.096 0.140 4,706.999 5,090.081 565.712
35 Bl1 O Popl RNaseP UNKNOWN 27.096 0.140 5,330.722 5,090.081 565.712
36 BI2 0O Pop1 RiaseP UNKNOWN 27.096 0140 5059768 5000.081 565712
37 Bi3 O Popl RNaseP UNKNOWN 27.096 0.140 5,052.877 5,090.081 565.712
38 Bl4 O Popl RiaseP UNKNOWN 27.096 0.140 5,366.522 5,090.081 565.712
39 B15 O Popl RHaseP UNKNOWN 27.096 0.140 5041529 5,090.081 565.712
55 7 O Popl RNaseP UNKNOWN 27.096 0.140 5,242.704 5,090.081 565.712
36 8 O Popl RiaseP UNKNOWN 27.096 0.140 4,775.204 5,090.081 565.712
57 @ O Popl RHaseP UNKNOWN  FAM-NFQ-. 27.096 0.140 4,646.954 5,090.081 565.712
58 C10 O Popl RNaseP UNKNOWN  FAM-NFQ-. 27.096 0.140 4,871.199 5,090.081 565.712
59 c11 0O Pop1 RiaseP UNKNOWN  FAM-HFQ- 27.096 0140 4,548.860 5000.081 565712
60 C12 O Popl RNaseP UNKNOWN  FAM-NFQ-. 27.096 0.140 4,664.264 5,090.081 565.712
61 13 O Popl RiaseP UNKNOWN  FAM-NFQ-. 27.096 0.140 4,628.641 5,090.081 565.712
62 Ci4 O Popl RHaseP UNKNOWN  FAM-NFQ-. 27.096 0.140 4,492.085 5,090.081 565.712
63 Ci5 O Popl RNaseP UNKNOWN  FAM-NFQ-. 27.096 0.140 4,320.416 5,090.081 565.712
79 D7 O Popl RiaseP UNKNOWN  FAM-NFQ-. 27.096 0.140 5,277.137 5,090.081 565.712
80 D8 O Popl RHaseP UNKNOWN  FAM-NFQ-. 27.096 0.140 5,048.890 5,090.081 565.712
81 D9 O Popl RNaseP UNKNOWN ~ FAM-NFQ-... 27.142 27.096 0.140 4,909.571 5,090.081 565.712
82 D10 0O Pop1 RiaseP UNKNOWN ~ FAM-NFQ-... 27.198 27.096 0140 4722698 5000.081 565712
83 D11 O Popl RNaseP UNKNOWN ~ FAM-NFQ-... 27.073 27.096 0.140 5,146.530 5,090.081 565.712
84 D12 O Popl RiaseP UNKNOWN  FAM-NFQ-... 27.266 27.096 0.140 4,508.289 5,090.081 565.712

85 D13 O Popl RHaseP UNKNOWN ~ FAM-NFQ-... 26.935 27.096 0.140 5651525 5,090.081 565.712 &3

& >
‘Wwell Summary: In Piste: 384 Set Up: 384 Analyred: 384 Fizgged: 4 Omitted by Anafysis: () Omittzd Manually: 0 Samples Used: 2 Targets Used: 1
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Section 5.1 Review Results 5
Assess amplification results using the Amplification Plot

Tips for analyzing When you analyze your own standard curve experiment, look for:

your own * Slope and amplification efficiency values — The amplification efficiency is

experiments calculated using the slope of the regression line in the standard curve. A slope
close to — 3.3 indicates optimal, 100% PCR amplification efficiency. Factors that
affect amplification efficiency:

— Range of standard quantities — For accurate and precise efficiency
measurements, use a broad range of standard quantities, 5 to 6 logs
(10° to 100 fold).

— Number of standard replicates — For accurate efficiency measurements,
include replicates to decrease the effects of pipetting inaccuracies.

— PCR inhibitors — PCR inhibitors in the reaction can reduce amplification
efficiency.

* R2values (correlation coefficient) — The R? value is a measure of the closeness of
fit between the regression line and the individual Ct data points of the standard
reactions. A value of 1.00 indicates a perfect fit between the regression line and
the data points. An R? value >0.99 is desirable.

* Cy values — The threshold cycle (Cr) is the PCR cycle number at which the
fluorescence level meets the threshold.

— A Cgvalue >8 and <35 is desirable.

— A Cpvalue <8 indicates that there is too much template in the reaction.

— A Cyvalue >35 indicates a low amount of target in the reaction; for C values
>35, expect a higher standard deviation.

If your experiment does not meet the guidelines above, troubleshoot as follows:

*  Omit wells (see “Improve Cy precision by omitting wells” on page 53).
Or

¢ Rerun the experiment.

Assess amplification results using the Amplification Plot

Amplification pl_ots The Amplification Plot screen displays amplification of all samples in the selected
available for wells. There are three plots available:

viewing * ARnvs Cycle - ARn is the magnitude of normalized fluorescence signal generated
by the reporter at each cycle during the PCR amplification. This plot displays ARn
as a function of cycle number. Use this plot to identify and examine irregular
amplification and to view threshold and baseline values for the run.

* Rnvs Cycle — Rn is the fluorescence signal from the reporter dye normalized to
the fluorescence signal from the passive reference. This plot displays Rn as a
function of cycle number. Use this plot to identify and examine irregular
amplification.

* Cyvs Well — Cyis the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Cr as a function of well
position. Use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.
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Assess amplification results using the Amplification Plot

Purpose The purpose of viewing the amplification plot for the example experiment is to
identify:
¢ Correct baseline and threshold values
¢ OQutliers
View the 1. From the Experiment Menu pane, select Analysis » Amplification Plot.
Amplification Plot Note: If no data are displayed, click Analyze.
2.

Display the RNase P wells in the Amplification Plot screen. Click the Plate Layout
tab. Enter the Plot Settings:

Menu Selection

Select Wells With Target » RNaseP

1 2 3 4 s & 7 & 9 i} 11 1z 13 14 15 16 17 18 19 20 21 2z 23 24
[R] ] ] 1 ] ] Popl | Popl | Popl | Popl | Popl | Popl | Popl ' Popl | Popl . Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Popl2 | Popl
& 5] mt .ot @ lof omf , @ lmf o ) m
Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl  Popl | Pop? | Pop2 | Pop2 | Pop2 | Popl '\ Pop2 | Popl | Popl
8| SAEAEAEAE GGG
Popl | Popl ' Popl | Popl . Popl | Popl | Popl . Popl | Popl | Pop2  Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2
clm '8 B B |8 |8 o (oF (oF (oF  oF  oF | oF | oF | o
Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl . Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Popl
olm B B B B |8 MM GGG
Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl  Popl | Pop? | Pop2 | Pop2 | Pop2 | Popl '\ Pop2 | Popl | Popl
£l SAEAEAEAE GGG
Popl | Popl ' Popl | Popl . Popl | Popl | Popl . Popl | Popl | Pop2  Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2
Flm '8 '8 '8 |8 |8 o (oF (oF (oF  oF  oF | oF | oF | o
Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl . Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Popl
slm '8 B B B |8 MM GGG
Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl  Popl | Pop? | Pop2 | Pop2 | Pop2 | Popl '\ Pop2 | Popl | Popl
Wl SAEAEAEAE GGG
Popl ' Popl ' Popl ' Popl ' Popl | Popl ' Popl . Popl | Popl | Pop2 ' Pop2 | Pop2 | Pop2 | Pop2 Pop2 | Pop2 | Pop2
(o (8 (8 (@ (@ [@ at @l @b @t e gf gt
IR 1 <] <] <] <] Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl . Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Popl
J 5l m'.mt,m.m mtamtamt Lmt ) m
Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl  Popl | Pop? | Pop2 | Pop2 | Pop2 | Popl '\ Pop2 | Popl | Popl
k| @ SAEAEAEAE GGG
Popl | Popl ' Popl | Popl . Popl | Popl | Popl . Popl | Popl | Pop2  Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2
o 8 (8 (@ (@ [@ o (oF (oF (oF  oF  oF | oF | oF | o
Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl . Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Popl
wlm B B B 8 |@ MM GGG
1 Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl  Popl | Pop? | Pop2 | Pop2 | Pop2 | Popl '\ Pop2 | Popl | Popl
w| @ b SAEAEAEAE GGG
Popl | Popl ' Popl | Popl . Popl | Popl | Popl . Popl | Popl | Pop2  Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2
of@ |8 B 8 8 @ .o o m .o .o o lm o
Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl | Popl . Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Pop2 | Popl
rlo T8 B @8 @ MM GGG

wels: [I] 288 [ 80 [1] 16 0 Empty

Well Summary: In Plste: 384 Set Up: 384 Anahyzed: 364 Flagged: 4 Ormitted by Analysis: (I Omitted Manualy: { Samples Used: 2 Targets Used: 1

3. In the Amplification Plot screen, enter:
Menu Select
Plot Type ARn vs Cycle
Plot Color Well (default)
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Assess amplification results using the Amplification Plot

Menu

Select

]

(This is a toggle button. When the legend
is displayed, the button changes to Hide

the plot legend.)

Check (default)

4. View the baseline values.

a. From the Graph Type drop-down menu, select Linear.

b. Select the Baseline check box to show the start cycle and end cycle.

c. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescent signal is
detected. In the example experiment, the baseline is set correctly.

Amplification Plot
Plot Settings

Plot Type:|ARn vs Cycle |v| Graph Type:‘unear v‘ Plot CDIDr:|WEH v|

[[1 save current settings as the default

Amplification Plot
8.0
7.5
7.0
6.5
6.0
5.5
5.0
4.5
4.0
35
3.0
25
2.0
1.5
1.0
0.5

ARn

)

LAl ®mEE

0.0 - — T
-0.5 {
2 4 L] a8 10 12 14 16 18 20 22 24 28 30 32 a4 a8 38 40
Cycle
Legm
A HsB C D E HF MG H ~
B B H< . Hv Hu Ho Hr v

Options

Show: [] Threshold — [+] Baseline Start: Well B Target 4~ Baseline End: Well (Ml Target 4.

Well Summary: In Plate: 384 Set Up: 384 Anatyzed: 384 Flagged: 4 Omitted by Anahysis: 0 Omitted Manuzlly: 0 Samples Used: 2 Targets Used: 1
5. View the threshold values.
Menu Select
Graph Type Log
Target RNaseP

a. Select the Threshold check box to show the threshold.
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b. Verify that the threshold is set correctly. In the example experiment, the
threshold is in the exponential phase.

Amplification Plot
Plot Settings
Plot Type:[ARN vs Cycle ~| Graph Type:llog v Plot Color:[well ~|
[[] save current settings as the default

Amplification Plot

1EO1
1EOO0
272151
&
Z ot
0.01
0.001
BN~ BB Wic WD MIE MNF WG WEH A
W M) Nk . Ev En o P @
‘Options
Target: Threshold: [ Auto [0272151 | 4] Auto Baseline ]
Show: [¥] Threshold — [] Baseline Start: Well M Target 4 Baseline End: Well ‘M Target 4.
v
Well Summary: In Plate: 384 Set Up: 384 Anatyzed: 384 Flagged: 4 Omitted by Analysis: 0 Omitted Manualy: Samples Used: 2 Targets Used: 1

6. Locate outliers:
a. From the Plot Type drop-down menu, select Ct vs Well.

b. Look for outliers from the amplification plot. In the example experiment,
there are no outliers for RNase P.

Amplification Plot <
Plot Settings
Plot Type:[CT vs Well | Graph Type: Plot Color:well ]
[[] Save current settings as the default
P-R-N-N
Amplification Plot
1E02
- e e e v e e
By oy a3 - = e -
1EO01
& 1E00
o1
o.01 10 20 30 40 S0 60 70 B0 90 100 110 120 130 140 150 160 170 180 190 200 210 220 230 240 250 260 270 280 290 300 310 320 330 340 350 360 370 380
Well Number
A BB C o} ENF HGc HH ~
Wi ) Mk . Ev Ey Ho He =
‘Options
Torget: Tveshod:  huro [0 [ Auto Baseine »
Show: || Threshold — [] Baseline Start: Well B Target 4 Baseline End: Well (M Target 4
3
Well Summary: In Plate: 384 St Up: 384 Anshyzed: 384 Flagged: 4 Omitted by Anahysis: () Omitted Manualy: Samples Used: 2 Targets Used: 1
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Assess amplification results using the Amplification Plot

Tips for analyzing When you analyze your own standard curve experiment, look for:

your own e Qutliers

experiments * A typical amplification plot — The QuantStudio'" 12K Flex Software

automatically calculates baseline and threshold values based on the assumption
that the data exhibit a typical amplification plot. A typical amplification plot has
four distinct sections:

— Plateau phase

— Linear phase

— Exponential (geometric phase)
— Baseline

A typical amplification plot should look like this:

Amplification Plot

Plot Settings
Plot Type:[ARn vs Cycle | Graph Typez[Log | Plot Color:Well v

[ Save current settings as the default

P L B R B S

Amplification Plot

1E01

1E00

272151

0.1

ARn

0.0

0.001

M+ B3 Wc Wp ME HWF Wc WH
M ) Ex . Ev Hy Ho Hr

(EANE3

Options
Target: Threshold: [ Auto [0272151 |

Show: [2] Threshold — (] Baseine Start: Well W Target 4 Baseline End: Wel (M Target 4

well Summary: In Pists: 384 Set Up: 384 Anslyzed: 384 Fisgged:4 Omitied by Anslyss: Omitted Manually: Samples Used: 2 Targsts Used: 1

IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the QuantStudio'" 12K Flex Software. Life
Technologies recommends that you examine the Amplification Plot screen and
review the assigned baseline and threshold values for each well after analysis.
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Assess amplification results using the Amplification Plot

Note: If you use the Relative Threshold algorithm to analyze an experiment that
includes amplification, select to view the analysis results using the ARn vs Cycle,
Rn vs Cycle, or Cgry vs Well plot type and Linear or Log graph type. Also select

the Show Crt check box to view the derived fractional cycle on the amplification

plot.

Amplification Plot

Plot Settings

Plot Type:[ARn vs Cycle v| Graph Type:[Log | Plot Color: [Well

v

[ save current settings as the defauft

0.001

Amplification Plot

APl H =

B A BB BNC WD MNE BIF MG MH
M M < . Ey Ey Ho My

Options

Target: Threshold:

Show: [] Threshold

fart: Wel B Target < Baseiine End: Wel

show Crt

W Target 4

Well Summary: n piate: 384 St Up: 384 Analyzed: 384

¢ Correct threshold values:

Flagged: 2 Omitted by Analyss: 0 Omitted Manusly: 0 ‘Samples Used: 2 Targets Used: 1

Threshold Set Correctly T O O O O S

The threshold is set in the

exponential phase of the 1€00

amplification curve.

Threshold settings above or
below the optimum increase
the standard deviation of the
replicate groups.

0.272151

Threshold Set Too Low

The threshold is set below the
exponential phase of the
amplification curve. The
standard deviation is
significantly higher than that
for a plot where the threshold
is set correctly. Drag the
threshold bar up into the
exponential phase of the curve.
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Threshold Set Too High

The threshold is set above the
exponential phase of the
amplification curve. The
standard deviation is
significantly higher than that
for a plot where the threshold
is set correctly. Drag the
threshold bar down into the

exponential phase of the curve.

o
6.04 7685

011"

ARN

¢ Correct baseline values:

Baseline Set Correctly

The amplification curve begins
after the maximum baseline.

Baseline Set Too Low

The amplification curve begins
too far to the right of the
maximum baseline. Increase
the End Cycle value.

Baseline Set Too High

The amplification curve begins
before the maximum baseline.
Decrease the End Cycle value.

EETE T

s B

0.001

\J ! A
2 AJ L] a w12 14 1|8 18 0 » M

Cyele
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Identify well problems using the Well Table

If your experiment does not meet the guidelines above, troubleshoot as follows:

Omit wells (see “Improve C precision by omitting wells” on page 53).
Or

Manually adjust the baseline and/or threshold (see “Adjust analysis settings” on
page 49).

Identify well problems using the Well Table

The Well Table displays data for each well in the reaction plate, including;:

The sample name, target name, task, and dyes

The calculated threshold cycle (Cr), normalized fluorescence (Rn), and quantity
values

Comments

Flags

Purpose The purpose of viewing the well table is to identify:

View the well table

-_—

Quantity values
Flags

Cr values (including C standard deviation)

From the Experiment Menu pane, select Analysis, then select the Well Table tab.
Note: If no data are displayed, click Analyze.

Use the Group By drop-down menu to group wells by a specific category. For the
example experiment, group the wells by replicate, flag, or Ct value.

Note: You can select only one category at a time.

To group by replicate

From the Group By drop-down menu, select Replicate. The software groups the
replicate wells: negative controls, standards, and samples. In the example experiment,
note that the quantity values within each replicate group are similar.
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Identify well problems using the Well Table

Note: In the example experiment, the Quantity, Quantity Mean, and Quantity SD
columns have been moved from their default locations to the beginning of the Well
Table. To move a column, click and drag on the column heading.

| Plate Layout Well Table

inTable W o Collspse Al
I Target Name |

# well | omit — et ... | Task Dyes cr Cr Mean | Cr SD Quantity | Quantit... | Quantit... | NOISE ou

1 AL O P wTC Undetermi... -~

2 A2 O sk STANDARD 29.140 0478  1,250.000

3 A3 O Replcate pJP STANDARD 28.113 0.181 2,500,000

5 As O Dye P STANDARD 26.132 0.100 10,000,000

6 A6 O Fig P STANDARD 25.056 0.098 20,000.000

7 A7 O - P UNKNOWN 27.09 0140 5015352 5090.081  565.712

8 A8 O P UNKNOWN 27.096 0140 5387.923 5000.081 565712

9 A9 O ROTE P UNKHOWN 27.096 0140 5645138 5000081 565712

10 AL0 O well Position (Row) P UNKNOWN 27.096 0140 5181.675 5090.081 565712

1 AL O Well Position (Column) P UNKNOWN 27.096 0140 5708.508 5000.081  565.712

12 AL2 O one P UNKNOWN 27.09 0140 5412.582 5000.081  565.712

13 A13 O UNKNOWH 27.096 0140 5,584.070 5000.081  565.712

14 Al4 O Pop1 RNaseP  UNKNOWN 27.096 0140 5284767 5000.081  565.712

15 ALS O Popl RNEssP  UNKNOWN 27.096 0140 6,041.067 5090.081 565712

16 Al6 O Pop2 RNEssP  UNKNOWN 26.101 0159 10,849.413 10,053.434 1,142.832

17 A17 O Pop2 RNaseP  UNKNOWMN 26.101 0159 11,484.034 10,053.434 1,142.832

18 A18 O Pop2 RNaseP  UNKNOWN 26.101 0159 9,891.872 10,053.434 1,142.832

19 A19 O Pop2 RNaseP  UNKNOWN 26.101 0159 9,519.561 10,053.434 1,142.832

20 A0 O Pop2 RNassP  LNKNOWN 26.101 0159 10,997.522 10,053.434 1,142.832

21 Az O Popz RNEssP  UNKNOWN 26.101 0159 12,373.389 10,053.434 1,142.832

2 A2 O Pop2 RNaseP  UNKNOWMN 26.101 0159 9,523.480 10,053.434 1,142.832

23 A2 O Pop2 RNaseP  UNKNOWMN 26.101 0159 10,793.909 10,053.434 1,142.832

24 A2 O Pop2 RNaseP  UNKNOWN 26.101 0159 10,008.625 10,053.434 1,142.832

25 Bl O RMassP  NTC

26 B2 O RNassP  STANDARD 29.140 0.178 1,250,000

27 83 O RNaseP  STANDARD 28.113 0181  2,500.000

28 B4 O RNaseP  STANDARD 27.133 0130 5,000.000

29 85 O RNaseP  STANDARD 26.132 0100 10,000.000

30 B O RNaseP  STANDARD 25.056 0.098 20,000.000

31 87 O Popl RNEssP  UNKNOWN 27.096 0140 5124.038 5090.081 565712

32 B8 O Popl RNEssP  UNKNOWN 27.096 0140 4,824.094 5090.081  565.712

33 B9 O Pop1 RNaseP  UNKNOWMN 27.09 0140 5200.990 5000.081  565.712

34 B0 O Popl RNaseP  UNKNOWN 27.096 0140 4706099 5000.081  565.712

35 Bi1 O Pop1 RNaseP  UNKNOWN 27.096 0140 5330722 5090.081 565712

36 Bl2 O Popl RNassP  UNKNOWN FAM-NFQ-... 27.097 27.096 0140 5059.768 5000.081  565.712 3

< >

Well Summary: In Plate: 384 Set Up: 384 Anahyzed: 384 Flagged: 4 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 2 Targets Used: 1

The well table looks like this:

> Plate Layout

Show in Table ¥ 5 B Expand Al @ Collapse Al
h d
= | Well | omit Flag Sample .| Target ... | Task Dyes cr Cr Mean | CTSD | Quantity | Quantit... | Quantit...| NOISE ou

Pop. [
7 A7 O Popl RiaseP  UNKNOWN 27.09 0.140 5015352 5090081  565.712
8 As O Pop1 RlaseP  UNKNOWMN 27.09 0140 5,387.923 5000081  565.712
9 A9 O Pop1 RlaseP  UNKNOWMN 27.09 0140 5,645.138 5000081  565.712
10 AlD O Popt RiaseP  UNKHOWMN 27.096 0.140 5181675 5000081 565712
11 ALL O Popl RizseP  UNKNOWMN 27.096 0.140 5708598 5090081  565.712
12 A2 O Popl RiaseP  UNKNOWMN 27.09 0.140 5412.562 5090081  565.712
13 A13 O Pop1 RlaseP  UNKNOWMN 27.09 0.140 5584070 5000081  565.712
14 Al4 O Pop1 RlaseP  UNKNOWMN 27.09 0.140 5284767 5000081  565.712
15 AlS O Popt RiaseP  UNKHOWMN 27.096 0140 6,041.067 5000081 565712
31 87 O Popt RiaseP  UNKHOWMN 27.096 0.140 5,124.039 5000081 565712
32 B8 O Popl RiaseP  UNKNOWMN 27.09 0.140  4,824.094 5090081  565.712
33 B0 O Popl RiaseP  UNKNOWMN 27.09 0.140 5200890 5090081  565.712
34 B10 O Pop1 RlaseP  UNKNOWMN 27.09 0.140 4,706.999 5090081  565.712
35 Bl1 O Pop1 RlaseP  UNKNOWMN 27.09 0.140 5330722 5000081  565.712
36 B12 O Popt RiaseP  UNKHOWMN 27.096 0.140 5050768 5000081  565.712
37 B3 O Popl RiaseP  UNKNOWMN 27.096 0.140 5,052.877 5090081  565.712
38 B14 O Popl RiaseP  UNKNOWMN 27.09 0.140 5,366.522 5090081  565.712
39 815 O Pop1 RlaseP  UNKNOWMN 27.09 0140 5,041.529 5000081  565.712
55 @7 O Pop1 RlaseP  UNKNOWMN 27.09 0.140 5242704 5090081  565.712
56 ce O Popt RiaseP  UNKHOWMN 27.096 0.140 4775204 5000081 565712
57 co O Popl RiizseP  UNKNOWMN 27.09 0.140  4,646.954 5000081  565.712
58 cio O Popl RiaseP  UNKNOWMN 27.09 0.140 4871199 5090081  565.712
59 ci1 O Popl RiaseP  UNKNOWMN 27.09 0140 4,548.860 5090081  565.712
60 Ci2 O Pop1 RlaseP  UNKNOWMN 27.09 0.140  4,664.264 5000081  565.712
61 €13 O Pop1 RiaseP  UNKHOWMN 27.09 0.140 4,628641 5000081  565.712
62 ci4 O Popt RiaseP  UNKHOWMN 27.096 0.140 4,492.085 5000081  565.712
63 Cis O Popl RiaseP  UNKNOWMN 27.09 0.140 4320416 5090081  565.712
79 D7 O Popl RiaseP  UNKNOWMN 27.09 0.140 5277.137 5090081  565.712
80 D8 O Pop1 RlaseP  UNKNOWMN 27.09 0140 5,048.890 5000081  565.712
81 D9 O Pop1 RlaseP  UNKNOWMN 27.09 0.140 4909.571 5000081  565.712
82 D10 O Popt RiaseP  UNKHOWMN 27.096 0.140 4,722.608 5000081 565712
83 DI1 O Popl RizseP  UNKNOWMN 27.096 0.140 5146530 5090081  565.712
84 D12 O Popl RiaseP  UNKNOWMN 27.09 0.140 4,508.289 5090081  565.712

85 D13 O Pop1 RlaseP  UNKNOWMN FAM-NFQ-.. 26.835 27.09 0.140 5,651.525 5000081  565.712 =

e >
Well Summary: In Piste: 384 SetUp: 384 Ansiyzsd: 384 Fisgged: 4 Omitted by Analyss: Cmitt=d Manusliy: (0 Sampies Us=d: 2 Targets Used: 1
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To group by flag

From the Group By drop-down menu, select Flag. The software groups the flagged
and unflagged wells. In the example experiment, there are four flagged wells.

Plate Layout S

in Table

Group by ¥ Expand Al

Target Name
# Omit

= Popl - Ria

et..  Task Dyes cr CT Mean Ct SD Quantity = Quantit... = Quantit... | NOISE ou

Sample Name

Task

7 A7 0 P UNKNOWN  FAM-NFQ-... 27.110 27.096 0.140 5015352 5,000.081  565.712
8 AB | Replicate P UNKHOWN ~ FAM-NFO-... 27.005 27.096 0.140 5367923 5000.081  565.712
] | Dye P UNKNOWN ~ FAM-NFQ-... 26.937 27.0%6 0.140 5645138 5090.081  565.712
10 A10 O [ e N UNKNOWN ~ FAM-NFQ-... 27.063 27.096 0.140 5181.675 5090.081  565.712
11 A1l O o UNKNOWN ~ FAM-NFQ-... 26.921 27.096 0.140 5708.508 5,090.081  565.712
12 A12 0 P UNKNOWN  FAM-NFQ-... 26.999 27.096 0.140 5412.582 5,000.081  565.712
13 A13 O NOISE P UNKHOWH ~ FAM-NFQ-... 26.953 27.096 0.140 5,584.070 5,000.081 565.712
14 Al4 | viell Position (Row) P UNKNOWN ~ FAM-NFQ-... 27.034 27.0%6 0.140 5284767 5090.081  565.712
15 AlS O Viell Position (Column) P UNKNOWN  FAM-NFQ-... 26.838 27.0%6 0.140 6,041.067 5090.081  565.712
31 B7 O None P UNKNOWN  FAM-NFQ-... 27.079 27.096 0.140 5124.039 5090.081  565.712
32 B8 | UNKNOWN ~ FAM-NFQ-... 27.167 27.096 0.140 4,824.094 5000081  565.712
33 B 0 Pop1 RMaseP UNKNOWN ~ FAM-NFQ-... 27.057 27.096 0.140 5200990 5000081  565.712
34 B10 | Popl RHaseP UNKNOWN ~ FAM-NFQ-... 27.203 27.0%6 0.140 4,706.999 5090.081  565.712
35 BIL | Popl RHaseP UNKNOWN ~ FAM-NFQ-... 27.021 27.0%6 0.140 5330722 5090.081  565.712
36 B12 O Pop1 RHaseP UNKNOWN ~ FAM-NFQ-... 27.097 27.096 0.140 5059.768 5,000.081  565.712
37 B13 O Pop1 RHaseP UNKNOWN ~ FAM-NFQ-... 27.099 27.096 0.140 5,052.877 5090.081  565.712
38 Bl4 0 Pop1 RMaseP UNKNOWN  FAM-NFQ-... 27.011 27.096 0.140 5366.522 5,000.081  565.712
39 B15 | Popl RHaseP UNKNOWN ~ FAM-NFQ-... 27.103 27.096 0.140 5041529 5090.081  565.712
55 7 | Popl RHaseP UNKNOWN ~ FAM-NFQ-... 27.045 27.0%6 0.140 5242704 5090.081  565.712
56 C8 O Pop1 RiaseP UNKNOWN ~ FAM-NFQ-... 27.182 27.096 0.140 4,775.204 5,090.081  565.712
57 €9 O Pop1 RHaseP UNKNOWN ~ FAM-NFQ-... 27.222 27.096 0.140 4,646.954 5000.081  565.712
58 C10 | Pop1 RMaseP UNKNOWN  FAM-NFQ-... 27.153 27.096 0.140 4,871.199 5,000.081  565.712
59 c11 0 Pop1 RMaseP UNKNOWN ~ FAM-NFQ-... 27.253 27.096 0.140 4,548.860 5000081  565.712
60 C12 | Popl RHaseP UNKNOWN ~ FAM-NFQ-... 27.217 27.0%6 0.140 4,664.264 5090.081  565.712
61 C13 O Pop1 RHaseP UNKNOWN ~ FAM-NFQ-... 27.228 27.0%6 0.140 4,628.641 5090.081  565.712
62 C14 O Pop1 RHaseP UNKNOWN  FAM-NFQ-... 27.272 27.096 0.140 4,492.085 5,090.081  565.712
63 C15 | Pop1 RHaseP UNKNOWN ~ FAM-NFQ-... 27.329 27.096 0.140 4,320.416 5,000.081  565.712
79 D7 0 Pop1 RMaseP UNKNOWN  FAM-NFQ-... 27.036 27.096 0.140 5277.137 5000081  565.712
80 D8 | Popt RHaseP UNKNOWN ~ FAM-NFQ-... 27.101 27.096 0.140 5048.890 5000.081  565.712
81 D3 | Popl RHaseP UNKNOWN ~ FAM-NFQ-... 27.142 27.0%6 0.140 4,909.571 5090.081  565.712
82 D10 O Pop1 RHaseP UNKNOWN ~ FAM-NFQ-... 27.198 27.096 0.140 4,722.698 5,000.081  565.712
83 DIl O Pop1 RHaseP UNKNOWN  FAM-NFQ-... 27.073 27.096 0.140 5146.530 5,000.081  565.712
84 D12 0 Pop1 RMaseP UNKNOWN  FAM-NFQ-... 27.266 27.096 0.140 4,508.280 5,000.081  565.712
85 D13 0 Pop1 RMaseP UNKNOWN  FAM-NFQ-... 26.935 27.096 0.140 5,651.525 5,000.081  565.712 2
G >
‘Well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 4 Omitted by Analyss: 0 Omitted Manualy: 0 Samples Used: 2 Targets Used: 1

To group by Cy value

From the Group By drop-down menu, select Ct. The software groups the wells by Ct
value: low, medium, high, and undetermined. In the example experiment, the Cy
values are within the expected range (>8 and <35).

Plate Layout

in Table W

Group by W Expand Al

Target Name
# Well | Omit

Low (CT lee]
= Medium (C1

et.. Task Dyes cr CT Mean CT SD Quantity = Quantit... | Quantit... | NOISE ouU

Sample Name

Task

2 A2 0 Replicate P STANDARD FAM-NFQ-... 29.012 29.140 0.178  1,250.000

3 A3 | Dye P STANDARD FAM-NFQ-... 28.102 28.113 0.181  2,500.000

4 A+ | Flag P STANDARD FAM-NFQ-... 26.788 27.133 0130 5,000.000

5 A5 O STANDARD FAM-NFQ-... 25.999 26.132 0.100 10,000.000

6 A6 | o [e'p STANDARD FAM-NFQ-... 24.996 25.056 0.098 20,000.000

7 A7 O NOISE P UNKNOWH ~ FAM-NFQ-... 27.110 27.096 0.140 5,015.352 5,000.081 565.712
8 A8 | Well Position (Row) P UNKNOWN  FAM-NFQ-... 27.005 27.006 0.140 5387.923 5,000.081 565712
] | Well Position (Column) P UNKNOWN ~ FAM-NFQ-... 26.937 27.0%6 0.140 5645.138 5,000.081  565.712
10 A10 O None P UNKNOWN ~ FAM-NFQ-... 27.063 27.096 0.140 5181.675 5000.081  565.712
11 A1l O - UNKNOWN ~ FAM-NFQ-... 26.921 27.096 0.140 5708.508 5,000.081  565.712
12 A12 0 Pop1 RMaseP UNKNOWN ~ FAM-NFQ-... 26.999 27.096 0.140 5412.582 5000081  565.712
13 A13 0 Pop1 RMaseP UNKNOWN ~ FAM-NFQ-... 26.953 27.096 0.140 5584.070 5000081  565.712
14 Al4 | Popl RiaseP UNKNOWN ~ FAM-NFQ-... 27.034 27.0%6 0.140 5284767 5090.081  565.712
15 AlS O Pop1 RiaseP UNKNOWN  FAM-NFQ-... 26.838 27.0% 0.140 6,041.067 5080.081  565.712
16 Al6 O Pop2 RiaseP UNKNOWN ~ FAM-NFQ-... 25.981 26,101 0.159 10,849.413 10,053.434 1,142.832
17 A17 | Pop2 RiaseP UNKNOWN ~ FAM-NFQ-... 25.897 26.101 0.159 11,484.034 10,053.434 1,142.832
18 Al8 0 Pop2 RMaseP UNKNOWN ~ FAM-NFQ-... 26.116 26.101 0.159 9,801.872 10,053.434 1,142.832
19 Al9 | Pop2 RHaseP UNKNOWN ~ FAM-NFQ-... 26.172 26,101 0.150 9,519.561 10,053.434 1,142.832
20 A20 | Pop2 RiaseP UNKNOWN ~ FAM-NFQ-... 25.961 26.101 0.159 10,997.522 10,053.434 1,142.832
21 A21 O Pop2 RiaseP UNKNOWN ~ FAM-NFQ-... 25.788 26,101 0.15¢ 12,373.389 10,053.434 1,142.832
2 A2 O Pop2 RiaseP UNKNOWN  FAM-NFQ-... 26.171 26,101 0.15¢ 9,523.480 10,053.434 1,142.832
23 A23 0 Pop2 RMaseP UNKNOWN ~ FAM-NFQ-... 25.988 26.101 0.159 10,793.909 10,053.434 1,142.832
24 A4 | Pop2 RHaseP UNKNOWN  FAM-NFQ-... 26.099 26.101 0.159 10,008.625 10,053.434 1,142.832
26 B2 | RiaseP STANDARD FAM-NFQ-... 28.981 28.140 0.178  1,250.000

27 B3 O RiaseP STANDARD FAM-NFQ-... 28.022 28.113 0.181  2,500.000

28 B4 O RiaseP STANDARD FAM-NFQ-... 27.076 27.133 0.130  5,000.000

29 BS | RMaseP STANDARD FAM-NFQ-... 25.960 26.132 0.100 10,000.000

30 B6 0 RMaseP STANDARD FAM-NFQ-... 25.018 25.056 0.098 20,000.000

31 B7 | Popl RiaseP UNKNOWN ~ FAM-NFQ-... 27.078 27.0%6 0.140 5124.039 5090.081  565.712
32 B8 O Pop1 RiaseP UNKNOWN  FAM-NFQ-... 27.167 27.0%6 0.140 4,824.094 5080.081  565.712
33 B O Pop1 RiaseP UNKNOWN ~ FAM-NFQ-... 27.057 27.096 0.140 5200.990 5,090.081  565.712
34 B10 | Pop1 RiaseP UNKNOWN  FAM-NFQ-... 27.203 27.096 0.140 4706999 5000081  565.712
35 BIL 0 Pop1 RMaseP UNKNOWN ~ FAM-NFQ-... 27.021 27.096 0.140 5330722 5000081  565.712 2

G >
‘Well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 4 Omitied by Anatysis: Omitted Manusly: 0 Samples Used: 2 Targsts Used: 1
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Tips for analyzing .
your own
experiments

Section 5.1 Review Results 5
Confirm accurate dye signal using the Multicomponent Plot

Replicate — The software groups the wells by replicate: negative controls,
standards, and samples. Look in the Quantity columns to make sure the quantity
values for each replicate group are similar indicating tight Ct precision.

Flag — The software groups the flagged and unflagged wells. A flag indicates that
the software has found a potential error in the flagged well. For a description of
the QuantStudio" 12K Flex Software flags, see “Flag Settings” on page 51.

Cr — The threshold cycle (Cy) is the PCR cycle number at which the fluorescence
level meets the threshold. A Ct value >8 and <35 is desirable. A Cy value <8
indicates that there is too much template in the reaction. A Ct value >35 indicates
alow amount of target in the reaction; for Cy values >35, expect a higher standard
deviation.

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.

Purpose In the standard curve example experiment, you review the Multicomponent Plot
screen for:

View the 1.

Multicomponent
Plot

T™

ROX™™ dye (passive reference)
FAM™ dye (reporter)
Spikes, dips, and/or sudden changes

Amplification in the negative control wells

From the Experiment Menu pane, select Analysis » Multicomponent Plot.

Note: If no data are displayed, click Analyze.

. Display the unknown and standard wells one at a time in the Multicomponent

Plot screen:
a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

From the Plot Color drop-down menu, select Dye.

Click |~ | Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Check the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the PCR process; a constant ROX dye signal
indicates typical data.
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Confirm accurate dye signal using the Multicomponent Plot

6. Check the FAM dye signal. In the example experiment, the FAM dye signal
increases throughout the PCR process; increase in FAM dye signal indicates
normal amplification.

Multicomponent Plot

Plot Settings
sotcobrpye  v]
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Well Summary: In Plat=: 384 Set Up: 384 Anatyzed: 384 Flagged: 4 Omitted by Anahysis: (1 Omitted Manually: Samples Used: 2 Targets Used: |

7. Select the negative control wells one at time and check for amplification. In the
example experiment, there is no amplification in the negative control wells.

Multicomponent Plot

Plot Settings
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Well Summary: In Plste: 384 Set Up: 364 Anshyzed: 384 Flsgged: 4 Omitted by Anslysis: (1 Omitted Manualy: Samples Used: 2 Targets Used: 1
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Section 5.1 Review Results 5
Determine signal accuracy using the Raw Data Plot

Tips for confirming  When you analyze your own standard curve experiment, look for:

dye accuracy in .
your own
experiment .

Passive reference — The passive reference dye fluorescence level should remain
relatively constant throughout the PCR process.

Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

Negative Control wells — There should not be any amplification in the negative
control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.

Pu rpose In the standard curve example experiment, you review the Raw Data Plot screen for a
stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data 1.

Plot

From the Experiment Menu pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.

Click E Show a legend for the plot (default). The legend displays the color
code for each row of the reaction plate (see the legend in the Raw Data Plot shown
below).
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Determine signal accuracy using the Raw Data Plot

Tips for
determining signal
accuracy in your
own experiments

46

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.

Raw Data Plot <

£ P By iy

R

Raw Data Plot

17,000,000
16,000,000
15,000,000
14,000,000
13,000,000
12.000.000

11,000,000 4

Ampltude

5.000.000
5.000,000
4,000,000
3.000.000
2.000,000

1,000,000

xtom xz'mz xama xama x5

Filber
e
I HB c D E HF MG H A
i1 ) E< L. Ev Ey Ho mpP a

‘Options
Show Cydle 40 J
1 5 10 15 20 25 30 35 40

Well Summary: In Plate: 384 Set Up: 384 Anahyzed: 384 Flagged: 4 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 2 Targets Used: 1

The filters used for the example experiment are:

Run Method

Reaction Volume per Welk uL
Graphical View

PCR Filter =

Emission Fiter
m1(520+15) m2(558+11) m3(586+10) m4(623+14) m5(682+14) me(711+12)

X1(47015)

X2(520£10)

¥X3(55011)

Excitation Filter

x4(580+10)

X5(64010)

X6(662+10)

Melt Curve Filter =

Emission Fiter
m1(520+15) m2(558+11) m3(586+10) m4(623+14) m5(682+14) m6(711+12)

X1(47015)

X2(520£10)

¥X3(55011)

Excitation Filter

x4(580+10)

X5(64010)

X6(662+10)

When you analyze your own standard curve experiment, look for the following in each
filter:

¢ Characteristic signal growth

* No abrupt changes or dips
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Review the flags in the QC Summary

QC Summary

Flag:
AMPNC

Section 5.1 Review Results 5
Review the flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags,
including the flag frequency and location for the open experiment.

View the QC Summary

1. From the Experiment Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the experiment. If the frequency is >0, the flag appears somewhere in
the experiment; the well position is listed in the Wells column.

In the example experiment, there are four flagged wells.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed
information about the flag. In the example experiment, the Frequency column
displays 0 for all flags.

4. (Optional) For those flags with frequency >0, click the troubleshooting link to view

information on correcting the flag.

Description
Amplification in negative control

Frequency

Wells

<

BADROX

Bad passive reference signal

OFFSCALE

Fluorescence is offscale

HIGHSD

High standard deviation in replicate group

NOAMP

Mo amplification

MNOISE

Moise higher than others in plate

121

SPIKE

loise spkes

MOSIGNAL

Mo signal in well

OUTLIERRG

Outlier in replicate group

24,12, 13

EXPFAIL

Exponential algorithm failed

BLFAIL

Baseline algorithm failed

THOLDFAIL

Thresholding algorithm failed

CTFAIL

Ct algorithm failed

FIEEEEREEEEEEEE

AMPSCORE

AMP Score

Total Wels:
‘Wells Set Up:

384 | Processed Wells:
384 | Flagged Wells:

384 Manually Omitted Wells:
4 Analysis Omitted Wells:

0
0

Targets Used:
Samples Used:

Well Summary: In Plate: 384

Possible flags

Set Up: 384 Analyzed: 384

Omitted by Anslyss:

Omitted Manually:

Samples Used: 2 Targets Used: 1

The flags listed below may be triggered by the experiment data.

Note: To change the flag settings, refer to “Flag Settings” on page 51.
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For more information

Flag Description

Pre-processing flag

OFFSCALE Fluorescence is offscale

Primary analysis flags

BADROX Bad passive reference signal

NOAMP No amplification

NOISE Noise higher than others in plate

SPIKE . Noise spikes

NOSIGNAL | No signal in well

EXPFAIL . Exponential algorithm failed

BLFAIL Baseline algorithm failed

THOLDFAIL Thresholding algorithm failed

CTFAIL Cy algorithm failed

AMPSCORE Amplification in the linear region is below a certain
threshold, corresponding to the score set in the analysis
settings

Secondary analysis flags

OUTLIERRG Outlier in replicate group
AMPNC Amplification in negative control
HIGHSD High standard deviation in replicate group

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL,
THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in
the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

For more information

For more information on... Refer to... Part number

Publishing data Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050
System Multi-Well Plate and Array Card Experiments
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Section 5.2 Adjust parameters for re-analysis of your own experiments 5
Adjust analysis settings

Section 5.2 Adjust parameters for re-analysis of your
own experiments

Adjust analysis settings

View the analysis
settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cr), flags, and advanced options.

If the default analysis settings in the QuantStudio'" 12K Flex Software are not suitable
for your own experiment, you can change the settings in the Analysis Settings dialog
box, then reanalyze your experiment.

1. From the Experiment Menu pane, select Analysis.

2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.
In the example experiment, the default analysis settings are used for each tab:
e (Cp Settings
¢ Flag Settings
* Advanced Settings
¢ Standard Curve Settings
The Analysis Settings dialog box for a Standard Curve experiment looks like this:

a Analysis Settings for 384-Well Fast Standard Curve Example

Flag Settings

Advanced Settings Standard Curve Settings

gets in this experiment. To use different settings for a target, select the target from the table, deselect Use Default

— Data Step Selection

Select the step and stage to use for C1 analysis, Only stage/step combinations for which data suitable for C1 Select the algorithm to calculate Cr.
analysis have been callected are displayed.

Stage 2, Step 2 v

Algorithm Settings

Baseline Threshold |+

~— Default Cr Settings
Default CT settings are used to calculate the CT for targets without custom settings. To edit the default settings, dick Edit Default Settings.

Threshold: AUTO Baseline Start Cycle: AUTO Baseline End Cyde: AUTO | Edit Default Settings

— Select a Target
Target
RNaseP

Threshold

|0.272151

— CT Settings for RNaseP

Baseline Start Baseline End Cr Settings to Use: [] Default Settings

‘3 ‘23 [ Automatic Threshold

Threshold: [0.272151
[ Automatic Baseline
Baseline Start Cycle: | 3 % | End Cycle: | 28 %

Save to Library Load from Library

Revert to Default Analysis Settings Apply Analysis Settings W
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Adjust analysis settings

3. View and, if necessary, change the analysis settings (see “Adjust analysis settings”

below).

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well
Plate and Array Card Experiments.

. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to
Default Analysis Settings.

Adjust analysis Ct Settings
settings * Data Step Selection
Use this feature to select one stage/step combination for Ct analysis when there is
more than one data collection point in the run method.
Algorithm Settings
You can select the algorithm that determines the Cy values. There are two
algorithms: Baseline Threshold (the default) and Relative Threshold.
The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for quantification.
The Relative Threshold algorithm is a well-based analysis based on the PCR
reaction efficiency and fitted to the Amplification curve. This setting is ideal for a
single sample across genes with no dependence on targets, thereby reducing
variability. It is not necessary to set either a baseline or a threshold when you use
the Relative Threshold algorithm, so any settings for baseline or threshold will
not affect the analysis.
Default Ct Settings
Use the default Cr settings feature to calculate Cr for the targets that do not have
custom settings. To edit the default settings, click Edit Default Settings.
Cr Settings for Target
When you manually set the threshold and baseline, Life Technologies
recommends:
Setting Recommendation
Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
¢ Below the plateau and linear regions of the amplification curve.
¢ Within the exponential phase of the amplification curve.
Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.
Note: This setting is applicable only to the Baseline Threshold algorithm.
Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.
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Adjust analysis settings

Flag Settings
Use the Flag Settings tab to:

¢ Adjust the sensitivity so that more wells or fewer wells are flagged.
* Change the flags that are applied by the QuantStudio 12K Flex Software.

To adjust the flag settings:
1. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of Ct SD. For some flags, analysis results calculated before
the well is rejected are maintained.

4. Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.

The Flag Settings tab looks like this:

CT Settings

@ Configure the flags and filtering. In this panel you can enable, disable, and configure flags, and indicate if a well is to be rejectec

Flag Description Use Attribute Condition Value Reject well
AMPNC Amplification in negat... T = ~ [35.000 Fl
BADROX Bad passive referenc... Bad passive referenc... |> + (0.600 O
OFFSCALE Fluorescence is offscale O
HIGHSD High standard deviati... Ct standard deviation |> + [0.500 F
NOAMP No amplification amplification algorith... |< + [0.100 Fl
NOISE Noise higher than at... Relative noise > v [4.000 O
SPIKE Noise spikes Spike algorithm result |= w [1.000 O
NOSIGHAL No signal in well O
QUTLIERRG Outlier in replicate gr... Fl
EXPFAIL Exponential algorithm... O
BLFAIL Baseline algorithm failed O
THOLDFAIL Thresholding algorith... O
CTFAIL Cr algorithm failed ]
AMPSCORE AMP Score AMP Score = w [1.000 F

Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings W
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Adjust analysis settings

sults and Adjust Experiment Parameters

Advanced Settings
Use the Advanced Settings tab to change baseline settings well-by-well.

Note: The baseline and threshold values do not affect the analysis using the Relative
Threshold algorithm.

To use custom baseline settings for a well-target combination:
1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target check box.

3. Define the custom baseline settings:

¢ For automatic baseline calculations, select the Automatic Baseline check
box.

¢ To define the baseline, deselect the Automatic Baseline check box, then enter
the baseline start cycle and baseline end cycle.
Standard Curve Settings

Use this tab to review the settings of the current standard curve experiment or to
import the standard curve from an external experiment (with the same samples and
targets) and apply it to the current experiment.

Note: The run method must be the same. Life Technologies recommends using the
standard curve from the current experiment.

For the example experiment, the settings from the current experiment have been used.

] Analysis Settings for 384-Well Fast Standard Curve Example

experiment, dick Import.

— Override Standard Curve

(&) Use the standard curve from this experiment

() Use a standard curve imported from another experiment

~— Standard Curve View

20.25
20,00
2875
28.50
28.25
28.00
2778
27.50
27.25
27.00
2875

26.50

100 200 Lovil 10000 0000
Reporter Target Slope Y-ntercept R{superscript 2} Efficiency(%)
FAM |RN35eP |—2.3 29 36.460 |U.936 |163.HZU ‘ e

Save to Library Load from Library

Revert to Default Analysis Settings Apply Analysis Settings W
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Improve Cy precision by omitting wells

»|  Plate Layout

Table

Section 5.2 Adjust parameters for re-analysis of your own experiments
Improve Cr precision by omitting wells

Experimental error may cause some wells to be amplified insufficiently or not at all.
These wells typically produce Cy values that differ significantly from the average for
the associated replicate wells. If included in the calculations, these outliers can result in
erroneous measurements; to ensure Cp precision, omit the outliers from the analysis.

1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. In the Amplification Plot screen, select Ct vs Well from the Plot Type drop-down

menu

3. Select the Well Table tab.

4. In the Well Table, view outliers:

a. From the Group By drop-down menu, select Replicate.

b. Look for any outliers in the replicate group (make sure they are flagged).

c. Select the Omit check box next to outlying well(s), as shown below.

Expand Al

Quantit...

NCISE

~
>

# well | |Omit Flag Sample ...| Target.. Task Dyes cT CT Mean | CT SD Quantity | Quantit...
366 P6 " | RMaseP STANDARD FAM-NFQ-... 24.861 25.056 0.098 20,000.000
I- RNaseP - STANDARD - 2500.0
3 A3 " | RMaseP STANDARD FAM-NFQ-... 28.102 28.113 0.181  2,500.000
27 B3 " | RMaseP STANDARD FAM-NFQ-... 28.022 28.113 0.181  2,500.000
51 @3 " | RMaseP STANDARD FAM-NFQ-... 28.089 28.113 0.181  2,500.000
75 D3 " | RMaseP STANDARD FAM-NFQ-... 28.067 28.113 0.181  2,500.000
99 B3 " | RMaseP STANDARD FAM-NFQ-... 28.254 28.113 0.181  2,500.000
123°F3 " | RMaseP STANDARD FAM-NFQ-... 28.312 28.113 0.181  2,500.000
147 G3 " | RMaseP STANDARD FAM-NFQ-... 28.194 28.113 0.181  2,500.000
171 H3 " | RMaseP STANDARD FAM-NFQ-... 28.382 28.113 0.181  2,500.000
19513 " | RMaseP STANDARD FAM-NFQ-... 28.163 28.113 0.181  2,500.000
219 13 " | RMaseP STANDARD FAM-NFQ-... 27.984 28.113 0.181  2,500.000
243 K3 " | RMaseP STANDARD FAM-NFQ-... 28.204 28.113 0.181  2,500.000
267 L3 " | RMaseP STANDARD FAM-NFQ-... 28.087 28.113 0.181  2,500.000
291 M3 " | RMaseP STANDARD FAM-NFQ-... 28.262 28.113 0.181  2,500.000
315 N3 " | 1 RMaseP STANDARD FAM-NFQ-... 27.603 28.113 0.181  2,500.000
339 03 " | RMaseP STANDARD FAM-NFQ-... 27.937 28.113 0.181  2,500.000
363 P3 " | RMaseP STANDARD FAM-NFQ-... 28.151 28.113 0.181  2,500.000
I
4 A4 " | 1 RMaseP STANDARD FAM-NFQ-... 26.788 27.133 0.130  5,000.000
28 B4 " | RMaseP STANDARD FAM-NFQ-... 27.076 27.133 0.130  5,000.000
52 4 " | RMaseP STANDARD FAM-NFQ-... 27.158 27.133 0.130  5,000.000
76 D4 " | RMaseP STANDARD FAM-NFQ-... 27.328 27.133 0.130  5,000.000
100 E4 " | RMaseP STANDARD FAM-NFQ-... 27.240 27.133 0.130  5,000.000
124 F4 " | RMaseP STANDARD FAM-NFQ-... 27.148 27.133 0.130  5,000.000
148 G4 " | RMaseP STANDARD FAM-NFQ-... 27.097 27.133 0.130  5,000.000
172 H4 " | RMaseP STANDARD FAM-NFQ-... 27.212 27.133 0.130  5,000.000
196 1 " | RMaseP STANDARD FAM-NFQ-... 27.220 27.133 0.130  5,000.000
220 14 " | RMaseP STANDARD FAM-NFQ-... 27.141 27.133 0.130  5,000.000
244 K4 " | RMaseP STANDARD FAM-NFQ-... 27.137 27.133 0.130  5,000.000
268 L4 " | RMaseP STANDARD FAM-NFQ-... 27.290 27.133 0.130  5,000.000
292 M4 " | RMaseP STANDARD FAM-NFQ-... 27.204 27.133 0.130  5,000.000
316 N4 " | RMaseP STANDARD FAM-NFQ-... 27.064 27.133 0.130  5,000.000
340 04 " | RMaseP STANDARD FAM-NFQ-... 27.048 27.133 0.130  5,000.000
364 P4 " | RMaseP STANDARD FAM-NFQ-... 26.973 27.133 0.130  5,000.000
<
Wwell Summary: In Plste: 384 Set Up: 384 Analyzed: 384 Flagged: 4 Omitted by Analysis: [ Omitted Manualy: (

5. Click Analyze to reanalyze the experiment data with the outlying well(s)

removed from the analysis.

Sempies Used: 2

Targets Used: 1

Note: You can also omit undesirable wells in an experiment from the Plate Layout
screen. To omit a well from the Plate Layout screen, right-click the well and select

Omit.
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Chapter 5 Review Results and Adjust Experiment Parameters
For more information

For more information

For more information on Refer to Part number

Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays 127AP05-03
Application Note.
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Export Analysis Results

1. Open the Standard Curve example experiment file that you analyzed in
Chapter 5.

2. In the Experiment Menu, click I ;4_— Export.

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

3. Select QuantStudio'" 12K Flex format.

4. Complete the Export dialog box as shown below:

Field or Selection Entry
Select Data to Results

export/ Select

Content

Export Data To One File

Export File Name 384-Well Fast Standard Curve Example_QuantStudio_export

File Type * txt

Export File Location | <drive>:\Applied Biosystems\QuantStudio 12K Flex
Software\User Files\experiments
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Chapter 6 Export Analysis Results

Your Export screen should look like this:

[] Auto Export Format : |QuantStudio 12KFlex v‘ Export Data To: & One File ) Separate Filas Open file(s) when export is complete

Export File Location: |C:\App\ied Biosystems\QuantStudio 12K FIexSnftware\U5| Export File Mame: [384-Well Fast Standard Curve Example_Qua| File Type

Sample Setup [ Raw Data Amplification [ multicomponent

Skip Empty Wells Skip Omitted Wi

Select Content well Well Position Sample Name | Target Name Task Reporter Quencher C
[¥] All Fields 2 1A1 RNaseP NTC FAM NFQ-MGB A
wel 242 RNaseP STANDARD FAM NFQ-MGB 29
! 343 RNaseP STANDARD FAM NFQ-MGE 28
Wel Position 444 RNaseP STANDARD FAM NFQ-MGE 26
5A5 RNaseP STANDARD FAM NFQ-MGB 25
Sample Name 6 AG RNaseP STANDARD FAM NFQ-MGB 24
747 Popl RMNaseP UNKNOWN FAM NFQ-MGB 27
Target Name 848 Popl RMaseP UNKNOWN FAM NFQ-MGB 27
94D Popl RNaseP UNKNOWN FAM NFQ-MGB 26
Task 10 A10 Popl RNaseP UNKNOWN FAM NFQ-MGB 27
Reparter 11 A11 Popl RNaseP UNKNOWN FAM NFQ-MGE 26
12 A2 Popl RNaseP UNKNOWN FAM NFQ-MGE 26
Quencher 13 A13 Popl RNaseP UNKNOWH FAM NFQ-MGB 26
14 Al4 Popl RNaseP UNKNOWN FAM NFQ-MGB 27
cT 15415 Popl RMaseP UNKNOWN FAM NFQ-MGB 26
16 A16 Pop2 RNaseP UNKNOWN FAM NFQ-MGB 25
CtMean 17 A17 Pop2 RMaseP UNKNOWN FAM NFQ-MGB 25
ctsp 18418 Pop2 RNaseP UNKNOWN FAM NFQ-MGB 26
19419 Pop2 RNaseP UNKNOWN FAM NFQ-MGE 26
Quantity 20 A20 Pop2 RNaseP UNKNOWN FAM NFQ-MGE 25
21 A21 Pop2 RNaseP UNKNOWH FAM NFQ-MGB 25
Quantity Mean 22 422 Pop2 RhaseP UNKNOWH FAM NFQ-MGB 26
23423 Pop2 RMaseP UNKNOWN FAM NFQ-MGB 25
Quantity SD 24 A24 Pap2 RilaseP UNKHOWI FAM NFQ-MGB 26
Automatic Ct Threshold 25B1 RMaseP NTC FAM NFQ-MGB
3 2682 RNaseP STANDARD FAM NFQ-MGB 28
Ct Threshold 2783 RNaseP STANDARD FAM NFQ-MGE 28
28B4 RNaseP STANDARD FAM NFQ-MGE 27
Automatic Baseline 2985 RNaseP STANDARD FAM NFQ-MGB 25
3086 RNaseP STANDARD FAM NFQ-MGB 25y
v -
Baseline Start g [z =

M Save Export Set As Load Export Set Delete Export Set

Your exported file when opened in Notepad should look like this:

Barcode = NA -
Block Type = 384-well Block =
calibration Background is expired = No

calibration Background performed on = 2011-08-05 01:46:18 AM S5GT

calibration Fam is expired = No

calibration Fam performed on = 2011-08-05 02:04:58 AM 5GT

calibration ROI is expired = No

calibration ROI performed on = 2011-08-04 11:42:31 AM 5GT

calibration rROX is expired = No

calibration roX performed on = 2011-08-05 02:23:30 AM 5GT

calibration uniformity is expired = No

calibration uniformity performed on = 2011-08-05 01:56:21 AM 5GT

calibration vIC is expired = No

calibration vIC performed on = 2011-08-05 02:15:08 AM 5GT

Chemistry = TAQMAN

Comment = NA

Date Created = 1970-01-01 07:30:00 AM SGT

Expaam'm;nt File Name = C:“\Program Files‘Applied Biosystems‘\Quantstudiol2krFlex'examples'Standard Curve'384-well Fast Standard Curve
xample. eds

Exgeriment Name = 384-well Fast Standard Curve Example

Experiment Run End Time = 2011-08-06 13:15:47 PM SGT

Experiment Type = Standard Curve

Instrument Name = QuantstudioDemo

Instrument Serial Number = qQuantstudiobDemo

Instrument Type = Quantstudio 12K Flex

Passive Reference = ROX

qQuantification cycle method = Ct

signal smoothing on = true

stage/ Cycle where analysis is performed = stage 2, step 2

User Name = NA

M & % % % % % %% 6 EXE R DGR AT

IEEEEEEEEE]

[sample setup]
well

well Position sample Name sample color Biogroup Name piogroup Color Target Name Target color Task Reporter

quencher qQuantity Comments

3 AL RNaseP "RGB(176,23,31)" NTC FAM NFQ-MGB

2 A2 RMaseP "RGB(176,23,31)" STANDARD FAM NFQ-MGBE "1, 250.000"
3 A3 RNaseP "RGB(176,23,31)" STANDARD FAM NFQ-MGE "2, 500.000"
4 Ad RNaseP "RGB(176,23,31)" STANDARD FAM NFQ-MGB "5, 000. 000"
5 A5 RNaseP "RGB(176,23,31)" STANDARD FAM NFQ-MGB 10, 000.000"
6 Ab RNaseP "RGB(176,23,31)" STANDARD FAM NFQ-MGBE "20, 000. 000"
7 AT Popl "RGB(0,255,0)" RNaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

8 AB Popl "RGB(0, 255,0)" RNaseP UNKNOWN FAM NFQ-MGB

] AQ Popl "RGB(0,255,0)" RNasep UNKNOWN FAM NFQ-MGB

10 A0 Popl "RGB(0, 255, 0 RNaseP UNKNOWN FAM NFQ-MGB

11 ALl Popl "RGB(0,255,0)" RNaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

12 Al2 Popl "RGB(0, 255,0)" RNaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

13 Al3 Popl "RGB(0,255,0)" RNaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

14 Ald Popl "RGB(0, 255,0)" RMaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

15 AlS Popl "RGB(0,255,0)" RNaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

16 Al6 Pop2 "RGB(255,102,0)" RNaseP 'RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

7 AL7 Pop2 "RGB(255,102,0)" RNaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

18 AlB Pop2 "RGB(255,102,0)" RMaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB

19 AL9 Pop2 "RGB(255,102,0)" RNaseP "RGB(176,23,31)" UNKNOWN FAM NFQ-MGB v
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PART |
Running Relative Standard Curve Experiments






About Relative Standard Curve
Experiments

This chapter covers:
About Relative Standard Curve experiments. ....................... ... .... 9

About the example experiment .............. ... . . ool 11

IMPORTANT! First-time users of the QuantStudio™ 12K Flex System, please read
Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array
Card Experiments and Booklet 7, QuantStudio™ 12K Flex System Multi-Well Plate and
Array Card Experiments - Appendixes of this binder thoroughly. The booklets provide
information and general instructions that are applicable to all the experiments
described in this binder.

Note: For more information about any of the topics discussed in this guide, access the
Help from within QuantStudio™ 12K Flex Software by pressing F1, clicking @ in the
toolbar, or selecting Help » QuantStudio™ 12K Flex Software Help.

About Relative Standard Curve experiments

Assemble required

The Relative Standard Curve method is used to determine relative target quantity in
samples. The QuantStudio™ 12K Flex Software measures amplification of the target
and of the endogenous control in samples, in a reference sample, and in a standard
dilution series. Measurements are normalized using the endogenous control. Data
from the standard dilution series are used to generate the standard curve. Using the
standard curve, the software interpolates target quantity and endogenous control
quantity in the samples and the reference sample. For each sample and reference
sample, the target quantity is normalized by endogenous control quantity (quantity of
target/quantity of endogenous control). The normalized quotient from samples is
divided by the quotient from the reference sample to get relative quantification (fold
change). The software determines the relative quantity of target in each sample by
comparing target quantity in each sample to target quantity in the reference sample.

Relative Standard Curve experiments are commonly used to:
* Compare expression levels of a gene in different tissues.
¢ Compare expression levels of a gene in a treated sample and an untreated sample.
e Compare expression levels of wild-type alleles and mutated alleles.

* Analyze the gene expression changes over time under specific treatment
conditions.

¢ Sample - The tissue group that you are testing for a target gene.

components ¢ Reference sample (also called a calibrator) — The sample used as the basis for
relative quantification results. For example, in a study of drug effects on gene
expression, an untreated control is an appropriate reference sample.
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1 Chapter 1 About Relative Standard Curve Experiments
About Relative Standard Curve experiments

PCR options

10

Standard — A sample that contains known quantities of the target; used in
quantification experiments to generate standard curves.

Standard dilution series — A set of standards containing a range of known
quantities. The standard dilution series is prepared by serially diluting standards.

Endogenous control — A gene that is used to normalize template input
differences, and sample-to-sample or run-to-run variation.

Replicates — The total number of identical reactions containing identical
components and identical volumes.

Negative Controls — Wells that contain water or buffer instead of sample
template. No amplification of the target should occur in the negative control
wells.

When performing real-time PCR, choose between:

Singleplex and multiplex PCR (page 10)
and
1-step and 2-step RT-PCR (page 11)

Singleplex and Multiplex PCR

You can perform a PCR reaction using either:

Singleplex PCR - In singleplex PCR a single primer and probe set is present in
the reaction tube or well. Only one target or endogenous control can be amplified
per reaction.

Or

Multiplex PCR — In multiplex PCR, two or more primer and probe sets are
present in the reaction tube or well. Each set amplifies a specific target or
™

endogenous control. Typically, a probe labeled with FAM ™ dye detects the target
and a probe labeled with VIC® dye detects the endogenous control.

IMPORTANT! SYBR® Green reagents cannot be used for multiplex PCR.

. O EE @ Target Primer Set
=
N 3 o0 (O Endogenous Control
-~ Primer Set
_ ~—~ cDNA
Singleplex PCR Multiplex PCR

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Chapter 1 About Relative Standard Curve Experiments 1
About the example experiment

1- and 2-Step RT-PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in
separate reactions (2-step). The reagent configuration you use depends on whether
you are performing 1- or 2-step RT-PCR:

¢ 1-step PCR-In 1-step RT-PCR, RT and PCR take place in one buffer system.
Using one buffer system provides the convenience of a single-tube preparation
for RT and PCR amplification. However, you cannot use Fast PCR Master Mix or
the carryover prevention enzyme, AmpErase® UNG (uracil-N-glycosylase), to
perform 1-step RT-PCR.

e 2-step PCR- 2-step RT-PCR is performed in two separate reactions: First, total
RNA is reverse-transcribed into cDNA, then the cDNA is amplified by PCR. This
method is useful for detecting multiple transcripts from a single cDNA template
or for storing cDNA aliquots for later use. The AmpErase® UNG enzyme can be
used to prevent carryover contamination.

About the example experiment

To illustrate how to perform a Relative Standard Curve, this guide leads you through
the process of designing and performing an example experiment. The example
experiment represents a typical setup that you can use to quickly familiarize yourself
with the QuantStudio™ 12K Flex System.

The objective of the Relative Standard Curve example experiment is to compare the
expression of the HPRT transcriptional factor (an oncoprotein that activates the
transcription of growth-associated genes) in Human cDNA tissues.

In the Relative Standard Curve example experiment:
* The samples are 1, 10, 100, 1000, 10000, Heart, and Kidney.
* The target is HPRT.
* The endogenous control is FAS.
* The reference sample is Kidney.

* One standard curve is set up for HPRT. The standard used for the standard
dilution series is a Human cDNA sample of known total concentration.

* One standard curve is set up for FAS (endogenous control). The standard used for
the standard dilution series is a Human Male Raji cDNA sample of known total
concentration.

™

¢ Reactions are set up for 2-step RT-PCR. The Invitrogen VILO "~ Kit is used for
reverse transcription; the TagMan® Gene Expression Master Mix (2X) is used for
PCR.

* Select primer and probe sets from the Life Technologies TagMan® Gene
Expression Assays product line:

— For the target assay (HPRT), select assay ID Hs99999909_m1.
— For the endogenous control assay (FAS), select assay ID Hs00907759_m1.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 1
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About the example experiment
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Design the Experiment

This chapter explains how to design the example experiment from the Experiment

Setup menu.

This chapter covers:

Define the experiment properties. . .......... ... 13
Define targets, samples, and biological replicates. ......................... 14
Assign targets, samples, and biological groups...................... ..o 15
Setuptherunmethod ...... ... ... ... . 17
Tips for designing your own experiment................ ..., 18
For more information.......... ... . i 19

Note: To automatically export the analyzed data to a specified location, select the Auto
Export task from the Export screen, before running the experiment. For more
information on Auto Export, refer to Chapter 1 in Booklet 1, Getting Started with
QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments.

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the
QuantStudio™ 12K Flex Software. Enter:

Field or Selection

Entry

Experiment Name
Barcode

User Name

96-Well Relative Std Curve Example
Leave field empty

Example User

Comments

Relative Standard Curve example

Block

96-Well (0.2 mL)

Experiment Type

Relative Standard Curve

Reagents TagMan® Reagents
Ramp speed Standard
Save the experiment.
Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 13
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Chapter 2 Design the Experiment

Define targets, samples, and biological replicates

Your Experiment Properties screen should look like this:

How do you want to identify this experiment?

* Experiment Name: |96-Well Relative Std Curve Example Comments: |Relative Standard Curve example -~
Barcode:

User Name: |Example User b

Which bleck are you using to run the experiment?

( 384-Well ] | Array Card | [~ 96-Well (0.2m1) ] | Fast 96-Well (0.1mL) J

What type of experiment do you want to set up?

[ Standard Curve ] ‘ e Relative Standard Curve | [ Comparative CT (AACT) ] [ Melt Curve ]

[ Genotyping ] [ Presence/Absence ]

Which reagents do you want to use to detect the target sequence?

| s TagMan® Reagents | [ SYBR® Green Reagents ] [ Other ]

What properties do you want for the instrument run?

| s Standard | [ Fast ]

Define targets, samples, and biological replicates

Click Define to access the Define screen. Enter:

1. Targets
Target name Reporter Quencher Color

FAS FAM NFQ-MGB ]

HPRT FAM NFQ-MGB ]
2. Samples

Sample name Color

! O

10

100 B

1000 B

10000 [

Heart .

Kidney .

3. Dye to be used as a Passive Reference
ROX

4. Analysis Settings

14 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Chapter 2 Design the Experiment

Assign targets, samples, and biological groups

Field Select
Reference Sample Kidney
Endogenous Control FAS

Your Define screen should look like this:

Target Name Reporter Quencher Color Sample Name Color
" = -
FAS FAM ~ [NFQ-MGB ~ [l v
i} | w
HPRT FAM  INFQ-MGB A4 |. »
100 |. v
1000 |. v
10000 |. -
Heart |. ~
Kidney |. vl

New

Biological Replicate Groups Analysis Settings
Delete:

Biological Group Name Color Comments

Reference Sample: [Kidney v
Endogenous Control: |FAS v

Passive Reference

ROX -

Note: This example experiment does not define biological replicate groups. Leave
Biological Replicate Groups blank.

Assign targets, samples, and biological groups

Click Assign to access the Assign screen.

Note: To automatically set up and assign standards, click \ ey |
open the Define and Set Up Standards dialog box.

To assign the targets and samples:
1. Set up the standards.

2. For the first standard for the FAS target:
a. Click-drag to select wells A1-A3.
b. Check check box next to FAS in the Targets list.
c. Select S in the Task drop-down menu.
d. Enter 10,000 in the Quantity column.

e. Repeat steps a through c for each of the standards for the FAS target,
selecting the wells listed in the table below, and entering the corresponding
quantity.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 15
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Assign targets, samples, and biological groups

3. Repeat step 2 for each standard for the HPRT target.

Target Well number Task Quantity Sample
name name
FAS A12 Negative None None
B4 - B6 Unknown Determined by Kidney
run
B7 - B9 Unknown Determined by Heart
run
Al - A3 Standard 10,000 10,000
Ah - Ab Standard 1,000 1,000
A7 - A9 Standard 100 100
A10 - A12 Standard 10 10
B1- B3 Standard 1 1
HPRT D12 Negative None None
D4 - D6 Unknown | Determined by Kidney
run
D7 - D9 Unknown | Determined by Heart
run
C1-C3 Standard 10,000 10,000
C4 - Cé Standard 1,000 1,000
C7-C9 Standard 100 100
C10 - C12 Standard 10 10
D1 - D3 Standard 1 1
16 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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| ™. Define and Set Up Standards

Targets —m8m ——m——m—o—
Name

Chapter 2 Design the Experiment
Set up the run method

Your Assign screen should look like this:

B ——
Fas I~ |
C1HeRT
Samples —mm0 ————— [

1

10
100
1000
10000
Heart
Kidney

| |0 0000

Biological Groups ———— 7

welks: [ 12 [ 30 [ 2

52 Empty

Set up the run method

* Reaction Volume Per Well: 20 uL

e Thermal Profile

Click Run Method to access the Run Method screen. Set the thermal profile under the
Graphical View tab. Enter:

Stage Step Ramp rate | Temperature Time
Hold Stage Step 1 1.6°C/s 50°C 2 minutes
Step 2 1.6°C/s 95°C 10 minutes
PCR Stage Step 1 1.6°C/s 95°C 15 seconds
Number of Cycles: 40 Step 2 1.6°C/s 60°C 1 minute

Enable AutoDelta:
Unchecked (default)

Starting Cycle: Disabled
when Enable AutoDelta is
unchecked

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Tips for designing your own experiment

Your Run Method screen should look like this:

Run Method
Reaction Volume per Well: 20| HL
Sapnca v
Hold Stage PCR Stage
Number of Cycles:
Starting Cycle:
- E— =
i)
B L)
Stept Step? Stepl Step?
£ >
Legend
[ Data Collsction On ~ | Data Collection OFf A AutoDelta On A AutoDelta Off

Tips for designing your own experiment

Life Technologies recommends that you:
* Set up a standard curve for each target assay in the reaction plate.

¢ Identify each target assay with a unique name and color. You can enter up to 100
characters in the Target Name field.

¢ Identify each sample using a unique name and color. You can enter up to 100
characters in the Sample Name field.

* Select an endogenous control for each sample. The endogenous control is a target
that is present in all samples under investigation. It should be expressed equally
in all sample types, regardless of treatment or tissue origin (examples of
endogenous controls are B-actin, GAPDH, and 18S ribosomal RNA [185 rRNA]).
The endogenous control is used to normalize the PCR results; the endogenous
control corrects for variable sample mass, nucleic acid extraction efficiency,
reverse transcription efficiency, and pipette calibration errors.

Note: Each sample type (for example, each tissue in a study comparing multiple
tissues) requires an endogenous control.

¢ Enter at least five dilution points for each standard curve in the reaction plate.

* Enter at least three replicates (identical reactions) for each point in the standard
curve and for each sample reaction.

* Enter at least three negative control reactions for each target assay.

18 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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For more information

¢ Carefully consider the appropriate range of standard quantities for your assay
because the range of standard quantities affects the amplification efficiency
calculations:

— For more accurate measurements of amplification efficiency, use a broad
range of standard quantities, spanning between 5 and 6 logs. If you do so,
use a PCR product or a highly concentrated template, such as a cDNA clone.

— If you have a limited amount of cDNA template and/or if the target is a low-
copy number transcript, or known to fall within a given range, a narrow
range of standard quantities may be necessary.

* Minimally run a five-point curve of 1:10 dilutions to minimize the effects of small
pipetting errors.

* Select a reference sample from your previously defined samples. Amplification
results from the samples and from the reference sample are compared to
determine relative expression.

* Select an endogenous control from your previously defined target assays.
Amplification results from the endogenous control are used to normalize the
amplification results from the target for differences in the amount of template
added to each reaction.

For more information

For more information on... Refer to... Part number

Consumables Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050
System Multi-Well Plate and Array Card Experiments

Appendix A in Booklet 7, QuantStudio™ 12K Flex System Multi-Well
Plate and Array Card Experiments - Appendixes

Using other quantification Booklet 2, Running Standard Curve Experiments and Part 2 of Booklet 4470050

methods 3, Running Relative Standard Curve and Comparative Cy Experiments.

Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays Application 127AP05-03
Note

Using alternative setup Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050

System Multi-Well Plate and Array Card Experiments

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 19
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For more information

20 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
Experiments User Guide for Relative Standard Curve and Comparative Cy Experiments



Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Relative Standard
Curve example experiment.

This chapter covers:

Assemble required materials ........ ... 21
Preparethetemplate ........ ... ... . . 21
Prepare the sample dilutions ............... .. .. ... . o il 22
Prepare the standard dilution series for FAS and HPRT assays.............. 22
Prepare the reaction mix (“cocktail mix”)......................... 23
Prepare the reactionplate . ....... ... ... .. . 24
Tips for preparing reactions for your own experiments. . ................... 26
For more information. ............. ... i i 27

Assemble required materials

Items listed in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-
Well Plate and Array Card Experiments.

Samples - Total RNA isolated from kidney, heart, liver, and brain tissues.
Example experiment reaction mix components:

- TaqMan® Gene Expression Master Mix (2X)

— FAS Assay Mix (20X)

— HPRT Assay Mix (20X)

Prepare the template

Example
experiment
settings

To prepare the

Prepare the template for the PCR reactions (both samples and standards) using one of
the Invitrogen VILO™ kits, SuperScript® VILO™ cDNA Synthesis Kit (PN 4453650).

For the Relative Standard Curve example experiment, the template for the PCR
reactions is cDNA reverse-transcribed from total RNA samples using the Invitrogen
VILO™ Kits.

Use the Invitrogen VILO™ kits to reverse-transcribe cDNA from the total RNA

template samples. Follow the procedures in the Invitrogen VILO Kits Protocol (PN 100002284) to:
. Isolate total RNA from cells using an Ambion® sample preparation kit
appropriate to the tissue or cell type.
Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 21
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3 Chapter 3 Prepare the Reactions
Prepare the sample dilutions

2. Quantify and perform quality control on the RNA.

3. Convert the RNA to cDNA via reverse transcription.

Prepare the sample dilutions

For the Relative Standard Curve example experiment, no more than 10% of your

reaction should consist of the undiluted cDNA.

1.

Label a separate microcentrifuge tube for each diluted sample:
¢ Kidney
¢ Heart

Add the required volume of water (diluent) to each empty tube:

Tube Sample name Diluent volume (pL)
1 Kidney 76
2 Heart 76

Add the required volume of sample stock (100 ng/uL) to each empty tube:

Tube Sample name Diluent volume (pL)
1 Kidney 4
2 Heart 4

Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

Place the diluted samples on ice until you prepare the reaction plate.

Prepare the standard dilution series for FAS and HPRT assays

The same standard materials are used to prepare the exact same dilutions for both the
target genes. The prepared standards are then used to generate the two standard
curves.

¢ The stock concentration for cDNA is 100 ng/uL.

* The volumes calculated for both the FAS and HPRT assays are:

Standard Standard
name Dilution Source Diluent Total volume R
. Source concentration
(Labeled point volume (pL) | volume (pL) (uL)
(ng/uL)
tube)
Std. 1 1 Stock 20 20 40 100
Std. 2 2 Dilution 1 20 20 40 50
Std. 3 3 Dilution 20 20 40 25
Std. 4 4 Dilution 3 20 20 40 12.5

22
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Prepare the reaction mix (“cocktail mix”)

Standard Standard
name Dilution Source Diluent Total volume .
. Source concentration
(Labeled point volume (pL) = volume (pL) (pL)
(ng/pL)
tube)
Std. 5 5 Dilution 4 20 20 40 6.25

1. Label ten separate microcentrifuge tubes for each diluted standard:

e FAS (FAS Std. 1 - FAS Std. 5)
e HPRT (HPRT Std. 1 - HPRT Std. 5)

2. Prepare five standard dilutions each for FAS and HPRT:

Note: For dilution 1, first vortex the stock for 3 to 5 seconds, then centrifuge both

the Std. 1 tubes briefly before pipetting 10 uL stock into each Std. 1 tube.

3. For each subsequent dilution, add source to the standard:

a. Use a new pipette tip to add 10 pL of source to the FAS and HPRT tubes

containing the standard.

b. Vortex the tubes for 3 to 5 seconds, then centrifuge the tubes briefly.

4. Place the standards on ice until you prepare the reaction plate.

Prepare the reaction mix (“cocktail mix”)

1. Label an appropriately sized tube for each reaction mix:
¢ FAS Reaction Mix
¢ HPRT Reaction Mix

2. For the FAS assay, add the required volumes of each component to the FAS

Reaction Mix tube:

Note: Extra volume is already factored in for pipetting error

Component Volume [u_L] for 1 Volume (u_Ll for 30
reaction reactions
TaqMan® Gene Expression 10 300
Master Mix (2X)
FAS Assay Mix (20X) 1 30
Water 8 240
Total Reaction Mix Volume 19 570

3. For the HPRT assay, add the required volumes of each component to the HPRT

Reaction Mix tube:

Component Volume [u_L] for 1 Volume (u_Ll for 30
reaction reactions
TagMan® Gene Expression 10 300

Master Mix (2X.)

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Prepare the reaction plate

Component Volur:\eea([:tlilalnfor 1 Volurrnecziptlitlnf:r 30
HPRT Assay Mix (20X 1 30
Water 8 240
Total Reaction Mix Volume 19 570

4. Mix the reaction in each tube by gently pipetting up and down, then cap each
tube.

5. Centrifuge the tubes briefly to remove air bubbles.

6. Place the reaction mixes on ice until you prepare the reaction plate.

Note: Do not add the sample or standard at this time.

Prepare the reaction plate

Example The reaction plate for the Relative Standard Curve example experiment contains:
experiment e A MicroAmp® Optical 96-Well Reaction Plate
reaction plate * Reaction volume: 20 pL/well

components e 12 Unknown wells

e 30 Standard wells E
¢ 2 Negative Control wells N
¢ 52 Empty wells

The plate layout for the example experiment looks like this:

R oA

bt

wels: [ 12 E30 [ 2 52 Empty

24 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Prepare the reaction plate

To prepare the 1. For each target, prepare the negative control reactions:
reaction plate a. To an appropriately sized tube, add the volumes of reaction mix and water
components listed below.
. . Reaction mix Water volume
Tube Reaction mix
volume (pL) (uL)
1 FAS Reaction Mix 19 1
2 HPRT Reaction Mix 19 1

b. Mix the reaction by gently pipetting up and down, then cap the tube.
c. Centrifuge the tube briefly to remove air bubbles.

d. Add 20 pL of the negative control reaction to the appropriate wells in the
reaction plate.

2. For each replicate group, prepare the standard reactions:

a. To appropriately sized tubes, add the volumes of reaction mix and standard
listed below.

Standard Reaction Standard
Tube . Reaction mix | mixvoulme Standard volume
rection
(uL) (uL)

1 FAS Std. 1 FAS Reaction 76 FAS Std. 1 4
Mix

2 FAS Std. 2 FAS Reaction 76 FAS Std. 2 4
Mix

3 FAS Std. 3 FAS Reaction 76 FAS Std. 3 4
Mix

4 FAS Std. 4 FAS Reaction 76 FAS Std. 4 4
Mix

5 FAS Std. b FAS Reaction 76 FAS Std. 5 4
Mix

6 HPRT Std. 1 | HPRT 76 HPRT Std. 1 4
Reaction Mix

7 HPRT Std. 2 | HPRT 76 HPRT Std. 2 4
Reaction Mix

8 HPRT Std. 3 | HPRT 76 HPRT Std. 3 4
Reaction Mix

9 HPRT Std. 4 | HPRT 76 HPRT Std. 4 4
Reaction Mix

10 HPRT Std. 5 | HPRT 76 HPRT Std. b 4
Reaction Mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.
c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 20 pL of the standard reaction to the appropriate wells in the reaction
plate.
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Tips for preparing reactions for your own experiments

3. For each replicate group, prepare the reactions for the unknowns:

a. To appropriately sized tubes, add the volumes of reaction mix and sample
listed below:

Reaction Sample
Unknown . . -
Tube . Reaction mix | mixvolume & Sample volume
reaction
(uL) (pL)
1 FAS Kidney FAS Reaction 76 Kidney 4
Mix
2 FAS Heart FAS Reaction 76 Heart 4
Mix
3 HPRT HPRT 76 Kidney 4
Kidney Reaction Mix
4 HPRT Heart | HPRT 76 Heart 4
Reaction Mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.
c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 20 pL of the unknown (sample) reaction to the appropriate wells in the
reaction plate.

4. Seal the reaction plate with optical adhesive film.
5. Centrifuge the reaction plate briefly to remove air bubbles.

6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of
time.

7. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

Tips for preparing reactions for your own experiments

Tips for preparing
templates

Tips for preparing
sample dilutions

Tips for preparing
the reaction mix

26

When you prepare your own Relative Standard Curve experiment, Life Technologies
recommends the following templates:

¢ Complementary DNA (cDNA) - cDNA reverse-transcribed from total RNA
samples.

¢ Genomic DNA (gDNA) - Purified gDNA already extracted from tissue or
sample

When you prepare your own Relative Standard Curve experiment, for optimal
performance of TagMan® Gene Expression Assays or Custom TagMan® Gene
Expression Assays, use 10 to 100 ng of cDNA template per 10uL reaction.

If your experiment includes more than one target assay, prepare the reaction mix for
each target assay separately.
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For more information

Tips for preparing When you prepare your own Relative Standard Curve experiment, make sure the
the reaction plate arrangement of the PCR reactions matches the plate layout displayed in the
QuantStudio™ 12K Flex Software.

For more information

For more information on... Refer to... Part number

Assigning the reaction plate Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K 4470050

components Flex System Multi-Well Plate and Array Card Experiments

Sealing the reaction plate Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K 4470050
Flex System Multi-Well Plate and Array Card Experiments
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For more information
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Start the run

Run the Experiment

This chapter explains how to run the example experiment on the QuantStudio™ 12K
Flex Instrument.

This chapter covers:
Start the FUN. . . ..o 29
Monitor the run. . . ... .. 29

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the QuantStudio™ 12K Flex Instrument is in operation.

1. Open the Relative Standard Curve example file that you created using
instructions in Chapter 2.

2. Load the reaction plate into the instrument.

3. Start the run.

Monitor the run

From the
Instrument
Console of the
QuantStudio™ 12K
Flex Software

Monitor the example experiment run:

¢ From the QuantStudio™ 12K Flex Software using the Run screen, while the
experiment is in progress.

¢ From the Instrument Console of the QuantStudio™ 12K Flex Software (to monitor
an experiment started from another computer or from the QuantStudio™ 12K
Flex Instrument touchscreen).

e From the QuantStudio™ 12K Flex Instrument touchscreen.

1. In the Instrument Console screen, select the instrument icon.
Click Manage Instrument or double-click on the instrument icon.

3. In the Manage Instrument screen, click Monitor Running Experiment to access
the Run screen.
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Monitor the run

Amplification Plot <
>

View the Amplification Plot

You can view the progress of the run in real time. During the run, periodically view all
the three plots available from the QuantStudio™ 12K Flex Software for potential
problems.

To view data in the Amplification Plot screen, click Amplification Plot from the Run
Experiment Menu, and select the Plate Layout tab, then select the wells that you want
to view.

The figure below shows the Amplification Plot screen as it appears at the end of the
example experiment.

Y Y T

Amplification Plot
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EDE‘E‘E‘ a

Legena
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Temperature

View the Temperature Plot

To view data in the Temperature Plot screen, click Temperature Plot from the Run
Experiment Menu.

The figure below shows the Temperature Plot screen as it appears during the example
experiment.

Temperature Plot Current Temperatures

= Y wn —, .Cuver

PP B E|Y

ol |_ = M sample
Block

Temperature Plot

Temperature Plot

00:37:30 00:41:40 00:4550 00:50:00 00:54:10 00:58:20 01:02:30 01:06:40 01:10:50 01:15:00 01:19:10 01:23:20 01:27:30 01:31:40

" Views 1 Hour v
Time
Fixed View []
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Monitor the run

Note: The Sample temperature displayed in the Current Temperatures group is an

estimated value.

View the Run Method

To view data in the Run Method screen, click Run Method from the Run Experiment

Menu.

The figure below shows the Run Method screen as it appears in the example

experiment.

Run Method Edit Run Method

Hold Stage PCR Stage
Number of Cycles:
Starting Cycle:

100 °C_|
75 °C_| .
50 °C_| -

I
26 °C_|

0
Stept Step2 Step1 Step2

<

[ Legend

Data Collection On |* »| Data Collection Off A AutoDelta On A AutoDelta Off

Run Data Report

Experiment Mame:
Start Time:

Stop Time:

Run Duration:

User Name:
Instrument Name:
Firmware Version:
Software Version:
Instrument Serial Number:
Sample Volume:
Cover Temperature:

Block Type:

View run data

To view the run data, click View Run Data from the Run Experiment Menu.

Your View Run Data screen should look like this:

96-Well Relative Std Curve Example
08-09-2011 09:30:33 5GT
08-09-2011 11:05:14 56T

94 minutes 40 seconds

DEFAULT

QuantStudioDemo

0.13.1

QuantStudio 12K Flex Software v1.0
QuantStudioDemo

20.0

105.0

96-well Block (0.2mL)

Errors Encountered:
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Chapter 4 Run the Experiment

Monitor the run

From the You can also view the progress of the run from the touchscreen of the QuantStudio™
QuantStudio™ 12K 12K Flex Instrument.

Flex Instrument The Run Method screen on the QuantStudio™ 12K Flex Instrument touchscreen
touchscreen looks like this:

Experiment view

®© Time View Plot View W]  Experiment View
Run Started: December 08 2011 - 12:05AM Sample: 95.0 °C
Reaction Volume: 20 pL Heated Cover (Set Point): 105.0 °C (105.0 °C)
Time Remaining: 01:27:04
2
Stage 1 Stage 2
10f1 X 40
95.0 °C 95.0 °C

7:14 0:15
50.0 °C / \__60.0 °C
- 1:00
2:00 e

December 08 2011 - 12:05AM 0

Heated cover reached target temperature.

Note: The above screenshot is for visual representation only. Actual results will vary
with the experiment.

Time view
© Time View Plot View if] Experiment View
Run Started: December 08 2011 - 12:05AM Sample: 59.5 °C
Reaction Volume: 20 pL Heated Cover (Set Pointl: 105.0 °C [105.0 °C)

Stage / Step /Cycle: 2/2/5

01:11:22

@ Remaining Time . Elapsed Time

December 08 2011 - 12:06AM o

Error occurred during run. Details: Holdtime 60 s exceeded. Actual Holdtim...
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Chapter 4 Run the Experiment
Monitor the run

Plot view
[ Experiment View I ®© Time View Plot View
Fast 96-Well Tagman ¥V ARn W

December 08 2011 - 12:07AM o

Heated cover reached target temperature.
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Chapter 4 Run the Experiment
Monitor the run
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Review Results and Adjust
Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis
screens and publish the data. Section 5.2 of this chapter walks you through the process
of modifying experiment parameters to troubleshoot problems with experiment

results before rerunning an experiment.

This chapter covers:

Section 5.1 Review Results ........ ..., 37
Analyze the example experiment. .............. ... 37
View the Standard Curve Plot ........ ... .. .. i 37
Assess amplification results using the Amplification Plot................... 39
Assess the gene expression profile using the Gene Expression Plot. .......... 46
Identify well problems using the Well Table .............................. 48
Confirm accurate dye signal using the Multicomponent Plot................ 50
Determine signal accuracy using the Raw DataPlot ....................... 51
View the endogenous control profile using the QCPlot .................... 53
Review the QC flags in the QC Summary ............ ... ..., 54
For more information. ........... ... ... i i 55

Section 5.2 Adjust parameters for re-analysis of your own experiments ........ 57
Adjust analysis settings........... ... . i 57
Improve Cy precision by omitting wells.......................... ... ... 61
For more information. . ........ ... ... 62
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Chapter 5 Review Results and Adjust Experiment Parameters

36 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
Experiments User Guide for Relative Standard Curve and Comparative Cy Experiments



Section 5.1 Review Results 5
Analyze the example experiment

Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.

2. Click Analyze. The software analyzes the data using the default analysis settings.

You can also access the experiment to analyze from the Home screen.

View the Standard Curve Plot

Example
experiment
standard curve
values

To view and assess
the Standard Curve
plot

The Standard Curve Plot screen displays the standard curve for samples designated as
standards. The QuantStudio™ 12K Flex Software calculates the quantity of an
unknown target from the standard curve.

In the standard curve example experiment, you review the Standard Curve Plot screen
for the following regression coefficient values:

¢ Slope/amplification efficiency
e R2value (correlation coefficient)

e Cypvalues

1. From the Experiment Menu pane, select Analysis » Standard Curve.

Note: If no data are displayed, click Analyze.

2. Display all 96 wells in the Standard Curve Plot screen by clicking the upper left
corner of the plate layout in the Plate Layout tab.

3. Enter the Plot Settings:

Menu Selection
Target All
Plot Color Default
F Check (default)

(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)

4. View the values displayed below the standard curve. In the example experiment,
the values for each target fall within the acceptable ranges:

Amplification
2
Target Slope R® Value efficiency (Eff%)
FAS -3.38 0.998 97.612
HPRT -3.652 0.983 87.858
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5 Chapter 5 Review Results and Adjust Experiment Parameters
View the Standard Curve Plot

5. Check that all samples are within the standard curve. In the example experiment,
all samples (blue dots) are within the standard curve (red dots).

Standard Curve <

Plot Settings
Target |AII V| Plot Color ‘Default v|
[[] Save current settings as the default
£ P iy
Standard Curve
275
25.0
325
z0.0
—
L&)
275
25.0
225
z0.0
a1 az 1 z 3 a s 10 zo a0 100 =200 1000 10000 100000
Quantity
Target: All
Leged
. Standard . Unknown . Unknown (Flagged)
Well Summary: In Plat=: 96 Set Up: 44 Anatyzed: 42 Flzgged: 0 Omitted by Anatysis: 0 Omitted Manually: 2 Samples Used: 7 Targsts Used: 2

. Check the Cy values:
Click the Well Table tab.

6
7
8. From the Group By drop-down menu, select Replicate.
9

. Look at the values in the Cp column. In the example experiment, the C values fall
within the expected range (>8 and <35).

Expand Al @ Collapse Al

# Well | Omit | Flag || Sample N... | Target Na... | Task Dyes CcT CT Mean  Ct SD Quantity | Mormali... | Moermali... Efficiency Slope RQ RQ !
B 1-FAS - STANDARD A
14 B2 1 FAS STANDARD  FAM-NFQ-MGB | |
Bl 1-FAS - STANDARD - 1.0
13 Bl ] 1 Fas STANDARD ~ FAM-NFQ-MGB [Undetermi. 1.000 85.379 -3.730
15 B3 0 1 FAS STANDARD  FAM-NFQ-MGB |undetermi. 1.000 85.379 -3.730
B 1 - HPRT - STANDARD - 1.0
37 D1 ] 1 STANDARD  FAM-NFQ-MGB 1.000 86.318 -3.700
38 D2 | 1 STANDARD  FAM-NFQ-MGB 1.000 86.318 -3.700 -
39 D3 | HPRT STANDARD  FAM-NFQ-MGB 1.000 86.318 -3.700
B 10 - FAS - STANDARD
12 A2 10 Fas STANDARD  FAM-NFQ-MGB | |
El 10 - FAS - STANDARD - 10.0
10 A0 O 10 FAS STANDARD ~ FAM-NFQ-MGB [37.109 37.207 0.138 10.000 85.379 -3.730
11 A1l il 10 FAS STANDARD  FAM-NFQ-MGB |37.305 0.138 10.000 85.379 -3.730
B 10 - HPRT - STANDARD - 10.0
34 Clo ] 10 HPRT STANDARD  FAM-NFQ-MGB [30.982 30.790 0.167 10.000 86.318 -3.700
35 it | 10 HPRT STANDARD  FAM-NFQ-MGB |30.706 30.790 0.167 10.000 86.318 -3.700
36 €12 0 10 HPRT STANDARD  FAM-NFQ-MGB |30.683 0.167 10.000 86.318 -3.700
Bl 100 - FAS - STANDARD - 100.0
7 A7 ] 100 Fas STANDARD ~ FAM-NFQ-MGB [33.287 0160 100.000 85.379 -3.730
8 A8 O 100 FAS STANDARD ~ FAM-NFQ-MGB |32.197 33.154 0160 100.000 85.379 -3.730
9 A0 il 100 FAS STANDARD  FAM-NFQ-MGB |32.976 33.154 0160 100.000 85.379 -3.730
E 100 - HPRT - STANDARD - 100.0
£ ] 100 HPRT STANDARD  FAM-NFQ-MGB [27.654 37.503 0.083  100.000 86.318 -3.700
32 8 | 100 HPRT STANDARD — FAM-NFQ-MGB |27.625 27.503 0.083  100.000 86.318 -3.700
13 9 0 100 HPRT STANDARD  FAM-NFQ-MGB |27.498 27.583 0.083 100000 86.318 -3.700
B 1000 - FAS - STANDARD - 1000.0
4 a4 ] 1000 Fas STANDARD  FAM-NFQ-MGB 29.296 0.093  1,000.000 85.379 -3.730 2
- - e e | o N Bt | o L,
Well Summary: In Plat=: 96 Set Up: 44 Anatyzed: 42 Flzgged: 0 Omitted by Anatysis: 0 Omitted Manually: 2 Samples Used: 7 Targsts Used: 2
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Section 5.1 Review Results 5
Assess amplification results using the Amplification Plot

Tips for analyzing When you analyze your own Relative Standard Curve experiment, look for:

your own * Slope/amplification efficiency values — The amplification efficiency is calculated
experiments using the slope of the regression line in the standard curve. A slope close to — 3.3
indicates optimal, 100% PCR amplification efficiency. Factors that affect
amplification efficiency:
— Range of standard quantities — For more accurate and precise efficiency
measurements, use a broad range of standard quantities, 5 to 6 logs
(10° to 100 fold).
— Number of standard replicates — For more accurate efficiency measurements,
include replicates to decrease the effects of pipetting inaccuracies.

— PCRinhibitors — PCR inhibitors in the reaction can alter amplification
efficiency.

* R2values (correlation coefficient) — The R? value is a measure of the closeness of
fit between the regression line and the individual Ct data points of the standard
reactions. A value of 1.00 indicates a perfect fit between the regression line and
the data points. An R? value >0.99 is desirable.

* Cy values — The threshold cycle (Cr) is the PCR cycle number at which the
fluorescence level meets the threshold.

— A Cgvalue >8 and <35 is desirable.

— A Cpvalue <8 indicates that there is too much template in the reaction.

— A Cyvalue >35 indicates a low amount of target in the reaction; for C values
>35, expect a higher standard deviation.

If your experiment does not meet the guidelines above, troubleshoot as follows:

*  Omit wells (see “Improve Cy precision by omitting wells” on page 61).
Or

¢ Rerun the experiment.

Assess amplification results using the Amplification Plot

Amplification pl_ots The Amplification Plot screen displays amplification of all samples in the selected
available for wells. There are three plots available:

viewing * ARnvs Cycle - ARn is the magnitude of normalized fluorescence signal generated
by the reporter at each cycle during the PCR amplification. This plot displays ARn
as a function of cycle number. Use this plot to identify and examine irregular
amplification and to view threshold and baseline values for the run.

* Rnvs Cycle — Rn is the fluorescence signal from the reporter dye normalized to
the fluorescence signal from the passive reference. This plot displays Rn as a
function of cycle number. Use this plot to identify and examine irregular
amplification.

* Cyvs Well — Cyis the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Cr as a function of well
position. Use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

Purpose The purpose of viewing the amplification plot for the example experiment is to
identify:
¢ Correct baseline and threshold values
¢ OQutliers
View the 1. From the Experiment Menu pane, select Analysis » Amplification Plot.
Amplification Plot Note: If no data are displayed, click Analyze.

2. Display the FAS wells in the Amplification Plot screen:

a. Click the Plate Layout tab.

b. From the Select Wells drop-down menu, select Target, then FAS.

The Plate Layout screen should look like this:

b Fla 3 Well Table

Vitvells W Select wrells W View Legend

LW ]

=

10 11

12

1 2 3 4 9 [ 7 = 9
10000 10000 10000 100 100 100
| o —— . e S [ e .
1 B 2 1 Kidney Kidney Kidney
S —— e e e e e

10 0 g
OO e

—

10000 10000 10000 100 100 100 10 10 10
< ___I*I*I*I_I_E_E_I—_

1 1 1 Kidney Kidney Kidney
E
F
]
H
;’e\ls: [M12E30 02 52 Empty
Well Summary: In Plate: 96 Set Up: 44 Analyzed: 42 Flagged: 01 Omitted by Anahysis: 0 Omitted Manually: 2 Samples Used: 7 Targets Used: 2
3. In the Amplification Plot screen, enter:
Menu Selection
Plot Type ARn vs Cycle (default)
Plot Color Well (default)

(This is a toggle button. When the legend
is displayed, the button changes to Hide

the plot legend.)

Check (default)

4. View the baseline values:

a. From the Graph Type drop-down menu, select Linear.

b. Select the Baseline check box to show the start cycle and end cycle.
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Section 5.1 Review Results 5
Assess amplification results using the Amplification Plot

c. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescent signal is
detected. In the example experiment, the baseline is set correctly.

Amplification Plot <

Plot Settings

Plot Type:|ARn vs Cycle || Graph Type:|Linear |v| Plot Color:|Well w

[] Save current settings as the default

Amplification Plot

ARn
w
[=]

e

IS B c D ME NF Hc HH

Options

Target: |All + | Threshold:

Show: [] Threshold — [¥] Baseline Start: Well B Target -~ Baseline End: Well (M Target 4
~

Well Summary: In Plst=: 96 Set Up: 44 Anzhyzed: 42 Flzgged: [ Omitted by Anafysis: I Omitted Manually: 2 Samples Used: 7 Targets Used: 2

5. View the threshold values:

Menu Select

Graph Type Log
Target FAS

a. Select the Threshold check box to show the threshold.
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

b. Verify that the threshold is set correctly. In the example experiment, the
threshold is in the exponential phase.

Amplification Plot
Plot Settings
Plot Type:|ARn vs Cycle w| Graph Type:|Log | Plot Color:|/Wwell v

[[] Save current settings as the default

Amplification Plot

0.544107

01

=
o
=

0.01

0.001

B C D ME HF Hc HH

Options

Target: [FAS v | Threshold: [#] Auto

Show: [¥] Thrashold — [[] Baseline Start: Well M Target 4. Baseline End: Well (M Target 4=
v

Well Summary: In Plate: 96 Set Up: 44
6. Locate outliers:
a. From the Plot Type drop-down menu, select Ct vs Well.

b. Look for outliers from the amplification plot. In the example experiment,
there are no outliers for FAS.

Amplification Plot {

Anshyzed: 42 Fiageed: 0 Ortted by Ansiysis: Oritted Manushy: 2 Samples Ussd: 7 Targsts Used: 2

Plot Settings
Plot Type:|CT ws Well + | Graph Type: Plot Color: |Well ~
[] Save current settings as the default
P P & ~ =
Amplification Plot
1E02
’-v_QA.-4
1E01
& 1EO00
0.1
0.01
s 10 15 20 25 30 as a0 a5 50 55 £ 85 7o 7s 80 as 80 a5
Well Number
Lege
A s C D Wc:c HWF Hc MH
Options
Target: [FAS s | Threshold: y
Show: =[] Baseline Start: Wel M Target .« Baseline End: Well (W Target .
v
Well Summary: In Plate: 96 Set Up: 44 Anahyzed: 42 Flagged: 0 Omitted by Analysis: Omitted Manually: 2 Samples Used: 7 Targets Used: 2
7. Repeat steps 2 through 6 for the HPRT wells.
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Section 5.1 Review Results 5
Assess amplification results using the Amplification Plot

Tips for analyzing When you analyze your own Relative Standard Curve experiment, look for:

your own e Qutliers

experiments * A typical amplification plot — The QuantStudio™ 12K Flex Software

automatically calculates baseline and threshold values based on the assumption
that the data exhibit a typical amplification plot. A typical amplification plot has
four distinct sections:

Plateau phase
— Linear phase

Exponential (geometric phase)

Baseline
A typical amplification plot should look like this:

Amplification Plot <
Plot Settings
Plot Type:[ARn vs Cycle [v| Graph Type:[Log [~ Plot Color:[well ~
[[] Sawe current settings as the default

Amplification Plot

PR Y

03544107

0185352

0.01

e, 1

AL\

B a e = 1o iz 1

0.001

a0

-
’V-A B WEC BND BNE BNF ENG EEH

Options

Target: |All * | Threshold:

Show: [] Threshold — [] Baseline Start: Well B Target 4~ Baseline End: Well (Ml Target <~

well Summary: In Piste: 06 ot Up: 44 Anshzad: 42 Fiagged: 0 Omittad by Anslys: 0 Onmittad Manusliy: 2 Sampies Usad: 7 Targsts Usad: 2

IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the QuantStudio™ 12K Flex Software. Therefore,
Life Technologies recommends that you examine the Amplification Plot screen
and review the assigned baseline and threshold values for each well after analysis
completes.
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Chapter 5 Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

Note: If you use the Relative Threshold algorithm to analyze an experiment that
includes amplification, select to view the analysis results using the ARn vs Cycle,
Rn vs Cycle, or Ciy vs Well plot type and Linear or Log graph type. Also select

the Show Crt check box to view the derived fractional cycle on the amplification

44

plot.

Amplification Plot
Plot Settings

Plot Type:[ARn vs Cycle w| Graph Type:llog %] Piot Color:|well

v

[ Save current settings as the default

0.1

ARn

Amplification Plot

0.001

Leges

A B C D ME HF Hc HH

Options

Target: Threshold:

Show: =

I

Well M Target 4 Baseline End: Well

Show Crt

B Target 4

‘Well Summary: In Plste: 96 Set Up: 44 Anahyzed: 42

¢ Correct threshold values.

Flagged: 2 Omitied by Analysis: [ Omitted Manually: 2 Samples Used: 7 Targsts Used: 2

Threshold Set Correctly o

The threshold is set in the
exponential phase of the
amplification curve.

0.1

ARN

Threshold settings above
or below the optimum
increase the standard
deviation of the replicate
groups.

' 544107

0.001
2

Threshold Set Too Low o

The threshold is set below
the exponential phase of
the amplification curve.
The standard deviation is
significantly higher than
that for a plot where the
threshold is set correctly.
Drag the threshold bar up
into the exponential phase
of the curve.

0.001

0.097909
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Section 5.1 Review Results 5
Assess amplification results using the Amplification Plot

Threshold Set Too High

The threshold is set above
the exponential phase of
the amplification curve.
The standard deviation is
significantly higher than
that for a plot where the
threshold is set correctly.
Drag the threshold bar
down into the exponential
phase of the curve.

5.837618

0001

e Correct baseline values

Baseline Set Correctly

The amplification curve
begins after the maximum
baseline.

0.001

Baseline Set Too Low

The amplification curve
begins too far to the right
of the maximum baseline.
Increase the End Cycle
value.

Baseline Set Too High

The amplification curve
begins before the
maximum baseline.
Decrease the End Cycle
value.

0001

0.001
P

If your experiment does not meet the guidelines above, troubleshoot as follows:

* Omit wells (see “Improve Cy precision by omitting wells” on page 61).

Or
* Manually adjust the baseline and/or threshold (see “Adjust analysis settings” on
page 57).
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Assess the gene expression profile using the Gene Expression Plot

Assess the gene expression profile using the Gene Expression
Plot

The Gene Expression Plot screen displays the results of relative quantification
calculations in the gene expression profile. There are two plots available:

¢ RQ vs Target — Groups the relative quantification (RQ) values by target. Each
sample is plotted for each target. You can view the plot as the linear, log10, Ln,
and log?2 graph types. The Gene Expression plot when viewed as a linear graph
type looks like this:

Gene Expression
Plot Settings

Plot Type: RQ vs Target «|Graph Type: Linear + |Orientation: Vertical Bars £

[1 5ave current settings as the default

RQ vs Target

0.998

RQ
o
m
o

HPRT

Target
.-E;l:eart W vidney
‘Well Summary: In Plate: 96 Set Up: 44 Anahyzed: 42 Flagged: 0 Omitted by Anahysis: Omitted Manualhy: 2 Samples Used: 7 Targets Used: 2
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Gene Expression

Section 5.1 Review Results

Assess the gene expression profile using the Gene Expression Plot

RQ vs Sample — Groups the relative quantification (RQ) values by sample. Each
target is plotted for each sample. You can view the plot as the linear, log10, Ln,
and log2 graph types. The Gene Expression plot when viewed as a linear graph
type looks like this:

Plot Settings

[] Save current settings as the default

Plot Type:|RQ vs Sample |+ Graph Type: Linear  |Orientation: |Vertical Bars w

"
o
17
&
is
|’
|

RQ vs Sample

g
0.6
0.5
0.4
0.3
0.2
0.1
oo 4 e T
Sample
.“-;H.-PRT
Well Summary: In Plste: 96 Set Up: 44 Anzhyzed: 42 Flzgged: 0 Omitted by Anahysis: 0 Omitted Manually: 2 Samples Used: 7 Targats Uszd: 2
Exampl_e Review each target in the Gene Expression Plot screen for the expression level (or fold

experiment values

View the Gene
Expression Plot

change) of the target sample relative to the reference sample.

From the Experiment Menu pane, select Analysis » Gene Expression.

Note: If no data are displayed, click Analyze.

In the Gene Expression Plot screen:
a. From the Plot Type drop-down menu, select RQ vs Sample.
b. From the Graph Type drop-down menu, select Log10.

c. From the Orientation drop-down menu, select Vertical Bars.

Click Ij Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 47
Experiments User Guide for Relative Standard Curve and Comparative Cr Experiments



5 Chapter 5 Review Results and Adjust Experiment Parameters
Identify well problems using the Well Table

In the example experiment, the expression level of HPRT in heart is displayed relative
to its expression level in the reference sample (kidney). Since the reference sample is
compared to itself, the relative expression level is 1. When the result is displayed in the
Log10 graph type, the expression level of the reference sample appears as 0 in the
graph (log10 of 1=0).

Gene Expression

Plot Settings
Plot Type:|RQ vs Sample | Graph Type:|Logl0 v | Orientation: Vertical Bars v
[] Save current settings as the default
PP BB E e s
RQ vs Sample
0.08
0.07
0.08
0.05
0.04
0.03
0.02
o 001
= 0
%» 000 -0.001
= .00
-0.02
-0.03
-0.04
-0.05
-0.06
-0.07
-0.08
= =
Sample
Leged
Il HPRT
‘Well Summary: In Plate: 06 Set Up: 44 Anahyzed: 42 Flagged: 0 Omitted by Anabysis: 0 Omitted Manually: 2 Samples Used: 7 Targets Used: 2

Assessing the gene  When you analyze your own Relative Standard Curve experiment, look for differences
expression plot in in gene expression (as a fold change) relative to the reference sample.

your own
experiments

Identify well problems using the Well Table

The Well Table displays data for each well in the reaction plate, including:
® The sample name, target name, task, and dyes

* The calculated threshold cycle (Ct), normalized fluorescence (Rn), and quantity

values
e Flags
Example Review the Well Table to evaluate the C precision of the replicate groups.
experiment values
and flags
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Section 5.1 Review Results 5
Identify well problems using the Well Table

View the well table 1. From the Experiment Menu pane, select Analysis » Amplification Plot, then click
the Well Table tab.

2. From the Group By drop-down menu, select Replicate.

3. Look at the Cp SD column to evaluate the Ct precision of the replicate groups. In
the example experiment, the Cp SD have the expected value of <0.5.

Plate Layout

Evpand Al

Well | Omit | Flag | Sample M... | Target Na... Task CT CT Mean ||CT SD Quantity | Normali... = Normali... | Efficiency | Slope
= 1 - FAS - STANDARD
14 B2 1 STANDARD  FAM-NFQ-MGB | ]
= 1 - FAS - STANDARD - 1.0
13 B1 O 1 FAS STANDARD ~ FAM-NFQ-MGB Undetermi.. 1.000 85.379 -3.730
15 B3 | 1 STANDARD  FAM-NFQ-MGB Undetermi.. 85.379 -3.730
= 1 - HPRT - STANDARD - 1.0
37 D1 ] 1 STANDARD ~ FAM-NFQ-MGB 34.390 34.475 0.211 86.318 -3.700
38 D2 | 1 HPRT STANDARD ~ FAM-NFQ-MGB 34.319 34475 0.211 1.000 86.318 -3.700 =
39 D3 | 1 STANDARD  FAM-NFQ-MGB 34.715 34.475 0.211 86.318 -3.700
= 10 - FAS - STANDARD
12 AL2 10 STANDARD  FAM-NFQ-MGB | ]
B 10 - FAS - STANDARD - 10.0
10 ALD O 10 STANDARD  FAM-NFQ-MGB 37.109 37.207 0.138 10.000 85.379 -3.730
11 AlL | 10 STANDARD  FAM-NFQ-MGB 37.305 37.207 0.138 10.000 85.379 -3.730
= 10 - HPRT - STANDARD - 10.0
34 Co O 10 HPRT STANDARD ~ FAM-NFQ-MGB 30.982 30.790 0.167 10.000 86.318 -3.700
35 C11 | 10 HPRT STANDARD ~ FAM-NFQ-MGB 30.706 30.750 0.167 10.000 86.318 -3.700
36 C12 | 10 STANDARD  FAM-NFQ-MGB 30.683 30.790 ! 10.000 86.318 -3.700
= 100 - FAS - STANDARD - 100.0
7 A7 ] 100 FAS STANDARD ~ FAM-NFQ-MGB 33.287 33.154 100.000 85.379 -3.730
8 A8 | 100 FAS STANDARD ~ FAM-NFQ-MGB 33.197 33.154 0.160(  100.000 85.379 -3.730
9 A9 | 100 FAS STANDARD  FAM-NFQ-MGB 32.976 33.154 L 100.000 85.379 -3.730
= 100 - HPRT - STANDARD - 100.0
31 ] 100 HPRT STANDARD ~ FAM-NFQ-MGB 27.654 27.593 0.083[  100.000 86.318 -3.700
32 8 | 100 HPRT STANDARD ~ FAM-NFQ-MGB 27.625 27.593 0.083[  100.000 86.318 -3.700
3 | 100 HPRT STANDARD  FAM-NFQ-MGB 27.498 27.593 0.083[  100.000 86.318 -3.700
5 1000 - FAS - STANDARD - 1000.0
4 A4 ] 1000 FAS STANDARD ~ FAM-NFQ-MGB 29.403 29.296 0.093( 1,000.000 85.379 -3.730 3
— L — PR s i PN | oo | . m
Well Summary: In Piste: 96 Set Up: 44 Analyzed: 42 Fiagged: Omitted by Ansysis: ) Oritted Manusly: 2 Samples Used: 7 Targets Used: 2

Note: To show or hide columns in the Well Table, select or deselect respectively the
column name from the Show in Table drop-down menu.

Assessing the well ~ When you analyze your own Relative Standard Curve experiment, look for standard
table in your own deviation in the replicate groups (Cy SD values). If needed, omit outliers (“Improve Cy

experiments precision by omitting wells” on page 61).
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Confirm accurate dye signal using the Multicomponent Plot

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.

Pu rpose In the Relative Standard Curve example experiment, you review the Multicomponent
Plot screen for:

View the 1.

Multicomponent
Plot

Multicomponent Plot
Plot Settings

ROX™ dye (passive reference)
FAM™ dye (reporter for RNase P)
Spikes, dips, and/or sudden changes

Amplification in the negative control wells

From the Experiment Menu pane, select Analysis » Multicomponent Plot.
Note: If no data are displayed, click Analyze.
Display the unknown and standard wells one at a time in the Multicomponent
Plot screen:

a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

From the Plot Color drop-down menu, select Dye.

Click Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Check the FAM dye signal. In the example experiment, the FAM dye signal
increases throughout the PCR process, indicating normal amplification.

Plot Color [Dye -

[] save current settings as the default

B =

z 3 4 5 6 7 8 9 10 11 12

130,000,000
120,000,000
110,000,000
100,000,000
20,000,000
80,000,000
70,000,000

50,000,000

Flugrescence

50,000,000
40,000,000
30,000,000
20,000,000
10,000,000

o

IS i By = 1 ) mg_
AL a R ﬁﬂﬂﬁﬁﬁﬁﬁrﬁmag‘“

Multicomponent Plot

=

=]

dg o HEE S
FFEERRBRS S ST
bd O O F &F &F @ &F O a

@

=

-;I;AM I rROX .
wele: [ 12 530 [ 2 52 Empty
Well Summary: In Plsts: 06 St Up: 44 Anshyzed: 42 Flsgged: 0 Omitted by Anslysis: (I Omitted Manually: 2 Samples Used: 7 Targets Used: 2
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Section 5.1 Review Results 5
Determine signal accuracy using the Raw Data Plot

6. Check the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the PCR process indicating typical data.

7. Select the negative control wells one at time and check for amplification. In the
example experiment, there is no amplification in any of the negative control wells.

Multicomponent Plot
Plot Settings

Plot Color [Dye v
[ save current settings as the default 1z

“®
ho]
[
%
R
=
B
B
R
S
B
=E
=N
O
o,

Multicomponent Plot
130,000,000

a.
o X
Q.
9
o
9
B
B
B
E

120,000,000
110,000,000 10 10 b1
0000 00 ddd
20,000,000

80,000,000 H | 1 1

ow Pd o o oF & oF oF O OF

70,000,000

-

80,000,000

Fluorescence

50,000,000
40,000,000

30,000,000 F

20,000,000 |

10,000,000

nnnnnnnnnnnnnnnnnnnnnnnnnnn

Lege H

P I ROX

wels: [ 12 [E 30 [ 2 52 Empty |

Well Summary: In Piate: 96 Set Up: 44 Anahyzed: 42 Fiagged: 0 Omitted by Analysis: 0 Omitted Manually: 2 Samples Used: 7 Targets Used: 2

Tips for confirming  When you analyze your own Relative Standard Curve experiment, look for:

dye accuracy in * Passive reference — The passive reference dye fluorescence level should remain
your own relatively constant throughout the PCR process.
experiment * Reporter dye — The reporter dye fluorescence level should display a flat region

corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

¢ Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

* Negative Control wells — There should not be any amplification in the negative
control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.

About the example In the Relative Standard Curve example experiment, you review the Raw Data Plot
experiment screen for a stable increase in signal (no abrupt changes or dips) from the appropriate
filter.

View the Raw Data 1. From the Experiment Menu pane, select Analysis » Raw Data Plot.
Plot Note: If no data are displayed, click Analyze.
2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.
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Raw Data Plot <

275,000,000
250,000,000 )
225,000,000
200,000,000
175,000,000
150,000,000 |
125,000,000
100,000,000
75,000,000
50,000,000

25,000,000

Chapter 5 Review Results and Adjust Experiment Parameters
Determine signal accuracy using the Raw Data Plot

3. Click |- | Show a legend for the plot (default). The legend displays the color
code for each row of the reaction plate (see the legend in the Raw Data Plot shown
below).

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.

Plate Layout

‘el Table

P L e

Raw Data Plot 0 L 12
10 10 Elﬂ

B B g

[N |

= M= W W= W - - - -
= O A . s s o

o

Legena G
P A e Mic Mo Mc Hr Hc EH z
Options
H
Show Cycle 40
1 5 10 15 20 25 30 s 40 ‘ wels: [T 12 30 [ 2 52 oty
Well Summary: In Plate: 36 Set Up: 44 Analyzed: 42 Flagged: 0 Omitted by Analysis: 0 Omitted Manually: 2 Samples Used: 7 Targets Used: 2
The filters used for the example experiment are:
PCR Filter =~

Ernission Filer

ml{520=15) m2(558+11) m3(586+10) ma(623+14) m5(682+14) me(711+12)
¥1(470+15)

%2(520+10)

%*3(550+11)

Excitation Filter

x4(580+10)

x5(640+10)

*x6(662+10)

Melt Curve

Filter /=

Emission Filter

m1{520+15) m2(558+11) m3(588+10) m4(623+14) m5(682+14) m&(711+12)
*1(47015)
£ *¥2(520+10)
5 ¥3(550+11)
g *4(580+10)
¥5(640£10) @
Tips for When you analyze your own Relative Standard Curve experiment, look for the
accuracy in your ¢ Characteristic signal growth
own experiment * No abrupt changes or dips

52
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Section 5.1 Review Results 5
View the endogenous control profile using the QC Plot

View the endogenous control profile using the QC Plot

In the Relative Standard Curve experiment, the QC Plot screen displays the
Endogenous Control Profile plot for all the targets in the experiment. The QC Plot
serves as a tool to help users choose the best endogenous control for that experiment.
The endogenous control profile plot is a visual display of the Ct values of the
endogenous control across each sample. You can view up to four endogenous controls
at a time. The sample is plotted on the X-axis, and the Cr is plotted on the Y-axis. Each
candidate control is viewed as a color and shape combination in the plot. Endogenous
controls are also known as reference genes.

To view the QC Plot:

1. From the Experiment Menu pane, select Analysis » QC Plot.

Note: If no data are displayed, click Analyze.

2. In the QC Plot screen, click Target Table to select a target to profile:

a. In the Candidate Control column, select the check box of the target of the
endogenous control profile to plot. In the example experiment, the

endogenous control is FAS.

b. Select a color from the Color drop-down menu.

c. Select a shape from the Shape drop-down menu.

3. Click the View Replicate Results Table.

4. Select the check box of the samples you want to plot.

5. Click

Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to

Hide the plot legend.

The QC Plot in the Relative Standard Curve example experiment looks like this.

/@ /@ A £L| LEI |¥ — F;\r;lrget Color - Shape - -
HPRT I o R
Endogenous Control Profile
3785
View Biological Groups ]
350
Target cr CT Mean | CTt SD Normali... = Normali... | RQ
325 HPRT
HPRT
300
2785
250
225
\ 200
17as
150
125
100
75
50
25
00
Heart Kid
Sample >
Well Summary: In Plate: 96 Sat Up: 44 Anzhyzed: 39 Omitted by Anatysis: 0 Omitted Manuzlly: 5 Samples Usad: 7 Targets Used: 2
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Review the QC flags in the QC Summary

This example experiment does not define Biological Groups.

Review the QC flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags,
including the flag frequency and location for the open experiment.

View the QC 1.
Summary
2.
3.
4,

From the Experiment Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.

Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the experiment. If the frequency is > 0, the flag appears somewhere in
the experiment; the well position is listed in the Wells column.

In the example experiment, there are no flagged wells.

In the Flag Details table, click each flag with a frequency > 0 to display detailed
information about the flag. In the example experiment, the Frequency column
displays O for all flags.

(Optional) For those flags with frequency > 0, click the troubleshooting link to
view information on correcting the flag.

The QC Summary screen for the example experiment looks like this:

QC Summary <
lag Details
Flag: Description Frequency Wells

AMPNC Amplification in negative control 0 ~
BADROX Bad passive refarence signal 0

OFFSCALE Fluorescence is offscale 0

HIGHSD High standard deviation in replicate group 0

NOAMP Mo amplification 0

NOISE MNoise higher than others in plate 0

SPIKE Noise spkes 0

NOSIGHNAL Mo signal in well 0

QUTLIERRG Qutlier in replicate group 0

EXPFAIL Exponential algorithm failed 0

BLFAIL Baseline algorithm failed 0

THOLDFAIL Thresholding algorithm failed 0

CTFAIL Cr algorithm failed 0 -

Total Wells: 96 | Processed Wells: 44 Manually Omitted Wels: 5 | Targets Used: 2

Wells Set Up: 44 | Flagged Wells: 0 Analysis Omitted Wels: 0 | Samples Used: 7

‘Well Summary: In Plate: 96 Set Up: 44 Anzhyzed: 39 Flagged: 0 Omitted by Analysis: () Omitted Manually: 5 Samples Used: 7 Targsts Used: 2
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Section 5.1 Review Results 5
For more information

Possible flags The flags listed below may be triggered by the experiment data.

Flag Description

Pre-processing flag

OFFSCALE Fluorescence is offscale
Primary analysis flags

BADROX Bad passive reference signal

NOAMP " No amplification

NOISE . Noise higher than others in plate

SPIKE " Noise spikes

NOSIGNAL No signal in well

EXPFAIL Exponential algorithm failed

BLFAIL Baseline algorithm failed

THOLDFAIL Thresholding algorithm failed

CTFAIL Cy algorithm failed

AMPSCORE Amplification in the linear region is below a certain

threshold, corresponding to the score set in the
analysis settings

Secondary analysis flags

OUTLIERRG Outlier in replicate group
AMPNC Amplification in the negative control
HIGHSD High standard deviation in replicate group

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL,
THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in
the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

For more information

For more information on... Refer to... Part number

Publishing data Chapter 1in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050
System Multi-Well Plate and Array Card Experiments.
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For more information
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Section 5.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

Section 5.2 Adjust parameters for re-analysis of your
own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cr), flags, and advanced options.

If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable
for your own experiment, you can change the settings in the Analysis Settings dialog
box, then reanalyze your experiment.

View the analysis 1. From the Experiment Menu pane, select Analysis.

settings

2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab:

e Crp Settings
* Flag Settings

¢ Relative Quantification Settings

* Advanced Settings

* Standard Curve Settings

The Analysis Settings dialog box for a Relative Standard Curve experiment looks
like this:

A Analysis Settings for 96-Well Relative 5td Curve Example

Flag Settings

change the settings.

Relative Quantification Settings Advanced Settings

Standard Curve Settings

Review the default settings for analysis of targets in this experiment. To use different settings for a target, select the target from the table, deselect Use Default Settings, then

— Data Step Selection

Stage 2, Step 2 v

Select the step and stage to use for CT analysis. Only stage/step combinations for which data suitable for CT analysis have been collected are displayed. Select the algorithm to calculate CT.

Algorithm Settings

Baseline Threshold

~— Default Ct Settings

Default CT settings are used to calculate the C7 for targets without custom settings. To edit the default settings, dick Edit Default Settings.

Threshold: AUTO Baseline Start Cycle: AUTO Baseline End Cycle: AUTO | Edit Default Settings

-~ Select a Target

Target Threshold Baseline Start Baseline End Cr Sattings to Use: Default Settings
FAS IAUTO AUTO AUTO A
HERT AUTO AUTO AUTO

b

~— CT Settings for FAS

Save to Library Load from Library

Revert to Default Analysis Settings

Apply Analysis Settings W
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Chapter 5 Review Results and Adjust Experiment Parameters

Adjust analysis settings

3. View and, if necessary, change the analysis settings (see “Adjust analysis settings”

below).

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well
Plate and Array Card Experiments.

. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to
Default Analysis Settings.

Adjust analysis Ct Settings
settings * Data Step Selection
Use this feature to select one stage/step combination for Ct analysis when there is
more than one data collection point in the run method.
Algorithm Settings
You can select the algorithm that determines the Cy values. There are two
algorithms: Baseline Threshold (the default) and Relative Threshold.
The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for quantification.
The Relative Threshold algorithm is a well-based analysis based on the PCR
reaction efficiency and fitted to the Amplification curve. This setting is ideal for a
single sample across genes with no dependence on targets, thereby reducing
variability. It is not necessary to set either a baseline or a threshold when you use
the Relative Threshold algorithm, so any settings for baseline or threshold will
not affect the analysis.
Default Ct Settings
Use the default Cr settings feature to calculate Cr for the targets that do not have
custom settings. To edit the default settings, click Edit Default Settings.
Cr Settings for Target
When you manually set the threshold and baseline, Life Technologies
recommends:
Setting Recommendation
Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
¢ Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.
Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.
Note: This setting is applicable only to the Baseline Threshold algorithm.
Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.
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Section 5.2 Adjust parameters for re-analysis of your own experiments 5
Adjust analysis settings

Flag Settings
Use the Flag Settings tab to:

¢ Adjust the sensitivity so that more wells or fewer wells are flagged.
* Change the flags that are applied by the QuantStudio™ 12K Flex Software.

To adjust the flag settings
1. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of Ct SD. For some flags, analysis results calculated before
the well is rejected are maintained.

4. Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.

The Flag Settings tab looks like this:

Advanced Settings Standard Curve Settings

Flag Description Use Attribute Condition Value Reject Well
AMPHC Amplification in negat... cr 3 ~ ||25.000 L]
BADROX Bad passive referenc... Bad passive referenc... |= ~ |0.600 (|
OFFSCALE Fluorescence is offscale (|
HIGHSD High standard deviati... Cr standard deviation |= ~ |0.500 (|
HOAMP No amplification Amplification algorith... |< ~ |l0.100 L]
HOISE Noise higher than ot... Relative noise = ~ |4.000 L]
SPIKE Noise spikes Spike algorithm result  |> ~ ||1.000 L]
MOSIGHAL Mo signal in well (|
OUTLIERRG Outlier in replicate gr... (|
EXPFAIL Exponential algorithm... (|
BLFAIL Baseline algorithm failed L]
THOLDFAIL Thresholding algarith... L]
CTFAIL Cr algorithm failed L]
AMPSCORE AMP Score AMP Score > ~ (1.000 (|

Revert to Default Analysis Settings Apply Analysis Settings
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Adjust analysis settings

Relative Quantification Settings

Use the Relative Quantification Settings tab to:
¢ Change the type of analysis, singleplex or multiplex.
* Change the reference sample and/or endogenous control.
¢ Reject Outliers with ACy values less than or equal to the entered value.

Note: The Outlier Rejection settings apply only to multiplex reactions.

* Select the algorithm to use to determine the relative quantification minimum and
maximum values (error bars):

— Confidence Level - Select to calculate the RQ minimum and maximum
values based on the selected confidence level. Select the confidence level to
use.

— Standard Deviations - Select to calculate the RQ minimum and maximum
values based on the selected number of standard deviations. Select the
number of standard deviations to use.

Advanced Settings
Use the Advanced Settings tab to change baseline settings well-by-well.

Note: The baseline and threshold values do not affect the analysis using the Relative
Threshold setting.

To use custom baseline settings for a well-target combination:
1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target check box.

3. Define the custom baseline settings:

e TFor automatic baseline calculations, select the Automatic Baseline check
box.

e To define the baseline, deselect the Automatic Baseline check box, then enter
the baseline start cycle and baseline end cycle.

Standard Curve Settings

Use this tab to review the settings of the current standard curve experiment or to
import the standard curve from an external experiment (with the same samples and
targets) and apply it to this current experiment.

Note: The run method must be the same. Life Technologies recommends using the
standard curve from the current experiment.
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Improve Cr precision by omitting wells

For the example experiment, the settings from the current experiment have been used.

CT Settings Flag Settings Relative Quantification Settings Advanced Settings

@ Review the standard curve plots for each target. To use a standard curve from another experiment, dick Import.

~— Override Standard Curve
(® Use the standard curve from this experiment
2 Use a standard curve imported from another experiment
~— Standard Curve View
ar.s
S = \
S T
.
a00 \\“-\__
.
278 . \\"“\\
-
25.0
226
20.0 =
o1 oz 1 z 3 486 0 20 30 100 200 1000 10000 10000
Reporter Target Slope Y-ntercept Risuperscript 2} Efficiency(%e)
FAM FAS -3.730 40.718 0.997 85.379 o
FAM HPRT -3.700 34.569 0.998 86.318
~
Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings

Improve Cy precision by omitting wells

Experimental error may cause some wells to be amplified insufficiently or not at all.
These wells typically produce Cy values that differ significantly from the average for
the associated replicate wells. If included in the calculations, these outliers can result in
erroneous measurements; to ensure Cp precision, omit the outliers from the analysis.

Note: In the Relative Standard Curve example experiment, there are no outliers. No

wells need to be removed from analysis.

1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. In the Amplification Plot screen, select Ct vs Well from the Plot Type drop-down

menu.
3. Select the Well Table tab, select replicates to omit:

4. In the Well Table:

a. From the Group By drop-down menu, select Replicate.

b. Look for outliers in the replicate group (make sure they are flagged).
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»|  Plate Layout

Chapter 5 Review Results and Adjust Experiment Parameters

c. Select the Omit check box next to outlying well(s), as shown below.

Show in Table W Se Expand all B Callapse all
# Well | Omit || Flag | Sample N... Target Na... | Task Dyes Eig CT Mean CT SD Quantity | Normali... | Normali... | Efficiency = Slope RQ RQ1
= 1 - FAS - STANDARD A
14 B2 1 FAS STANDARD FAM-NFQ-MGB
B 1-F/S5-STANDARD - 1.0
13 B1 | 1 FAS STANDARD FAM-NFQ-MGB 1.000
15 B3 | 1 FAS STANDARD FAM-NFQ-MGB 1.000
B 1 - HI'RT - STANDARD - 1.0
7 O 1 HPRT STANDARD FAM-NFQ-MGB 1.000
38 D2 | 1 HPRT STANDARD FAM-NFQ-MGB 1.000 W
39 D3 ] 1 HPRT STANDARD FAM-NFQ-MGB 1.000
B 10 - FAS - STANDARD
12 A12 10 FAS STANDARD FAM-NFQ-MGB
= 10 - FAS - STANDARD - 10.0
10 Al0 | 10 FAS STANDARD FAM-NFQ-MGB 10.000
11 A1l | 10 FAS STANDARD FAM-NFQ-MGB 10.000
= 10 - HPRT - STAMDARD - 10.0
34 Ci0 " 10 HPRT STANDARD FAM-NFQ-MGB 10.000
35 €1l | 10 HPRT STANDARD FAM-NFQ-MGB 10.000
36 C12 | 10 HPRT STANDARD FAM-NFQ-MGB 10.000
7 A7 O 100 FAS STANDARD FAM-NFQ-MGB 100.000
8 AB | 100 FAS STANDARD FAM-NFQ-MGB 100.000
9 A9 ] 100 FAS STANDARD FAM-NFQ-MGB 100.000
= 100 - HPRT - STANDARD - 100.0
31 o7 | 100 HPRT STANDARD FAM-NFQ-MGB 100.000
32 c8 " 100 HPRT STANDARD FAM-MFQ-MGB 100.000
33 @ ] 100 HPRT STANDARD FAM-NFQ-MGB 100.000
= 1000 - FAS - STANDARD - 1000.0
4 A4 ] 1000 FAS STANDARD FAM-MFQ-MGB 1,000.000 3
_ ‘,—. . — P—— - P | B
Well Summary: In Plate: 06 Set Up: 44 Anatyzed: 39 Flagged: Omitted by Analysis: 0 Omitted Manually: 5 Samples Used: 7 Targets Used: 2

5. Click Analyze to reanalyze the experiment data with the outlying well(s)
removed from the analysis.

Note: You can also omit undesirable wells in an experiment from the Plate Layout
screen. To omit a well from the Plate Layout screen, right-click the well and select
Omit.

For more information

For more information on

Refer to

Part number

Amplification efficiency

Amplification Efficiency of TagMan® Gene Expression Assays
Application Note

127AP05-03
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Export Analysis Results

1. Open the Relative Standard Curve example experiment file that you analyzed in
Chapter 5.

2. In the Experiment Menu, click i ;—'i Export.

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

3. Select QuantStudio'" 12K Flex format.
Note: Select 7900 Format if you want to export the Clipped Data.

4. Complete the Export dialog box as shown below:

Field or Selection Entry
Select Data to Results

export/ Select

Content

Export Data To One File

Export File Name 96-Well Relative Std Curve Example_QuantStudio_export
File Type *.txt

Export File Location | <drive>:\Applied Biosystems\QuantStudio 12K Flex
Software\experiments
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H Chapter 6 Export Analysis Results

Your Export screen should look like this:

[] Auto Export Forrmat = |Qua ntStudio 12kKFlex v‘ Export Data To: (& One File (O Separate Files Open file(s) whan export is complete

Export File Location: |C:\App\ied Biosyste ms\QuantStudio 12K Flex Software\Us Export File Name: |95—WE|| Relative Std Curve Example_QuantS | File Type: |E§j (=txt)
[ sample setup [] Raw Data [ amplification [ multicompanent [ tech. Rep. Resuits [ sio. Rep. Results
Skip Empt, s Skip Omitted \
Select Content well Well Position Sample Name | Target Name Task Reporter Quencher R
All Fields 2 1Al 10000 FAS STANDARD FAM MFQ-MGB ~
el 2 A2 10000 FAS STANDARD FAM MFQ-MGB B
g 3A3 10000 FAS STANDARD FAM MFQ-MGB
well Postion 4 A4 1000 FAS STANDARD FAM MFQ-MGB
5A5 1000 FAS STANDARD FAM MFQ-MGB
sample Name 6 AG 1000 FAS STANDARD FAM MFQ-MGB
7 A7 100 FAS STANDARD FAM MFQ-MGB
Target Name 8 A8 100 FAS STANDARD FAM MFQ-MGE
aAG 100 FAS STANDARD FAM MFQ-MGB
Task 10 A10 10 FAS STANDARD FAM MFQ-MGB
Reporter 11 ATT 10 FAS STANDARD FAM MFQ-MGB
13 B1 1 FAS STANDARD FAM MFQ-MGB
Quencher 1583 il FAS STANDARD FAM MFQ-MGB
16 B4 Kidney FAS UNKNOWWN FAM MFQ-MGB
RQ 17 BS Kidney FAS UNKNOWWN FAM MFQ-MGB
) 18B6 Kidney FAS UNKNOWWN FAM MFQ-MGB
RQ Min 1987 Heart FAS. UNKNOWWIN FAM NFQ-MGB
RQ Max 20 B8 Heart FAS UNKMNOWWT FAM MFQ-MGB
21 B9 Heart FAS UNKMNOWVWTN FAM MFQ-MGB
cT 24 B12 FAS NTC FAM MFQ-MGB
25C1 10000 HPRT STANDARD FAM MFQ-MGB
Ct Mean 26 C2 10000 HPRT STANDARD FAM MFQ-MGB N |
27 C3 10000 HPRT STANDARD FAM MFQ-MGB
ceso 28 C4 1000 HPRT STANDARD FAM MFQ-MGB
Quantity = 29Cs 1000 HPRT STANDARD FAM MFQ-MGB
30 Ce 1000 HPRT STANDARD FAM MFQ-MGB
Quantity Mean 31C7 100 HPRT STANDARD FAM MFQ-MGB
3z2c8 100 HPRT STANDARD FAM MFQ-MGB
Quantity SD 33Co 100 HPRT STANDARD FAM NFQ-MGB
Automatic Ct Threshold a = 34 C10 10 : HPRT STANDARD FAM NFQ-MGB , ~

Start Export || Save Export Set As | Load Export Set | Delete Export Set

Your exported file when opened in Notepad should look like this:

® Barcode = NA ~
* Block Type = 96-well Block (0.2mL) 3
= calibration Background is expired = No

* calibration Background performed on = 2011-08-08 01:15:53 AM 5GT

* Calibration FAM is expired = No

* calibration FAM performed on = 2011 08-08 01:39:58 AM SGT

* Calibration ROI is expired =

* calibration ROI performed on = 2011 08-08 01:05:24 AM SGT

= calibration rox is expired = No

* calibration ROX performed on = 2011—08—08 02:07:15 AM 5GT

* Calibration SYBR is expired =

* calibration syBr performed on 2011—08—08 01:58:11 AM SGT

* Calibration TAMRA 15 expired = No

* calibration TAMRA performed on 2011-08-08 02:16:10 AM SGT

= calibration uniformity is exp'lr‘ed = NO

* calibration Uniformity performed on = 2011-08-08 01:24:47 AM 5GT

* Calibration VIC is expired = No

= calibration vic performed on = 2011-08-08 01:49:09 AM SGT

* Chemistry = TAQMAN

* Comment = NA

* Date Ccreated = 1970-01-01 07:30:00 AM SGT

® Experiment File Name = C:“Program Files‘Applied Biosystems‘QuantsStudiol2kFlex\examples\Gene Expression‘Relative standard Curve'9o-well
Relative std Curve Exam;ﬂe eds

= EXperiment Name = 96- we'H relative std curve Example

* Experiment Run End Time = 2011-08-09 11:05:14 AM SGT

* Experiment Type = Relative Standard Curve

* INSTrument Name = QuantstudiobDemo

#* Instrument Serial Number = QuantstudioDemo

* Instrument Type = QuantStudio 12K Flex

* passive Reference = ROX

* quantification Cycle Method =

* signal smoothing on = true

= stage/ cycle where analysis is performed = stage 2, step 2

® User Name = NA

[Results]

well well Position sample Name Target Name Task Reporter Quencher RQ RQ Min RQ Max CT Ct Mean Ct
sD i quagt‘ity qQuantity Mean Quantity SD Automatic €t Threshold ct Threshm1d Automatic Baseline Baseline start
Baseline En

1 A 10000 FAS STANDARD FAM NFQ-MGE 25.990 25.983 0.027 10, 000. 000"

true 0.544 true 3 15

2 A2 10000 FAS STANDARD FAM NFQ-MGB 26.009 25.985 0.027 "10, 000. 000"

true 0.544 true 3 19

3 A3 10000 FAS STANDARD FAM NFQ-MGB 25.856 25.985 0.027 "10, 000. 000"

True 0.544 true 3 19

4 Ad 1000 FAS STANDARD FAM NFQ-MGE 29.403 29.296 0.093 "1,000. 000"

true 0 544 true 3 23

5 1000 FAS STANDARD FAM NFQ-MGB 29.251 29.296 0.003 "1,000. 000"

true Cl 544 true 3 22

6 1000 FAS STANDARD FAM NFQ-MGB 209,234 29.296 0.093 "1, 000. 000"

True 0 544 true 3 23

7 100 FAS STANDARD FAM NFQ-MGE 33.287 33.154 0.160 100. 000

true 0 544 true 3 26 ~
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About Comparative C; Experiments

This chapter covers:
About Comparative Crexperiments............. .. ..., 69

About the example experiment .............. ... . . ool 71

IMPORTANT! First-time users of the QuantStudio™ 12K Flex System, please read
Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array
Card Experiments and Booklet 7, QuantStudio™ 12K Flex System Multi-Well Plate and
Array Card Experiments - Appendixes of this binder thoroughly. The booklets provide
information and general instructions that are applicable to all the experiments
described in this binder.

Note: For more information about any of the topics discussed in this guide, access the
Help from within QuantStudio™ 12K Flex Software by pressing F1, clicking @ in the
toolbar, or selecting Help » QuantStudio™ 12K Flex Software Help.

About Comparative C; experiments

Assemble required

The Comparative CT (AACt) method is used to determine the relative target quantity
in samples. With the comparative Cy method, the QuantStudio™ 12K Flex Software
measures amplification of the target and of the endogenous control in samples and in a
reference sample. Measurements are normalized using the endogenous control. The
software determines the relative quantity of target in each sample by comparing
normalized Cy (ACy) in each sample to normalized Ct (ACy) in the reference sample.
Comparative Cp experiments are commonly used to:

* Compare expression levels of a gene in different tissues.

¢ Compare expression levels of a gene in a treated sample and an untreated sample.

¢ Compare expression levels of wild-type alleles and mutated alleles.

* Analyze the gene expression changes over time under specific treatment
conditions.

¢ Sample - The tissue group that you are testing for a target gene.

components * Reference sample (also called a calibrator)- The sample used as the basis for
relative quantification results. For example, in a study of drug effects on gene
expression, an untreated control is an appropriate reference sample.
* Endogenous control — A gene that is used to normalize template input
differences, and sample-to-sample or run-to-run variation.
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Chapter 7 About Comparative C; Experiments
About Comparative Cr experiments

Replicates — The total number of identical reactions containing identical
components and identical volumes.

Negative Controls — Wells that contain water or buffer instead of sample
template. No amplification of the target should occur in negative control wells.

When performing real-time PCR, choose between:

Singleplex and multiplex PCR (below)
and
1-step and 2-step RT-PCR (page 70)

Singleplex and Multiplex PCR

You can perform a PCR reaction using either:

Singleplex PCR - In singleplex PCR a single primer and probe set is present in
the reaction tube or well. Only one target or endogenous control can be amplified
per reaction.

Or

Multiplex PCR - In multiplex PCR, two or more primer and probe sets are
present in the reaction tube or well. Each set amplifies a specific target or
™

endogenous control. Typically, a probe labeled with FAM ™ dye detects the target
and a probe labeled with VIC® dye detects the endogenous control.

IMPORTANT! SYBR® Green reagents cannot be used for multiplex PCR.

] O EE [ Target Primer Set
=
s 3 ©o (O Endogenous Control
7 Primer Set
. ~~ cDNA
Singleplex PCR Multiplex PCR

1- and 2-Step RT-PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in
separate reactions (2-step). The reagent configuration you use depends on whether
you are performing 1- or 2-step RT-PCR:

1-step RT-PCR- In 1-step RT-PCR, RT and PCR take place in one buffer system.
Using one buffer system provides the convenience of a single-tube preparation
for RT and PCR amplification. However, you cannot use Fast PCR Master Mix or
the carryover prevention enzyme, AmpErase® UNG (uracil-N-glycosylase), to
perform 1-step RT-PCR.

2-step RT-PCR- 2-step RT-PCR is performed in two separate reactions: First, total
RNA is reverse-transcribed into cDNA, then the cDNA is amplified by PCR. This
method is useful for detecting multiple transcripts from a single cDNA template
or for storing cDNA aliquots for later use. The AmpErase® UNG enzyme can be
used to prevent carryover contamination.
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About the example experiment

About the example experiment

To illustrate how to perform comparative C experiment, this guide leads you through
the process of designing and performing an example experiment. The example
experiment represents a typical setup that you can use to quickly familiarize yourself
with the QuantStudio™ 12K Flex System.

The objective of the comparative Ct example experiment is to compare the expression
of GH1, LPIN1, TGFB1, LIPC, ACTB, and CCKAR in liver, heart, brain, and lung
tissues.

* The samples are liver, heart, lung, and brain tissues.

® The targets are GH1, LPIN1, TGFB1, LIPC, ACTB, and CCKAR.

* The reference sample is brain.

¢ The endogenous control is ACTB.

* The experiment is designed for singleplex PCR, where the targets and
endogenous control assays are performed in separate wells.

* Reactions are set up for 2-step RT-PCR. The Invitrogen VILO" Kit is used for
reverse transcription; the TagqMan® Fast Universal PCR Master Mix is used for
PCR.

* Primer and probe sets are selected from the Life Technologies TagMan® Gene
Expression Assays product line:

— GH1 Assay Mix: Hs00236859_m1

— LPIN1 Assay Mix: Hs00299515_m1
— LIPC Assay Mix: Hs00165106_m1

— ACTB Assay Mix: Hs99999903_m1

— TGFB1 Assay Mix: Hs00998133_m1
— CCKAR Assay Mix: Hs00167891_m1
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About the example experiment
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Design the Experiment

This chapter explains how to design the example experiment from the Experiment

Setup menu.

This chapter covers:

Define the experiment properties. . .......... ... 73
Define targets, samples and biological replicates .......................... 74
Assign targets, samples and biological groups ............. ... ... . oL 75
Setuptherunmethod ...... ... ... ... . 77
Tips for designing your own experiment................ ..., 78
For more information.......... ... . i 79

Note: To automatically export the analyzed data to a specified location, select the Auto
Export task from the Export screen, before running the experiment. For more
information on Auto Export, refer to Chapter 1 in Booklet 1, Getting Started with
QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments.

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the
QuantStudio™ 12K Flex Software. Enter:

Field or Selection

Entry

Experiment Name
Barcode

User Name

96-Well Fast Comparative Ct Example.eds
Leave field empty

Example User

Comments

Comparative C; example

Block

96-Well (0.2mL)

Experiment Type

Comparative Cy (AACT)

Reagents TagMan® Reagents
Ramp speed Fast
Save the experiment.
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Define targets, samples and biological replicates

Your Experiment Properties screen look like this:

How do you want to identify this experiment?

* Experiment Name: |96-Well Fast Comparative Ct Example.eds Comments: |Comparative CT example A
Barcode:

User Name: Example user hd

Which block are you using to run the experiment?

[ 384-Well ] [ Array Card ] v 96-Well (0.2mL) | [ Fast 96-Well (0.1mL) ]

What type of experiment do you want to set up?

[ Standard Curve ] [ Relative Standard Curve ] ‘ v Comparative Ct (AACT) ‘ [ Melt Curve ]

[ Genotyping ] [ Presence/Absence ]

Which reagents do you want to use to detect the target sequence?

4 TagMan® Reagents | [ SYBR® Green Reagents ] [ Other }

What properties do you want for the instrument run?

[ Standard ] | s Fast |

Define targets, samples and biological replicates

Click Define to access the Define screen. Enter:

1. Targets
Target name Reporter Quencher Color
GH1 FAM NFQ-MGB B
LPTN1 FAM NFQ-MGB | ]
TGFB1 FAM NFQ-MGB ]
L1PC FAM NFQ-MGB |
ACTB FAM NFQ-MGB ]
CCKAR FAM NFQ-MGB

2. Samples

Sample Name Color

Brain [ ]
Lung [ ]
Liver
Heart [ ]

3. Dye to be used as a Passive Reference
ROX

~
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4. Analysis Settings

Chapter 8 Design the Experiment
Assign targets, samples and biological groups

Field Select
Reference Sample Brain
Endogenous Control ACTB

Your Define screen should look like this:

Sawe to Library Irnport from Library

Samples

Mew  Savetolibrary  Import from Library

Target Name Reporter Quencher Color Sample Name Color

GH1 FAM + [NFQ-MGB v|. ~| |Brain ‘. v
LP1HL FAM + [NFQ-MGB v|. ~ | [Heart ‘. v
TGFB1 FAM + [NFQ-MGB ~ |. ~ | |Liver ‘ v
L1PC FAM + |[NFQ-MGB v| ~ Lung ‘. ~
ACTB FAM + [NFQ-MGB ~ |. ~

CCKAR FAM + [NFQ-MGB v| ~

Biological Replicate Groups

Biological Group Name Color Comments

Analysis Settings

Reference Sample: [Brain v
Endogenous Control: |ACTE w

Passive Reference

ROX -

Note: This example experiment does not define biological replicate groups. Leave
Biological Replicate Groups blank.

Assign targets, samples and biological groups

Click Assign to access the Assign screen. Enter the targets and samples:
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Assign targets, samples and biological groups

Target name Well number Task Sample
name
GH1 A1, B1, C1 Unknown Heart
A2, B2, C2 Unknown Brain
E1, F1, G1 Unknown Lung
E2, F2, G2 Unknown Liver
D1, D2, H1, H2 Negative Heart, Brain,
Lung, Liver
LPTN1 A3, B3, C3 Unknown Heart
A4, B4, C4 Unknown Brain
E3, F3, G3 Unknown Lung
E4, F4, G4 ' Unknown | Liver
D3, D4, H3, H4 . Negative Heart, Brain,
Lung, Liver
TGFB1 Ab, B5, C5 Unknown Heart
Aéb, Bb, C6 Unknown Brain
E5, F5, G5 Unknown Lung
E6, F6, Gb Unknown Liver
D5, D6, H5, H6 Negative Heart, Brain,
Lung, Liver
L1PC A7, B7, C7 Unknown Heart
A8, B8, C8 Unknown Brain
E7, F7, G7 Unknown Lung
E8, F8, G8 . Unknown Liver
D7, D8, H7, H8 . Negative Heart, Brain,
Lung, Liver
ACTB A9, B9, C9 Unknown Heart
A10, B10, C10 Unknown Brain
E9, F9, G9 Unknown Lung
E10, F10, G10 Unknown Liver
D9, D10, H9, H10 Negative Heart, Brain,
Lung, Liver
CCKAR A11, B11, C11 Unknown Heart
A12, B12, C12 Unknown Brain
E11, F11, G11 Unknown Lung
E12, F12, G12 . Unknown Liver
D11, D12, H11, H12 . Negative Heart, Brain,
Lung, Liver
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Targets

Your Assign screen should look like this:

Chapter 8 Design the Experiment
Set up the run method
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Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the
Graphical View tab. Enter:

¢ Reaction Volume Per Well: 20 ul

e Thermal Profile

Stage Step Rraartnep Temperature Time
Hold Stage Step 1 2.05°C/s 95°C 20 seconds
PCR Stage Step 1 2.05°C/s 95°C 1 second
Number of Cycles: 40 Step 2 1.71°C/s 60°C 22 seconds

Enable AutoDelta:
Unchecked (default)

Starting Cycle: Disabled
when Enable AutoDelta is
unchecked
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Tips for designing your own experiment

Your Run Method screen should look like this:

Run Method

Reaction Volume per Well: 20 | pL

Optical Filters

Hold Stage PCR Stage
MNumber of Cycles:

Starting Cycle:

100 °C__|

TS

60 "C_]
25°C_|
o
Stept Stept Step2
< >
Legend
Data Collection On =/ Data Collection Off A AutoDefta On A AutoDetra Off

Tips for designing your own experiment

Life Technologies recommends that you:

* Identify each target assay with a unique name and color. You can enter up to 100
characters in the Target Name field.

¢ Identify each sample using a unique name and color. You can enter up to 100
characters in the Sample Name field.

* Select an endogenous control for each sample. The endogenous control is a target
that is present in all samples under investigation. It should be expressed equally
in all sample types, regardless of treatment or tissue origin (examples of
endogenous controls are -actin, GAPDH, and 18S ribosomal RNA [185 rRNA]).
The endogenous control is used to normalize the PCR results; the endogenous
control corrects for variable sample mass, nucleic acid extraction efficiency,
reverse transcription efficiency, and pipette calibration errors. Note that:

— Each sample type (for example, each tissue in a study comparing multiple
tissues) requires an endogenous control.

— If samples are spread across multiple plates, each plate must have an
endogenous control. Additionally, every plate must include an endogenous
control for every sample type on the plate.
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For more information

* Select an endogenous control from your previously defined target assays.
Amplification results from the endogenous control are used to normalize the
amplification results from the target for differences in the amount of template
added to each reaction.

* Select a reference sample from your previously defined samples. Amplification
results from the samples and from the reference sample are compared to
determine relative expression.

For more information

For more information on Refer to Part number

Consumables Chapter 1 in Booklet 1, Getting Started with 4470050
QuantStudio™ 12K Flex System Multi-Well Plate and
Array Card Experiments

Appendix A in Booklet 7, QuantStudio™ 12K Flex System
Multi-Well Plate and Array Card Experiments -

Appendixes
Using the Standard Curve quantification | Booklet 2, Running Standard Curve Experiments. 4470050
methods
Using the Relative Standard Curve Part 1 of this booklet 4470050
quantification method
Selecting an endogenous control Application Note Using TagMan® Endogenous Control 127AP05-03

Assays to Select an Endogenous Control for
Experimental Studies

Reference samples (also known as User Bulletin #2: Relative quantification of Gene 4303859
calibrators) and endogenous controls Expression
Using alternative setup Chapter 2 in Booklet 1, Getting Started with 4470050

QuantStudio™ 12K Flex System Multi-Well Plate and
Array Card Experiments
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For more information
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Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Comparative Cy
(AACt) example experiment.

This chapter covers:

Assemble required materials ........ ... 81
Preparethetemplate ........ ... ... . . 81
Prepare the sample dilutions ............... .. .. ... . o il 82
Prepare the reaction mix (“cocktail mix”)........... ... ... .. L. 82
Prepare the reactionplate . ....... ... ... ... .. 83
Tips for preparing reactions for your own experiments. . ................... 84
For more information. . ............u i 85

Assemble required materials

Items listed in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-
Well Plate and Array Card Experiments.

Samples - Total RNA isolated from liver, heart, brain, and lung tissues.
Example experiment reaction mix components:

— TaqMan® Fast Universal PCR Master Mix (2X.)

— ACTB Assay Mix (20X)

— TGFB1 Assay Mix (20X)

— GH1 Assay Mix (20X)

— LIPN1 Assay Mix (20X)

— LIPC Assay Mix (20X)

— CCKAR Assay Mix (20X)

Prepare the template

Prepare the template for the PCR reactions using the High-Capacity cDNA Reverse
Transcription Kit or one of the Invitrogen VILO™" kits to carry out the reverse

transcription.
Example For the Comparative Cy example experiment, the template for the PCR reactions is
experiment cDNA reverse-transcribed from total RN A samples using one of the Invitrogen VILO™
. . . ® ™ . .
settings kits, SuperScript® VILO ™ cDNA Synthesis Kit (PN 4453650).
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Prepare the sample dilutions

Prepare the Use the Invitrogen VILO™ kits to reverse-transcribe cDNA from the total RNA
template samples. Follow the procedures in the Invitrogen VILO Kits Protocol (PN 100002284) to:

1. Prepare the RT master mix.
2. Prepare the cDNA reactions.

3. Perform reverse transcription on a thermal cycler.

Prepare the sample dilutions

For the Comparative Cy example experiment, no more than 10% of your reaction
should consist of the undiluted RT product.
1. Label a separate microcentrifuge tube for each diluted sample:
e Liver
¢ Heart
¢ Brain

* Lung

2. Add the required volume of water (diluent) to each empty tube:

Tube Sample name Diluent volume (pL)
1 Liver 19
2 Heart 19
3 Brain 19
4 Lung 19

3. Add the required volume of cDNA sample stock (100 ng/uL) to each empty tube:

Tube Sample name Volume (pL)
1 Liver 1.0
2 Heart 1.0
3 Brain 1.0
4 Lung 1.0

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the reaction mix (“cocktail mix”)

1. Label an appropriately sized tube for each reaction mix:
¢ ACTB Reaction Mix
¢ TGFB1 Reaction Mix
* GHI Reaction Mix
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¢ [PIN1 Reaction Mix
e LIPC Reaction Mix
¢ (CCKAR Reaction Mix

Chapter 9 Prepare the Reactions n

Prepare the reaction plate

2. For the ACTB assay, add the required volumes of each component to the ACTB

Reaction Mix tube:

Component

Volume (pL) for 1

Volume (pL) for 16
reactions (plus

reaction 10% excess)
TagMan® Fast Universal PCR 10.0 176.0
Master Mix (2X]
ACTB Assay Mix (20X) 1.0 17.6
Water 8 140.8
Total Reaction Mix Volume 19.0 158.4

3. Mix the reaction mix in each tube by gently pipetting up and down, then cap each

tube.

4. Centrifuge the tubes briefly to remove air bubbles.

5. Place the reaction mixes on ice until you prepare the reaction plate.

6. Repeat steps 2 through 5 for the TGFB1, GH1, LPIN1, LIPC, and CCKAR assays.

Note: Do not add the sample at this time.

Prepare the reaction plate

Example The reaction plate for the Comparative C example experiment contains:
experiment * A MicroAmp® Optical 96-Well Reaction Plate

reaction plate * Reaction volume: 20 uL/well

components

* The reaction plate contains:
— 72 Unknown wells [

— 24 Negative Control wells [

— 0 Empty wells
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Tips for preparing reactions for your own experiments

The plate layout experiment looks like this:

bl Plate Layout Well Table

1 2 | 3 | 4 | 5 | 3 | 7 | ) | 3 | 10 | 1 | 12 |
e o o O OB O Ol oo e e Ol mees
o o o O O O Ol o< e O O mee
o o o o o o o) o e e e mee
S W 3 3 B - u 3 3 3
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Liver Liver Liver Liver Liver Liver

F o] I o~p o o]
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wels: [ 72 [ 24 0 Empty

B

@

2

o
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To prepare the 1. Add 1 pL of each cDNA to the appropriate wells.
reaction plate 2. Pipette 1 pL of sterile water into the NTC wells.
components
3. Add 19 pL of the appropriate assay-specific cocktail to the wells.
4. Seal the reaction plate with optical adhesive film.
5. Centrifuge the reaction plate briefly to remove air bubbles.
6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,

centrifuge the reaction plate again at a higher speed and for a longer period of
time.

7. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

Tips for preparing reactions for your own experiments

Tips for preparing When you prepare your own Comparative Ct experiment, Life Technologies
templates recommends the following templates:

e Complementary DNA (cDNA) — cDNA reverse-transcribed from total RNA
samples.

¢ Genomic DNA (gDNA) - Purified gDNA already extracted from tissue or
sample.
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For more information

Tips for preparing If your experiment includes more than one target assay, prepare the reaction mix for
the reaction mix each target assay separately.

Tips for preparing When you prepare your own Comparative Ct experiment, make sure the arrangement
the reaction plate of the PCR reactions matches the plate layout displayed in the QuantStudio™ 12K Flex
Software.

For more information

For more information on... Refer to... Part
number
Assigning the reaction plate | Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System 4470050
components Multi-Well Plate and Array Card Experiments
Sealing the reaction plate Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex System 4470050
Multi-Well Plate and Array Card Experiments
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For more information
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Start the run

Run the Experiment

This chapter explains how to run the example experiment on the QuantStudio™ 12K
Flex Instrument.

This chapter covers:
Start the FUN. . . ..o 87
Monitor the run. . . ... .. 87

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the QuantStudio™ 12K Flex Instrument is in operation.

1. Open the Comparative Ct example file that you created using instructions in
Chapter 8.

2. Load the reaction plate into the instrument.

3. Start the run.

Monitor the run

From the
Instrument
Console of the
QuantStudio™ 12K
Flex Software

Monitor the example experiment run:

¢ From the QuantStudio™ 12K Flex Software using the Run screen, while the
experiment is in progress.

¢ From the Instrument Console of the QuantStudio™ 12K Flex Software (to monitor
an experiment started from another computer or from the QuantStudio™ 12K
Flex Instrument touchscreen).

e From the QuantStudio™ 12K Flex Instrument touchscreen.

1. In the Instrument Console screen, select the instrument icon.
Click Manage Instrument or double-click on the instrument icon.

3. In the Manage Instrument screen, click Monitor Running Experiment to access
the Run screen.
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Monitor the run

View the Amplification Plot

You can view the progress of the run in real time. During the run, periodically view all
the three plots available from the QuantStudio™ 12K Flex Software for potential
problems.

Click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab,
then select the wells t to view.

The figure below shows the Amplification Plot screen as it appears at the end of the
example experiment.

Amplification Plot < ate Layol
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425
4.00
378
350
325
3.00
275
F 280
225
2.00
175
1.50
125
100
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Amplification Plot
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oo e e e o e e e e o
oo e e e o e e e e o
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o

m

Legn

075 Liver Liver Liver Liver Liver Liver
F o
050
025
0.00
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025
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Chapter 10 Run the Experiment
Monitor the run

View the Temperature Plot
Click Temperature Plot from the Run Experiment Menu.

The figure below shows the Temperature Plot screen as it appears during the example
experiment.

Temperature Plot Current Temperatures

® B By | ||E M
£ P B LR 1 Ml sample
Block
Temperature Plot
15
10
105
100 /
o5l [ gt H ; i | [ ; ; i
90 ‘." i {
85 ‘.I
804 |
75 3'
70 JI
g o
g o Tl NSESENEAEN AR ARE R RRRAREREARERE
g ss
]
45
40
35
30
25—
20
15
10
5
0 Temperature Plot
00:00:00 00:04:10 00:08:20 00:12:30 00:16:40 00:20:50 00:25:00 DUETB‘:”E; 00:33:20 00:37:30 00:41:40 00:45:50 00:50:00 005410 00:58:20 View
Fixed View []
Note: The Sample temperature displayed in the Current Temperatures group is an
estimated value.
View the Run Method
Click Run Method from the Run Experiment Menu.
The figure below shows the Run Method screen as it appears in the example
experiment.
Run Method Edit Run Method
Hold Stage PCR Stage
Number of Cycles:
Starting Cycle:
Stept Sten? Sten2
< >
Legend
Data Collaction O~ = Data Collaction Off A AutoDelta On A AutoDelta Off
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Run Data Report

Experiment Name:
Start Time:

Stop Time:

Run Duration:

User Name:
Instrument: Name:
Firmware Version:
Software Version:
Instrument Serial Number:
Sample Volume:
Cover Temperature:

Block Type:

Errors Encountered:

Chapter 10 Run the Experiment
Monitor the run

View Run Data
Click View Run Data from the Run Experiment Menu.

Your View Run Data screen should like this:

96-Well Fast Comparative Ct Example
09-28-2011 12:49:01 5GT
09-28-2011 13:33:38 56T

44 minutes 36 seconds

DEFAULT

QuantStudioDemo

0.16.1

QuantStudio 12K Flex Software v1.0
QuantstudioDemo

20.0

105.0

96-Well Block (0.2mL)

From the
QuantStudio™ 12K
Flex Instrument

You can also view the progress of the run from the touchscreen of the QuantStudio™
12K Flex Instrument.

The Run Method screen on the QuantStudio™ 12K Flex Instrument touchscreen looks

touchscreen like this:
Experiment view
@ Time View Plot View 1]  Experiment View
Run Started: December 08 2011 - 12:05AM Sample: 95.0 °C
Reaction Volume: 20 pL Heated Cover (Set Point): 105.0 °C (105.0 °C)
Time Remaining: 01:27:04
O
Stage 1 Stage 2
10f1 X 40
95.0 °C 95.0 °C
— 7:14 0:15 N 40.0 °C
——— 1:00
2:00 a
December 08 2011 - 12:05AM o
Heated cover reached target temperature.
Note: The above screenshot is for visual representation only. Actual results will vary
with the experiment.
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Monitor the run

Time View

@ Time View Plat View ] Experiment View

Sample: 59.5 °C
Heated Cover [Set Point): 105.0 °C [105.0 °C)
Stage /Step / Cycle: 2/2/5

01:11:22

@ Remaining Time -~ Elapsed Time

Run Started: December 08 2011 - 12:05AM
Reaction Volume: 20 pL

December 08 2011 - 12:06AM

Error occurred during run. Details: Holdtime 60 s exceeded. Actual Holdtim...

Plot View
|  Experiment View @ Time View Plot View
Fast 96-Well Tagman v ARn W

100

December 08 2011 - 12:07AM o

Heated cover reached target temperature.
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Review Results and Adjust
Experiment Parameters

In Section 11.1 of this chapter you review the analyzed data using several of the
analysis screens and publish the data. Section 11.2 of this chapter walks you through
the process of modifying experiment parameters to troubleshoot problems with

experiment results before rerunning an experiment.

This chapter covers:

Section 11.1 Review Results ..., 95
Analyze the example experiment. .............. ... 95
Assess the gene expression profile using the Gene Expression Plot. .......... 95
Identify well problems using the Well Table .............................. 97
Assess amplification results using the Amplification Plot................... 99
Confirm accurate dye signal using the Multicomponent Plot............... 106
Determine signal accuracy using the Raw DataPlot ...................... 108
View the endogenous control profile using the QCPlot ................... 110
Review the flags inthe QC Summary ..., 111
For more information............... ... .o i i 113

Section 11.2 Adjust parameters for re-analysis of your own experiments ..... 115
Adjust analysis settings............ ... i i 115
Improve Cy precision by omittingwells................. ... ... ... .. 118
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Section 11.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 10.

2. Click Analyze. The software analyzes the data using the default analysis settings.

Note: You can also access the experiment to analyze from the Home screen.

Assess the gene expression profile using the Gene Expression
Plot

The Gene Expression Plot screen displays the results of relative quantification
calculations in the gene expression profile. There are two plots available:

¢ RQ vs Target — Groups the relative quantification (RQ) values by target. Each
sample is plotted for each target. You can view the plot as the linear, log10, Ln,
and log?2 graph types. The Gene Expression plot when viewed as a linear graph

type looks like this:
Gene Expression
Plot Settings
Plot Type: RQ vs Target | Graph Type:|Linear | Orientation: Vertical Bars v
[] Save current settings as the default
PP oAl E
RQ vs Target
280
270
260
250 244,038
240
230
220
210
200
190
180
170
160
o 150
& 140
130
120
110
100
30
80
70
60
50
40
30
20
) 1 oass  ooas 1 °Fozzosea 1 382 || com 1 2eWormscs; 1 G raaedZ
% = g = =
g @ = o 5
Target
Well Summary: In Plste: 96 Sat Up: 96 Anahyzed: 96 Flagged: 10 Ormitted by Analysis: [ Omitted Manualy: { Samples Used: 4 Targets Used: 6
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1 1 Chapter 11 Review Results and Adjust Experiment Parameters
Assess the gene expression profile using the Gene Expression Plot

* RQ vs Sample — Groups the relative quantification (RQ) values by sample. Each
target is plotted for each sample. You can view the plot as the following graph
types: linear, log10, Ln, log2.

Gene Expression

Plot Settings
Plot Type: RQ ws Sample + |Graph Type: Linear + | Orientation: Vertical Bars ~
[] Save current settings as the default
P P A B R E
RQ vs Sample
280
270
260
250 244.039
240
230
220
210
200
190
180
170
160
o 150
or 140
130
120
110
100
a0
80
70
&0
50
40
30
20
e LR R R N R oses 732288 T 0213 | | 07831249 00ss086202310531°38° |
= 5 g g
(=] == — —
Sample
‘Well Summary: In Plste: 96 Set Up: 96 Anatyred: 96 Flagged: 10 Ormitted by Analysis: (I Omitted Manually: Samples Usad: 4 Targets Used: 6
Exampl_e Review each target in the Gene Expression Plot screen for the expression level (or fold

experiment values change) of the target sample relative to the reference sample.

View the Gene 1. From the Experiment Menu pane, select Analysis » Gene Expression.
Expression Plot Note: If no data are displayed, click Analyze.

2. In the Gene Expression Plot screen, select:

Menu Selection
Plot Type RQ vs Sample (default)
Graph Type Log10
Orientation Vertical Bars

3. Click Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.
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Gene Expression

Section 11.1 Review Results
Identify well problems using the Well Table

In the example experiment, as shown below, the expression level of each target gene in
liver, heart, and lung is displayed relative to its respective expression level in the
reference sample (brain). Since the reference sample is compared to itself, the relative
expression level is 1. When the result is displayed in the Log10 graph type, the
expression level of the reference sample appears as 0 in the graph (log10 of 1 =0).

Plot Settings
Plot Type:|RQ vs Sample w | Graph Type:|Logl0 | Orientation: |Vertical Bars v
[] Save current settings as the default
P LBl WK IE
RQ vs Sample
2.50 2.387
2.25
2.00
1.795
1.50
1.25
1.00
- 0.739
< 075 0.696
[ 0.64
= Il osse u
"= 0.50 0423
= 1]
0.25 I
0.096
0.00 ] o] T 0 o " L
_0.108 -0.084
0.25 L
-0275
0.50 -0.438 II
0.75 0.672 -0.636
1.00
1.25
-1.338
1.50 -
= = = =
& £ = 3
Sample
Well Summary: In Plate: 96 Set Up: 06 Anatyzed: 06 Flzgged: 10 Omitted by Anahysis: 0 Omitted Manuzly: 0 Samples Used: 4 Targets Used: 6

Assessing the gene
expression plot
your own
experiments

When you analyze your own Comparative Ct experiment, look for differences in gene
expression (as a fold change) relative to the reference sample.

Identify well problems using the Well Table

Example
experiment values
and flags

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card

The Well Table displays data for each well in the reaction plate, including;:
* The sample name, target name, task, and dyes

* The calculated threshold cycle (Ct), normalized fluorescence (Rn), and quantity
values

¢ Flags

Review the Well Table to evaluate the Ct precision of the replicate groups.
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1 1 Chapter 11 Review Results and Adjust Experiment Parameters
Identify well problems using the Well Table

View the well table 1. From the Experiment Menu pane, select Analysis » Amplification Plot, then click
the Well Table tab.

2. From the Group By drop-down menu, select Replicate.

3. Look at the Cp SD column to evaluate the Ct precision of the replicate groups. In
the example experiment, there are ten outliers. You will omit these wells in the
troubleshooting section (“Improve C precision by omitting wells” on page 118).

»|  Plate Layout Well Table

Show in Table ¥ 2 % Expand Al 8 Collapse Al
# Well | Omit Flag Sample ...| Target... | Task Dyes cT CT Mean | CT SD ACT ACT Me... | ACT SE AACT RQ
= fopttpc___________ @
8 A8 " | Brain L1PC UNKNOWHM  FAM-NFQ-... 31.479 31.637 0.217 12.054 0.130 0.000
20 B8 " | Brain L1PC UNKNOWHM  FAM-NFQ-... 31.548 31.637 0.217 12.054 0.130 0.000
32 c8 " | Brain L1PC UNKNOWHM  FAM-NFQ-... 31.884 31.637 0.217 12.054 0.130 0.000
44 D8 " | Brain L1PC NTC FAM-NFQ-... Undetermi...
4 A4 " | Brain LP1N1 UNKNOWHN  FAM-NFQ-... 24.883 24955 0.133 5.372 0.085 0.000
16 B4 " | Brain LP1N1 UNKNOWM  FAM-NFQ-... 25.108 24955 0.133 5.372 0.085 0.000
28 4 " | Brain LP1N1 UNKNOWM  FAM-NFQ-... 24.873 24955 0.133 5.372 0.085 0.000
40 D4 " | Brain LP1N1 NTC FAM-NFQ-... Undetermi...
6 A6 " | Brain TGFB1 UNKNOWHN  FAM-NFQ-... 26.743 26.793 0.144 7.210 0.091 0.000
18 B6 " | Brain TGFB1 UNKNOWHN  FAM-NFQ-... 26.680 26.793 0.144 7.210 0.091 0.000
30 C6 " | Brain TGFB1 UNKNOWHM  FAM-NFQ-... 26.956 26.793 0.144 7.210 0.091 0.000
42 D& " | Brain TGFB1 NTC FAM-NFQ-... Undetermi... B
9 A9 "] Heart ACTB UNKNOWHM  FAM-NFQ-... 22.101 21.917 0.168
21 B9 "] Heart ACTB UNKNOWM  FAM-NFQ-... 21.880 21.917 0.168
33 oo "] Heart ACTB UNKNOWM  FAM-NFQ-... 21.771 21.917 0.168
45 D9 ] Heart ACTB NTC FAM-NFQ-... Undetermi...
11 A1l "] 1 Heart CCKAR UNKNOWM  FAM-NFQ-... 37.170 37.383 0.649 15465 0.387 1453
23 Bl1 "] 1 Heart CCKAR UNKNOWM  FAM-NFQ-... 38.111 37.383 0.649 15465 0.387 1453
35 C11 "] 1 Heart CCKAR UNKNOWHM  FAM-NFQ-... 36.867 37.383 0.649 15465 0.387 1453
47 D11 ] Heart CCKAR NTC FAM-NFQ-... Undetermi...
1 Al "] Heart GH1 UNKNOWHM  FAM-NFQ-... 34.655 34.427 0.292 12.509 0.194 -2.454
13 B1 "] Heart GH1 UNKNOWM  FAM-NFQ-... 34.098 34.427 0.292 12.509 0.194 -2.454
25 "] Heart GH1 UNKNOWHM  FAM-NFQ-... 34.527 34.427 0.292 12.509 0.194 -2.454
37 D ] Heart GH1 NTC FAM-NFQ-... Undetermi...
B Heart - L1PC
7 A7 "] Heart L1PC UNKNOWM  FAM-NFQ-... 31.978 32.015 0.073 10.097 0.106 -1.957
19 B7 "] Heart L1PC UNKNOWM  FAM-NFQ-... 32.099 32.015 0.073 10.097 0.106 -1.957
31 7 "] Heart L1PC UNKNOWHM  FAM-NFQ-... 31.967 32.015 0.073 10.097 0.106 -1.957
43 D7 ] Heart L1PC NTC FAM-NFQ-... Undetermi... P
< ] 3
Well Summary: In Plate: 96 Sat Up: 36 Analyzed: 96 Flagged: 10 Omitted by Analysis: Omitted Manualy: ( Samples Used: 4 Targets Used: 6

Note: To show/hide columns in the Well Table, select/deselect the column name from
the Show in Table drop-down menu.

Assessing the well ~ When you analyze your own Comparative Cr experiment, look for standard deviation
table in your own in the replicate groups (Ct SD values). If needed, omit outliers (see “Improve Cp
experiments precision by omitting wells” on page 118).
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Section 11.1 Review Results 1 1
Assess amplification results using the Amplification Plot

Assess amplification results using the Amplification Plot

Ampl_ification plots The Amplification Plot screen displays amplification of all samples in the selected
available for wells. There are three plots available:

viewing * ARnvs Cycle — ARn is the magnitude of normalized fluorescence signal generated
by the reporter at each cycle during the PCR amplification. This plot displays ARn
as a function of cycle number. You can use this plot to identify and examine
irregular amplification and to view threshold and baseline values for the run.

* Rnvs Cycle — Rn is the fluorescence signal from the reporter dye normalized to
the fluorescence signal from the passive reference. This plot displays Rn as a
function of cycle number. You can use this plot to identify and examine irregular
amplification.

* Cyvs Well — Cyis the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Cr as a function of well
position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

Purpose The purpose of viewing the amplification plot for the example experiment is to
identify:
* Correct baseline and threshold values
¢ OQutliers
View the 1. From the Experiment Menu pane, select Analysis » Amplification Plot.
Amplification Plot Note: If no data are displayed, click Analyze.

2. Display the LPIN1 wells in the Amplification Plot screen:
a. Click the Plate Layout tab.
b. From the Select Wells drop-down menus, select Target, then LP1N1.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 99
Experiments User Guide for Relative Standard Curve and Comparative Cr Experiments



Chapter 11 Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

The Plate Layout screen should look like this:

= =
o o
o .
= =

e

P

iR EE

"R EERER N R Y

1 Liver Liver Liver Liver 2 2 -
o W W B e mi o o
* Livel Liver Liver Liver 2 o
i v o o T o
1 Liver Liver Liver Liver Liver 2 .
(i oE O o I O
. w Liver w Liver Liver D@ O :::r Liver w Liver
TNeHs: @722 0 Empty
Well Summary: In Platz: 96 Set Up: 96 Analyzed: 96 Flzgged: 10 @mitted by Anahysis: Omitted Manually: 0 Samples Used: 4 Targets Uszd: 6
3. In the Amplification Plot screen, enter:
Menu Selection
Plot Type ARn vs Cycle (default)
Plot Color Well (default)
— Check (default)
(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)
4. View the baseline values:
a. From the Graph Type drop-down menu, select Linear.
b. Select the Baseline check box to show the start cycle and end cycle.
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Assess amplification results using the Amplification Plot

c. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescent signal is
detected. In the example experiment, the baseline is set correctly.

Amplification Plot <
Plot Settings
Plot Type:[ARn vs Cycle v Graph Type:[Linear v Plot Color: [Well ~
[ save current settings as the default

Amplification Plot

A
o
1]
[
i
[

50
as
40
35 ]

30

20

A B c D ME NF HGc HH

Options

Target: |All w | Threshold:

v

Well Summary: In Pizte: 96 St Up: 96 Anzlyzed: 96 Flagged: 10 Omitted by Analysis: 0 Omitted Manuzlly: 0 Samples Used: 4 Targets Used: 6

5. View the threshold values:

Menu Select

Graph Type Log
Target LPTN1

a. Select the Threshold check box to show the threshold.

b. Verify that the threshold is set correctly. In the example experiment, the
threshold is in the exponential phase.

Ampiification Plot <

Plot Settings
Plot Type:[ARn vs Cycle w| Graph Typezlog v Plot Color: el ~
[ 'save current settings as the defautc

£ P By

Amplification Plot
1E01

1E00

279306

£ o
-V?A B c
‘Options
Target: [LPINL ] Threshold: [ Auto o
Show: [¥] Threshold — [] Baseline Start: Well B Target 4 Baseline End: Well (M Target 4=
‘Well Summary: In Plat=: 06 SetUp: 96 Anzhyzed: 06 Flagged: 10 Omitted by Analysie: Omitted Manuzly: 0 Samplas Used: 4 Targets Used: 6
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Assess amplification results using the Amplification Plot

6. Locate any outliers:
a. From the Plot Type drop-down menu, select Ct vs Well.

b. Look for outliers from the amplification plot. In the example experiment,
there are no outliers for LPINI.

Amplification Plot <
Plot Settings
Plot Type:[CT vs Well v Graph Type: Plot: Color: [Well v
[] Save curment settings as the default
PP aly R
Amplification Plot
1E02
on
v- v- a
1E01
& 1E00
0.1
001
5 o W5 EY ES 30 a5 E P £ EY &5 o 7s E) s EY E3
Well Number
L
LI B c D Mle HF Hc WH
Options
Target: [(PINL | Threshold: L
Show: — [ Baseline Start: Wel ! Target 4 Baselne End: Well (M Target 4
v
Well Summary: In Plate: 96 St Up: 06 Anshyzed: 06 Flagged: 10 Omitted by Analysis: 01 Omitted Manually: 0 Samples Used: 4 Targets Used: 6

7. Repeat steps 2 through 6 for the GH1, TGFB1, LIPC, ACTB, and CCKAR wells. In
the example experiment, there is seven outliers for CCKAR and three outliers for
GH1. You will omit these wells in the troubleshooting section (“Improve Ct
precision by omitting wells” on page 118).

Tips for analyzing When you analyze your own Comparative Ct experiment, look for:
your own e Outliers

experiments * A typical amplification plot — The QuantStudio™ 12K Flex Software
automatically calculates baseline and threshold values based on the assumption
that the data exhibit a typical amplification plot. A typical amplification plot has
four distinct sections:
— Plateau phase

— Linear phase
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Assess amplification results using the Amplification Plot

— Exponential (geometric phase)
— Baseline
A typical amplification plot should look like this:

Amplification Plot

Plot Settings
Plot Type:[ARn vs Cycle v| Graph Type:[Log  |v| Plot Color:[well ~
[ save current settings as the default
AL B R
Amplification Plot
1E01
S
1E00
279306
&£ o1
&
0.01
25 %y N
0.001 = =
z P I B 1o = i Ta T EY 0 2 % 0 aa w0
ENA BB MNC BND MNE BNF ENG HEH
Options
Target: [LPIN1 v | Threshold: [#] Auto
Show: [7] Threshold — [7] Baseiine SEarts wel I Target 4 Baseline End: Well (M Target 4
Well Summary: In Piste: 96 Set Up: 96 Anatyzed: 96 Flagged: 10 Omitted by Analyss: 0 Omitted Manualty: 0 Samples Used: 4 Targets Used: 6

IMPORTANT! Experimental error (such as contamination or pipetting errors)
can produce atypical amplification curves that can result in incorrect
baseline and threshold value calculations by the QuantStudio™ 12K Flex
Software. Therefore, Life Technologies recommends that you examine the
Amplification Plot screen and review the assigned baseline and threshold
values for each well after analysis completes.

Note: If you use the Relative Threshold algorithm to analyze an experiment
that includes amplification, select to view the analysis results using the ARn
vs Cycle, Rn vs Cycle, or Cgry vs Well plot type and Linear or Log graph type.
Also select the Show Crt check box to view the derived fractional cycle on
the amplification plot.

Ampiification Plot
Plot Settings
Plot Type:[An vs Cycle v] Graph Types[log ] Plot Color:[Well v

[ Save current settings as the default

Amplification Plot

0001 % e —

C M WEMF MG MK ‘

| Threshold:

- Wel W Target & Baseine End: Well M Target 4

Well Summary: Inpie: 96 StUpia4 Anayasd: 42 Fagged2 Omtad by Analys: 0 Omited Manualy: 2 Samples Used: 7 Targets Used: 2
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Assess amplification results using the Amplification Plot

e Correct threshold values

Threshold Set Correctly 10

The threshold is set in the
exponential phase of the

amplification curve.
0.279306

Threshold settings above or
below the optimum increase | & os
the standard deviation of the
replicate groups.

0.001
2

Threshold Set Too Low 0

The threshold is set below
the exponential phase of the
amplification curve. The
standard deviation is
significantly higher than that
for a plot where the threshold
is set correctly. Drag the
threshold bar up into the
exponential phase of the 0.005058
curve.

ARN

0.1

0.001

Threshold Set Too High 10

The threshold is set above 2575626 e
the exponential phase of the
amplification curve. The
standard deviation is
significantly higher than that
for a plot where the threshold
is set correctly. Drag the
threshold bar down into the
exponential phase of the
curve.

01

ARN

0.001
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Assess amplification results using the Amplification Plot

e Correct baseline values

Baseline Set Correctly 1o

The amplification curve
begins after the
maximum baseline.

o1

ARN

0001

Baseline Set Too Low 10

The amplification curve
begins too far to the
right of the maximum
baseline. Increase the
End Cycle value.

N
ooo1 AL S
IR I EEEEEEEEEEEE

Cycle

Baseline Set Too High 0

The amplification curve
begins before the
maximum baseline.
Decrease the End Cycle
value.

0.1

ARN

0.001

* View the analyzed data using the relative threshold settings

The QuantStudio™ 12K Flex Software provides the Relative Threshold method to
view the analyzed data. The relative threshold algorithm lets you compare the
data per well and per target. These options allow analysis of a single gene across
samples or, alternatively, a single sample across genes with no dependency on
targets, thereby reducing variability.

To view the analyzed data using the relative threshold settings, see “Adjust
analysis settings” on page 115.
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Confirm accurate dye signal using the Multicomponent Plot

If your experiment does not meet the guidelines above, troubleshoot as follows:
*  Omit wells (see “Improve Cp precision by omitting wells” on page 118).
Or

* Manually adjust the baseline and/or threshold (see “Adjust analysis settings” on
page 115).

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.

Purpose In the Comparative Cy example experiment, you review the Multicomponent Plot
screen for:

e ROX™ dye (passive reference)
e FAM'"™ dye (reporter)
* Spikes, dips, and/or sudden changes

* Amplification in the negative control wells

View the 1. From the Experiment Menu pane, select Analysis » Multicomponent Plot.
Multicomponent Note: If no data are displayed, click Analyze.
Plot

2. Display the unknown and standard wells one at a time in the Multicomponent
Plot screen:

a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select Dye.

4. Click Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.
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Confirm accurate dye signal using the Multicomponent Plot

5. Check the FAM dye signals. In the example experiment, the FAM dye signal
increases throughout the PCR process, indicating normal amplification.

Multicomponent Plot

Plot Settings

Plat Color sgend o - B

[] save current settings as the default
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Well Summary: In Plste: 96 St Up: 96 Analyzed: 96 Fiagged: 10 Ormitted by Analysis: Omitted Manuslly: 0 Samples Used: 4 Targets Used: 6

6. Select the negative control wells one at time and check for amplification. In the
example experiment, there is no amplification in the negative control wells.

Multicomponent Plot
Plot Settings

[[] save current settings as the default
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Determine signal accuracy using the Raw Data Plot

Tips for confirming ~ When you analyze your own Comparative Ct experiment, look for:

dye accuracy in * Passive reference — The passive reference dye fluorescence level should remain
your own relatively constant throughout the PCR process.
experiment * Reporter dye — The reporter dye fluorescence level should display a flat region

corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

* Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

* Negative Control wells — There should not be any amplification in the negative
control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.

About the example  Inthe Comparative Ct example experiment, you review the Raw Data Plot screen for a
experiment stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data 1. From the Experiment Menu pane, select Analysis » Raw Data Plot.
Plot Note: If no data are displayed, click Analyze.

2. Display all 48 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.

3. Click Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Note: The legend displays the color code for each row of the reaction plate (see
the legend in the Raw Data Plot shown below).
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Section 11.1 Review Results
Determine signal accuracy using the Raw Data Plot

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.

Raw Data Plot <

Raw Data Plot
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Show Cycle 40
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well Summ:

PCR Filter

ary:

In Plste: 96 Set Up: 96

Anahyzed: 06 Flagged: 10 Omitted by Anahysis: [ Omitted Manualy: 0 Samples Used: 4 Targets Used: 6

The filters used for the example experiment are:

¥1(470£15)

m1(520+15)

Emission Filter

m2(558+11) m3(586+10) m4(623x14) m5(682+14) m&(711+12)

*¥2(520410)

x3(550+11)

Excitation Filter

x4(580£10)

#5(64010)

x6(66210)

Melt Curve Filter

%#1(470+15)

ml(520£15)

Emission Fitter

m2(558+11) m3(586:x10) m4(623x14) m5(682+14) m6(711 £12)

%2(520+10)

%3(550+11)

Excitation Filter

*4(580+10)

%5(640+10)

#6(662+10)
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View the endogenous control profile using the QC Plot

Tips for When you analyze your own Comparative Ct experiment, look for the following in
determining signal  each filter:

accuracy in your ¢ Characteristic signal growth

own experiment * No abrupt changes or dips

View the endogenous control profile using the QC Plot

In the Comparative Cy experiment, the QC Plot screen displays the Endogenous
Control Profile plot for all the targets in the experiment. The QC Plot serves as a tool to
help you choose the best endogenous control for that experiment. The endogenous
control profile plot is a visual display of the Cr level of the endogenous control across
the sample. You can view up to four endogenous controls at a time. The sample is
plotted on the X-axis, and Cr is plotted on the Y-axis. The expression is viewed as a
color and shape combination in the plot. Endogenous controls are also known as
reference genes.

Example In the example experiment, you can view the endogenous control profile of GH1,
experiment LPIN1, TGFB1, L1PC, ACTB, and CCKAR in the QC Plot screen.

settings

View the QC Plot 1. From the Experiment Menu pane, select Analysis » QC Plot.

Note: If no data are displayed, click Analyze.

2. In the QC Plot screen, click Target Table.

a. In the Candidate Control column, select the check box of the target of the
endogenous control profile to plot. In the example experiment, the
endogenous controls selected are GH1, LP1N1, TGFB1, and L1PC.

b. Select a color for each target, from the Color drop-down menu.
c. Select a shape for each target, from the Shape drop-down menu.

3. Click the View Replicate Results Table.

4. Select the check box of the samples to plot. In the example experiment, all the four
samples, Brain, Heart, Liver, and Lung are selected.

5. Click Ij Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.
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The QC Plot in the Comparative Ct example experiment looks like this:

o

Section 11.1 Review Results
Review the flags in the QC Summary

Y o - — |»| candidate Control Target Color Shape
¥ 2 B [ H g P
£P B HEBE aH1 — E —
LP1NL I o v
p TGFB1 v a v
Endogenous Control Profile L1PC — = <
(i ACTB ~ ~
s O CCKAR v v
150 .‘./\‘
325 View View Biological Groups ]
Omit Sample Target CT Mean | ACT Me...| ACT SE AMNCT RQ
300 FI Heart GH1 34.427 12.500 0.194 2.454
Brain GH1 34.546 14.963 0.188 0
275 [F] Heart LPIN1 26.181 4.264 0.106 -1.618
Brain LPIM1 25.465 5.882 0.075 0
250 [0 Heart TGFB1 26.814 4.897 0.088 -2.313
Brain TGFB1 26.793 7.21 0.091 0
e il Heart L1PC 32.015 10.097 0.106 -1.957
Brain L1PC 31.637 12.054 0.13 0
Heart ACTB 21,917
5 200 Brain ACTB 19.583
[F] Heart CCKAR 37.383 15.465 0.387 1.453
175 Brain CCKAR 33.594 14.012 0.062 0
| Lung GH1 35.214 15.177 0.351 0.214
15.0 O Liver GH1 37.503 17.195 0.185 2.232
[F] Lung LPIN1 26.56 6.523 0.028 0.641
125 [ Liver LPIM1 26.315 6.007 0.038 0.124
|l Lung TGFB1 25.12 5.083 0.017 -2.127
100 O Liver TGFB1 27.198 6.89 0.085 -0.32
| Lung L1PC 34.204 14.167 0.174 2.113
O Liver L1PC 24,431 4.123 0.039 -7.931
75 Lung ACTB 20.037
Liver ACTB 20.308
50 | Lung CCKAR 38.495
O Liver CCKAR
25
< >
00 .
Brain Heart Liver Lung
Sample
& GH1 @ LP1NT == TGFB1 4 L1PC
Well Summary: In Plsts: 06 Set Up: 06 Anslyzed: 06 Flagged: 10 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 4 Targsts Usd: 6

Note: This example experiment does not define Biological Groups.

Review the flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags,
including the flag frequency and location for the open experiment.

Review the QC Summary screen in the Comparative C1 example experiment for any
flags triggered by the experiment data. Wells A11, B11, C11, E1, F1, and G1 have data
that triggered the HIGHSD flag; wells E11, E12, F11, and F12 have data that triggered

the NOAMP flag, and wells E11, E12, F12, and G12 have data that triggered the

EXPFAIL flag.
View the QC 1. From the Experiment Menu pane, select Analysis » QC Summary.
Summary Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the experiment. If the frequency is > 0, the flag appears somewhere in

the experiment; the well position is listed in the Wells column.

In the example experiment, there are ten flagged wells.
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Review the flags in the QC Summary

3. In the Flag Details table, click each flag with a frequency >0 to display detailed
information about the flag. In the example experiment. The HIGHSD flag appears
six times, in the wells A11, B11, C11, E1, F1, and G1, indicating high standard
deviation in the replicate group. The NOAMP flag appears four times, in the
wells E11, E12, F11, and F12, indicating no amplification in the replicate group.
The EXPFAIL flag appears in the wells E11, E12, F12, and G12, indicating that the
exponential algorithm failed.

Note: The HIGHSD flag appears because the Ct values exceed the expected range
due to low expression of the CCKAR gene in the Heart sample and the GH1 gene
in the Lung sample.

4. (Optional) For those flags with frequency >0, click the troubleshooting link to view
information on correcting the flag.

The QC Summary for the example experiment looks like this:

T

Flag: Description Fregquency Wells
AMPNC Amplification in negative control 0
BADROX Bad passive reference signal (]
OFFSCALE Fluorescence is offscale 0
HIGHSD High standard deviation in replicate group & All, B11, C11, E1, F1, Gl
MNOAMP Mo amplification 4 E11, E12, F12, G12
NOISE Moise higher than others in plate 0
SPIKE MNoise spikes 0
MNOSIGNAL Mo signal in well (]
OUTLIERRG Qutlier in replicate group 0
EXPFAIL Exponential algorithm failed 4 Ei1, E12, F12, G12
BLFAIL Baseline algorithm falled (]
THOLDFAIL Thresholding algorithm failed 0
CTFAIL Cr algorithm failed 0
AMPSCORE AMP Score o
Total Wells: 96 | Processed Wells: 96 Manually Omitted Wells: 0 | Targets Used: 6
Wells Set Up: 96 | Flagged Wels: 10 Analysis Omitted Wells: 0 | Samples Used: 4
‘Well Summary: In Plstz: 96 Set Up: 96 Anzlyzed: 06 Flagged: 10 Omitted by Anabysis: [ Omitted Manualhy: 0 Samples Uszd: 4 Targets Uszd: §
Possible fl_ags The flags listed below may be triggered by the experiment data.
Flag Description
Pre-processing flag
OFFSCALE Fluorescence is offscale
Primary analysis flags
BADROX Bad passive reference signal
NOAMP No amplification
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For more information

Flag Description
NOISE Noise higher than others in plate
SPIKE Noise spikes
NOSIGNAL No signal in well
EXPFAIL Exponential algorithm failed
BLFAIL Baseline algorithm failed
THOLDFAIL Thresholding algorithm failed
CTFAIL | Cy algorithm failed
AMPSCORE | Amplification in the linear region is below a certain

threshold, corresponding to the score set in the
analysis settings

Secondary analysis flags

OUTLIERRG Outlier in replicate group
AMPNC Amplification in the negative control
HIGHSD High standard deviation in replicate group

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL,
THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in
the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

For more information

For more information on... Refer to... Part number

Publishing data Chapter 1in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050
System Multi-Well Plate and Array Card Experiments
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For more information
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Section 11.2 Adjust parameters for re-analysis of your own experiments
Adjust analysis settings

Section 11.2 Adjust parameters for re-analysis of
your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cr), flags, and advanced options.

If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable
for your own experiment, you can change the settings in the Analysis Settings dialog
box, then reanalyze your experiment.

View the analysis 1. From the Experiment Menu pane, select Analysis.
settings

2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab:

e Crp Settings

* Flag Settings

¢ Relative Quantification Settings

* Advanced Settings

The Analysis Settings dialog box for a Comparative Ct experiment looks like this:

.'.. Analysis Settings for 96-Well Fast Comparative Ct Example

s, then chang

— Data Step Selection

Flag Settings Relative Quantification Settings Advanced Settings

default se anal rgets in this experiment. To use different settings for a target, select the target from the table, deselect Use Default

analysis have been collected are displayed.

Stage 2, Step 2 (v

Select the step and stage to use for CT analysis. Only stage/step combinations for which data suitable for CT Select the algorithm to calculate CT.

Algorithm Settings

Baseline Threshold |+

~— Default Cr Settings

Default CT settings are used to calculate the Cr for targets without custom settings, To edit the default settings, dick Edit Default Settings.

Threshold: AUTO Baseline Start Cycle: AUTO Baseline End Cycle: AUTO Edit Default Settings

~— Select a Target

~—CT Settings for ACTB——————————————

Target Threshold Baseline Start Baseline End Cr Settings to Use: [] Default Settings

e i i i - Automatic Threshold

CCKAR 0.170213 AUTO AUTO

GH1 0.122748 AUTO AUTO

LiPC AUTO AUTO AUTO

LP1M1 0.279306 3 25

TGFEL AUTO AUTO AUTO

v

Save to Library Load from Library

Revert to Default Analysis Settings Apply Analysis Settings [W
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Adjust analysis settings

Adjust analysis
settings

3.

View and, if necessary, change the analysis settings (see “Adjust analysis settings”
below).

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well
Plate and Array Card Experiments.

Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to
Default Analysis Settings.

Cr Settings

Data Step Selection

Use this feature to select one stage/step combination for Cy analysis when there is
more than one data collection point in the run method.

Algorithm Settings

You can select the algorithm that determines the Cy values. There are two
algorithms: Baseline Threshold (the default) and Relative Threshold.

The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for quantification.

The Relative Threshold algorithm is a well-based analysis based on the PCR
reaction efficiency and fitted to the Amplification curve. This setting is ideal for a
single sample across genes with no dependence on targets, thereby reducing
variability. It is not necessary to set either a baseline or a threshold when you use
the Relative Threshold algorithm, so any settings for baseline or threshold will
not affect the analysis.

Default Ct Settings

Use the default Cr settings feature to calculate Cr for the targets that do not have
custom settings. To edit the default settings, click Edit Default Settings.

Cr Settings for Target

When you manually set the threshold and baseline, Life Technologies
recommends:

Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:

¢ Above the background.

¢ Below the plateau and linear regions of the amplification curve.
¢ Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.
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Adjust analysis settings

Flag Settings
Use the Flag Settings tab to:

Adjust the sensitivity so that more wells or fewer wells are flagged.
Change the flags that are applied by the QuantStudio™ 12K Flex Software.

To adjust the flag settings
1.
2.

In the Use column, select the check boxes for flags to apply during analysis.

(Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of Ct SD. For some flags, analysis results calculated before
the well is rejected are maintained.

Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.

The Flag Settings tab looks like this:

CT Settings

Flag Settings

Relative Quantification Settings

@ Confiqure the flags and fitering. In this panel you can enabie, disable, and configure fiags, and indicate if 2 well & to be rejected when a flag s raised.

Advanced Settings

Flag Description Use Attribute Condition Value Reject well
AMPHC Amplification in negat...| T < w [35.000 [}
BADROX Bad passive referenc... Bad passive referenc... |= ~ 0.600 [}
OFFSCALE Fluorescence is offscale .|
HIGHSD High standard deviati... CT standard deviation |= « [0.500 [}
HOAMP Mo amplfication Amplification algorith... |< w [0.100 [}
MOISE Moise higher than of... Relative noise > w [4.000 [}
SPIKE Moise spikes Spike algorithm result |= w [1.000 [}
MOSIGHAL Mo signal in well |
QUTLIERRG Outlier in replicate gr... L]
EXPFAIL Exponential algorithm...| .|
BLFAIL Baseline algorithm failed| .|
THOLDFAIL Thrasholding algorith... |
CTFAIL CT algorithm failed L]
AMPSCORE AMP Score AMP Score > w [1.000 [}

Save to Library Load from Library

Revert to Default Analysis Settings

Apply Analysis Settings [W
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Improve Cr precision by omitting wells

Relative Quantification Settings

Use the Relative Quantification Settings tab to:
¢ Change the type of analysis, singleplex or multiplex.
* Change the reference sample and/or endogenous control.
¢ Reject Outliers with ACpvalues less than or equal to the entered value.
Note: The Outlier Rejection settings apply only to multiplex reactions.

* Select the algorithm to use to determine the relative quantification minimum and
maximum values (error bars):

— Confidence Level - Select to calculate the RQ minimum and maximum
values based on the selected confidence level. Select the confidence level to
use.

— Standard Deviations - Select to calculate the RQ minimum and maximum
values based on the selected number of standard deviations. Select the
number of standard deviations to use.

Advanced Settings
Use the Advanced Settings tab to change baseline settings well-by-well.

Note: The baseline and threshold values do not affect the analysis using the Relative
Threshold setting.

To use custom baseline settings for a well-target combination:
1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target check box.

3. Define the custom baseline settings:

e TFor automatic baseline calculations, select the Automatic Baseline check
box.

e To define the baseline, deselect the Automatic Baseline check box, then enter
the baseline start cycle and baseline end cycle.

Improve C; precision by omitting wells

Experimental error may cause some wells to be amplified insufficiently or not at all.
These wells typically produce C values that differ significantly from the average for
the associated replicate wells. If included in the calculations, these outliers can result in
erroneous measurements; to ensure Ct precision, omit the outliers from the analysis.

In the Comparative Cy example experiment, there are seven outliers. To remove these
wells from analysis.

1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. In the Amplification Plot screen, select Cy vs Well from the Plot Type drop-down
menu.

3. Select the Well Table tab.
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Improve Cr precision by omitting wells

4. In the Well Table, identify outliers:

Q

b.

From the Group By drop-down menu, select Replicate.

Look for outliers in the replicate group (make sure they are flagged). In the
example experiment, wells A11, B11, C11, E1, F1, E11, E12, F11, F12, and G12
have outliers.

vell: ¥ Group by W Expand Al
# Well | Omit Flag Sample ... Target... | Task Dyes cr CT Mean | Ct SD ACT ACT Me... | ACT SE AACT RQ
28 O Brain LPINL UNKNOWN  FAM-NFQ-... 25.391 25.465 0.114 5.882 0.075 0.000 fad
40 D4 [ Brain LP1N1 NTC FAM-NFQ-... Undetermi...
6 A6 O Brain TGFB1 UNKNOWN  FAM-NFQ-... 26.743 26.793 0.144 7.210 0.091 0.000
18 B6 O Brain TGFB1 UNKNOWN  FAM-NFQ-... 26.680 26.793 0.144 7.210 0.091 0.000
30 6 ] Brain TGFBL UNKNOWN ~ FAM-NFQ-... 26.956 26.793 0.144 7.210 0.001 0.000
42 D6 | Brain TGFB1 NTC FAM-NFQ-... Undetermi...
9 A9 ] Heart ACTB UNKNOWN  FAM-NFQ-... 22.101 21.917 0.168
21 B9 O Heart ACTB UNKNOWH 21.880 21.917 0.168
3 0o O Heart ACTB UNKNOWN 21.771 21.917 0.168
45 D9 ] Heart ACTB NTC Undetermi...
B Heart - CCKAR
11 A1l O 1 Heart CCKAR UNKNOWN  FAM-NFQ-... 37.170 37.383 0.649 15.465 0.387 1.453
23 B11 ] 1 Heart CCKAR UNKNOWN ~ FAM-NFQ-... 38.111 37.383 0.649 15.465 0.387 1.453
35 Q1 ] 1 Heart CCKAR UNKNOWN ~ FAM-NFQ-... 36.867 37.383 0.649 15.465 0.387 1.453
47 D11 ol Heart CCKAR NTC FAM-NFQ-... Undetermi...
B Heart - GH1 T
1 Al ] Heart GH1 UNKNOWN ~ FAM-NFQ-... 34.655 34.427 0.292 12.509 0.194 -2.454
13 B1 O Heart GH1 UNKNOWN  FAM-NFQ-... 34.098 34.427 0.292 12.509 0.194 -2.454
25 a O Heart GH1 UNKNOWN  FAM-NFQ-... 34.527 34.427 0.292 12.509 0.194 -2.454
37 D1 O Heart GH1 NTC FAM-NFQ-... Undetermi...
B Heart - LIPC
7 A7 O Heart L1PC UNKNOWN  FAM-NFQ-... 31.978 32.015 0.073 10.097 0.106 -1.957
19 B7 ] Heart L1PC UNKNOWN ~ FAM-NFQ-... 32.099 32.015 0.073 10.007 0.108 -1.957
31 a O Heart L1PC UNKNOWN ~ FAM-NFQ-... 31.967 32.015 0.073 10.097 0.106 -1.857
43 D7 ol Heart L1PC NTC FAM-NFQ-... Undetermi...
B Heart - LP1IN1
3 A3 O Heart LPINT UNKNOWN ~ FAM-NFQ-... 26.259 26.181 0.073 4.264 0.106 -1.618
15 B3 O Heart LPINL UNKNOWN  FAM-NFQ-... 26.169 26.181 0.073 4.264 0.106 -1.618
27 G ] Heart LPIN1 UNKNOWN ~ FAM-NFQ-... 26.116 26.181 0.073 4.264 0.108 -1.618
39 D3 ] Heart LP1N1 NTC FAM-NFQ-... Undetermi...
B Heart - TGFB1
5 A5 1 Heart TGFBL UNKNOWN  FAM-NFQ-... 26.830 26.814 0.026 4.897 0.098 -2.313
17 B85 ] Heart TGFBL UNKNOWN ~ FAM-NFQ-... 26.784 26.814 0.026 4.897 0.008 -2.313
< >
Well Summary: In Plate: 96 Set Up: 96 Analyzed: 96 Flagged: 10 Omitted by Analyss: 0 Omitted Manually: 0 Samples Used: 4 Targsts Used: 6

Plate Layout =

c. Select the Omit check box next to outlying well(s).

vein Table W k¥ Groupby W Expand All
# Well | Omit Flag Sample ... Target.. | Task Dyes cT CT Mean | CT SD ACT ACT Me... | ACT SE AACT RQ
28 4 -] Brain LPIN1 UNKNOWN ~ FAM-NFQ-... 25.391 25.465 0.114 5.882 0.075 0.000 -~
40 D4 O Brain LPIN1 NTC FAM-NFQ-... Undetermi...
= Brain - TGFB1
6 A6 | Brain TGFBL UNKNOWN  FAM-NFQ-... 26.743 26.793 0.144 7.210 0.091 0.000
18 B6 O Brain TGFB1 UNKNOWN ~ FAM-NFQ-... 26.680 26.793 0.144 7.210 0.091 0.000
30 C6 O Brain TGFB1 UNKNOWN  FAM-NFQ-... 26.956 26.793 0.144 7.210 0.091 0.000
42 D6 ] Brain TGFB1 NTC FAM-NFQ-... Undetermi...
B Heart - ACTB
9 A9 O Heart ACTB UNKNOWN  FAM-NFQ-... 22.101 21.917 0.168
21 B9 1 Heart ACTB UNKNOWN ~ FAM-NFQ-... 21.880 21.917 0.168
3 O ] Heart ACTB UNKNOWN ~ FAM-NFQ-... 21.771 21.917 0.168
45 D9 ol Heart ACTB NTC FAM-NFQ-... Undetermi...
H Heart - CCKAR
11 A1l 1 Heart CCKAR UNKNOWN  FAM-NFQ-... 37.170 37.383 0.649 15.465 0.387 1453
23 Bl11 1 Heart CCKAR UNKNOWN ~ FAM-NFQ-... 38.111 37.383 0.649 15.465 0.387 1.453
35 a1 1 Heart CCKAR UNKNOWN  FAM-NFQ-... 36.867 37.383 0.649 15.465 0.387 1.453
47 D11 - Heart CCKAR NTC FAM-NFQ-... Undetermi...
B Heart - GH1 T
1 A O Heart GH1 UNKNOWN  FAM-NFQ-... 34.655 34.427 0.292 12.509 0.194 -2.454
13 Bl | Heart GH1 UNKNOWN ~ FAM-NFQ-... 34.098 34.427 0.292 12.509 0.194 -2.454
25 C O Heart GH1 UNKNOWN ~ FAM-NFQ-... 34.527 34.427 0.292 12.509 0.194 -2.454
37 0 ol Heart GH1 NTC FAM-NFQ-... Undetermi...
B Heart - LIPC
7 A7 ] Heart L1PC UNKNOWN ~ FAM-NFQ-... 31.978 32.015 0.073 10.097 0.106 -1.957
19 B7 O Heart L1PC UNKNOWN  FAM-NFQ-... 32.099 32.015 0.073 10.097 0.106 -1.957
31 a 1 Heart L1PC UNKNOWN ~ FAM-NFQ-... 31.967 32.015 0.073 10.097 0.108 -1.957
43 D7 ] Heart L1PC NTC FAM-NFQ-... Undetermi...
B Heart - LPIN1
3 A3 O Heart LPINT UNKNOWN  FAM-NFQ-... 26.259 26.181 0.073 4.264 0.106 -1.618
15 B3 ] Heart LPIN1 UNKNOWN 26.169 26.181 0.073 4.264 0.108 -1.618
27 G O Heart LPINT UNKNOWH 26.116 26.181 0.073 4.264 0.106 -1.618
39 D3 ol Heart LP1IN1 NTC FAM-NFQ-... Undetermi...
B Heart - TGFB1
5 A5 O Heart TGFB1 UNKNOWN ~ FAM-NFQ-... 26.830 26.814 0.026
17 B5 O Heart TGFB1 UNKNOWN  FAM-NFQ-... 26.784 26.814 @
— —— —_ = P o m
Well Summary: In Plate: 96 Set Up: 96 Anahyzed: 96 Flagged: 10 Omitted by Analysis: 0 Omitted Manualty: 0 Samples Used: 4 Targets Used: 6
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1 1 Chapter 11 Review Results and Adjust Experiment Parameters
Improve Cr precision by omitting wells

5. Click Analyze to reanalyze the experiment data with the outlying well(s)
removed from the analysis.

Note: You can also omit undesirable wells in an experiment from the Plate Layout
screen. To omit a well from the Plate Layout screen, right-click the well and select
Omit.
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Export Analysis Results

1. Open the Comparative Ct example experiment file that you analyzed in
Chapter 11.

2. In the Experiment Menu, click E Export.

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

3. Select QuantStudio'" 12K Flex format.
Note: Select 7900 Format if you want to export the Clipped Data.

4. Complete the Export dialog box as shown below:

Field or Selection Entry
Select Data to Results

export/ Select

Content

Export Data To One File

Export File Name 96-Well Fast Comparative Ct Example_QuantStudio_export
File Type *.txt

Export File Location | <drive>:\Applied Biosystems\QuantStudio 12K Flex
Software\experiments
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Chapter 12 Export Analysis Results

12

Your Export screen should look like this:

[] Auto Export Format : |Quant8tudi012KF\ex v| Export Data To: (3 One File ) Separate Files

Open file(s) when export is complete

Export File Location: ‘C:\Applled Biosystems\QuantStudio 12K FIexSnftware\Us| Export File Name: |96-We|l Fast Comparative Ct ExampleiQuan'| File Type: |[‘:;_‘] (=bd) |»

[] sample Setup [ Raw Data [ Amplfication [ Multicomponent [ tech. Rep. Results [ Bio. Rep. Results

Skip Empty Wels

Skip Omitted Wells

Select Content
ect Conten Well Well Position Sample Name Delta Ct 5D Target Name Task
All Fields & 1AL Heart 0.337 GHL UNKNOWN
2A2 Brain 0.326 GHL UNKNOWN
el 3A3 Heart 0.185 LPIN1 UNKNOWMN
Wel Pasition 474 Brain 0.147 LPINL UNKNOWN
5AS Heart 0.170 TGFBL UNKNOWN
Sample Name 6 A6 Brain 0.157 TGFBL UNKNOWN
787 Heart 0.183 L1PC UNKNOWN
Target Name 848 Brain 0.226 L1PC UNKHOWHN
9A9 Heart ACTB UNKNOWN
Task 10 A10 Brain ACTE UNKNOWN
Reparter 11A1L Heart 0.670 CCKAR UNKNOWN
12 A12 Brain 0.108 CCKAR UNKNOWN
Quencher 1381 Heart 0.337 GHL UNKHOWN
1482 Brain 0.326 GHL UNKNOWN
RQ 1583 Heart 0.185 LP1NL UNKNOWN
1684 Brain 0.147 LPINL UNKNOWN
RQ Hin 1785 Heart 0.170 TGF81 UNKNOWMN
Q Max 1886 Brain 0.157 TGFBL UNKNOWN
1987 Heart 0.183 L1PC UNKNOWN
cT B 2088 Brain 0.226 L1PC UNKNOWN
2189 Heart ACTB UNKNOWN
Ct Mean 22810 Brain ACTB UNKHOWHN
23811 Heart 0.670 CCKAR UNKNOWN
cesb 24812 Brain 0.108 CCKAR UNKNOWM
Quantity 25CL Heart 0.337 GHL UNKNOWN
26C2 Brain 0.326 GHL UNKNOWN
elta Ct Mean 27C3 Heart 0.185 LP1NL UNKNOWN
28C4 Brain 0.147 LPINL UNKNOWN
Detta Ct SD 20¢5 Heart 0.170 TGFBL UNKNOWN
Datta Dek Gt 30C6 Brain 0.157 TGFBL UNKNOWN
™| |= |

Reporter o]
FAM MNF A
FAM N
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM MF_
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF
FAM HF &

>

[W Save Export Set As Load Export Set Delete Export Set

Your exported file when opened in Notepad should look like this:

* Barcode = N ~
* Block Type = 96-well Block (0. ZmL) 5
* Calibration Background is expired = No
* calibration Background perfurmed on = 2011-08-08 01:15:53 AM SGT
* Calibration FAaM s expired =
* calibration FAM performed on = 2011—08—08 01:39:58 AM 5GT
* Calibration ROI is expired = No
* calibration ROI performed on = 2011-08-08 01:05:24 AM SGT
* Calibration ROX is expired = NoO
* calibration ROX performed on = 2011-08-08 02:07:15 AM SGT
* calibration svyBr is expired = No
* calibration syBrR performed on = 2011-08-08 01:58:11 AM SGT
* Calibration TAMRA is expired = No -
* calibration TAMRA performed on = 2011-08-08 02:16:10 AM SGT
* Calibration uniformity is expired = No
* calibration uniformity performed on = 2011-08-08 01:24:47 AM 5GT
® Calibration VIC is expired = No
* Calibration vIiC performed on = 2011-08-08 01:49:09 AM SGT
* Chemistry = TAQMAN
* Comment = NA
* Date Created = 2011-12-14 12:54:29 PM SGT
* Experiment File Name = C:‘\Program Files\Applied Biosystems‘qQuantstudiol2kFlex\examples\Gene Expression‘Comparative Ct'96-well Fast
Comparative Ct Example.eds
* Experiment Name = 96-well Fast comparative Ct Example
* experiment Run End Time = 2011-09-28 13:33:38 PM SGT
* Experiment Type = camparatw ve €T (AACT)
* Instrument Name = quantStudeemo
* TAstrument Serwa'\ Number quantstudiobema
* Instrument quantstudm 12K Flex
* Passive Re‘Ference = ROX
* quantification (yc'\e Method = Ct
* 5ignal smoothing on = true
* stage/ Cycle where Ana'\yms is performed = Stage 2, Step 2
* User Name = NA
[Resu'lts]
well position sample Name Target Name Task Reporter quencher RQ Min RQ Max CT €T Mean CT
qQuantity Delta €t Mean pelta €t sD Delta Delta €t Automatic €t Threshold Ct Threshn'\d Automatic Baseline
Base'hne start Baseline End efficiency EXPFAIL HIGHSD NOAMP
Al Heart GH1 UNKNOWN FAM NFQ-MGE 5.479 3.769 7.965 34.655 34.427 0.292 12.509 0.337 -2.4534
false 0.123  true 3 1.000 N N N
2 A2 Brain GH1 UNKNOWN FAM NFQ-MGE 1.000 0.696 1.436 34.186 34.546 0.320 14.963 0.326 0.000
false 0.123 true 3 20 1.000 N N N
3 A Heart LPINL UNKNOWN FAM NFQ-MGBE 2.648 25157, 32252, 25.965 25.884 0.076 3.967 0.185 -1.405
True 0.279 True 1.000 N N
4 A4 Erain LP1INL UNKNOWN FAM NFQ-MGE 1.000 0.850 8 [ia 77 24.883 24.955 0.133 5.372 0.147 0.000
True 0.279 True 3 19 1.000 N N N
5 A5 Heart  TGFB1 UNKNOQWN FAM NFQ-MGE 4.970  4.114 6.005 26.830 26.814 0.026 4,897 0.170 -2.313
true 0. 376 true 1.000 N N
6 Brain TGFB1 UNKNOWN FAM NFQ-MGB 1.000 0. 840 B i 3 26.743 26.793 0.144 7.210 0.157 0.000
true O 376 true 3 21 1.000 N N N
Z. Heart L1PC UNKNOWN FAM NFQ-MGE 3. 882 3.166 4.760 31.978 32.015 0.073 10.097 0.182 -1.957
True 0 422 True 3 25 1.000 N N N v
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adjusting parameters, re-analyzing own
experiments 59, 115
Advanced Settings tab 62, 118
Algorithm Settings
Baseline Threshold 60, 116
Relative Threshold 60, 116
amplification efficiency, factors affecting
PCR inhibitors 39
standard quantities 39
standard replicates 39
amplification plot
amplification efficiency 19, 39, 64
assessing amplification results 40, 99
reviewing baseline values 41, 100
reviewing outliers 43, 102
reviewing threshold values 42, 101
tips for analyzing own experiments 44, 103
viewing 30, 40, 88, 99
AMPNC flag 57, 114
AMPSCORE flag 57, 114
analysis settings
adjusting 59, 115
Advanced Settings 59, 115
Cr Settings 59, 115
defining 14, 75
Flag Settings 59, 115
Relative Quantification Settings 59, 115
Standard Curve Settings 59
Analyze
Amplification Plot 40, 99
Gene Expression Plot 47, 95
Multicomponent Plot 51, 107
QC Plot 55, 111
QC Summary 56, 112
Raw Data Plot 53, 109
Standard Curve Plot 37
Well Table 49, 97
Auto Export 65, 121
Automatic Baseline, advanced settings 62, 118
Automatic Threshold 60, 116

Index

BADROX flag 57, 113
baseline values, correcting 46, 105
BLFAIL flag 57, 114

C

cocktail mix 23, 82
comparative CT experiments
example experiment 71
overview 69
PCR options 70
required components, assemble 69
Cr settings
algorithm settings 60, 116
data step, selecting 60, 116
default 60, 116
target 60, 116
Cr Settings tab 60, 116, 57, 114

D

defining samples 14, 74
defining targets 14, 74
designing experiment
assigning targets, samples, and biological
groups 15,75
defining and setting up standards 15
defining experiment properties 13, 73
defining targets, samples, and biological
replicates 14, 74
setting up run method 17, 77
tips for designing own experiment 18, 78
dye accuracy
irregularities in the signal 53, 109
negative control wells 53, 109
passive reference 53, 109
reporter dye 53, 109

E

endogenous control, selecting 18, 78
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Index

experiment properties, defining 13, 73
EXPFAIL flag 57, 114
Export 65, 121

F

Flag Settings tab 61, 117

flags, QC
AMPNC 57, 114
AMPSCORE 57, 114
BADROX 57, 113
BLFAIL 57, 114
CTFAIL 57, 114
EXPFAIL 57, 114
HIGHSD 57, 114
NOAMP 57, 113
NOISE 57, 114
NOSIGNAL 57, 114
OFFSCALE 57, 113
OUTLIERRG 57, 114
SPIKE 57, 114
THOLDFAIL 57, 114

G

gene expression plot
assessing gene expression profile 47, 95
assessing own experiments 49, 97
viewing 48, 96

gene expression plots available
RQ vs Sample 48, 96
RQ vs Target 47, 95

H
HIGHSD flag 57, 114

improving Cr precision, omitting wells 63, 118

NOISE flag 57, 114
NOSIGNAL flag 57, 114

0]

OFFSCALE flag 57, 113
OUTLIERRG flag 57, 114

P

PCR options
1-step PCR 11, 70
2-step PCR 11, 70
Multiplex PCR 10, 70
Singleplex PCR 10, 70
preparing reactions
reaction mix 23, 82
reaction plate 24, 83
required materials 21, 81
sample dilutions 22, 82
standard dilution series 22
template 21, 81
tips for your own experiment 26, 84
preparing template
Complementary DNA 26
Genomic DNA 26
Pre-processing flag
OFFSCALE 57, 113
Primary analysis flags
AMPSCORE 57, 114
BADROX 57, 113
BLFAIL 57,114
CTFAIL 57, 114
EXPFAIL 57, 114
NOAMP 57,113
NOISE 57, 114
NOSIGNAL 57, 114
SPIKE 57, 114
THOLDFAIL 57, 114
publishing data 58, 114

M
multicomponent plot Q
confirming dye accuracy 51, 107 QC plots
tlps for analyzing own experiment 53, 109 Viewing endogenous Control profile 55, 111
viewing 51, 107 QC Summary
reviewing flags 56, 112
N
NOAMP flag 57,113
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raw data plot
determining signal accuracy 53, 109
tips for analyzing own experiments 54, 111
viewing 53, 109
reaction mix
components 21, 81
preparing reactions 23, 82
reactions, assembling materials for 21, 81
Relative Quantification Settings tab 62, 118
relative standard curve experiments
example experiment 11
overview 9
PCR options 10
required components, assemble 9
relative target quantity 9
required components
endogenous control 10, 69
negative controls 10, 70
reference sample 9, 69
replicates 10, 70
sample 9, 69
standard 10
standard dilution series 10
review results 37, 95
run
monitoring 29, 87
starting 29, 87
run method
reaction volume per well 17, 77
settingup 17, 77
thermal profile 17, 77
viewing 31, 90
Run screen
Amplification Plot 30, 88
Run Method 31, 90
Temperature Plot 30, 89
View Run Data 31, 90

S

sample dilutions, preparing reactions 22, 82
samples, defining 14, 74
Secondary analysis flags
AMPNC 57, 114
HIGHSD 57, 114
OUTLIERRG 57, 114
SPIKE flag 57, 114

Index

standard curve 18
standard curve plot
tips for analyzing own experiment 39
viewing and assessing 37
Standard Curve Settings tab 62
standard curve values
amplification efficiency 37
correlation coefficient 37
Crvalues 37
standard dilution series, preparing reactions 22
standards, defining and setting up 15

T

targets and samples, assigning 75
targets, defining 14, 74
targets, samples, and biological groups
assigning 15, 75
defining 14, 74
temperature plot, viewing 89
template, preparing reactions 21, 81
THOLDFAIL flag 57, 114
threshold cycle 39
threshold values, correcting 45, 105
tips for your own experiment, preparing reactions 26,
84
touchscreen, running the experiment from
Experiment View 32, 91
Plot View 33, 92
Time View 32, 91

w

well table
assessing own experiments 50, 98
identifying well problems 49, 97
viewing 50, 98
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About Genotyping Experiments

This chapter covers:

About data collection. ....... ... ... 5
About TagMan® SNP Genotyping assays. . . .. ....ovovrnenenanaraenenen... 6
About TagMan® MGB probes. . . .. ...ovvti e 6
5 nuclease assay ... .......... 6
Minimizing non-specific fluorescence. . ............. ... ... ... ..ol 7
Reading and analyzing the plates ................... ... .. 7
About the example experiment ............... ... . il 8

IMPORTANT! First-time users of the QuantStudio™" 12K Flex System please read
Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array
Card Experiments and Booklet 7, QuantStudio™ 12K Flex System Multi-Well Plate and
Array Card Experiments - Appendixes of this binder thoroughly. The booklets provide
information and general instructions that are applicable to all the experiments
described in this binder

Note: For more information about any of the topics discussed in this guide, access the
Help from within QuantStudio™ 12K Flex Software by pressing F1, clicking @ in the
toolbar, or selecting Help » QuantStudio™ 12K Flex Software Help.

About data collection

Genotyping experiments are performed to detect single nucleotide polymorphism
(SNP) variants of a target nucleic acid sequence in samples. The PCR reactions contain
primers designed to amplify the sequence containing the SNP and reagents to detect
two different alleles.

You can collect the results of a genotyping experiment in two different ways: At the
end of the experiment, or continuously during the experiment. Data collection at the
end of the experiment is called end-point data collection. Data collection during the
experiment run is considered real-time PCR. The real-time data helps further data
analysis.

In end-point data collection, the normalized intensity of the reporter dye, or Rn, is the
data collected. Some end-point experiments also include pre-PCR (data collected
before the amplification process) data collection. The system calculates the delta Rn
(ARn) value per the following formula:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized readings.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 5
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Chapter 1 About Genotyping Experiments

57nuclease assay

About TagMan®
SNP Genotyping
assays

About TagMan®
MGB probes

5" nuclease assay

A Genotyping assay detects variants of a single nucleic acid sequence, without
quantifying the target. The presence of two probes in each reaction allows Genotyping
of the two possible variants at the single nucleotide polymorphism (SNP) site in a
target sequence.

Each TagMan® SNP Genotyping Assay consists of a single, ready-to-use tube
containing:

* Two sequence-specific primers for amplifying the polymorphism of interest

* Two allele-specific TagMan® MGB probes for detecting the alleles for the specific

polymorphism of interest

Each allele-specific TagMan® MGB probe has:

* Areporter dye at its 5" end:

— VIC® dye is linked to the 5" end of the Allele 1 probe.
— FAM™ dye is linked to the 5" end of the Allele 2 probe.

The Allele 1 VIC® dye-labeled probe corresponds to the first nucleotide inside the
square brackets of the context sequence in the assay information file (AIF)
shipped with each order. The Allele 2 FAM™ dye-labeled probe corresponds to
the second nucleotide inside the square brackets of the context sequence in the
AIF. For the context sequence ATCGATT[G/T]ATCC, the VIC® dye-labeled probe
binds to the G allele, and the FAM"" dye-labeled probe to the T allele.

A minor groove binder (MGB), which increases the melting temperature (T,,) for
a given probe length and allows the design of shorter probes. The use of shorter
probes results in greater differences in T ,, values between matched and
mismatched probes, and more robust genotyping.

A non-fluorescent quencher (NFQ) at its 3" end, which allows for detection of the
reporter dye fluorescence with greater sensitivity than with a fluorescent
quencher.

The figure below is a schematic depiction of the 5" nuclease assay. During PCR:

Each TagMan® MGB probe anneals specifically to its complementary sequence
between the forward and reverse primer sites.

When the oligonucleotide probe is intact, the proximity of the quencher dye to the
reporter dye quenches the reporter signal.

AmpliTaq Gold® DNA polymerase extends the primers bound to the genomic
DNA template.
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Chapter 1 About Genotyping Experiments

Minimizing non-specific fluorescence

* AmpliTaq Gold® DNA polymerase (with its 5" nuclease activity) cleaves probes
that are hybridized to the target sequence.

* C(Cleavage of the probes hybridized to the target sequence separates the quencher
dye from the reporter dye, resulting in increased fluorescence by the reporter. The
fluorescence signal generated by PCR amplification indicates which alleles are
present in the sample.

1. Assay Components and DNATemplate
&J_\GB GB
I
Probe Probe )M" _
Forward primer ®—?_0 Reverse primer
G A <lllining,
° DNA | [G/A] 3'
& template %
3 [crm 5
2. Denatured Template and Annealing Assay Components 5o ] LEGEND
e S—
S V. VIC®dye
B B
Probe )&G Probe M/G Reverse primer
Y V-—w-——-f—@ \E,—~——~H ‘ F FAM™ dye
G A
Forward primer \ /
\ @ Quencher
3'/ [cml \5- Minor G
inor Groove
\MGdB Binder
3. Polymerization and Signal Generation S 3 S&nkléggn?grlgfe
.-l-?ze:/-e;se primer
GB
Probe ) = Probe
. V\ === Primer
Forward primer G )&GB
i 0 ===  Template
c Extended Primer
Match

Minimizing non-specific fluorescence

In TagMan® assays, fluorescence from nonspecifically bound probes is reduced,
because nucleotide mismatches between a probe and a sequence reduce the chances
that the probe will be cleaved. The probe’s short length means that a one-base-pair
mismatch will a have a larger negative effect on the binding. The mismatched probe
will not bind tightly to the allele; the AmpliTaq Gold® DNA polymerase will likely
displace the probe without cleaving the dye.

Reading and analyzing the plates

The QuantStudio™ 12K Flex Software genotypes the DNA samples from the reaction
plate simultaneously. First, the software normalizes the fluorescence of the reporter
dyes to the fluorescence of the passive reference dye in each well. Next, the software
plots the normalized intensities (Rn) of the reporter dyes in each sample well on an
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About the example experiment

Allelic Discrimination Plot, which contrasts the reporter dye intensities of the allele-
specific probes. Finally, the QuantStudio™ 12K Flex Software algorithmically clusters
the sample data, and assigns a genotype call to the samples of each cluster according to
its position on the plot.

Note: The QuantStudio™ 12K Flex Software clustering algorithm does not call
genotypes when only one genotype is present in an experiment.

4.0

Allele 2

35

3.0

LI s

24 24 34 24
Allele 1

The clustering of datapoints can vary along the horizontal axis (Allele 1), vertical axis
(Allele 2), or diagonal (Allele 1/Allele 2). This variation results from differences in the
extent of reporter dye fluorescent intensity after PCR amplification. The table below
shows the correlation between fluorescence signals and sequences in a sample.

A substantial increase in... Indicates...

VIC® dye-labeled probe fluorescence only | Homozygosity for Allele 1
FAM™ dye-labeled probe fluorescence only | Homozygosity for Allele 2

Both VIC® and FAM™ dye-labeled probes | Allele 1-Allele 2 heterozygosity
fluorescence

About the example experiment

To illustrate how to perform Genotyping experiments, this guide leads you through
the process of designing and performing an example experiment. The example
experiment represents a typical setup that you can use to quickly familiarize yourself
with a QuantStudio™ 12K Flex System.

The objective of the example Genotyping experiment is to investigate SNP rs8039,
where possible genotypes are AA, AC, and CC. In the example, 19 unknown genomic
DNA (gDNA) samples were genotyped using TagMan® Drug Metabolism Genotyping
Assay ID C___1240647_1_and C___1213693_10. The reactions were set up so that the

8 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Chapter 1 About Genotyping Experiments

About the example experiment

PCR primers and probes that target both alleles of SNP rs8039 were present in the
same well. The PCR was performed using the TagMan® Genotyping Master Mix and
run according to the protocol that is described in the Performing a TagMan® Drug
Metabolism Genotyping Assay.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 9
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About the example experiment
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Design the Experiment

This chapter explains how to design the example experiment from the Experiment
Setup menu.

This chapter covers:

Define the experiment properties. . .......... ... 11
Define SNPs and samples . .. ... 12
Assign markersand samples .......... .. ... o i il 14
Setuptherunmethod ...... ... ... ... . 16
For more information........... ... i 17

Note: To automatically export the analyzed data to a specified location, select the Auto
Export task from the Export screen, before running the experiment. For more
information on Auto Export, refer to Chapter 1 in Booklet 1, Getting Started with
QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments.

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the
QuantStudio™ Software. Enter:

Field Entry
Experiment Name 96-Well Genotyping Example
Barcode Leave field empty
User Name . Example User
Comments | Genotyping example
Block | 96-Well (0.2mL)
Experiment Type Genotyping
Reagents TagMan® Reagents
Ramp speed Standard

Select all three data-collection check boxes: Pre-PCR, Amplification, and Post-PCR
collection methods:

Pre-PCR Read Checked
Amplification Checked
Post-PCR Read Checked
Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 1
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2 Chapter 2 Design the Experiment
Define SNPs and samples

Save the experiment.
Your Experiment Properties screen should look like this:

How do you want to identify this experiment?

* Experiment Name: |96-Well Genotyping Example Comments: |Genotyping example e

Barcode:

User Name: Example User

Which block are you using to run the experiment?

[ 384-Well ] [ Array Card ] v 96-Well (0.2mL) | [ Fast 96-Well (0.1mL) ]

What type of experiment do you want to set up?

[ Standard Curve ] [ Relative Standard Curve ] [ Comparative Ct (AACT) } [ Melt Curve ]

| v Genotyping | [ Presence/Absence ]

Which reagents do you want to use to detect the target sequence?

| o TaqMan® Reagents | [ Other ]

What properties do you want for the instrument run?

| s Standard | [ Fast ]

Include: Pre-PCR Read Amplfication

Define SNPs and samples

Click Define to access the Define screen. Enter:

1. SNP Assays

SNP
assay NCBISNP Context Allele Reporter | Quencher Allele Reporter | Quencher | Color
reference | sequence 1 2
name
SNP Allele1 | VIC NFQ-MGB | Allele2 | FAM NFQ-MGB .
Assay 1
SNP Allele1 | VIC NFQ-MGB | Allele2 | FAM NFQ-MGB -
Assay 2
Note: The NCBI SNP reference and Context sequence fields are optional fields
and are used for reference. They are not required to run an experiment.
2. Samples
Sample Color Sample Color
name name
Sample 1 [ Sample 11
Sample 2 [ Sample 12
Sample 3 [ ] Sample 13 | [ ]
Sample 4 [ Sample 14 [
12 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card

Experiments User Guide for Genotyping Experiments



Chapter 2 Design the Experiment
Define SNPs and samples

Sample Color Sample Color

name name
Sample 5 Sample 15 [ ]
Sample 6 [ Sample 16 [
Sample 7 [ Sample 17 [
Sample 8 [ | Sample 18 [
Sample ¢ [ Sample 19 [
Sample 10

3. Dye to be used as a Passive Reference

ROX

Your Define screen should look like this:

Import from Library

SNP Assay Name NCBI SNP Refer... | Context Segue...  Allele 1 Reporter Quencher Allele 2 Reporter Quencher
SNP Assay 1 Allele 1 VIC NFQ-MGB Allele 2 FAM MNFQ-MGB
SNP Assay 2 Allele 1 VIC NFQ-MGB Allele 2 FAM MNFQ-MGB

Color

Samples

Mew  Savetolibrary  Importfrom Library  Delete

Sample Name

Sample 1 |- v
Sample 2 |- v
Sample 3 |- v
Sample 4 |- w
Sample 5 || v
Sample 6 |- v
Sample 7 |- v
Sample 8 |- v
[samnle [

Passive Reference

Note: This example experiment does not define biological replicate groups. Leave

Biological Replicate Groups blank.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Chapter 2 Design the Experiment

Assign markers and samples

Assign markers and samples

Click Assign to access the Assign screen. Enter the SNP assays and samples:
e SNP Assay 1

Target name Well number Task Sample

SNP Assay 1 A1, E1 Unknown Sample 1
A2, E2 Sample 2
A3, E3 Sample 3
A4, E4 Sample 4
A5, Eb Sample 5
A6, E6 Sample 6
B1, F1 Sample 7
B2, F2 Sample 8
B3, F3 Sample 9
B4, F4 Sample 10
B5, Fb Sample 11
B6, Fé6 Sample 12
C1, G1 Sample 13
C2, G2 Sample 14
C3, G3 Sample 15
C4, G4 Sample 16
C5, G5 Sample 17
Cé, Gb Sample 18
D1, H1 ' Sample 19

SNP Assay 1 | D2 - D6 No Template |
H2 - Hb Control

14 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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* SNP Assay 2

Chapter 2 Design the Experiment

Assign markers and samples

Target name Well number Task Sample

SNP Assay 2 A7, E7 Unknown Sample 1
A8, E8 Sample 2
A9, E9 Sample 3
A10, E10 Sample 4
A1, EN Sample 5
A12, E12 Sample 6
B7, F7 Sample 7
B8, F8 Sample 8
B9, F9 Sample 9
B10, F10 Sample 10
B11, F11 Sample 11
B12, F12 Sample 12
C7, G7 Sample 13
C8, G8 Sample 14
C9, G9 Sample 15
C10, G10 Sample 16
C11, G111 Sample 17
C12, H12 Sample 18
D7, H7 Sample 19

SNP Assay 2 D8 - D12 No Template
HS - H12 Control

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Chapter 2 Design the Experiment
Set up the run method

Your Assign screen should look like this:

e W Plate Layout

N
SNP Assay 1 I ~| o s i e :-:
TSNP Assay 2 : - =

=

2 3 4 5 ) 7 8 k] 10

4 Sample § 3 4 Sample § 3
w v Jv fv v Is Iv Jv Qv Jv Qv Qv |

Sample 7 & El Sample 10 Sample 11 | Sample 12 Sample 7 & El Sample 10 Sample 11 | Sample 12
w Iv v v v v v v v Iv v Qv |
Eilin i i Gl e O Gl N G G Gl

4 Sample § 3 4 Sample § 3
5 v v fv Iv Iv v fv Iv Iv Qv v

Sample 7 & El Sample 10 Sample 11 | Sample 12 Sample 7 & El Sample 10 Sample 11 | Sample 12
als " 4v v §5 Iv Uv v v U§v v U5 Qv |

13 14 15 17 13 14 15 17
2 fv Iv fv v &v v Iv Iv v Qv

@

A

T

wels: [ 36 [ 12 [ oEHo[Ho 0 Empty

Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the
Graphical View tab. Enter:

* Reaction Volume Per Well: 50 uL

e Thermal Profile

Ramp .
Stage Step rate Temperature Time

Pre-Read Stage Step 1 1.6°C/s 60°C 30 seconds
Hold Stage Step 1 1.6°C/s 95°C 10 minutes
PCR Stage Step 1 1.6°C/s 95°C 15 seconds
* Number of Cycles: 40 Step 2 1.6°C/s 60°C 1 minute

(default)
¢ Enable AutoDelta: Unchecked

(default)
e Starting Cycle: Disabled

when Enable AutoDelta is

unchecked
Post-Read Stage Step 1 1.6°C/s 60°C 30 seconds

16 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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For more information

Your Run Method screen should look like this:

Include:

Run Method

Reaction Volume per Well: pL
(] Optical Filkers

Pre-Read Stage

Hold Stage

PCR Stage Post-Read Stage

MNumber of Cycles:
Starting Cycle:

Stept Stept Stept Step2 Stept
< >
Legend
’V Data Collection On |* = Data Collection Off A AutoDefra On A AutoDelts OFf
For more information
For more information on... Refer to... Part number
Consumables Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050
System Multi-Well Plate and Array Card Experiments
Appendix A in Booklet 7, QuantStudio™ 12K Flex System Multi-Well
Plate and Array Card Experiments - Appendixes
Data collection Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050
System Multi-Well Plate and Array Card Experiments
Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays Application 127AP05-03
Note
Using alternative setup Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050

System Multi-Well Plate and Array Card Experiments

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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For more information
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Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Genotyping example
experiment.

This chapter covers:

Assemble required materials ........ ... 19
Prepare the sample dilutions ............... ... ... . o il 19
Prepare the reaction mix (“cocktail mix”)............... ... oo 20
Prepare the reaction plate . . ........ ... ... i 20
Tips for preparing reactions for your own experiments. . ................... 22
For more information. . ......... ...t e 22

Assemble required materials

Items listed in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-
Well Plate and Array Card Experiments

Samples - Sample 1 - Sample 19

Example experiment reaction mix components:
— TaqMan® Genotyping Master Mix (2X)
— SNP 1 Assay Mix (20X)
— SNP 2 Assay Mix (20X)

Prepare the sample dilutions

For the example experiment, two targets are assigned to 38 wells each. Each well
contains 20 ng of Coriell DNA. The stock concentration is 10 ng/uL.

To prepare the sample dilutions:

1.

Label a separate microcentrifuge tube for each sample to be diluted.

Note: You can also use a MicroAmp® Optical 96-Well Reaction Plate to prepare
the sample dilutions.

Add 2 pL of sample stock to each empty tube.

Add 48 L of sterile water (diluent) to each tube, such that each working stock
tube has a final concentration of 10 ng/uL

Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

Place the diluted samples on ice until you prepare the reaction plate.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 19
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3 Chapter 3 Prepare the Reactions
Prepare the reaction mix (“cocktail mix”]

Prepare the reaction mix (“cocktail mix”)

1. Label an appropriately sized tube for each reaction mix:

e SNP 1 Reaction Mix
e SNP 2 Reaction Mix

2. For SNP Assay 1, prepare a cocktail by adding the required volumes of each

component to the SNP 1 reaction tube, as detailed below.

Reaction volume

i o,
Reaction component Per well (pL) 38 Reactions + 10%
excess (uL)
Dry Wet Dry Wet
TagMan® Genotyping Master Mix (2X) 10.0 10.0 420.0 420.0
SNP Assay Mix (20X) 1.0 1.0 42.0 42.0
H,0, DNase-free 39.0 37.0 1,638.0 1,554.0
Total Reaction Mix Volume 50.00 48.00 2,100.0 2,016.0
3. Gently pipette the reaction mix up and down, then cap the tube.
4. Centrifuge the tube briefly.
5. Place the reaction mixes on ice until you prepare the reaction plate.
6. Repeat step 2 through 5 for the SNP 2 assay.
Note: Do not add the sample at this time.
Prepare the reaction plate
Example The reaction plate for the Genotyping example experiment contains:
experiment * A MicroAmp® Optical 96-Well Reaction Plate
reaction plate ¢ Reaction volume: 50 uL/well
components e 76 Unknown wells &
20 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Chapter 3 Prepare the Reactions

Prepare the reaction plate

The reaction plate for the example experiment looks like this:

uﬁ|r‘|ri|rﬁ|&|uﬁ|uﬁ|r‘|nﬁ|ﬁ&

| i - - . (R i (S I CE (I R

I

@

fal

@

‘:’eIIS:BEDIZDDDD 0 Empty ‘
To prepare the 1. Pipette 2.0 pL of the appropriate sample (20 ng of purified genomic DNA) into
reaction plate: each well of the reaction plate.
dried gDNA All wells belonging to the same Genotyping assay must contain approximately

the same quantity of sample or control.

Note: While preparing the reaction plate for your own Genotyping experiment,
add between 1 and 20 ng of purified DNA per reaction.

2. Dry down the samples by evaporation at room temperature in a dark, amplicon-
free location. (Cover the reaction plate with a lint-free tissue while drying.)

3. Transfer 48 uL of reaction mix to each well.

IMPORTANT! Make sure that no cross-contamination occurs from well to well.

Seal the reaction plate with adhesive film.
Vortex the reaction plate for 3 to 5 sec.

Briefly centrifuge the reaction plate.

N o g &

Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the plate again at a higher speed and for a longer period of time.
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Chapter 3 Prepare the Reactions

Tips for preparing reactions for your own experiments

To prepare the 1.

reaction plate: wet
gDNA

S L B o

Add 2 uL of DNA to the appropriate wells.

Add 2 pL of water to wells containing the NTCs.

Transfer 48 UL of reaction mix to the appropriate wells.

Seal the reaction plate with optical adhesive film.

Vortex the reaction plate for 3 to 5 seconds, then briefly centrifuge it.
Centrifuge the reaction plate briefly.

Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

Tips for preparing reactions for your own experiments

Tips for preparing When you prepare the samples for your own experiment:

samples » Use DNAse-free water to dilute the samples.

* Use the same quantity of DNA per well for each experiment.
Tips for preparing When you prepare the reaction mix for your own experiment, make sure you prepare
the reaction mix the reactions for each SNP separately.

Prior to use:

Mix the master mix thoroughly by swirling the bottle.
Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

Thaw frozen samples by placing them on ice. When thawed, resuspend the
samples by vortexing, then centrifuge the tubes briefly.

Tips for preparing ~ When you prepare the reaction plate for your own experiment:

the reaction plate .

Make sure the reaction locations match the plate layout in the QuantStudio™ 12K
Flex Software.

Load 1 to 20 ng of purified genomic DNA per reaction

All wells belonging to the same Genotyping assay must contain approximately
the same quantity of sample or control.

Multiple assays may be run on one reaction plate, but must be analyzed
separately.

For more information

For more information on...

Refer to... Part number

Assigning the reaction plate
components

Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K 4470050
Flex System Multi-Well Plate and Array Card Experiments

Sealing the reaction plate

Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K 4470050
Flex System Multi-Well Plate and Array Card Experiments
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Start the run

Run the Experiment

This chapter explains how to run the example experiment on the QuantStudio™ 12K
Flex Instrument.

This chapter covers:
Start the FUN. . . ..o 23
Monitor the run. . . ... .. 23

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the QuantStudio™ 12K Flex Instrument is in operation.

1. Open the Genotyping example file that you created using instructions in
Chapter 2.

2. Load the reaction plate into the instrument.

3. Start the run.

Note: To collect real-time data during a run, click the button on the Run
Method screen in the Experiment Setup menu.

Monitor the run

Monitor the example experiment run:

¢ From the QuantStudio™ 12K Flex Software using the Run screen, while the
experiment is in progress.

¢ From the Instrument Console of the QuantStudio™ 12K Flex Software (to monitor
an experiment started from another computer or from the QuantStudio™ 12K
Flex Instrument touchscreen).

¢ From the QuantStudio™ 12K Flex Instrument touchscreen.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 23
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Chapter 4 Run the Experiment
Monitor the run

From the 1. In the Instrument Console screen, select the instrument icon.

Instrument 2. Click Manage Instrument or double-click on the instrument icon.

Console of the

QuantStudio™ 12K 3. On the Manage Instrument screen, click Monitor Running Instrument to access

Flex Software the Run screen.

View the Amplification Plot

You can view the progress of the run in real time. During the run, periodically view all
the three plots available from the QuantStudio™ 12K Flex Software for potential
problems.

Click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab,
then select the wells to view.

The figure below shows the Amplification Plot screen as it appears at the end of the
example experiment.

Note: The Amplification Plot is not available for experiments that do not include the
PCR process.
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View the Temperature Plot

Chapter 4 Run the Experiment

Click Temperature Plot from the Run Experiment Menu.

Monitor the run

The figure below shows the Temperature Plot screen as it appears during the example

experiment.

Temperature Plot Current Temperatures

m o ii &R ~ .Cuver
/O /O o = L W sample
Block
Temperature Plot
115
110
103
100
SO O Lol : : Lol ; ; i
a0
u ; | i
80 ] 1
75 ] i
70 ] i ]
T oes i ! ‘
g;:g‘ A S A A A A S 1 A A A S S R A - L
2 s
45
40
3s
30
25
20 !
15
10
5
0 Temperature Plot
00:37:30 00:41:40 00:45:50 00:50:00 00:54:10 00:58:20 01:02:30 01:06:40 01:10:50 011500 01:19:10 01:23:20 01:27:30 01:31:40
Time Fixed View []
Note: The sample temperature displayed in the Current Temperatures group is a
calculated value.
View the Run Method
Click Run Method from the Run Experiment Menu.
The figure below shows the Run Method screen as it appears in the example
experiment.
Run Method Edit Run Method
Pre-Read Stage Hold Stage PCR Stage Post-Read Stage l:l
Mumber of Cycles:
Starting Cycle:
Stept Stept Stept Step2 Stept
< ¥
Legend
Data Collection On = Data Colection Off A AutoDelta On A AutoDeftz OFf
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Monitor the run

View run data
Click View Run Data from the Run Experiment Menu.

The figure below shows the View Run Data screen as it appears in the example
experiment.

Run Data Report
Experiment Name: 96-Well Genotyping Example

Start Time: 08-11-2011 13:39:455GT
Stop Time: 08-11-2011 15:13:21 SGT
Run Duration: 93 minutes 35 seconds
User Name: DEFAULT
Instrument Name: QuantStudioDemo
Firmware Version: 0.13.1
Software Version: QuantStudio 12K Flex Software v1.0
Instrument Serial Number: QuantStudioDemo
Sample Volume: 50.0
Cover Temperature: 105.0

Block Type: 96-Well Block (0.2mL)

Errors Encountered:

< ¥
From the You can also view the progress of the run from the touchscreen of the QuantStudio™
QuantStudio™ 12K 12K Flex Instrument.
Flex Instrument The Run Method screen on the QuantStudio™ 12K Flex Instrument touchscreen
touchscreen looks like this:

Experiment View

@ Time View Plot View i] Experiment View
Run Started: January 19 2012 - 01:54PM Sample: 60.0 °C
Reaction Volume: 20 pL Heated Cover (Set Point): 105.0 °C [105.0 °C)

Time Remaining: 01:18:58

Stage 1 Stage 2 Stage 3 Stage 4
X1 X1 1 of 40 X1
95.0 °C 95.0 °C
0.0 °C / 00 il \ 60.0 °C 60.0 °C
0:30 0:29 0:30
a <] a

January 19 2012 - 01:54PM o

Heated cover reached target temperature.

Note: The above screenshot is for visual representation only. Actual results will vary
with the experiment.
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Monitor the run

Chapter 4 Run the Experiment

Time View
@ Time View Plat View ] Experiment View
Run Started: December 08 2011 - 12:05AM Sample: 59.5 °C

Heated Cover [Set Point): 105.0 °C [105.0 °C)
Stage /Step / Cycle: 2/2/5

01:11:22

@ Remaining Time -~ Elapsed Time

Reaction Volume: 20 pL

December 08 2011 - 12:06AM

Error occurred during run. Details: Holdtime 60 s exceeded. Actual Holdtim...

Plot View
|  Experiment View @ Time View Plot View
Fast 96-Well Tagman v ARn W

100

December 08 2011 - 12:07AM o

Heated cover reached target temperature.

Note: You will see the Plot View only if your experiment includes the PCR process.
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Monitor the run
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Review Results and Adjust
Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis
screens and publish the data. Section 5.2 of this chapter walks you through the process
of modifying experiment parameters to troubleshoot problems with experiment
results before rerunning an experiment.

This chapter covers:

Section 5.1 Review Results ........ ...ttt 31
Analyze the example experiment. .............. ... 31
View clusters in the Allelic Discrimination Plot ........................... 31
Confirm setup accuracy using Plate Layout. ........................... ... 34
Assess amplification results using the Amplification Plot................... 37
Identify well problems using the Well Table .............................. 40
Confirm accurate dye signal using the Multicomponent Plot................ 43
Determine signal accuracy using the Raw DataPlot ....................... 46
Review the flags inthe QC Summary ..................... i 47
For more information. . ......... ... . . 49

Section 5.2 Adjust parameters for re-analysis of your own experiments. ........ 51
Adjust analysis settings............ ... i 51
For more information. . . ......... ... . 55
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Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.

2. Click Analyze. The software analyzes the data using the default analysis settings.

Note: You can also access the experiment to analyze from the Home screen.

View clusters in the Allelic Discrimination Plot

The Allelic Discrimination Plot contrasts the normalized reporter dye fluorescence
(Rn) for the allele-specific probes of the SNP assay.

View the allelic discrimination plot to identify:

* C(Clusters for the three possible genotypes (Allele 1 homozygous, Allele 2
homozygous, and Allele 1/2 heterozygous).

* A cluster for the no template controls.

-_—

To view and assess From the Experiment menu pane, select Analysis » Allelic Discrimination Plot.

the allelic

LT 2. Click the Plate Layout tab, then click any empty well to select it.
discrimination plot

Note: In the Allelic Discrimination Plot, the software highlights all wells that are
selected in the Plate Layout tab. If the plot displays a single color for all wells,
then all wells in the plate layout are selected.

3. In the allelic discrimination plot, select SNP Assay 1 from the SNP Assay menu,
then enable Autocaller.

The Allelic Discrimination Plot displays allele symbols for each sample evaluated
for the selected SNP. The samples are grouped on the plot as follows:

Genotype Symbol Location
Homozygous for Allele 1 of the @ (red) X-axis of the plot
selected SNP assay
Homozygous for Allele 2 of the @ (blue) | Y-axis of the plot
selected SNP assay
Heterozygous for both alleles of the (green) | Midway between the
selected SNP assay (Allele 1 and homozygote clusters
Allele 2)
No Template Control M (black) | Bottom-left corner of the

plot

Undetermined %* (black) | Anywhere on plot

Note: If the Autocaller is not enabled, the Allelic Discrimination Plot displays a
crossmark (X — Undetermined) for each sample.
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View clusters in the Allelic Discrimination Plot

4. Review each cluster in the plot:

a. Click and drag a box around the cluster to select the associated wells in the
plate layout and well table.
b. Confirm that the expected wells are selected in the well table.

For example, if you select the cluster at the bottom-left corner of the plot,
only the no template controls should be selected. The presence of an
unknown among the no template controls may indicate that the sample
failed to amplify.

c. Repeat steps a and b for all other clusters in the plot.

d. The table below describes the elements of the Allelic Discrimination Plot.

Element Description

SNP Assay drop- Determines the SNP assay data that the QuantStudio™

down menu 12K Flex Software displays in the plot.

Plot Type drop- Determines the type of plot (Cartesian or Polar) that the

down menu QuantStudio™ 12K Flex Software uses to display the
data.

Apply Call drop- When a datapoint is selected, this menu allows you to

down menu assign an allele call to the datapoint within the
scatterplot.

Toolbar Contains tools for manipulating the scatterplot:

o 5 _ Selection tool.
o [¢ - Selection tool.
% - Repositioning tool.

o - Zooms in.
e & - Zooms out.
Legend Explains the symbols in the scatterplot.
Options The Reveal Traces option allows you to trace the

clusters throughout the PCR process.

This option is not activated for the example experiment.
To activate the feature, see “Adjust analysis settings” on
page 52.
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View clusters in the Allelic Discrimination Plot

The Allelic Discrimination plot for the example experiment looks like this:

Allelic Discrimination Plot
Plot Settings

SHP Assay: |SNP Assay 1l v Apply Call: |Mixed ~ ol ¥ -
Plot Type: |Cartesian 2 3 5 5 = 5 S I 1 | 12 ‘
B w‘ﬁl /® /9 é E;i_i. LE' Iz . i 2 4 Sample 5 Sample 6 1 2 4[Sample 5 Sample 6
Allelic Discrimination Plot 2 t wwt o1 &§ t wwt o1 &§
®
- o Szmple 7| & Sample 3 Sampl., Sampl.. Sampl. Sample7 & Sample 3 Sampl.., Sampl.. Sampl...
¥ Bomsavmom em en 0 o0 eI |eT &

: . EETEORTBTEB®

o 30 L
3 EDw'l]l]l]l]ljw'l]l]l]l]l]
20 |
i E 4 |Sample 5 Sample & i E 4 |Sample 5 Sample &
T L L
Sample 7 & Sample 3 Sampl... | Sampl... Sampl.. Sample 7 & Sample 3 Samgpl... | Sampl.. Sampl...
o® Flem oD em eI &1 O o0 o0 e @0
0o | ||
04 0e Al 1 1.4 19 [ ﬁ i m E wo m m ﬁ E wo
::Enmnzygnus Allele 1/allele 1 »Homozygous Allele 2/allele 2 |
w#Heterozygous Allele 1/4llele 2 yUndetermined
T Ht'l]l]l]l]l]t'l]l]l]l]l]
wels: [ 36 12 EoEoHo 0 Empty
Well Summary: In Plate: 96 Set Up: 06 Anatyzed: 06 Flagged: 0 Omitted by Anahysis: 0 Omitted Manualhy: 0 Samples Us=d: 19 SNP Assays Used: 2
Troubleshoot Do all controls have the correct genotype?
clustering on the

) In the example experiment and in your own experiments, confirm that data points
Al_-l-e“f: o cluster as expected.
Discrimination Plot

Clustering in positive controls

1. From the well table, select the wells containing a positive control to highlight the
corresponding data points (symbols) in the Allelic Discrimination Plot.

2. Check that the data points for the positive controls cluster along the expected axis
of the plot. For example, if you select the Positive Control Allele 1/Allele 1, then
the controls should cluster along the X-axis.

3. Repeat steps 1 and 2 for the wells containing the other positive controls.

Failed amplification in the unknown samples

1. Select the data points of the cluster in the lower left corner of the Allelic
Discrimination Plot to select the corresponding wells in the well table.

2. Check that the selected wells in the well table are the no template controls, and
not unknown samples.
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Confirm setup accuracy using Plate Layout

Samples clustered with the no template controls

Samples that clustered with the no template controls may:
¢ Contain no DNA
¢ Contain PCR inhibitors

¢ Be homozygous for a sequence deletion

Confirm the results of these samples by retesting them.

Are outliers present?

If the Allelic Discrimination Plot contains clusters other than the three representative
genotype clusters (heterozygous, homozygous allele 1, and homozygous allele 2), then
those can be classified as outliers.

Confirm the results of the associated samples by retesting them.

Note: The results displays are synchronized. For example, selecting a well in the plate
layout selects the corresponding data in the well table and Allelic Discrimination Plot.

Confirm setup accuracy using Plate Layout

Example
experiment plate
layout values

View the layout

34

Review the experiment results in the Plate Layout. The plate layout displays the assay-
specific setup and analysis properties for the experiment in a well format
corresponding to the type of reaction plate used for the run.

For the example experiment, confirm that the QuantStudio™ 12K Flex Software called:
* 24 samples as Allele 1 homozygous ( ® )
* 38 samples as Allele 2 homozygous ( @)
* 14 samples as heterozygous ( @ )

¢ 0samples as undetermined (X)

Confirm that no wells of the reaction plate triggered QC flags (. ). The example
experiment does not display any flags.

1. Click the < icon beside the Allelic Discrimination Plot to maximize the plate
layout.

2. Click Show in Wells, then select or deselect a parameter that you want the
wells to display. Repeat this step until the plate layout contains all of the desired

parameters.
Parameter Description
Sample Name The name of the sample applied to the well.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Confirm setup accuracy using Plate Layout

Parameter Description
Task The task assigned to the well:
ﬂl - Unknown
Bl -No Template Control
D - Positive Control - Allele 1
B - Positive Control - Allele 2
[l - Positive Control - Allele 1/2
SNP Assay The name of the SNP evaluated by the well.
Name
Assay ID The Assay ID number of the SNP evaluated by the well.

Allele 1 / Allele 2

The name of the associated allele for the SNP evaluated by the
well

Allele 1 Dyes /

The name of the reporter and quencher dyes of the associated

Allele 2 Dyes allele for the SNP evaluated by the well

SNP Assay Color | The color of the SNP evaluated by the well.
Sample Color / The color of the sample or task applied to the well.
Task Color

Genotype Call

The allele call assigned to the sample:
¢ ® Homozygous 1/1

e @ Homozygous 2/2

e ® Heterozygous 1/2

e B No Template Control

X Undetermined

Experiments User Guide for Genotyping Experiments

Flag The number of QC flags the well triggered as listed in the
symbol.
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Confirm setup accuracy using Plate Layout

The following figure shows the plate layout of the example Genotyping experiment.

Plate Layout

Well Table

xxxxx

| shovw in el [EESRERUEES § View Legerd el :m:
[

E e [Select data to show or hide in wells I | : - - |
E Sample Calor S Sample 5
cE. . L-----m & & L----
E Genotype Call
’Z Flags

SampE 8 Sample 10 Sample 11 Sample 12 Sample 7 8 Sample 10 Sample 11 Sample 12
+ | o [N o [N o (R o N o NS o (S o R o DN © I o R o N © N

n

Sample 13 14 Sample 15 14 Sample 15 16 17
N Oy Bt B B Bt Ov v Bv Ov Gv |

1o | o [l ™ (S = S = S = S = S , iy = (N = N = N = N =

m

om om ot om o% o- om om ot om T

o [ «
Sample 7 ] Sample 10 Sample 11 Sample 12 Sample 7 ] Sample 10 Sample 11 Sample 12
- | o [ o o [N~ [ « SN « N o O o [ ~ [ » NS « N

@

Sample 13 12 Sample 15 14 Sample 15 16 17
o CT o (i - (S - (S - (i o (S - (R - O - . - i - O - O

+| o [l ™ [ = N = N = I = O, [y ™ O = N = O = CR =

wels: [ 36 [ 12 Mo Eo[Ho

Well Summary: In Plzte: 96 Set Up: 96

0 Empty

Anatyzed: 06 Fiagged: 0 Omitted by Analysis: 0 Omitted Manualty: 0 Samples Used: 10 SNP Assays Used: 2

Tips for
troubleshooting
plate setup in your
own experiment .

You can adjust your view of the plate layout:
* Note the location of any samples that trigger QC flags . . Understanding the
position of errors can aid in diagnosing any failures that may occur.

You can select the entire reaction plate, areas of the reaction plate, or specific
wells:

— Click the upper left corner of the reaction plate to select all 96 wells.
— Left-click the mouse and drag across the area to select it.
— Select Sample, SNP Assay, or Task from the Select Wells menu in the Plate
Layout tab to select wells of a specific type using the well-selection criteria.
Use the (Zoom In), (Zoom Out), and (Fit Plate) buttons to magnify or
compress the view of the wells shown.

Use the € arrow tabs to expand the plate layout to cover the entire screen.
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Assess amplification results using the Amplification Plot

Assess amplification results using the Amplification Plot

IMPORTANT! Amplification plots are not used to make SNP calls. Examine the plots to
help with troubleshooting and quality control.

If you collected real-time data for your experiment, review the amplification data to
further understand the flags triggered by the experiment data.

About amplification = The Amplification Plot screen displays amplification of all samples in the selected
plots wells. Use the amplification plots to confirm the results of the experiment:

* ARnvs. Cycle - ARn is the difference in normalized fluorescence signal generated
by the reporter between the pre-PCR read and the post-PCR read. This plot
displays AR}, as a function of cycle number. You can use this plot to identify and
examine irregular amplification and to view threshold and baseline values for the
run.

Note: Viewing the ARn vs. Cycle plot is discussed in this booklet as an example of
how to view the plot.

* Rnvs. Cycle — Rn is the fluorescence signal from the reporter dye normalized to
the fluorescence signal from the passive reference. This plot displays Rn as a
function of cycle number. You can use this plot to identify and examine irregular
amplification.

* Cyvs. Well - Cris the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Cr as a function of well
position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.
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Assess amplification results using the Amplification Plot

View the ARn vs.
Cycle plot

1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. Select the plot type and format:

Menu Selection
Plot Type ARn vs. Cycle
Plot Color Target
E Check (default)

(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)

Amplification Plot <
Plot Settings
Plot Type:[ARn vs Cycle | Graph Type:Log  +| Plot Color:[Target ~]
[[] save current settings as the default
£ P By By & IS
1o Amplification Plot
1
0.183465
g o pogrsm
0.01
0.001 . o s a8 i
Cycle
-
B ShP Assay 1-Allele 2 | SHP Assay 1-Allele 1 [l SMP Assay 2-allele 2 [l SHP Assay 2-Allele 1
Options |
Show: [#] Threshold — ] Baseline Start: Well M Target 4 Baseline End: Well (M Target 4
Well Summary: In Plate: 96 Set Up: 96 Anatyzed: 96 Flagged: 0 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 19 SNP Assays Ussd: 2
3. View the baseline values:
a. From the Graph Type drop-down menu, select Linear.
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Assess amplification results using the Amplification Plot

b. Select Baseline to show the start cycle and end cycle.

Amplification Plot <

Plot Settings

Plot Tvpe:\ARn vs Cycle v| Graph Tvpe:\LmEar V\ Plot Cu\ur:|Target vl

[] save current settings as the default

5.0

4.5

4.0

35

3.0

ARn

25

2.0

o0s

0.0 t——wa

P L B

B =

Amplification Plot

Leg

Cycle

B st Assay 1-Allele 2

Shp Assay 1-allele 1 [l SMP Assay 2-alele 2 [l SNP Assay 2-Allele 1

Options

A
Show: [] Threshold — /] Baseline Start: Well M Target -+ Baseline End: Well (M Target 4.

~

‘Well Summary: In Pizte: 06

Set Up: 06 Anshyzed: 06 Fagged: Orvitted by Anahysis: Onvitted Manually: Samples Used: 10 SHP Assays Used: 2

4. View the threshold values:
a. From the Graph Type drop-down menu, select Log.
b. From the Target drop-down menu, select SNP Assay 1-Allele 2.
c. Select the Threshold check box to show the threshold.

Amplification Plot <

Plot Settings

Plot Type:|ARn ws Cycle % Graph Type:Llog %/ Plot Color: Target v

[[] save current settings as the default

Amplification Plot
1E01

1E00

183465

0.1

ARn

o.001 £

B 5P Assay 1-Alkle 2 SHp Assay 1-Alele 1 [l SHP Assay 2-Alele 2 [l SNP Assay 2-Allele 1

Options

Target: |SNP Assay 1-Allele 2 '+ | Threshold: [#] Aute I:l

Show: [#] Threshold — [ 35

t2 Well B Target 4 Baseline End: Well (M Target 4

>

Well Summary: In Piatz: 96 Set Up: 96 Analyzed: 06 Flagged: 0 Omitted by Analyss: 0

Omitted Manually: 0 Szmples Used: 19 SNP Assays Used: 2
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Identify well problems using the Well Table

Note: If you use the Relative Threshold algorithm to analyze an experiment that
includes amplification, select to view the analysis results using the ARn vs Cycle, Rn vs
Cycle, or Cgy vs Well plot type and Linear or Log graph type. Also select the Show Crt
check box to view the derived fractional cycle on the amplification plot.

Amplification Plot
Plot Settings
Plot Type:[ARn vs Cycle v | Graph Type:Llog  »| Plot Color:[well v

[ save current settings as the default

ppawl g

Amplification Plot

0.001

=
A g Wic Mip e HF Hc Wy

Options
Tager: B

Show: —_ Wel B Target 4 Baseline End: Well (M Target 4~

Show Crt

Well Summary: In plste: 06 S=t Up: 86 Analyzed: 06 Fisgged: [ Omitted by Anayss: ) Omitted Manualy: ) Sampies Used: 10 SNP Assays Used: 2

Identify well problems using the Well Table

Review the details of the experiment results in the Well Table and identify any flagged
wells. The Well Table displays the assay-specific setup and analysis properties for the
experiment in a tabular format.

Example For the example experiment, look for wells that triggered QC flags (/). The example
experiment values  experiment has no flags.
and flags

View the well table 1. Select the Well Table tab.

2. Click the Flag column header to sort the data so that the wells that triggered flags
appear at the top of the table.
3. Confirm the integrity of the controls:

a. From the Group By menu, select Task to organize the table rows by their
function on the reaction plate.

b. Confirm that each of the controls do not display flags ().

c. Click the [B icon to collapse the negative and positive controls.
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Identify well problems using the Well Table

The figure below shows the well table of the example Genotyping experiment.

Amplification Plot < Well Table

Plot Settings >
Plot Type:|ARn ws Cycle ~ Graph Type:Log ~ | Plot Color:|Well v Show in Tsble ¥ Select i Expand &l @ Collapse &ll
[] Save current settings as the defautt ‘ # well | omit Flag Sample ...| SNP As... | AssayID | Task
» = Gl 1T (= No Templgte Control [
/O /O a L= |g . 38 D2 I | SNP Assay 1 No Temph...
40 D4 I | SHP Assay 1 Mo Temph...
Amplification Plot 42 D6 ) SNP Assay 1 No Tempa...
10 44 DB a SHP Assay 2 Mo Temph...
46 D10 ™ | SHP Assay 2 No Templa...
48 D12 ) SHP Assay 2 No Templa...
86 H2 | SHP Assay 1 Mo Templa...
88 H4 I | SNP Assay 1 Mo Templa...
1 a0 He I | SNP Assay 1 No Temph...
92 He I | SNP Assay 2 Mo Temph...
94 Hi0 A SNP Assay 2 Mo Temph...
0.183465 96 H12 a SHP Assay 2 Mo Templa...
I3 B Unknown
5 oot 2 A2 0 Sampla2  SNP Assay 1 Unknown
4 A4 | Sample 4 SHP Assay 1 Unknown
6 A6 " Sample & SNP Assay 1 Unknown
8 Ag | Sample 2 SNP Assay 2 Unknown
a.01 10 A1D I | Sample 4 SNP Assay 2 Unknown
12 A12 A Sample 6 SNP Assay 2 Unknown
14 B2 " | Sample 8 SWP Assay 1 Unknown
= A & 16 B4 0 Sample 10 SNP Assay 1 Unknown
/s eﬂﬁ\ / 18 B6 0 Sample 12 SNP Assay 1 Unknown
o001 2 ! A ! 20 BS I | Sample 8 SHP Assay 2 Unknown
poosn o 22 B1O 0 Sample 10 SNP Assay 2 Unknown
- 24 B12 | Sample 12 SHP Assay 2 Unknown
—— % a Sample 14 SHP Assay 1 Unknown
A 8 CHp H: M- EG H: 28 (4 A Sample 16  SNP Assay 1 Unknown
30 C6 " | Sample 18 SHP Assay 1 Unknown
= 32 C8 " | Sample 14 SNP Assay 2 Unknown
Options = 34 Cn " | Sample 16 SHP Assay 2 Unknown
Targetz |SNP Assay l-allele 2« | Threshold: Auto 36 C12 I | Sample 18  SNP Assay 2 Unknown
50 E2 " Sample 2 SNP Assay 1 Unknown
Show: [#] Thrashold = [*] Baseline Start: Well M Target 4 Baseline End: Well (M Target . 52 B4 O Sample 4 SNP Assay 1 Unknown
< 5 = 54 E6 0 Sample 6 SNP Assay 1 Unknown
¢ >
Well Summary: In Plste: 96 Set Up: 96 Anslyzed: 96 Fizgged: 0 Omitted by Anshysis: 0 Omitted Manually: 0 Samples Ussd: 19 SNP Assays Ussd: 2
The following table gives the names and description of the columns in the well
table:
Column Description
Well The position of the well on the reaction plate.
Omit A check mark indicates that the well has been removed from the
analysis.
Flag A (/) indicates that the well triggered the number of flags
listed inside the symbol.
Sample Name The name of the sample.
SNP Assay The name of the SNP assay evaluated by the well.
Name
Assay ID The Assay ID number of the SNP evaluated by the well.
Task The task assigned to the well (Unknown, No Template Control, or
Positive Control).
Allele 1/ 2 The name of the associated allele for the SNP evaluated by the
well.
Allele 1/2 Dyes The name of the reporter and quencher dyes of the associated
allele for the SNP evaluated by the well.
Allele 1/2R, Normalized signal (R,,) of the reporter dye of the associated
allele for the SNP evaluated by the well.
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Identify well problems using the Well Table

Column

Description

Pass Ref

The signal of the passive reference dye for the well.

Call

The allele call assigned to the sample, where possible calls are:
e @ Homozygous 1/1 - Homozygous for allele 1

* @ Homozygous 2/2 - Homozygous for allele 2

e ©® Heterozygous 1/2 - Heterozygous

e W No Template Control

e X Undetermined

Quality (%)

The quality value calculated for the genotype call.

Method

The method used to assign the call to the sample (Auto if
assigned by the QuantStudio™ 12K Flex Software, or Manual if
applied by a user).

Comments

Comments entered for the associated sample well.

Allele 1/2 Cy

Threshold cycle (Cy) of the sample for the associated allele for
the SNP evaluated by the well.

Identify qual_ity The Well Table displays columns for QC flags that are triggered by the experimental
control (QC) data. If the experiment data does not trigger a QC flag, then the QuantStudio™ 12K
problems Flex Software does not display a corresponding column for the flag.
A () in one of the following columns indicates that the associated well triggered the
flag.
Flag Description

BADROX The well produced a passive reference signal greater than the
limit defined in the analysis settings.

OFFSCALE The well produced a level of fluorescence greater than the
QuantStudio™ 12K Flex System can measure.

NOSIGNAL The well did not produce a detectable level of fluorescence.

CLUSTER# For the SNP evaluated by the well, the number of clusters
generated from the experiment data is greater than the limit
defined in the analysis settings.

PCFAIL The positive control did not produce an R,, for the associated
allele greater than the limit defined in the analysis settings
indicating that the control may have failed to amplify.

SMCLUSTER The number of data points in the associated cluster is less than
the limit defined in the analysis settings.

AMPNC The negative control has produced an R, greater than the limit
defined in the analysis settings indicating possible amplification.

NOAMP The well did not produce an R, for either allele that is greater
than the limit defined in the analysis settings indicating that the
well may have failed to amplify.

NOISE The background fluorescence (noise) produced by the well is
greater than the other wells on the reaction plate by a factor
greater than the limit defined in the analysis settings.
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Flag Description

SPIKE The amplification plot for the well contains one or more data
points inconsistent with the other points in the plot.

EXPFAIL The software cannot identify the exponential region of the
amplification plot for the well.

BLFAIL The software cannot calculate the best fit baseline for the data
for the well.

THOLDFAIL The software cannot calculate a threshold for the associated
well.
CTFAIL The software cannot calculate a threshold cycle (Cy) for the

associated well.

AMPSCORE Amplification in the linear region is below a certain threshold,
corresponding to the score set in the analysis settings

Tips for analyzing Confirm the integrity of positive controls

your ‘?W" When you analyze the example experiment or your own experiment, if you are using
experiments positive controls, confirm the integrity of the positive controls:

1. From the Group By menu, select Task to organize the table rows by their function
on the reaction plate

2. Confirm that the positive controls do not display flags (/) and that their
normalized reporter dye fluorescence (R,) is appropriate for the genotype
(for example, if evaluating the Positive Control Allele 1/Allele 1, you would
expect to see significant increase in R, for the Allele 1 probe and very little for the
Allele 2 probe).

Adjust the Well Table

¢ Review the data for the Unknown samples. For each row that displays (. ) in the
Flag column, note the data and the flag(s) triggered by the associated well.

* Select areas of the table or wells of a specified type by:

— Left-clicking the mouse and dragging across the area you want to select an
area of the table.

— Selecting Sample, SNP Assay, or Task from the Select Wells menu in the
Well Table tab to select wells of a specific type using the well-selection tool.

* Group the rows of the plate layout by selecting an option from the Group By
menu. You can then collapse or expand the lists either by clicking the +/- icon next
to individual lists, or by clicking [§] Collapse All or ] Expand AllL

* Omit a well from the analysis by selecting the Omit check box for that well. To
include the well in the analysis, deselect the Omit check box.

Note: You must reanalyze the experiment each time you omit or include a well.

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.
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Confirm accurate dye signal using the Multicomponent Plot

Pu rpose In the example experiment, you review the Multicomponent Plot screen for:
» ROX™ dye (passive reference)
* FAM" dye (reporter)
» VIC® dye (reporter)
e Spikes, dips, and/or sudden changes

¢ Amplification in the no template control wells

View the 1. From the Experiment Menu pane, select Analysis » Multicomponent Plot.
Multicomponent Note: If no data are displayed, click Analyze.
Plot

2. Display the unknown wells in the plate layout to display the corresponding data
in the Multicomponent Plot screen:

a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select Dye.

4, Click E Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the PCR process; a constant ROX dye signal
indicates typical data.
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Confirm accurate dye signal using the Multicomponent Plot

6. Check the FAM dye signal. In the example experiment, the FAM dye signal
increases throughout the PCR process; increase in FAM dye signal indicates
normal amplification.

Plot Settings

Plot Color [Dye £

[] Save current settings as the default

115,000,000
110.000.000
105,000,000
100,000,000
95,000,000
90,000,000
§5.000.000
80,000,000
75,000,000
70.000.000
65,000,000
60.000.000
55,000,000
50,000,000
45.000.000
40,000,000
35,000,000
30,000,000
25,000,000
20.000.000

Fluorescence

E.;
Rl
|

Multicomponent Plot

15,000,000
10,000,000

5.000.000
a

o 2 4

Cycle

Legm
Ay B Rox I VIC

Well Summary: In Plate: 9

Tips for confirming

dye accuracy in
your own
experiment
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7. Select the no template control wells one at time and check for amplification. Wells
with the no template control should not show amplification. In the example

experiment the wells with no template controls do not show any amplification.

When you analyze your own Genotyping experiment, look for:

* Passive Reference — The passive reference dye fluorescence level should remain
relatively constant throughout the PCR process.

¢ Reporter Dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

* Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

¢ No Template Control wells — There should not be any amplification in the no
template control wells.
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Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.

Purpose In the Genotyping example experiment, you review the Raw Data Plot screen for a
stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data 1. From the Experiment Menu pane, select Analysis » Raw Data Plot.
Plot Note: If no data are displayed, click Analyze.

2. Display all 96 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.

3. Click E Show a legend for the plot (default). The legend displays the color
code for each row of the reaction plate (see the legend in the Raw Data Plot shown
below).

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 42. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to

the FAM™ dye filter.
Raw Data Plot <
ppE B
Raw Data Plot
260,000,000
250,000,000 +
240,000,000 -
230,000,000 4
220,000,000 1 %
210,000,000 %
200,000,000 -5
190,000,000 +
180,000.000 -
170,000,000
160,000,000 =
150,000,000 =
1 140.000.000 -
= 130,000,000 -
S 120.000.000 4
= 110,000,000 -
100,000,000 4
90,000,000 -
80,000,000 .
70,000,000 25
60,000,000
50,000.000 =
40,000,000
30,000.000
20,000,000 | =
10,000,000 —
-10,000.000 |
®1-m1 ®2-m2 ®3-m3 ®4-ma ®5-m5!
Filter
Legend
ra B C o M Hr Hc HH
Options
Show Cyde 42 J
1 5 10 15 20 25 30 35 40 42

Well Summary: In Plate: 96 Set Up: 96 Anatyzed: 96 Flagged: 0 Omitted by Anahyss: 0 Omitted Manually: 0 Samples Used: 19 SNP Asszys Used: 2
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Review the flags in the QC Summary

The filters are:

Run Method

Reaction Volume per Wel: 50| uL
PCR Filter =)
Emission Fitter
ml(520£15) m2(558=11) m3(586+10) ma(623+14) mS(682x14) me(711£12)
x1(470+15)
] X2(520#10)
o
5 ¥3(550£11)
i)
1) x4(580+10)
]
x5(640+10)
X6(662+10)
Melt Curve Filter )

Emission Fitter

m1(520+15) m2(558x11) m3(586+10) m4(623+14) m5(682+14) me(711+12)
X1(470£15)
3 X2(5204£10)
5 x3(55011)
% x4(580£10)
X5(640£10)
X6(6624£10)
Tips for When you analyze your own Genotyping experiment, look for the following in each
determining signal filter:
accuracy in your * Characteristic signal growth
own experiment e No abrupt changes or dips

Review the flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags,
including the flag frequency and location for the open experiment.

For Genotyping experiments, flag appearance is triggered by experiment data or the
assay. If a flag has been triggered by the assay, the Plate Layout does not display the
icon. The flag details appear in the QC Summary.

In the example experiment, there are no flags.
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Review the flags in the QC Summary

View the QC
Summary

1. From the Experiment Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the experiment. If the frequency is >0, the flag appears somewhere in
the experiment; the well position is listed in the Wells column.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed
information about the flag.

4. (Optional) For those flags with frequency >0, click each flag with a frequency >0 to
display detailed information about the flag.

T

Flag Details
Flag: Description Fregquency Wells

BADROX Bad passive reference signal 0

OFFSCALE Fluorescence is offscale 0

MNOSIGNAL Mo signal in well 0

PCFAIL Positive control failed [1

SMCLUSTER Smal number of samples in cluster (]

AMPNC Amplification in negative control 0

MNOAMP Mo amplification 0

NOISE MNoise higher than others in plate (]

SPIKE Moise spikes 0

EXPFAIL Exponential algorithm failed 0

BLFAIL Baseline algorithm falled (]

CTFAIL Cr algorithm failed 0

AMPSCORE AMP Score o

Flag: BADROX—Bad passive reference signal
Flag Detail: Passive reference signal is abnormal.
Flag Criteria: Fluorescence < 500.0
Flagged Wells: None
View BADROX Troubleshooting Information
Total Wells: 96 | Processed Wells: 96 Manually Omitted Wells: 0 | SNP Assays Used: 2
Wells Set Up: 96 | Flagged Wels: 0 Analysis Omitted Wells: 0 | Samples Used: 19
Well Summary: In Plste: 96 Set Up: 96 Anshzed: 96 Flagged: 0 Ormitted by Analysis: [ Omitted Manualy: { Samples Used: 19 SNP Assays Used: 2
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For more information

Possible flags The flags listed below may be triggered by the experiment data or the assay.

Flag Description

Pre-processing flag

OFFSCALE Fluorescence is offscale
Primary analysis flags

BADROX Bad passive reference signal

NOAMP " No amplification

NOISE . Noise higher than others in plate

SPIKE " Noise spikes

NOSIGNAL No signal in well

EXPFAIL Exponential algorithm failed

BLFAIL Baseline algorithm failed

THOLDFAIL Thresholding algorithm failed

CTFAIL Cy algorithm failed

AMPSCORE Amplification in the linear region is below a certain

threshold, corresponding to the score set in the
analysis settings

Secondary analysis flags

AMPNC | Amplification in negative control
PCFAIL Positive Control failed
SMCLUSTER# Small number of samples in clusters

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL,
THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in
the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

For more information

For more information on... Refer to... Part number

Publishing data Chapter 1in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050
System Multi-Well Plate and Array Card Experiments
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Adjust analysis settings

Section 5.2 Adjust parameters for re-analysis of your
own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the call, threshold
cycle (Cy), flags, and advanced options.

You can change the settings in the Analysis Settings dialog box, then reanalyze your

experiment.
View the analysis 1. From the Experiment Menu pane, select Analysis.
settings 2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab:
¢ Call Settings
o Cy Settings
¢ Flag Settings
* Advanced Settings
The Analysis Settings dialog box for a Genotyping experiment looks like this:

Call Settings C Settings Flag Settings Advanced Settings

Review the default settings for analysis of the SMP assays in this experiment. To use different settings for a SNP assay, selact the SNP assay in the table, deselect Use 1

Default Settings, then change the settings.

~— Data Analysis Settings

() Analyze Data from Post-PCR Read Only (®) Analyze Data from Pre-PCR Read and Post-PCR Read
) Analyze Real-Time Rn Data (O Analyze Real-Time Rn - Median(Rna to Rnb)
— Default Call Settings
Default call settings are used to make allele calls for SNP aszays without custom settings. To edit the default settings, dick Edit Default Settings.
Autocaller Enabled: Yes Keep Manuzl Calls from Previous Analysis: No  Quality Value: 95 | Edit Default Settings
— Select a SNP Assay ~— Call Settings for SNP Assay 1
SNP Assay Analysis Type Autocaller Keep Manual C... | Quality Value Apply Call Settings: [7] Default Settings
SNP Assay 1 Default Yes No 05 2
SHP Assay 2 Default \CH Mo 05
hi

Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings m
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Adjust analysis settings

3. View and, if necessary, change the analysis (see “Adjust analysis settings” below).
Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with QuantStudio™ 12K Flex System
Experiments.

4. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to
Default Analysis Settings.

Adjust analysis Call Settings

settings Use the Call Settings tab to:

* Change the default data analysis settings. You can select from:

— Analyze data from Post-PCR Read only - Select if you do not want to use
data from the pre-PCR read to determine genotype calls.

— Analyze data from Pre-PCR Read and Post-PCR Read - If you included the
pre-PCR read in the run, select if you want to use data from the pre-PCR read
to determine genotype calls.

— Analyze Real-Time Rn Data - If you included amplification in the run, select
if you want to use the normalized reporter (Rn) data from the cycling stage to
determine genotype calls.

— Analyze data from Rn - Avg (Rna to Rnb) - If you included amplification in
the run, select if you want to use the subtracted median of the normalized
reporter (Rn) data from the cycling stage to determine genotype calls, where
Rna to Rnb refers to all the cycles from the Start Cycle Number to the End
Cycle Number. The average subtraction provides improved data accuracy.
Note: To activate the Reveal Traces feature on the Allelic Discrimination Plot
scree, select either Analyze Real-Time Rn Data or Analyze data from Rn -
Avg (Rna - Rnb).

* Edit the default call settings. Click Edit Default Settings, then specify the default
settings:

— Autocaller Enabled - Select for the software to make genotype calls using the
autocaller algorithm.

— Keep Manual Calls from Previous Analysis - If the autocaller is enabled,
select to maintain manual calls after reanalysis

— Quality Value - Enter a value to use to make genotype calls. If the confidence
value is less than the call setting, the call is undetermined.

* Use custom call settings for a SNP assay.

— Select one or more SNP assays in the table, then deselect the Default
Settings checkbox.

— Define the custom call settings.

Ct Settings

e Data Step Selection
Use this feature to select one stage/step combination for Cy analysis when there is
more than one data collection point in the run method.

* Algorithm Settings
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Adjust analysis settings

You can select the algorithm that determines the Cy values. There are two
algorithms: Baseline Threshold (the default) and Relative Threshold.

The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for quantification.

The Relative Threshold algorithm is a well-based analysis based on the PCR
reaction efficiency and fitted to the Amplification curve. This setting is ideal for a
single sample across genes with no dependence on targets, thereby reducing
variability. It is not necessary to set either a baseline or a threshold when you use
the Relative Threshold algorithm, so any settings for baseline or threshold will
not affect the analysis.

¢ Default Cy Settings

Use the default Cr settings feature to calculate Cr for the alleles that do not have
custom settings. To edit the default settings, click Edit Default Settings.

® Cr Settings for Target
When you manually set the threshold and baseline, Life Technologies

recommends:
Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
¢ Below the plateau and linear regions of the amplification curve.
¢ Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.

Flag Settings
Use the Flag Settings tab to:
* Adjust the sensitivity so that more wells or fewer wells are flagged.
* Change the flags that are applied by the QuantStudio™ 12K Flex Software.
To adjust the flag settings:
To adjust the flag settings:

1. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.
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Adjust analysis settings

3. In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of Ct SD. For some flags, analysis results calculated before
the well is rejected are maintained.

4. Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.

The Flag Settings tab looks like this:

Analysis Setti

Call Settings

CT Settings

Advanced Settings

@ Confiure the flags and filtering. In this panel you can enabie, disable, and configure fiags, and indicate if 2 well s to be rejects

when a flag is raised.

Flag Description Use Attribute Condition Value Reject well
BADROX Bad passive referenc... Fluorescence < « [500.000
OFFSCALE Fluorescence is offscale .|
HOSIGHAL Mo signal in well .|
PCFAIL Positive control failed
SMCLUSTER Small number of sam... Mumber of data poin... |= w 2.000
AMPHC Amplification in negat...| cT < w [35.000 [}
HOAMP Mo amplfication Amplification algorith... |< w[0.100 [}
MOISE Moise higher than of... Relative noise > w [4.000 [}
SPIKE Moise spikes Spike algorithm result |= w [1.000 [}
EXPFAIL Exponential algorithm...| .|
BLFAIL Baseline algorithm failed| .|
THOLDFAIL Thresholding algorith...

CTFAIL CT algorithm failed L]
AMPSCORE AMP Score AMP Score > w [1.000 [}

Save to Library Load from Library

Revert to Default Analysis Settings

Apply Analysis Settings [W

54

Advanced Settings
Use the Advanced Settings tab to change baseline settings well-by-well.

Note: The baseline and threshold values do not affect the analysis using the Relative
Threshold setting.

To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.

2. Deselect the Use Ct Settings Defined for Target check box.
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For more information

3. Define the custom baseline settings:

¢ For automatic baseline calculations, select the Automatic Baseline check
box.

¢ To define the baseline, deselect the Automatic Baseline check box, then enter
the baseline start cycle and baseline end cycle.

For more information

For more information on... Refer to... Part number

Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays 127AP05-03
Application Note
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Export Analysis Results

1. Open the Genotyping example experiment file that you analyzed in Chapter 5.

2. In the Experiment Menu, click E-_t Export.

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

3. Select QuantStudio'" 12K Flex format.

4. Complete the Export dialog box as shown below:

Field or Selection Entry
Select Data to Results

export/ Select

Content

Export Data To One File

Export File Name 96-Well Genotyping Example_QuantStudio_export

File Type * txt

Export File Location | <drive>:\Applied Biosystems\QuantStudio 12K Flex
Software\experiments
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Your Export screen should look like this:

[1 Auto Export Farmat : |Quant5tud|nl2KFIex v| Export Data To: (&) One File () Separate Files Open file(s) when export is complete

Export File Location: |C:\App|led Biosystems\QuantStudio 12K Flex Software\

Export File Name: |96-Well Genotyping Example_QuantStudio_g| File Type

[ sample setup [] Raw Data [] ampliication [ mMulticomponent
p Empty Wells ip Omitted W
Select Content
elect Lonten well Well Position Sample Name SNP AssayN... | Task Allelel Delta ... | Allele2 Delta ... | P
All Fields b 1A1 Sample 1 SHP Assay 1 custom task 1.458 3343 A
wel 2A2 Sample 2 SHP Assay 1 UHKNOWH 1.474 3.455
i 3A3 Sample 3 SHP Assay 1 custom task 0.124 4.941
ell Posttion 4 A4 Sample 4 SHP Assay 1 UHKNOWH 0.122 5.080
5A5 Sample 5 SHP Assay 1 custom task 0.108 5.020
Sample Name 6 A6 Sample & SHP Assay 1 UHKNOWH 0.092 5.062
7 A7 Sample 1 SHP Assay 2 custom task 0.979 0.371
SNP Assay Name 8A8 Sample 2 SHP Assay 2 UNKNOWN 0.981 0.357
Task 9 AQ Sample 3 SHP Assay 2 custom task 0.913 0.403
= 10 A10 Sample 4 SHP Assay 2 UHKNOWH 0.087 0930
alelel Delta Rn 11A11 Sample 5 SHP Assay 2 custom task 0.082 0.864
12412 Sample & SHP Assay 2 UHKNOWH 0.090 0.885
Allele2 Defta Rn 13B1 Sample 7 SHP Assay 1 custom task 0.122 4.885
= 1482 Szmple 8 SHP Assay 1 UHKNOWH 1.491 3.516
Pass.Ref 1583 Sample @ SHP Assay 1 custom task 0.109 5.023
16 B4 Szmple 10 SHP Assay 1 UHKNOWH 1.475 3.462
Qualty(%) 1785 Sample 11 SNP Assay 1 custom task 0.008 4933
cal 1886 Sample 12 SHP Assay 1 UHKNOWH 0.093 4.873
1987 Sample 7 SHP Assay 2 custom task 0.093 0.852
Method 2088 Sample 8 SHP Assay 2 UHKNOWH 1.011 0.280
21 B9 Sample 9 SHP Assay 2 custom task 0.101 0.894
Allelel Automatic Ct Threshold 22810 Sample 10 SHP Assay 2 UNKNOWN 1.049 0.362
23B11 Sample 11 SHP Assay 2 custom task 0.084 0.895
Allele1 CE Threshold 24812 Sample 12 SHP Assay 2 UNKHOWHN 0.109 0.904
allelel Automatic Baseline y 25C1 Sample 13 SHP Assay 1 custam task 1.501 3.380
26C2 Sample 14 SHP Assay 1 UHKNOWH 0.130 4.641
Allelel Baseline Start 27C3 Sample 15 SHP Assay 1 custom task 1.463 3.369
28C4 Sample 16 SHP Assay 1 UHKNOWH 2.200 0.233
Allelel Baseline End 29C5 sample 17 SHP Assay 1 custom task 1.462 3.503
Allele2 Automatic Ct Threshold 3008 Sample 18 SHP Assay 1 UHKNOWH 2.215 0.278 &
>l e | ’ 3

[m Save Export Set As Load Export Set Delete Export Set

Your exported file when opened in Notepad should look like this:

B 96-Well Genotyping Exampls xport.txt - Notepad
Fie Edit Format View Help
P’ Barcode = NA ~

Block Type = 96-well Block (0.2mL)

calibration Background is expired = No

calibration Background perFormed on = 2011-08-08 01:15:53 AM SGT
calibration FaM is expired =

calibration FAM performed on = 20].].—08—08 01:39:58 AM SGT
calibration roI is expired = nNo

calibration ROI performed on = 2011-08-08 01:05:24 AM SGT
Calibration ROX is expired = No

calibration ROX performed on = 2011-08-08 02:07:15 AM 5GT
calibration syBr is expired = No

calibration SYER performed on = 2011-08-08 01:58:11 AM SGT
calibration TAMRA is expired = No £
calibration Tamra performed on = 2011-08-08 02:16:10 AM SGT
calibration uniformity is expired = No

calibration uniformity performed on = 2011-08-08 01:24:47 aM 5GT
calibration VIC is expired = No

calibration vic performed on = 2011-08-08 01:49:09 aM SGT
Chemistry = TAQMAN

Comment = NA

Date (reated 1970-01-01 07:30:00 AM SGT

Experiment File Name = C:\Program Fﬂes\Apr]ﬂw‘ed Biosystems‘\Quantstudiol2kFlex'examples\Genotyping'96-well Genotyping Example.eds
Experiment Name = 96-well Genotyping Example

Experiment Run End Time = Not started

Experiment Type = Genatypin

Instrument Name = Quant5tudiobemo

Instrument Serial Number = guantstudioDemo

INsTrument Type = quantstudio 12K Flex

Passive Reference = ROX

qQuantification Cycle Method =

signal smoothing on = true

stage/ Cycle where Analysis is performed = Stage 3, Step 2

User Name = NA

IR N

[results]

wWell wWell Position Sample Name SNP Assay Name Task Allelel pelta Rn Allele2 pelta Rn Pass. Ref quality(®)
call Method Allelel Automatic Ct Threshold Allelel ct Threshold Allelel Automatic Baseline Allelel Baseline start Allelel
Base]ljne Eng Allele2 Automatic ct Threshold Allele2 ct Threshold Allele2 Automatic Baseline Allele2 Baseline start Allelez
Baseline En

1 Al Sample 1 SNP Assay 1 custom task 1.458 3.343 98.416 Heterozygous Allele 1/allele 2 Auto

true 0.068 true 3 21 true 0.183  true 3 20

AZ sample 2 SNP Assay 1 UNKNOWN 1.474 3.455 98.416 Heterozygous Allele 1/allele 2 Auto True

0.068 true 3 22 true 0.183 true 3 21

3 A3 Sample 3 SNP Assay 1 custom task 0.124 4,941 98.416 Homozygous Allele 2/Allele 2 Auto

true 0.068 true 3 39 True 0.183 true 3 20

4 Ad Sample 4 SNP Assay 1 UNKNOWN 0.122 5.080 98.416 Homozygous Allele 2/Al17ele 2 Auto true

0.068 true 3 39 true 0.183 true 3 19

5 AS sample 5 SNP Assay 1 custom task 0.108 5.020 98,416 Homozygous Allele 2/Allele 2 Auto

true 0.068 true 3 39 True 0.183 true 3 20

AG Sample & SNP Assay 1 UNKNOWN 0.092 5.062 98.416 Homozygous Allele 2/aAl17ele 2 Auto true

0.068 true 3 39 true 0.183  true 3 19

7 A7 sample 1 SNP Assay 2 custom task 0.979 0.37: 98.416 Homozygous Allele 1/A1lele 1 Auto

true 0.040 true 3 22 true 0.040 true 3 23 ~
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About Presence/Absence
Experiments

This chapter covers:

About data collection. . ... e 5
Setting up PCRreactions. ........ ... 6
About the instrument run . . ... 6
About theanalysis ....... ... ... 7
About the example experiment ............. ... ... ... o 7

IMPORTANT! First-time users of the QuantStudio™ 12K Flex System, please read
Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array
Card Experiments and Booklet 7, QuantStudio™ 12K Flex System Multi-Well Plate and
Array Card Experiments - Appendixes of this binder thoroughly. The booklet provides
information and general instructions that are applicable to all the experiments
described in this binder.

Note: For more information about any of the topics discussed in this guide, access the
Help from within QuantStudio™ 12K Flex Software by pressing F1, clicking @ in the
toolbar, or selecting Help » QuantStudio™ 12K Flex Software Help.

About data collection

End-point PCR
Data

Real-Time PCR
Data

Presence/Absence experiments are end-point experiments that are performed to detect
a target nucleic acid sequence in a sample.

You can collect the experiment data at the end of the run or continuously in real time.

The QuantStudio™ 12K Flex System collects data at an end-point, that is after the
process has completed.

The data collected is the normalized intensity of the reporter dye, or Rn.

Note: Some end-point experiments also include pre-PCR (data collected before the
amplification process) datapoints. If so, the system calculates the delta Rn (ARn) value
per the following formula:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized readings.

The QuantStudio™ 12K Flex System provides the option of collecting real-time data,
during the PCR process.

Note: Real-time data collection is used only for troubleshooting, and not for Presence/
Absence analysis.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 5
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Chapter 1 About Presence/Absence Experiments

Setting up PCR reactions

Setting up PCR reactions

IPC setup

No IPC, singleplex

setup

With Presence/Absence experiments, you prepare PCR reactions that contain primers
and probes to amplify the target and a reagent to detect amplification of the target. You
can set up the PCR reactions for the Presence/Absence experiments two different ways.

Note: The example experiment uses IPC setup for setting up the PCR reactions.

Use an internal positive control (IPC) to monitor the PCR progress and ensure that a
negative result is not caused by failed PCR in the sample. PCR reactions contain two
primer/probe sets: One to detect the unknown target (unknown target primer set and
TagMan® probe to detect the unknown target) and one to detect the IPC (IPC primer
set and a VIC dye-labeled TagMan® probe to detect the IPC template). With this setup,
there are three well types:

* Unknown-IPC wells contain sample template and IPC template; the presence of

the target is not known.

Negative control-IPC wells contain IPC template and water or buffer instead of
sample template in the PCR reaction. Only the IPC template should amplify in
negative control-IPC wells because the reaction contains no sample template.
Also called IPC+.

Negative control-blocked IPC wells do not contain sample template in the PCR
reaction. Amplification is prevented by a blocking agent. As a result, no
amplification should occur in negative control-blocked IPC wells because the
reaction contains no sample template and amplification of the IPC is blocked.
negative control-blocked IPC is called no amplification control (NAC).

If the run method includes amplification, real-time data are plotted in an
amplification plot.

Omit the IPC from your Presence/Absence experiment. PCR reactions contain one
primer/probe set. PCR reactions do not contain the IPC. With this setup, there are two
well types:

¢ Unknown wells — Wells contain sample template; the presence of the target is not

known.

Negative controls — Wells contain water or buffer instead of sample template.

About the instrument run

With Presence/Absence experiments, the instrument runs can include:
* Pre-PCR read — Perform the pre-PCR read on the QuantStudio™ 12K Flex

Software before PCR amplification to collect baseline fluorescence data.

Amplification — Perform amplification on the QuantStudio™ 12K Flex Software
to collect fluorescence data during PCR amplification. If you do not include
amplification in the run method, perform amplification on another instrument.

Post-PCR read — To determine the results for Presence/Absence experiments,
perform the post-PCR read on the instrument after PCR amplification to collect
endpoint fluorescence data.
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About the analysis

Fluorescence data collected during the instrument run are stored in an experiment
data file (.eds).

About the analysis

Data from the instrument run are used to determine Presence/Absence calls. Results
are plotted in a Presence/Absence plot. If the experiment includes amplification,
results are plotted in an amplification plot.

Pre-PCR read - If included, the data collected from the pre-PCR read can be used
to normalize data collected from the post-PCR read.

Amplification - If included, the data collected from the amplification can be used
to troubleshoot.

Post-PCR read — The data collected from the post-PCR read are used to make
Presence/Absence calls:

— Presence — The target amplified above the target’s threshold. The target is
present in the sample.

— Absence — The target did not amplify above the target’s threshold. The target
is absent in the sample.

— Unconfirmed — The data collected is below the target threshold, and the
intensity of IPC is below the IPC threshold.

With the IPC setup, the data collected form the post-PCR read are used to make the
following calls:

IPC Failed — The IPC target did not amplify in the IPC wells and/or the IPC target
amplified in the blocked IPC wells.

IPC Succeeded — The IPC target amplified in the IPC wells and the IPC target did
not amplify in the blocked IPC wells.

About the example experiment

To illustrate how to perform Presence/Absence experiments, this guide leads you
through the process of designing and performing an example experiment. The
example experiment represents a typical setup that you can use to quickly familiarize
yourself with a QuantStudio™ 12K Flex System.

The objective of the Presence/Absence example experiment is to determine if a
pathogen is present or absent in each batch of ground beef.

In the Presence/Absence example experiment:--

DNA is extracted from samples using the PrepMan® Ultra Sample Preparation
Reagent (PN 4318930). The DNA is extracted from each of the four samples of
ground beef or from the bacteria found in the ground beef.

The target is a pathogen.

The experiment is designed for duplex PCR, where each reaction contains two
primer/probe sets. One set detects the pathogen sequence, TGFB (primer set and
FAM™ dye-labeled probe to detect the TGFB sequence). The other primer/probe
set detects the IPC primer set and VIC® dye-labeled TagMan® probe detects the
IPC template.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 7
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About the example experiment
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Design the Experiment

This chapter explains how to design the example experiment from the Experiment
Setup menu.

This chapter covers:

Define the experiment properties. . ......... ... 9
Define targets and samples. .. ... 10
Assign targetsand samples. . ........ .. oo oo 11
Setuptherunmethod ...... ... ... ... . 12
For more information........... ... i 13

Note: To automatically export the analyzed data to a specified location, select the Auto
Export task from the Export screen, before running the experiment. For more
information on Auto Export, refer to Chapter 1 in Booklet 1, Getting Started with
QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments.

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the
QuantStudio™ 12K Flex Software. Enter:

Field or Selection

Entry

Experiment Name

96-Well Presence Absence Example

Barcode
User Name
Comments

Block

Leave field empty
Example User
Presence/Absence example

96-Well (0.2mL)

Experiment Type

Presence/ Absence

Reagents

TagMan® Reagents

Ramp speed

Standard

Select all three data-collection check boxes: Pre-PCR, Amplification, and Post-PCR

collection methods:

Pre-PCR Read Checked
Amplification Checked
Post-PCR Read Checked

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Define targets and samples

Save the experiment.

Your Experiment Properties screen should look like this:

How do you want to identify this experiment?

* Experiment Name: |96-Well Presence Absence Example Comments: |Presence Absence example A
Barcode:

User Name: |Example User

Which block are you using to run the experiment?

{ 384-Well } [ Array Card ] |v 96-Well (0.2mL) | { Fast 96-Well (0.1mL) }

What type of experiment do you want to set up?

[ Standard Curve } [ Relative Standard Curve ] [ Comparative Ct {(AACT) ] [ Melt Curve }

{ Genotyping } | v Presence/Absence |

Which reagents do you want to use to detect the target sequence?

‘ v TagMan® Reagents ‘ [ Other ]

What properties do you want for the instrument run?

‘ v Standard ‘ [ Fast ]

Include: Pre-PCR Read Amplification

Define targets and samples

Click Define to access the Define screen. Enter:

1. Targets
Target Name Reporter Quencher Color
TGFB FAM NFQ-MGB .
IPC vic TAMRA | u
2. Samples
Sample Name Color

(+) B
(-) B

NAC

NTC [

3. Dye to be used as a Passive Reference
ROX

10 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Your Define screen should look like this:

Chapter 2 Design the Experiment
Assign targets and samples

Target Name Reporter Quencher Color Sample Name Color

TGFB FAM + [NFQ-MGB v|. v |+ ] v

IPC vIC ~ | TAMRA v|. o (@] ] v
HAC A
HTC L] v

Passive Reference

ROX

Assign targets and samples

Click Assign to access the Assign screen. Enter the targets and samples:

'I'Naargleet Well Number Task Sample
TGFB A1 - A4 (Columns 1 - 4) Negative = NAC
IPC No IPC

TGFB A5 - A8 (Columns 5 - 8) IPC NTC
IPC Negative

TGFB B1 - B10 (Columns 1- 10) Unknown | (+)

IPC IPC

TGFB C1 - C10 (Columns 1 - 10} Unknown | (-]

IPC IPC

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Chapter 2 Design the Experiment
Set up the run method

Your Assign screen should look like this:

Targets

TGFB

ju] ells Select tidells s =8 13
pe A4 ; o [ o [ =

NAC
Ana--mmmm
{:) (-} (-] (-} ) -] -} {:) (-} (-]
T T 1 T T T T T T 1
L1] L1 0 L] L1] 0 L] L1] L1 0

m

lal

Samples —— e

e ]
CIi+) E
] (9]
NAC —
m [

wels: [ o [ o 2044 68 Emoty

Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the
Graphical View tab. Enter:

* Reaction Volume Per Well: 25 uL

e Thermal Profile

Ramp .
Stage Step rate Temperature Time

Pre-Read Stage Step 1 1.6°C/s 60 °C 30 seconds
Hold Stage Step 1 1.6°C/s 95°C 10 minutes
PCR Stage Step 1 1.6°C/s 95°C 15 seconds
* Number of Cycles: 40 Step?2 1.6°C/s 60°C 1 minute

(default)
e Enable AutoDelta:

Unchecked (default)
¢ Starting Cycle: Disabled

when Enable AutoDelta is

unchecked
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Reaction Volume per Well: pL

Gr Optical Filkers

Chapter 2 Design the Experiment
For more information

Ramp .
Stage Step rate Temperature Time
Post-Read Stage Step 1 1.6°C/s 60°C 30 seconds

Your Run Method screen should look like this:

Include:

Run Method

Pre-Read Stage

Hold Stage

PCR Stage

Post-Read Stage

MNumber of Cycles:

Starting Cydle:

Step?

Step1

Stept

Stepz

Step1

<

’— Legend

Data Collection On |* =/ Data Collection Off A AutoDeka On A AutoDelts Off

For more information

For more information on... Refer to Part number
Consumables Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050
System Multi-Well Plate and Array Card Experiments
Appendix A in Booklet 7, QuantStudio™ 12K Flex System Multi-Well
Plate and Array Card Experiments - Appendixes
Data collection Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050
System Multi-Well Plate and Array Card Experiments
Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays 127AP05-03
Application Note
Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050

Using alternative setup

System Multi-Well Plate and Array Card Experiments
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For more information
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Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Presence/Absence
example experiment.

This chapter covers:

Assemble required materials ........ ... 15
Prepare the reaction mix (“cocktail mix”)............... ... oo 15
Prepare thereactionplate . .......... ... ... . il 17
For more information. . ......... ..o 18

Assemble required materials

¢ Items listed in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-
Well Plate and Array Card Experiments

¢ Samples - DNA extracted from ground beef (100 ng/uL)
¢ Example experiment reaction mix components:

— TaqMan® Universal PCR Master Mix

- 10X IPC Mix

- 50X IPC DNA

— 20X Primer/ Probe Mix

Prepare the reaction mix (“cocktail mix”)

For the Presence/Absence example experiment, four cocktail mixes are used; one each
for:

* ™
* 0
e NTC/IPC+
* NAC/IPC-
The following tables list the universal assay conditions (volume and final

concentration) for using the TagMan® Universal PCR Master Mix for the four cocktail
mixes.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 15
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Chapter 3 Prepare the Reactions

Prepare the reaction mix (“cocktail mix”]

Cocktail Mix

Reaction component

Volume for 1
reaction (uL)

Volume for 11
reactions (10
wells + 10%
excess) (pL)

Cocktail Mix 1 for Sample (+) | TagMan® Universal PCR Master Mix (2.0X) 12.50 137.50
10X IPC Mix 2.50 27.5
50X |IPC DNA 0.50 5.5
20X Primer/ Probe Mix 1.25 13.75
Water/ Buffer 5.75 63.25
Diluted unknown 1 25 27.5
Total reaction mix volume 25.0 275

Cocktail Mix 2 for Sample (-] | TagMan® Universal PCR Master Mix (2.0X) 12.50 137.50
10X IPC Mix 2.50 27.5
50X IPC DNA 0.50 5.5
20X Primer/ Probe Mix 1.25 13.75
Water/ Buffer 5.75 63.25
Diluted unknown 2 2.5 275

Cocktail Mix

Reaction component

Volume for 1
reaction (pL)

Volume for 5
reactions (4
wells + 10%
excess) (pL)

Cocktail Mix 3 for NTC/ IPC+ | TagMan® Universal PCR Master Mix (2.0X) 12.50 62.5
10X IPC Mix 2.50 12.5
50X IPC DNA 0.50 25
20X Primer/ Probe Mix 1.25 6.25
Water/ Buffer 8.25 41.25
Total reaction mix volume 25.0 125.0

Cocktail Mix 4 for NAC/ IPC- | TagMan® Universal PCR Master Mix (2.0X) 12.50 62.5
10X IPC Mix 2.50 12.5
50X IPC DNA 0.50 25
20X Primer/ Probe Mix 1.25 6.25
IPC Block 2.5 12.5
Water/ Buffer 5.75 28.75
Total reaction mix volume 25.0 125.0
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Chapter 3 Prepare the Reactions

Prepare the reaction plate

To prepare the reaction mix for each of the four types:

1. Label four appropriately sized tubes for the reaction mixes:
Sample (+), Sample (-), NTC, NAC.

2. Add the required volumes of each cocktail mix component to the tube.

3. Mix the cocktail thoroughly by gently pipetting up and down several times, then
cap the tube.

4. Centrifuge the tube briefly to remove air bubbles.

5. Place the cocktail mix on ice until you prepare the reaction plate.

Note: You can separately add the sample to the reaction plate, as opposed to
preparing individual reaction mixes for each sample.

Prepare the reaction plate

The reaction plate for the Presence/Absence example experiment contains:
e A MicroAmp® Optical 96-Well Reaction Plate (0.2 mL)
e Reaction volume of 25 uL/well
e 10 (+) wells
* 10 Sample (-) wells
« 4NTC/IPC+ L [
« 4NAC/PC- [

The plate layout looks like this:

H

§ m.. 8. 68 Empty
wels: [ o o 2044
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Chapter 3 Prepare the Reactions

For more information

To prepare the reaction plate:

1.

N o &~ w D

Add 25 pL of Cocktail mix 1 to wells B1 - B10.
Add 25 pL of Cocktail mix 2 to wells C1 - C10.
Add 25 pL of Cocktail mix 3 to wells A5 - AS8.
Add 25 pL of Cocktail mix 4 to wells Al - A4.

Seal the reaction plate with optical adhesive film.

Centrifuge the reaction plate briefly to remove air bubbles.

Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of

time.

Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

For more information

For more information on... Refer to... Part number
Assigning the reaction plate Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K 4470050
components Flex System Multi-Well Plate and Array Card Experiments
Sealing the reaction plate Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K 4470050
Flex System Multi-Well Plate and Array Card Experiments
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Start the run

Run the Experiment

This chapter explains how to run the example experiment on the QuantStudio™ 12K
Flex Instrument.

This chapter covers:
Start the FUN. . . ..o 19
Monitor the run. . . ... .. 19

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the QuantStudio™ 12K Flex Instrument is in operation.

1. Open the Presence/Absence example file that you created using instructions in
Chapter 2.

2. Load the reaction plate into the instrument.

3. Start the run.

Monitor the run

From the
Instrument
Console of the
QuantStudio™ 12K
Flex Software

Monitor the example experiment run:

¢ From the QuantStudio™ 12K Flex Software using the Run screen, while the
experiment is in progress.

¢ From the Instrument Console of the QuantStudio™ 12K Flex Software (to monitor
an experiment started from another computer or from the QuantStudio™ 12K
Flex Instrument).

e From the QuantStudio™ 12K Flex Instrument touchscreen.

1. In the Instrument Console screen, select the instrument icon.
Click Manage Instrument or double-click on the instrument icon.

3. On the Manage Instrument screen, click Monitor Running Instrument to access
the Run screen.
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Monitor the run

View the Temperature Plot
Click Temperature Plot from the Run Experiment Menu.

The figure below shows the Temperature Plot screen as it appears during the example

experiment.
Temperature Plot Current Temperatures
2 P B iy = [ [ cover
]
[z lsarple
Block
Temperature Plot
15
110
108 —
100
a5 b 5 H L i ik i 4 4
a0
a5
80
75
70
@ 65
2
- A S S A S A I I A A S S S B
g =5
5
P =0
45
40
35
30
2
20
15
10
5
0 Temperature Plot
00:37:30 00:41:40 004550 00:S0:00 00:5410 00:58:20 01:02:30 01:06:40 01:10:50 01:1500 011910 01:23:20 01:27:30 01:31:40
Time
Fixed View []

Note: The Sample temperature displayed in the Current Temperatures group is an
estimated value.

View the Run Method
Click Run Method from the Run Experiment Menu.

The figure below shows the Run Method screen as it appears in the example

experiment.
Run Method Edit Run Method
Pre-Read Stage Hold Stage PCR Stage Post-Read Stz I:l
Number of Cycles:
Starting Cycle:
Stepl Step? Stepl Step? Stepl
< ¥
Legend
Data Collection On ~ = Data Collection Off A AutoDefa On A AutoDeka Off
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Monitor the run

View run data
Click View Run Data from the Run Experiment Menu.

The figure below shows the View Run Data screen as it appears in the example
experiment.

Run Data Report

Experiment Mame: 96-Well Presence Absence Example
Start Time: 08-11-2011 11:59:56 SGT
Stop Time: 08-11-2011 13:33:57 SGT
Run Duration: 94 minutes 1 seconds
User Name: DEFAULT
Instrument Mame: QuantStudioDemo
Firmware Version: 0.13.1
Software Version: QuantStudio 12K Flex Software v1.0
Instrument Serial Mumber: QuantStudioDemo
Sample Volume: 25.0
Cover Temperature: 105.0

Block Type: 96-Well Block (0.2mL)

Errors Encountered:

£ >
From the You can also view the progress of the run from the touchscreen of the QuantStudio™
QuantStudio™ 12K 12K Flex Instrument.
Flex Instrument The Run Method screen on the QuantStudio™ 12K Flex Instrument touchscreen
touchscreen looks like this:

Experiment View

@ Time View Plot View H|  Experiment View
Run Started: January 19 2012 - 01:53PM Sample: 60.0 °C
Reaction Volume: 20 pL Heated Cover [Set Point): 105.0 °C (105.0 °C]

Time Remaining: 01:18:40

Stage 1 Stage 2 Stage 3 Stage 4
X1 X1 1 of 40 X1
95.0 °C 95.0 °C
10:00 0:15
60.0 °C / \ 60.0 °C 0.0 °C
0:30 0:22 0:30
] o <]

January 19 2012 - 01:53PM 0

Heated cover reached target temperature.
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Monitor the run

Note: The above screenshot is for visual representation only. Actual results will vary
with the experiment.

Time View
] Time View Plot View 1]  Experiment View
Run Started: December 08 2011 - 12:05AM Sample: 59.5 °C
Reaction Volume: 20 pL Heated Cover (Set Point): 105.0 °C [105.0 °C)

Stage / Step / Cycle: 2/2/5

01:11:22

@ Remaining Time Elapsed Time

December 08 2011 - 12:06AM o

Error occurred during run. Details: Holdtime 60 s exceeded. Actual Holdtim...

Plot View
1]  Experiment View @ Time View Plot View
Fast 96-Well Tagman ¥ ARn ¥

100

December 08 2011 - 12:07AM

(1]

Heated cover reached target temperature.

Note: You will see the Plot View only if your experiment includes the PCR process.
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Review Results and
Adjust Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis
screens and publish the data. Section 5.2 of this chapter walks you through the process
of modifying experiment parameters to troubleshoot problems with experiment
results before rerunning an experiment.

This chapter covers:

Section 5.1 Review Results ..ottt ittt 25
Analyze the example experiment. .............. ... 25
View the Presence/Absence Plot .. ....... ... i, 25
Assess amplification results using the Amplification Plot................... 27
View the Well Table .. ... ... e 32
Confirm accurate dye signal using the Multicomponent Plot................ 35
Determine signal accuracy using the Raw DataPlot ....................... 38
Review the flags in the QC Summary ...................... i, 40
For more information. . . ....... ... 42

Section 5.2 Adjust parameters for re-analysis of your own experiments. ........ 43
Adjust analysis settings . ....... ... 43
For more information. . ............utiiint i 47
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Section 5.1 Review Results

Analyze the example experiment

1. Open the Presence/Absence example experiment file that you ran in Chapter 4.

2. Click Analyze. The software analyzes the data using the default analysis settings.

Note: You can also access the experiment to analyze from the Home screen.

View the Presence/Absence Plot

The Presence/Absence Plot displays the intensity of the fluorescence for each well
position. There are four Presence/Absence plot views available:

o AllCalls
* Presence calls only
* Absence calls only

e Unconfirmed calls

For each view you can choose to:
¢ Show IPC

e Show Controls

Purpose The purpose of viewing the Presence/Absence Plot for the example experiment is to
confirm that:

* The target is absent in samples NTC and Sample (-).
* The target is present in Sample (+).

¢ There are no unconfirmed wells.

* The IPC succeeded in all wells.

¢ There is no amplification in NAC wells.

To view and assess From the Experiment menu pane, select Analysis » Presence/Absence Plot.

the Presence/

Note: If no data are displayed, click Analyze.
Absence Plot

1. Display all 96 wells in the Presence/Absence Plot screen by clicking the upper left
corner of the plate layout in the Plate Layout tab.

2. Enter the Plot Settings:

Menu Selection
Target Reporter TGFB
Control Reporter IPC
Show Calls All Calls
Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 25
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5 Chapter 5 Review Results and Adjust Experiment Parameters
View the Presence/Absence Plot

Menu Selection

F Check (default)

(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)

3. Click the Show IPC check box to view the fluorescence intensity of the IPC target
in the Unknown-IPC wells.

4. Click the Show Controls check box to view the fluorescence intensity of the IPC
target in the negative control-IPC wells and the negative control-Blocked IPC

wells.

5. To view the fluorescence intensity of:
* DPresence calls— select Presence from the Show Calls drop-down menu.
* Absence calls- select Absence from the Show Calls drop-down menu.

* Unconfirmed calls- select Unconfirmed from the Show Calls drop-down
menu.

Note: The Presence/Absence example experiment does not contain any
unconfirmed calls.

The Presence/Absence Plot for the example experiment looks like this:

T

Plot Settings
Target Reporter TGFB - Show IPC [
Control Reporter ||pC hd Show Controls []
Show Calls (2] calls
[[1 save current settings as the default
h)e P LAl k=
Presence/Absence Results
1T =
B B B o5 7OE I\
L2]

12
E
- or

cl
02
Target Threshold
— T
Kl 8 13 18 23 28 33
Well Position
Legena
’7 Unikngwn Callz: @ Sresence & Abmence 7 Uncorffirmed
IPC Calls IE IPC Faled B PC
Corttris W Negetive Cortrd g Slocked [FC Cotod
‘Well Summary: In Pltz: 96 Set Up: 28 Anatyzed: 28 Flagged: 15 Omitted by Anahysis: 0 Omitted Manuzlly: 0 Samples Used: 4 Targets Used: 2
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Section 5.1 Review Results 5
Assess amplification results using the Amplification Plot

Tips for viewing * The IPC threshold is calculated from the negative control- Blocked IPC reactions.

Presence/Absence ¢ The Target Threshold is calculated from the negative control- IPC reactions. If the

plots in your own target’s intensity is:

experiments — Above the target threshold, the call is present (regardless of the intensity of
the IPC).

— Below the target threshold, and the IPC’s intensity is above the IPC
threshold, the call is absent.

— Below the target threshold, and the IPC’s intensity is below the IPC
threshold, the call is unconfirmed.

e Target Calls:
— Presence
— Absence
— Unconfirmed
e IPC Calls:
— IPC Succeeded
— [IPC Failed
¢ Control Well Calls:
— negative control - IPC
— negative control - Blocked IPC

Assess amplification results using the Amplification Plot

IMPORTANT! Amplification plots are not used to make Presence/Absence calls.
Examine the plots to help with troubleshooting and quality control.

Amplification plots  The Amplification Plot displays amplification of all samples in the selected wells.
available for There are three amplification plot views available:

viewing * ARn vs Cycle — ARn is the difference in normalized fluorescence signal generated
by the reporter between the pre-PCR read and the post-PCR read. This plot
displays ARn as a function of cycle number. You can use this plot to identify and
examine irregular amplification and to view threshold and baseline values for the
run.

* Rnvs Cycle — Rn is the fluorescence signal from the reporter dye normalized to
the fluorescence signal from the passive reference. This plot displays Rn as a
function of cycle number. You can use this plot to identify and examine irregular
amplification.

* Cyvs Well — Cyis the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Cr as a function of well
position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

Purpose The purpose of viewing the amplification plot for the example experiment is to review
the target to identify:

e Correct baseline and threshold values

* Irregular amplification

¢ OQutliers
View the 1. From the Experiment menu pane, select Analysis » Amplification Plot.
Amplification Plot Note: If no data are displayed, click Analyze.

2. Display all 96 wells in the amplification plot by clicking the upper left corner of
the plate layout in the Plate Layout tab.

3. Expand the Plate Layout tab by clicking the left facing arrow that is left of the tab.

4, In the Amplification Plot screen, enter:

Menu Selection
Plot Type ARn vs Cycle
Plot Color Well
E Check (default)

(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)

5. View the baseline values:
a. From the Graph Type drop-down menu, select Linear.
b. Select the Baseline check box to show the start cycle and end cycle.

c. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescent signal is
detected. In the example experiment, the baseline is set correctly.
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Assess amplification results using the Amplification Plot

Your screen should look like this:

Amplification Plot <

Plot Settings >

Plot Tvpe:\ARn vs Cycle v| Graph Tvpe:|Linear V‘ Plot Cn\nr:‘WeH 0‘

[] Save current settings as the default

5
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Show: [#] Threshold — [*] Baseline Start: Well B Target -~ Baseline End: Well (M Target.

¥ m
< | 3 Wels: [ o [do 2044

68 Empty

‘Well Summary: In Plste: O Set Up: 28 Analyzed: 28 Flagged: 15 Omitted by Analyss: () Omitted Manually: 0 Samples Used: 4

6. View the threshold values:
a. From the Graph Type drop-down menu, select Log.
b. Select the Threshold check box to show the threshold.
c. Verify that the threshold is set correctly.

Your screen should look like this:

Amplification Plot <L

Plot Settings

Plot Type:[ARn vs Cycle v | Graph Type:|log |~/ Plot Color:[Well v

[ Save current settings as the defaul

Targets Used: 2

£ P A s

Amplification Plot

2 2 2
‘ o Ei P 1 S T 1 S T ST
m m m
0.2
c
% 0.1 i}
0.028289 =
- _—
oot \ ( /‘ E
0.001 et =
2 4 &8 a4 w2 ou % B X F
Cycle
{-A 8 Mic Mo Me Hr Hc HH 5
Options
H
Show: [v] Threshold — [] Baseline Start: Well B Target . Baseline End: Well (M Target 4 b
& wels: [ o o 20 4 4 68 Empty
‘Well Summary: In Piate: 06 Set Up: 28 Analyzed: 28 Flagged: 15 Omitted by Analyss: 0 Omitted Manually: 0 Samples Used: 4 Targets Used: 2
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

7. Locate any outliers:
a. From the Plot Type drop-down menu, select Ct vs Well.

b. Look for outliers from the amplification plot. In the example experiment,
there are no outliers for IPC.

Your screen should look like this:

Amplification Plot <
Plot Settings
Plot Type:[CT vs Well | Graph Type: Plot Color:[well v
[] Save current settings zs the defaulf
AP aEw s
\20n Amplification Plot
I I S
-j}A B c D ME HF Hc HH
Options
Target: [Al || Threshold: s
Show: — [] Baseline Start: Well M Target 4 Baseline End: Wel (M Target 4
‘well Summary: In Plste: 96 Set Up: 28 Analyzed: 28 Flagged: 15 Omitted by Analyss: Omitted Manualty: 0 Samples Used: 4 Targets Used: 2
Tips for viewing When you analyze your own Presence/ Absence experiment, look for:
amplification plots e Outliers
In your own * A typical amplification plot — The QuantStudio™ 12K Flex Software
experiments automatically calculates baseline and threshold values based on the assumption
that the data exhibit a typical amplification plot. A typical amplification plot has
four distinct sections:
— Plateau phase
— Linear phase
— Exponential (geometric phase)
— Baseline
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Section 5.1 Review Results

Assess amplification results using the Amplification Plot

A typical amplification plot should look like this:

‘Amplification Plot
Plot Settings
Plot: Type:|ARn vs Cycle +| Graph Type:[Linear ~| Plot Color:|well ~

[ save current settings as the default

ppoa sl

Amplification Plot
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ORn

.2

} 3 B ) 2 i T Ta EY ES 2 Y EY 0 2 A a aa 20
Cycle
’V- A B C D ME NF Hc HH
Options
Target: |All ~ | Threshold:
Show: [7] Threshold — [7] Baseline Start: Wel M Target 4 Baseline End: Well (M Target 4.
Well Summary: In Piste: 96 Set Up: 28 Anatyzed: 28 Flagged: 15 Omitted by Analyss: 0 Omitted Manualty: 0 Samples Used: 4 Targets Used: 2

IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the QuantStudio™ 12K Flex Software. Life
Technologies recommends that you examine the Amplification Plot screen and review
the assigned baseline and threshold values for each well after analysis.

Note: If you use the Relative Threshold algorithm to analyze an experiment that
includes amplification, select to view the analysis results using the ARn vs Cycle, Rn vs
Cycle, or Cgy vs Well plot type and Linear or Log graph type. Also select the Show Crt
check box to view the derived fractional cycle on the amplification plot.

Amplification Plot
Plot Settings
Plot Type:|aRn vs Cycle v| Graph Type:[Llog || Plot Color:[well v

[ save current settings as the default

Amplification Plot

0.1

ARn

0.001

{-A s Mic Mo Me M- Mo WH

Options

Target: Al | Threshold:

Show: — ‘Well W Target 4 Baseine End: Wel (M Target &
[¥] Show Crt
Wwell Summary: In Plste: 06 setup: 28 Anslyzed: 28 Fiagged: 13 Omttad by Anaiyss: 0 Omtted Manually: 0 Samples Useciz 4 Targets Used: 2
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Chapter 5 Review Results and Adjust Experiment Parameters
View the Well Table

View the Well Table

The well table displays results data for each well in the reaction plate, including;:
¢ The well number, sample name, target name, task, and dyes
e The calculated values: ARn, ARn mean, and ARn SD

Note: ARn, ARn mean, and ARn SD are calculated only when the analysis call
settings specify to analyze data from the pre-PCR read and the post-PCR read.

¢ Target and IPC thresholds, Call, Comments
¢ Flags

Purpose In the Presence/Absence example experiment, you review the well table for:
e Call
¢ ARn
* Flag

To view the Well 1. From the Experiment Menu pane, select Analysis » Amplification Plot, then
Table select the Well Table tab.

Note: If no data are displayed, click Analyze.

2. Use the Group By drop-down menu to group wells by a specific category. For the
example experiment, group the wells by flag, call, and ARn value.

Note: You can select only one category at a time.
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View the Well Table

a. From the Group By drop-down menu, select Flag:

* 30 wells are listed under Flagged.

¢ 66 wells are listed under Unflagged.

Expand all
# Well | Omit Flag Sample ... Target.. Task Dyes ARR ARn Mean | ARn SD Thresh... | Call Comme... | AMPNC NO.
= feggegwpels . B
5 AS ] 3 HTC IPC HTC VIC-TAMRA 0.658 0.657 0.010 Negative C...
5 AS ] 3 HTC TGFB IPC FAM-HFQ-... 0.056 0.059 0.008 IPC Falled
6 A6 [ 3 HTC IPC HTC VIC-TAMRA 0.646 0.657 0.010 MNegative C...
6 A6 (i 3 HTC TGFB IPC FAM-HFQ-... 0.056 0.059 0.008 IPC Falled
7 A7 [ 3 HTC IPC HTC VIC-TAMRA 0.670 0.657 0.010 MNegative C...
7 A7 (i 3 HTC TGFB IPC FAM-HFQ-... 0.054 0.059 0.008 IPC Falled
8 A8 [ 3 HTC IPC HTC VIC-TAMRA 0.653 0.657 0.010 MNegative C...
8 A8 (i 3 HTC TGFB IPC FAM-HFQ-... 0.071 0.059 0.008 IPC Falled
13 B1 [ A\ (+) IPC IPC VIC-TAMRA 0.106 0.549 0.158 0.717 Absence
13 B1 (i 1 (+) TGFB UNKNOWN  FAM-MFQ-... 0.478 1.511 0.367 0.095 IPC Succe... B
25 C1 [ A\ (-) IPC IPC VIC-TAMRA 0.532 0.622 0.177 0.717 Unconfirmed
25 C1 (i 1 (-) TGFB UNKNOWN  FAM-MFQ-... -0.127 0.048 0.064 0.095 IPC Falled
26 C2 [ A\ (-) IPC IPC VIC-TAMRA 0.681 0.622 0.177 0.717 Unconfirmed
26 C2 (i 1 (-) TGFB UNKNOWN  FAM-MFQ-... 0.030 0.048 0.064 0.095 IPC Falled
27 G [ 2 (-) IPC IPC VIC-TAMRA 0.684 0.622 0.177 0.717 Unconfirmed
27 G (i 2 (-) TGFB UNKNOWN  FAM-MFQ-... 0.056 0.048 0.064 0.095 IPC Falled
28 4 [ 2 (-) IPC IPC VIC-TAMRA 0.700 0.622 0.177 0.717 Unconfirmed
28 4 (i 2 (-) TGFB UNKNOWN  FAM-MFQ-... 0.076 0.048 0.064 0.095 IPC Falled
29 C5 [ 2 (-) IPC IPC VIC-TAMRA 0.692 0.622 0.177 0.717 Unconfirmed
29 C5 (i 2 (-) TGFB UNKNOWN  FAM-MFQ-... 0.071 0.048 0.064 0.095 IPC Falled
30 C6 [ 2 (-) IPC IPC VIC-TAMRA 0.690 0.622 0.177 0.717 Unconfirmed
30 C6 (i 2 (-) TGFB UNKNOWN  FAM-MFQ-... 0.064 0.048 0.064 0.095 IPC Falled
31 G [ 2 (-) IPC IPC VIC-TAMRA 0.715 0.622 0.177 0.717 Unconfirmed
31 G (i 2 (-) TGFB UNKNOWN  FAM-MFQ-... 0.082 0.048 0.064 0.095 IPC Falled
32 [ 2 (-) IPC IPC VIC-TAMRA 0.688 0.622 0.177 0.717 Unconfirmed
32 (i 2 (-) TGFB UNKNOWN  FAM-MFQ-... 0.068 0.048 0.064 0.095 IPC Falled
3 o [ 2 (-) IPC IPC VIC-TAMRA 0.703 0.622 0.177 0.717 Unconfirmed
3 o (i 2 (-) TGFB UNKNOWN  FAM-MFQ-... 0.072 0.048 0.064 0.095 IPC Falled
34 Cio [ 2 (-) IPC IPC VIC-TAMRA 0.140 0.622 0.177 0.717 Unconfirmed
34 Cio ] 2 (-) TGFB UNKNOWN  FAM-MFQ-... 0.089 0.048 0.064 0.095 IPC Falled
= Unflagged Wells
1 Al (i HAC IPC BlockedIPC  VIC-TAMRA 0.096 0.098 0.013 Blocked IP...
1 Al [ HAC TGFB HTC FAM-HFQ-... 0.078 0.073 0.004 MNegative C...
2 A2 (i HAC IPC BlockedIPC  VIC-TAMRA 0.086 0.098 0.013 Blocked IP... B
JEE : "
Well Summary: In Plste: 96 Set Up: 28 Anshzed: 28 Flagged: 15 Omitted by Anahysis: Omitted Manually: 0 Samples Used: 4 Targets Used: 2
b. From the Group By drop-down menu, select Call. Wells are listed in the
order:
e Absence
e Blocked IPC Control
e IPC Failed
e JPC Succeeded
¢ Negative Control
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View the Well Table

e Unconfirmed
e No Call

Group by ¥ Expand Al
# Well | Omit Flag Sample ... Target.. Task Dyes ARN ARn Mean  ARn SD Thresh... = Call Comme... | AMPNC NO

&
13 B1 O 1 (+) PC 1PC VIC-TAMRA 0.106 0.54¢ 0.158 0.717 Absence
14 B2 O (+) rc PC VIC-TAMRA 0.598 0.549 0.158 0.717 Absence
15 B3 O (+) PC PC VIC-TAMRA 0.629 0.54% 0.158 0.717 Absence
16 B4 O (+) PC 1PC VIC-TAMRA 0.606 0.549 0.158 0.717 Absence
17 BS O (+) PCc PC VIC-TAMRA 0.612 0.549 0.158 0.717 Absence
18 Bo6 O (+) Pc PC VIC-TAMRA 0.609 0.549 0.158 0.717 Absence
19 B7 O (+) PC 1PC VIC-TAMRA 0.609 0.54¢ 0.158 0.717 Absence
20 B8 | (+) PC 1PC VIC-TAMRA 0.604 0.549 0.158 0.717 Absence

21 B9 O (+) Pc PC VIC-TAMRA 0.590 0.549 0.158 0.717 Absence B
22 BlO O (+) IPC 1PC VIC-TAMRA 0.530 0.549 0.158 0.717 Absence

B Blocked IPC Control
1 A O MNAC PC BlockedIPC  VIC-TAMRA 0.096 0.008 0.013 Blocked IP...
2 A2 O NAC PC BlockedIPC  VIC-TAMRA 0.086 0.098 0.013 Blocked IP...
3 A3 O NAC PC BlockedIPC  VIC-TAMRA 0.094 0.098 0.013 Blocked IP...
4 A4 O MAC PC BlockedIPC  VIC-TAMRA 0.116 0.098 0.013 Blocked IP...
B IPC Failed
5 A5 O 3 NTC TGFB 1PC FAM-NFQ-... 0.058 0.059 0.008 IPC Failed
6 A6 O 3 NTC TGFB PC FAM-NFQ-... 0.056 0.059 0.008 IPC Failed
7 A7 O 3 NTC TGFB PC FAM-NFQ-... 0.054 0.05% 0.008 IPC Failed
8 A8 O 3 NTC TGFB 1PC FAM-NFQ-... 0.071 0.059 0.008 IPC Failed
25 Cl O 1 ) TGFB UMKNOWN ~ FAM-NFQ-... -0.127 0.048 0.064 0.095 IPC Failed
26 C2 O 1 ) TGFB UNKNOWN  FAM-NFQ-... 0.030 0.048 0.064 0.085 IPC Failed
27 . O 2 () TGFB UMKNOWN  FAM-NFQ 0.058 0.048 0.064 0.095 IPC Failed
28 4 | 2 ) TGFB UMKNOWN  FAM-NFQ-. 0.076 0.048 0.064 0.095 IPC Failed
29 G5 O 2 ) TGFB UNKNOWN  FAM-NFQ 0.071 0.048 0.064 0.085 IPC Failed
30 6 O 2 ) TGFB UNKNOWN  FAM-NFQ-. 0.064 0.048 0.064 0.095 IPC Failed
31 o O 2 ) TGFB UMKNOWN  FAM-NFQ 0.082 0.048 0.064 0.095 IPC Failed
32 c O 2 ) TGFB UNKNOWN  FAM-NFQ-. 0.068 0.048 0.064 0.095 IPC Failed
33 O 2 ) TGFB UNKNOWN  FAM-NFQ 0.072 0.048 0.084 0.095 IPC Failed
34 Ci0 O 2 (-) TGFB UMKNOWN  FAM-NFQ 0.089 0.048 0.064 0.095 IPC Failed
B IPC Succeeded

13 Bl O 1 (+) TGFB UNKNOWN  FAM-NFQ-. 0.478 1.511 0.367 0.095 IPC Succe...
14 B2 O (+) TGFB UMKNOWN  FAM-NFQ 1.713 1.511 0.367 0.095 IPC Succe...

15 B3 O (+) TGFB UNKNOWN  FAM-NFQ 1.628 1.511 0.367 0.095 IPC Succe... v

& : ] 5

Well Summary: In Plate: 96 Set Up: 28 Anahyzed: 28 Fiagged: 15 Omitted by Anatysis: 0 Omitted Manually: 0 Samples Used: 4 Targets Used: 2

c. From the Group By drop-down menu, select None. In the table, click the
column heading ARn. Wells are listed in order of increasing ARn. Click the
column heading again to reverse the sort order.

in Table ¥ Group by ¥ <pa Callspse Al
# Well | Omit Flag Sample ...| Target ... | Task Dyes ARn 71| ARn Mean ARn SD Thresh... | Call Comme... = AMPNC NO
14 B2 O (+) TGFB UNKNOWN  FAM-NFQ-... 1.713 1.511 0.367 0.095 IPC Succe... o)
19 87 O (+) TGFB UNKNOWN  FAM-NFQ 1.656 1.511 0.367 0.095 IPC Succe.
20 B8 O (+) TGFB UNKNOWN  FAM-NFQ 1.645 1.511 0.367 0.095 IPC Succe.
16 B4 O (+) TGFB UNKNOWN  FAM-NFQ 1.640 1.511 0.367 0.095 IPC Succe.,
17 BS O (+) TGFB UNKNOWN  FAM-NFQ 1.635 1.511 0.367 0.095 IPC Succe.
15 B3 O (+) TGFB UNKNOWN  FAM-NFQ 1.628 1.511 0.367 0.095 IPC Succe.
18 Bo O (+) TGFB UNKHOWN  FAM-NFQ-... 1.619 1.511 0.367 0.005 IPC Succe.
21 B9 O (+) TGFB UNKNOWN  FAM-NFQ-... 1.604 1.511 0.367 0.095 IPC Succe...
22 B10 O (+) TGFB UNKNOWN  FAM-NFQ-... 1.489 1.511 0.367 0.095 IPC Succe...
31 a O 2 ) PC 1PC VIC-TAMRA 0.715 0.622 0.177 0.717 Unconfirmed
33 o O 2 ) Pc PC VIC-TAMRA 0.703 0.622 0.177 0.717 Unconfirmed u
28 4 O 2 ) PC PC VIC-TAMRA 0.700 0.622 0.177 0.717 Unconfirmed
29 G5 | 2 ) PC 1PC VIC-TAMRA 0.692 0.622 0.177 0.717 Unconfirmed
30 Ce O 2 ) sy PC VIC-TAMRA 0.690 0.622 0.177 0.717 Unconfirmed
32 8 O 2 ) PC 1PC VIC-TAMRA 0.688 0.622 0.177 0.717 Unconfirmed
27 G O 2 ) PC 1PC VIC-TAMRA 0.684 0.622 0.177 0.717 Unconfirmed
26 Q2 O 1 ) rc PC VIC-TAMRA 0.681 0.622 0.177 0.717 Unconfirmed
7 A7 O 3 NTC PC NTC VIC-TAMRA 0.670 0.657 0.010 Negative C...
5 A5 O 3 NTC PC NTC VIC-TAMRA 0.658 0.657 0.010 Negative C...
8 A8 O 3 NTC PCc NTC VIC-TAMRA 0.653 0.657 0.010 Negative C...
6 A6 O 3 NTC PC NTC VIC-TAMRA 0.640 0.657 0.010 Negative C...
15 B3 O (+) PC 1PC VIC-TAMRA 0.629 0.54¢ 0.158 0.717 Absence
17 B85 O (+) PC 1rC VIC-TAMRA 0.612 0.549 0.158 0.717 Absence
19 87 O (+) Pc PC VIC-TAMRA 0.609 0.549 0.158 0.717 Absence
18 B6 O (+) PC 1PC VIC-TAMRA 0.609 0.549 0.158 0.717 Absence
16 B4 O (+) PC 1PC VIC-TAMRA 0.606 0.549 0.158 0.717 Absence
20 BB O (+) Pc PC VIC-TAMRA 0.604 0.549 0.158 0.717 Absence
14 B2 O (+) PC PC VIC-TAMRA 0.598 0.54% 0.158 0.717 Absence
21 B9 | (+) PC 1PC VIC-TAMRA 0.580 0.549 0.158 0.717 Absence
25 O 1 ) sy PC VIC-TAMRA 0.532 0.622 0.177 0.717 Unconfirmed
22 B10 O (+) PC 1PC VIC-TAMRA 0.530 0.549 0.158 0.717 Absence
13 B1 O 1 (+) TGFB UNKNOWN  FAM-NFQ-... 0.478 1.511 0.367 0.095 IPC Succe...
34 c1o O 2 ) rc PC VIC-TAMRA 0.140 0.622 0.177 0.717 Unconfirmed
4 A4 O NAC PC BlockedIPC  VIC-TAMRA 0.116 0.098 0.013 Blocked IP...
13 Bl O 1 (+) PC 1PC VIC-TAMRA 0.106 0.549 0.158 0.717 Absence v
m— e =
Well Summary: In Plate: 96 Set Up: 28 Anahyzed: 28 Flagged: 15 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 4 Targets Used: 2
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Confirm accurate dye signal using the Multicomponent Plot

Tips for analyzing When you analyze your own Presence/Absence experiment, group the wells by:

your own .
experiments

Flag —The software groups the flagged and unflagged wells. A flag indicates that
the software has found an error in the flagged well. For a description of the
QuantStudio™ 12K Flex Software flags, see “Review the flags in the QC
Summary” on page 40.

Call - The software groups the wells by call: Negative Control, Blocked-IPC,
Presence, Absence, Unconfirmed, IPC Succeeded, and IPC Failed.

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.

Purpose In the Presence/Absence example experiment, you review the Multicomponent Plot
screen for:

View the 1.

Multicomponent
Plot

ROX™ dye (passive reference)
FAM™ dye (reporter)

VIC® dye (reporter)

TAMRA (reporter)

Spikes, dips, and/or sudden changes

Amplification in the negative control wells

From the Experiment Menu pane, select Analysis » Multicomponent Plot.

Note: If no data are displayed, click Analyze.

Display the wells one at a time in the Multicomponent Plot screen:
a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

From the Plot Color drop-down menu, select Dye.

Click EI Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Check the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the PCR process; a constant ROX dye signal
indicates typical data.
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Confirm accurate dye signal using the Multicomponent Plot

6. Check the VIC dye signal. In the example experiment the VIC dye signal should
not amplify for NAC-Blocked IPC wells or if the IPC call for the Unknown-IPC
well is IPC Failed.

Multicomponent Plot
Plot Settings

[[] save current settings as the default
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Well Summary: In Plste: 06 Set Up: 28 Anatyzed: 28 Flagged: 15 Omitted by Anatysis: Omitted Manually: 0 Samples Used: 4 Targets Used: 2

7. Check the FAM dye signal. In the example experiment, for the sample (+), the
FAM dye signal increases throughout the PCR process; increase in FAM dye
signal indicates normal amplification.

Well Table

Multicomponent Plot
Plot Settings

[[] Save current settings as the default

v [z [ s [ 4+ [ s R
o o ﬁﬂ‘ By \g = NAC NAC ENAC NAC 31 3’ 3’ 3)
A [H] W] [N] [K]
K] 5] o ] a E a a
Multicomponent Plot 1 t('ﬂ E(;) () E(;J ) E[IH ) E(;) EEIH
47.500,000 f < c E ol - = < < E
e -l
42 500,000 | —
40,000,000
37,500,000
35,000,000 -
32,500,000 P
30,000,000 7 o
27,500,000 ot
25000000 { ——————————————————— — - 1
22,500,000
20,000,000 E
17,500,000
15,000,000
12,500,000 F
10,000,000
7,500,000 [
6,000,000
2,500,000

o -
0 2 4 B & W 2 W 18 18 W W ¥ MW W A} W X B W o4 &2

@

2

e e e Y

-

Fluorescence

H

e

Ml Fav Il ROX M VIC TAMRA

wels: [ o [Jo f=420 &4 4 68 Empty
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Section 5.1 Review Results 5
Confirm accurate dye signal using the Multicomponent Plot

8. Check the TAMRA dye signal. In the example experiment the TAMRA dye signal
should not amplify for NAC-Blocked IPC wells or if the IPC call for the
Unknown-IPC well is IPC Failed.

Multicomponent Plot
Plot Settings

[] save current settings as the default 4

NAC MAC MAC NAC 3 a 3 3
D =
o o @ o (2O OpEc
Multicomponent Plot 1 ;) ;J ;J ;) ) ;J ;) Etl*-) ;J
47 500,000 o =T = = = = 2§ =T = BT
45,000 000 'ﬁ.@

42,500,000 -
40,000,000 1 1 2 2 2 2 2 2 2 2
37,500,000 ?ﬂ 7ﬂ ?ED ?ﬂ >ﬂ ?ﬂ ?ﬂ 7ﬂ ?ﬂ ?ﬂ
35,000,000 m m m m m m m m m m
32,500,000
30,000,000 o
27 500,000 :
25,000,000 i
22,500,000
20,000,000
17,500,000 | |
16,000,000
12,500,000 F
10,000,000
7,500,000
5,000,000
2,500,000
o I

]
Ao}
I
&
=
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m

[l

Fluorescence

Legena

Il Fa Il ROX I VIC TAMRA

sells: U [ 68 Empty
wels: [ o o ZDE44

Well Summary: In Plate: 96 Set Up: 28 Analyzed: 28 Flagged: 15 Omitted by Analysi: 0 Omitted Manuzliy: 0 Samples Used: 4 Targsts Used: 2

9. Select the negative control (NTC) wells one at time and check for amplification. In
the example experiment, there is no amplification in the negative control wells.

Multicomponent Plot
Plot Settings

[] Save current settings as the defauft 1 ‘ 2 ‘ 3 4 5 ‘ & | 7 | [ ‘ 9 | 10 | 11 ‘ 12 |

Multicomponent Plot 1 +) () (+) +) () ) (+) ) )
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‘Well Summary: In Plste: 86 Set Up: 28 Anaiyzed: 28 Flagged: 15 Omitted by Analysis: () Omitted Manualty: 0 Samples Used: 4 Targets Used: 2
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Determine signal accuracy using the Raw Data Plot

Tips for confirming  When you analyze your own Presence/Absence experiment, look for:

dye accuracy in .
your own
experiment .

Passive reference (ROX)- The passive reference dye fluorescence level should
remain relatively constant throughout the PCR process.

Reporter dye (FAM) — The reporter dye fluorescence level should display a flat
region corresponding to the baseline. If target is present in the sample (a Presence
call is made), the baseline will be followed by a rapid rise in fluorescence as the
amplification proceeds.

Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

Negative control wells — There should not be any amplification in the negative
control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.

Pu rpose In the Presence/Absence example experiment, review the Raw Data Plot screen for a
stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data 1.

Plot

From the Experiment Menu pane, select Analysis » Raw Data Plot.
Note: If no data are displayed, click Analyze.
Click EI Show a legend for the plot (default). The legend displays the color

code for each row of the reaction plate (see the legend in the Raw Data Plot shown
below).

Display all 96 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.
Select wells corresponding to a replicate group:

¢ (-) wells: From the Select Wells with drop-down menus, select sample (-).

* (+) wells: From the Select Wells with drop-down menus, select sample (+).

* Negative control-IPC wells: Select wells A5-AS8.

* Negative control-blocked IPC wells: Select wells A1-A4.
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Section 5.1 Review Results 5
Determine signal accuracy using the Raw Data Plot

5. Click and drag the Show Cycle pointer from cycle 1 to cycle 42. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.

Raw Data Plot <

Raw Data Plot

260,000,000
250.000.000
240,000,000
230.000.000
220,000,000
210.000.000
200,000,000
190,000,000
180,000,000
170,000,000
160,000,000
150,000,000
140,000,000
130,000,000
120,000,000
110,000,000
100,000,000
90,000,000
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70,000,000
60,000,000
50,000,000
40,000,000
30,000,000
20,000,000
10.000.000

Amplitude

a
-10.000.000 |
1o x2'mz x3md e x5-mS

Legs

L B c o e HF N HH

Options

Show Cycle 42
1 5 10 15 20 25 30 35 40 42

Well Summary: In Pist=: 06 SetUp: 28 Analyzed: 28 Flagged: 15 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 4 Targets Used: 2

The filters used for the example experiment are:

Run Method
Reaction Volume per Well: uL

PCR Filter =

Emission Filter

m1(520+15) m2(558=11) m3(586+10) m4(623+14) m5(682+14) m6(711+12)
x1(470£15)

¥2(520+10)

*¥3(550411)

Excitation Filter

¥4(58010)

x5(64010)

x6(6624+10)

Melt Curve Filter [==]

Emission Filter
ml(520+15) m2(558=11) m3(586+10) m4(623=14) m5(682x14) m6(711+12)
x1(470415)

*¥2(520£10)

¥3(550+11)

Excitation Filker

*4(580+10)

¥5(640210)

X6(66210)
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Review the flags in the QC Summary

Tips for When you analyze your own Presence/ Absence experiment, look for the following in
determining signal  each filter:

accuracy in your ¢ Characteristic signal growth

own experiments * No abrupt changes or dips

Review the flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags,
including the flag frequency and location for the open experiment. In the example
experiment, 31 flags have been triggered.

Note: The flags triggered in the example experiment are seen in the (+) and (-) wells.
The flag NOAMP indicates that the well containing the sample (+) did not amplify. The
flags, NOAMP and EXPFAIL indicate that the wells containing the sample (-) did not
amplify and and that the software could not identify the exponential region of the
amplification plot (as amplification did not take place). The occurrence of these flags in
the (-) wells in the example experiment is valid because it indicates the absence of the
target in the sample.

View the QC 1. From the Experiment Menu pane, select Analysis » QC Summary.
Summary Note: If no data are displayed, click Analyze.

2. Review the Flags Summary

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the experiment. If the frequency is >0, the flag appears somewhere in
the experiment; the well position is listed in the Wells column.

In the example experiment, there are 15 flagged wells.
3. In the Flag Details table, click each flag with a frequency >0 to display detailed
information about the flag. In the example experiment:
* The NOAMP flag appears 13 times, in the wells A5 - A8, B1, C3 - C10.

¢ The EXPFAIL flag appears 14 times, in the same wells as the NOAMP flag,
that is, A5 - A8, B1, C3 - C10. In addition, the flag EXPFAIL also appears in
the B1 well.

e The AMPNC flag appears 4 times, in the wells A5-A8.
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Section 5.1 Review Results
Review the flags in the QC Summary

4. (Optional) For those flags with frequency >0, click the troubleshooting link to view
information on correcting the flag.

e

Flag: Description Frequency Wells
BADROX Bad passive reference signal 1]
NOSIGNAL Mo signal in well 0
OFFSCALE Fluorescence is offscale 0
AMPNC Amplification in negative control 14 A5, AB, A7, AB
NOAMP o amplification 13 |AS, AG, A7, A8, B1, C3, C4, C5, C6, C7, C8, C9, C10
NOISE oise_higher than others in plate 0
SPIKE nise spikes 0
=XPFAIL Exponential algorithm failed 14 AS, A6, A7, A8, C1, C2, C3, ¢4, C5, C6, C7, C8, €9, C10
LFAIL Baseline algorithm failed
HOLDFAIL Thresholding algerithm failed
TFAIL |Cr algorithm failed
AMPSCORE |AMP Scare

Flag: NOAMP—No amplfication
Flag Detail: The sample did not amplify.
Flag Criteria: Ampification algorithm resuft < 0.1
Flagged Wells: A5, AG, A7, A8, B1, C3, C4, C5, C6, C7, C8, C9, C10
View NOAMP Troubleshooting Information

e Se U 20 | Fagoed viele ™ 75 Homhes Orted ek o | Sames Uond ;
Well Summary: 1n P 06 s JR—— E— ot by Arsya: 0 onitd Manuaty:0 e Uses & Targt e 2
Possible flags For Presence/Absence experiments, the flags listed below may be triggered by the
experiment data.
Flag Description
Pre-processing flag
OFFSCALE Fluorescence is offscale
Primary analysis flags

BADROX Bad passive reference signal
NOAMP No amplification
NOISE Noise higher than others in plate
SPIKE Noise spikes
NOSIGNAL No signal in well
EXPFAIL Exponential algorithm failed
BLFAIL Baseline algorithm failed
THOLDFAIL Thresholding algorithm failed
CTFAIL Cy algorithm failed
AMPSCORE Amplification in the linear region is below a certain

threshold, corresponding to the score set in the

analysis settings
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Chapter 5 Review Results and Adjust Experiment Parameters
For more information

Flag Description

Secondary analysis flags

AMPNC Amplification in negative control

Note: If the experiment does not include amplification, then the only flags are
BADROX, NOSIGNAL, and OFFSCALE.

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL,
THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in
the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

For more information

For more information on... Refer to... Part number
Publishing data Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050
System Multi-Well Plate and Array Card Experiments

42 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
Experiments User Guide for Presence/Absence Experiments



Section 5.2 Adjust parameters for re-analysis of your own experiments 5
Adjust analysis settings

Section 5.2 Adjust parameters for re-analysis of your
own experiments

Adjust analysis settings

View the analysis
settings

The Analysis Settings dialog box displays the analysis settings for the call, threshold
cycle (Cy), flags, and advanced options.

If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable
for your own experiment, you can change the settings in the Analysis Settings dialog
box, then reanalyze your experiment.

1. From the Experiment Menu pane, select Analysis.

2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.
In the example experiment, the default analysis settings are used for each tab:
¢ Call Settings
o Cy Settings
¢ Flag Settings
* Advanced Settings

The Analysis Settings dialog box for a Presence/Absence experiment looks like
this:

o T

—EI

CT Settings Flag Settings

Advanced Settings

e target from the table, deselect Use Default 3

— Data Analysis Settings

(O Analyze Data from Post-PCR Read Only

(® Analyze Data from Pre-PCR Read and Post-PCR Read

-~ Default Call Settings

Default call settings are used to make presence/absence calls for targets without custom settings. To edit the default settings, dick Edit Default Settings.

Confidence Value: 99% Edit Default Settings

— Select a Target

— Call Settings for TGFB

Target Analysis Type Confidence Call Settings to Use: [#] Default Settings
TGFB Default 100% ad
IPC Default 09%

Save to Library Load from Library

Revert to Default Analysis Settings Apply Analysis Settings [m
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Chapter 5 Review Results and Adjust Experiment Parameters

Adjust analysis settings

Adjust analysis
settings

44

3. View and, if necessary, change the analysis settings (see “Adjust analysis settings”

below).

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well
Plate and Array Card Experiments.

. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to
Default Analysis Settings.

Call Settings
Use the Call Settings tab to:

Change the default data analysis settings. You can select from:
— Analyze data from Post-PCR Read only
— Analyze data from Pre-PCR Read and Post-PCR Read

e Edit the default call settings.

— Click Edit Default Settings, then select the confidence value to use to make
presence/absence calls. If the confidence value is less than the call setting, the
call is unconfirmed.

— Click Save Changes.

¢ Use custom call settings for a target.

— Select one or more targets in the table, then deselect the Default Settings
checkbox.

— Select the confidence value to use to make Presence/Absence calls for the
selected target(s).

Ct Settings
e Data Step Selection

Use this feature to select one stage/step combination for Ct analysis when there is
more than one data collection point in the run method.

Algorithm Settings

You can select the algorithm that determines the Cy values. There are two
algorithms: Baseline Threshold (the default) and Relative Threshold.

The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for quantification.

The Relative Threshold algorithm is a well-based analysis based on the PCR
reaction efficiency and fitted to the Amplification curve. This setting is ideal for a
single sample across genes with no dependence on targets, thereby reducing
variability. It is not necessary to set either a baseline or a threshold when you use
the Relative Threshold algorithm, so any settings for baseline or threshold will
not affect the analysis.
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Section 5.2 Adjust parameters for re-analysis of your own experiments 5
Adjust analysis settings

¢ Default Cy Settings

Use the default Cr settings feature to calculate Cr for the targets that do not have
custom settings. To edit the default settings, click Edit Default Settings.

® Cp Settings for Target
When you manually set the threshold and baseline, Life Technologies

recommends:
Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
¢ Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.

Flag Settings
Use the Flag Settings tab to:

* Adjust the sensitivity so that more wells or fewer wells are flagged.
¢ Change the flags that are applied by the QuantStudio™ 12K Flex Software.

To adjust the flag settings:
1. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of Ct SD. For some flags, analysis results calculated before
the well is rejected are maintained.

4. Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Adjust analysis settings

The Flag Settings tab looks like this:

... Analysis Settings for 96-Well Presence Absence Example

Call Settings CT Settings Flag Settings Advanced Settings

@ Confiqure the flags and fitering. In this panel you can enabie, disable, and configure fiags, and indicate if a well & to be rejected when a flag s raised.

Flag Description Use Attribute Condition Value Reject well
BADROX Bad passive referenc... Fluorescence < « [500.000
MOSIGHAL Mo signal in well I
OFFSCALE Fluorescence is offscale I
AMPHC Amplification in negat...| T < w [35.000 (]
HOAMP Mo amplfication Amplification algorith... |< w (0.100 (]
MOISE Moise higher than of... Relative noise > w [4.000 (]
SPIKE Moise spikes Spike algorithm result  |= w [1.000 (]
EXPFAIL Exponential algorithm...| I
BLFAIL Baseline algorithm failed| I
THOLDFAIL Thrasholding algorith... I
CTFAIL CT algorithm failed I
AMPSCORE AMP Score AMP Score > w [1.000 (]

Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings [W

Advanced Settings
Use the Advanced Settings tab to change baseline settings well-by-well.

Note: The baseline and threshold values do not affect the analysis using the Relative
Threshold setting.

To use custom baseline settings for a well-target combination:
1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target check box.

3. Define the custom baseline settings:

e TFor automatic baseline calculations, select the Automatic Baseline check
box.

¢ To define the baseline, deselect the Automatic Baseline check box, then enter
the baseline start cycle and baseline end cycle.
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For more information

For more information

For more information on... Refer to Part number

Amplification efficiency Amplification Efficiency of TagMan® Gene 127AP05-03
Expression Assays Application Note.
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For more information
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Export Analysis Results

1. Open the Presence/Absence example experiment file that you analyzed in
Chapter 5.

2. In the Experiment Menu, click % Export.

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

3. Select QuantStudio'" 12K Flex format.

4. Complete the Export dialog box as shown below:

Field or Selection Entry

Select Data to Results

export/ Select

Content

Export Data To One File

Export File Name 96-Well Presence Absence Example_QuantStudio_export

File Type * txt

Export File Location | <drive>:\Applied Biosystems\QuantStudio 12K Flex
Software\experiments
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Chapter 6 Export Analysis Results

Your Export screen should look like this:

[ Auto Export Format : |QuantStudio 12KFlex v| Export Data To: (& One File (O Separate Files Open file(s) when export is complete

Export File Location: ‘C:\Applied Biosystems\QuantStudio 12K Flex SD&ware\uE| Export File Name: |96-Well Presence Absence Example_Guant<| Fie Type: ‘EJ (=) v

[] Sample sstup [] Raw Data [ amplification ] multicompenent:

B Skip Empty Wells B Skip Omitted Wells

Select Content Well Well Position Sample Name | Target Name Task Reporter Quencher D
[¥] All Fields 2, 1AL NAC PC BlockedIPC VIC TAMRA ~
1AL NAC TGFB NTC FAM NFQ-MGB
el 2A2 NAC PC BlockedIPC vIC TAMRA
wel Posttion 242 NAC TGFB NTC FAM NFQ-MGB
3A3 NAC PC BlockedIPC vIc TAMRA
sample Name 343 NAC TGFB NTC FAM NFQ-MGB
404 NAC PC BlockedIPC vIc TAMRA
Target Name 424 NAC TGFB NTC FAM NFQ-MGB
5A5 NTC PC NTC vIc TAMRA
Task 545 NTC TGFB PC FAM NFQ-MGB
Reporter 646 NTC PC NTC VIC TAMRA
6 A6 NTC TGFB IPC FAM NFQ-MGB
Quencher 747 NTC PC NTC VIC TAMRA
7 A7 NTC TGFB IPC FAM NFQ-MGB
Defta Rn 8AB NTC PC NTC VIC TAMRA
8 A8 NTC TGFB IPC FAM NFQ-MGB
Defta R Mean 1381 ) PC IPC vIC TAMRA 3
Delta Rn SD 13B1 (+) TGFB UNKNOWN FAM NFQ-MGB
1482 (+) PC IPC VIC TAMRA
Thrashold Value 1482 (+) TGFB UNKNOWN FAM NFQ-MGB
1583 (+) PC IPC VIC TAMRA
Gal 1583 (+) TGFB UNKNOWN FAM NFQ-MGB
1684 (+) PC IPC VIC TAMRA
Comments 1684 (+) TGFB UNKNOWN FAM NFQ-MGB
Automatic Ct Threshold | 1785 (+) pc pc vic TAMRA
1785 (+) TGFB UNKNOWN FAM NFQ-MGB
Ct Threshold 18B6 ) PC IPC VIC TAMRA
1886 (+) TGFB UNKNOWN FAM NFQ-MGB
Automatic Baseline 1987 (+) o PC vic TAMRA
1987 (+) TGFB UNKNOWN FAM NFQ-MGB 2
Baseline Start ¥ | 5

lw Save Export Set As Load Export Set Delete Export Set

Your exported file when opened in Notepad should look like this:

96-Well Presence Ab:
Fle Edit Format View Help

[ Barcode = NA -~
* Block Type = 96-well Block (0.2mL) =
Calibration Background is expired = No

Calibration Background performed on = 2011-08-08 01:15:53 AM SGT

Calibration FAM is expired = No

calibration FAM performed on = 2011-08-08 01:39:38 AM 5GT

calibration ror is expired o

calibration ROI performed on = 2011-08-08 01:05:24 AM 5GT

calibration rox is expired = NO

calibration ROX performed on = 2011-08-08 02:07:15 AM 5GT

calibration syBr is expired = no

calibration SYBR performed on = 2011-08-08 01:58:11 AM SGT

calibration TaMRa is expired = o

Calibration TaMrRa performed on = 2011-08-08 02:16:10 AM SGT
calibration uniformity is expired = nNo

calibration uniformity performed on = 2011-08-08 01:24:47 AM SGT
calibration vIC is expired = No

Calibration vIC performed on = 2011-08-08 01:49:09 AM SGT

Chemistry = TAQWAN -
Comment = NA

Date Created = 1970-01-01 07:30:00 AM SGT

Exp$r1msnt File Name = C:\Program Files‘\applied Biosystems‘\QuantStudiol2kFlex\examples\Presence Absence'96-well Presence Absence
Example. eds

Experiment Name = 96-Well Presence Absence Example

Experiment Run End Time = Not started

Experiment Type = Presence/absence

Instrument Name = QuantstudioDemo

Instrument serial Number = quantstudiobemo

Instrument Type = Quantstudio 12K Flex

Passive rReference = rROX

Quanmﬁcat‘luﬂ Cycle Method =

signal smoothing on = true

Stage/ Cycle where Analysis is performed = Stage 3, Step 2

user Name = NA

E ok % R % R R E R E RM B X R KR KK T KK KK KK EREXE T

[Results]
well well position  Sample Name Target Name ask Reporter qQuencher Delta Rn pelta Rn Mean Delta Rn SD
Threshold value call Comments Automatic Ct Thr‘esho'\d ct Threshold Automatic Baseline Baseline start Baseline end
AMPNC NOAMP EXPFAIL
1 Al NAC IPC BlockedIPC VIC TAMRA  0.096 0.098 0.013 0.000 Blocked IPC control false
0.028 true 3 39 N N N
Al NAC TGFB NTC FAM NFQ-MGB 0.078 0.073 0.004 0.000 Negative Control false 0.200
false 3 15 N N N
A2 NAC IPC BlockedIPC VIC TAMRA  0.086 0.098 0.013 0.000 Blocked IPC Control false
0.028 True 3 9 N N N
2 A2 NAC TGFB NTC FAM NFQ-MGB 0.073 0.073 0.004 0.000 Negative Control false 0.200
false 3 15 N N N
A3 NAC IPC B1 uckedIPC VIC TAMRA  0.094 0.098 0.013 0.000 Blocked IPC Control false
0.028 true 3 4 N N
3 A3 NAC TGFB NTC FAM NFQ-MGB 0.070 0.073 0.004 0.000 Negative Control false 0.200
false 3 15 N
4 AL NAC IPC B'\ uckedIPC VIC TAMRA  0.116 0.098 0.013 0.000 Blocked IPC Control false
0.028 True 3 39 N N v
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About Melt Curve Experiments

This chapter covers:

OV VIBW . ettt e e e e e e e 5
About the Melt Curve reactions . . . . ..o oottt e e 5
About the example experiment ........... ... ... i 6

IMPORTANT! First-time users of the QuantStudio™ 12K Flex System, please read
Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-Well Plate and Array
Card Experiments and Booklet 7, QuantStudio™ 12K Flex System Multi-Well Plate and
Array Card Experiments - Appendixes of this binder thoroughly. The booklet provides
information and general instructions that are applicable to all the experiments
described in this binder.

Note: For more information about any of the topics discussed in this guide, access the
Help from within QuantStudio™ 12K Flex Software by pressing F1, clicking @ in the
toolbar, or selecting Help » QuantStudio™ 12K Flex Software Help.

Overview

A Melt Curve, also known as dissociation curve, is a plot of data collected during the
Melt Curve stage of an experiment. Melt Curve experiments are performed to
determine the melting temperature (Tm) of a target nucleic acid sequence or to identify
nonspecific PCR amplification.

Melting temperature (Tm) is the temperature at which 50% of the target DNA is
double-stranded and 50% is dissociated into single-stranded DNA.

The melting temperature and non-specific PCR amplification can be identified as
peaks in the melt curve stage of an experiment.

About the Melt Curve reactions

With Melt Curve experiments, the reactions consist of completed PCR reactions that
contain amplified products and SYBR® Green dye to detect double-stranded DNA.

The QuantStudio™ 12K Flex Software detects the number of fluorescence peaks,
determines the melting temperature (Tm) for each peak, and plots the results in a melt
curve.

The fluorescence data collected during the QuantStudio™ 12K Flex Instrument run are
stored in an experiment data file (*.eds).

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 5
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Chapter 1 About Melt Curve Experiments

About the example experiment

There are two types of reactions in a Melt Curve experiment:

* Unknowns - Wells containing PCR product with unknown melting
temperature(s).

¢ Negative Controls - Wells containing buffer or water instead of sample. The
negative control wells should contain no double-stranded DNA.

About the example experiment

To illustrate how to perform Melt Curve experiments, this guide leads you through the
process of designing and performing an example experiment. The example experiment
represents a typical setup that you can use to quickly familiarize yourself with a
QuantStudio™ 12K Flex System.

The objective of the example Melt Curve experiment is to investigate the melting
temperature of Target 1, and verify that no extraneous peaks appear. The SYBR® Green
reagent is used to detect the melting temperature stage.

Note: The example experiment performs a melt curve analysis on PCR products from
a PCR performed on the QuantStudio™ 12K Flex System or on another thermal cycler.

6 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
Experiments User Guide for Melt Curve Experiments



Design the Experiment

This chapter explains how to design the example experiment from the Experiment
Setup menu.

This chapter covers:

Define the experiment properties. . ......... ... 7
Define targets and samples. .. ... 8
Assign targetsand samples. . ........ ... oo 9
Setuptherunmethod ...... ... ... ... . 10
For more information........... ... i 12

Note: To automatically export the analyzed data to a specified location, select the Auto
Export task from the Export screen, before running the experiment. For more
information on Auto Export, refer to Chapter 1 in Booklet 1, Getting Started with
QuantStudio™ 12K Flex System Multi-Well Plate and Array Card Experiments.

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the

QuantStudio™ Software. Enter:

Field or Selection

Entry

Experiment Name

384-Well Melt Curve Example

Barcode Leave field empty
User Name Example User
Comments Melt Curve example
Block 384-Well
Experiment Type Melt Curve

Reagents SYBR® Green Reagents
Ramp speed Standard
Include PCR Unchecked

Save the experiment.
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Chapter 2 Design the Experiment

Define targets and samples

Your Experiment Properties screen should look like this:

How do you want to identify this experiment?

* Experiment Name: | 384-well Melt Curve Example Comments: |Meft Curve example
Barcade: ||

User Mame: |Example user

Which block are you using to run the experiment?

[v 384-Well | [ e } [ 96-Well (0.2mL) ] [ Fast 96-Well (0.1ml) ]

What type of experiment do you want to set up?

[ Standard Curve ] { Relative Standard Curve } [ Comparative Ct (AACT) ] | s Melt Curve |

[ Genotyping ] [ Presence/Absence }

Which reagents do you want to use to detect the target sequence?

[v SYBR® Green Reagents | { Other }

What properties do you want for the instrument run?

| s Standard | [ Fast }

[ Include PCR

Define targets and samples

Click Define to access the Define screen. Enter:

1. Targets
Target Name Reporter Quencher Color
Target 1 SYBR None .
2. Samples
Sample Name Color
Sample 1

3. Dye to be used as a Passive Reference
ROX

[o0)
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Chapter 2 Design the Experiment

Assign targets and samples

Your Define screen should look like this:

Target Name Reporter Quencher Color Sample Name Color

Target 1 SYBR « [None v |. ~ ‘ Sample 1 ‘ - ‘

Passive Reference

ROX. ~

Assign targets and samples

Click Assign to access the Assign screen. Enter the targets and samples:

Target Name Sample Well Number Task
SYBR Sample 1 A1-P2 (Columns 1 and 2), A3-G3 Unknown
(Column 3)
Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 9
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Chapter 2 Design the Experiment
Set up the run method

Your Assign screen should look like this:

Targets ———— (&) ([RNSE o) Table
[ [ Lo [ —
E|.Target1 |+ :-:
Sample 1 F
* | -
Sample 1
© |-
Sample 1
© | O
D =
Samples ——— (&) ; _
B
Ell |Samp\e 1 ‘ - Sample 1
Sample 1
" |-
Sample 1
¢ |
Sample 1
! | - "
Wels: [ 37 [ 2 345 Empty
Set up the run method
Set the thermal Click Run Method to access the Run Method screen. Set the thermal profile under the
profile Graphical View tab. Enter:
* Reaction Volume Per Well: 20 uL
e Thermal Profile
Stage Step Ramp rate Temperature Time
Melt Curve Stage Step 1 1.6°C/s 95°C 15 seconds
Step 2 1.6°C/s 60°C 1 minute
Step 3 0.05°C/s 95°C 15 seconds
(Dissociation)
Edit the ramp Edit the ramp increment for a melt curve (dissociation) step.
Increment 1. Select a melt curve ramp increment method:
¢ Step and Hold - Increases or decreases the ramp temperature in 0.1 °C
increments over the time (duration) for the melt curve ramp.
* Continuous (default) — Increases or decreases the ramp rate in 0.005 °C per
second increments.
10 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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Run Method

Reaction Volume per Wel:

Optical Filters

AddStep ¥ Dile

Chapter 2 Design the Experiment
Set up the run method

2. If you selected the Step and Hold ramp increment method, edit the melt curve
ramp time:

¢ Toincrease or decrease the time in 1-minute or 1-second increments, click the
Step and Hold field, select the minutes or seconds, then use the up or down
arrow keys or click the up or down buttons in the field until you reach the
desired time.

¢ To enter the desired time, click the Step and Hold field, select the minutes or
seconds, then enter the desired time.

3. Edit the melt curve ramp increment:

¢ To increase or decrease the ramp increment, click the melt curve
(dissociation) ramp increment in the thermal profile, then use the up or
down arrow keys or click the up or down buttons in the field until you reach
the desired value.

* To enter the desired ramp increment, click the melt curve (dissociation) ramp
increment in the thermal profile, select the value in the field, then enter the
desired value.

Note: To view the maximum and minimum allowed values, place the cursor
over melt curve (dissociation) ramp increment in the thermal profile and
wait for the tooltip to pop up.

Your Run Method screen should look like this:

20| WL

Melt Curve Stage

Stept

Step2 Step3 (Dissociation)

<

Legend
Data Collection On ~

= Data Collection Off A AutoDela On A AutoDef OFf

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 1
Experiments User Guide for Melt Curve Experiments



Chapter 2 Design the Experiment

For more information

For more information

For more information on... Refer to Part number

Consumables Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050
System Multi-Well Plate and Array Card Experiments

Appendix A in Booklet 7, QuantStudio™ 12K Flex System Multi-Well
Plate and Array Card Experiments - Appendixes

Using alternative setup Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050
System Multi-Well Plate and Array Card Experiments
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Prepare the Reactions

This chapter explains how to prepare the reactions for running a PCR prior to running
a Melt Curve.

To perform a Melt Curve experiment without running a PCR, use the reaction plate
containing the PCR product.

Note: The example experiment performs a melt curve analysis on PCR products from
a PCR performed on the QuantStudio™ 12K Flex System or on another thermal cycler.

This chapter covers:

Assemble required materials ......... ... ... o o ool 13
Prepare the sample dilutions ........... ... ... ... i 13
Prepare the reaction mix (“cocktail mix”)......................... 14
Prepare the reactionplate . ....... ... ... .. . 14
For more information. . ...........c.oi it e 15

Assemble required materials

¢ Jtems listed in Booklet 1, Getting Started with QuantStudio™ 12K Flex System Multi-
Well Plate and Array Card Experiments

* Sample1

¢ Example experiment reaction mix components:
— Power SYBR® Master Mix
— Target - Assay Mix Forward primer (10uM)
— Target - Assay Mix Reverse primer (10uM)

Prepare the sample dilutions

The stock concentration of each sample is 100 ng/uL. After you dilute the sample
according to the Sample Dilutions Calculations table, the sample will have a
concentration of 10 ng/pL. Add 2uL to each reaction.

. Total volume of
Sample volume Diluent volume .
Sample name diluted sample
(uL) (uL)
(pL)
Sample 1 (Amplified PCR 10 90 100
Product)
Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 13
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Chapter 3 Prepare the Reactions

Prepare the reaction mix (“cocktail mix”]

Prepare the reaction mix (“cocktail mix”)

The following table lists the universal assay conditions [volume and final
concentration for using the Power SYBR® Master Mix (2X)].

Reaction Component Volun_1e for 1 Volun_me for 40
reaction (pL) reactions (pL)
Power SYBR®Green PCR Master Mix (2X) 10 400
Forward primer (10uM) 0.1 4
Reverse primer (10pM) 0.1 4
Water 7.8 312
Total reaction mix volume 18 720
Procedure 1. Label an appropriately sized tube for the reaction mix: Power SYBR® Reaction

Mix.
2. Add the required volume of each cocktail mix component to the tube.

3. Mix the cocktail thoroughly by gently pipetting up and down several times, then
cap the tube.

4. Centrifuge the tube briefly to remove air bubbles.

5. Place the cocktail mix on ice until you prepare the reaction plate.

Calculations Determine the quantity of primer to be added to the reaction mix by performing the
following calculation:

Concentration (initial) C1 x Volume (primer stock) V1 = Concentration (final) C2 x
Volume (final reaction) V2

(10uM) x (V1) = (0.05uM) (20uL)
V1=(0.05x20)/10=0.1

Prepare the reaction plate

1. Add reaction mix and sample to a tube.

a. To an appropriately sized tube, add the volumes of reaction mix and sample

listed below.
Reaction
. Sample
Unknown . . mix

Tube . Reaction mix Sample volume

reaction volume (L)

(uL) H
1 Target 1 Power SYBR® 720 Sample 1 80
reaction mix
14 Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card
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For more information

Chapter 3 Prepare the Reactions

b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.
Pipette 20 puL of the unknown (sample) reaction to each well in the reaction plate.
Seal the reaction plate with optical adhesive film.

Centrifuge the reaction plate briefly to remove air bubbles.

@ &~ WD

Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of
time.

6. Until you are ready to perform the PCR run, place the reaction plate at 4°C, in the
dark.

7. Run the PCR.

8. After the PCR is completed, use the same reaction plate containing the PCR
product to run the Melt Curve as described in Chapter 4.

For more information

For more information on... Refer to... Part number
Assigning the reaction plate Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050
components System Multi-Well Plate and Array Card Experiments
Sealing the reaction plate Chapter 1in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050

System Multi-Well Plate and Array Card Experiments
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For more information
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Run the Experiment

This chapter explains how run the example experiment on the QuantStudio™ 12K Flex
Instrument.

This chapter covers:
Start the FUN. . . ..o 17
Monitor the run. . . ... .. 17

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the QuantStudio™ 12K Flex Instrument is in operation.

Start the run

1. Open the Melt Curve example file that you created using instructions in
Chapter 2.

IMPORTANT! The example experiment includes the melt curve analysis of a PCR
product from PCR on QuantStudio™ 12K Flex System or another thermal cycler.
To run a Melt Curve on the example file you created in Chapter 2, ensure that PCR
has already been performed on the reaction plate you load into the instrument.
Absence of the PCR product will lead to no results in the Dissociation Step of the
Melt Curve Stage.

2. Load the reaction plate, containing the PCR product, into the instrument.

3. Start the run.

Monitor the run

Monitor the example experiment run:

* From the QuantStudio™ Software using the Run screen, while the experiment is
in progress.
¢ From the Instrument Console of the QuantStudio™ Software (to monitor an

experiment started from another computer or from the QuantStudio™ 12K Flex
Instrument touchscreen).

¢ From the QuantStudio™ 12K Flex Instrument touchscreen.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 17
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Chapter 4 Run the Experiment
Monitor the run

From the 1. In the Instrument Console screen, select the instrument icon.

Instrument 2. Click Manage Instrument or double-click on the instrument icon.

Console of the

QuantStudio™ 3. On the Manage Instrument screen, click Monitor Running Instrument to access
Software the Run screen.

View the Melt Curve

You can view the progress of the run in real time. During the run, periodically view all
the three plots available from the QuantStudio™ Software for potential problems.

Click Melt Curve from the Run Experiment Menu, select the Plate Layout tab, then
select the wells to view.

The figure below shows the Melt Curve as it appears at the end of the example
experiment.

Melt Curve Plot Plate Layout

Plot Settings
m Showe in el

Plot Target |All ~ | Color |Sample M ls W Select iells W View Legend

4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

[] save current settings as the default

£ L almE = |[f

L)

Melt Curve Plot B

AF T af [4f [ af [af [ af | af |w

Mormalized Reporter (Rn)

Temperature (°C) e}
e
sample 1 3

x
TAETAETAETAETAET AT AET AET AETAET AT AET A ET A ET AT
TR TAETAE AT A TAC T A TACTACTAE AT A TAET AT TA I

wels: [ 37 [ 2 345 Empty
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Temperature Plot

Temperature

Chapter 4 Run the Experiment
Monitor the run

View the Temperature Plot

Click Temperature Plot from the Run Experiment Menu.

The figure below shows the Temperature Plot screen as it appears during the example

experiment.

e W cover
— W sarole
Block

Temperature Plot

00:00:00 00:04:10 00:08:20 00:12:30 00:16:40 00:20:50 00:25:00 00:2910 00:33:20 00:37:30 00:41:40 00:45:50 00:50:00 00:54:10 00:56:20

Temperature Plot

View 1 Hour e
Time

Fixed View []

Note: The Sample temperature displayed in the Current Temperatures group is an
estimated value.

View the Run Method
Click Run Method from the Run Experiment Menu.

The figure below shows the Run Method screen as it appears in the example

experiment.

Run Method Edit Run Method
Melt Curve Stage
\ ST
“
Step1 Step2 Step3 (Dissociation)
< bd
Legend

Datz Collection On =/ Data Collection Off A AutoDefta On A AutoDelta OFF
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Run Data Report

Experiment Name:
Start Time:

Stop Time:

Run Duration:

User Name:
Instrument Nama:
Firmware Version:
Software Version:
Instrument: Serial Number:
Sample Volume:
Cover Temperature:

Block Type:

Errors Encountered:

Chapter 4 Run the Experiment
Monitor the run

View run data
Click View Run Data from the Run Experiment Menu.

The figure below shows the View Run Data screen as it appears in the example
experiment.

384-Wel Meft Curve Example
09-20-2011 12:14:48 5GT
09-20-2011 12:30:16 5GT
15 minutes 28 seconds
DEFAULT

QuantstudioDemo

0.16.1

QuantStudio 12K Flex Software v1.0
QuantStudioDemo

20.0

105.0

384-Wel Block

From the

QuantStudio™ 12K
Flex Instrument

touchscreen

20

You can also view the progress of the run from the touchscreen of the QuantStudio™
12K Flex Instrument.

The Run Method screen on the QuantStudio™ 12K Flex Instrument touchscreen
looks like this:

Experiment View

o

Time View Plot View it Experiment View

Run Started: January 19 2012 - 01:46PM
Reaction Volume: 20 pL

Sample: 60.0 °C
Heated Cover [Set Point): 105.0 °C (105.0 °C)
Time Remaining: 00:13:34

Melt Curve
10f1

95.0 °C 95.0 °C

3 05
0:15 copoc B 05
0:17

January 19 2012 - 01:46PM

i

Heated cover reached target temperature.

Note: The above screenshot is for visual representation only. Actual results will vary
with the experiment.
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Chapter 4 Run the Experiment

Time View
@ Time View Plot View fif]  Experiment View
Run Started: December 08 2011 - 12:05AM Sample: 59.5 °C
Reaction Volume: 20 pL Heated Cover (Set Point): 105.0 °C (105.0 °C)

Stage / Step /Cycle: 2/2/5

01:11:22

@ Remaining Time - Elapsed Time

December 08 2011 - 12:06AM 0

Error occurred during run. Details: Holdtime 60 s exceeded. Actual Holdtim...

Plot View
]  Experiment View @ Time View Plot View
Fast 96-Well Tagman ¥V AR W

100

| ST EEATITT RS RETT M RETTT R MR |

0.001

December 08 2011 - 12:07AM

Heated cover reached target temperature.

i

Monitor the run

Note: You will see the Plot View only if your experiment includes the PCR process.
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Monitor the run
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Review Results and Adjust
Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis
screens and publish the data. Section 5.2 of this chapter walks you through the process
of modifying experiment parameters to troubleshoot problems with experiment
results before rerunning an experiment.

This chapter covers:

Section 5.1 Review Results ........ooiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiin, 25
Analyze the example experiment. .............. ... 25
View the Melt Curve Plot . ... ... o e 25
Identify well problems using the Well Table .............................. 26
Confirm accurate dye signal using the Multicomponent Plot................ 29
Determine signal accuracy using the Raw DataPlot ....................... 30
Review the flags in the QC Summary ..., 32
For more information. . ......... ...t e 34

Section 5.2 Adjust parameters for re-analysis of your own experiments. . ....... 35
Adjust analysis settings........... ... ... 35
For more information. . ......... ...ttt 39
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Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.

2. Click Analyze. The software analyzes the data using the default analysis settings.

Note: You can also access the experiment to analyze from the Home screen.

View the Melt Curve Plot

View the Melt Curve Plot as the Derivative Reporter (-Rn) versus the Temperature Plot
generated by the target.

The Melt Curve screen displays the melt curve of the targets in the selected wells. Use
the Melt Curve plots to confirm the results of the experiment:

¢ Normalized Reporter (Rn) vs. Temperature — This plot displays the fluorescence
signal from the reporter dye normalized to the fluorescence signal of the passive
reference. You can use this plot to see the change in Rn with change in the
temperature. You cannot use this plot to determine the Tm of the target.

* Derivative Reporter (-Rn) vs. Temperature — This plot displays the derivative
reporter signal in the y-axis. The peaks in the plot indicate significant decrease in
SYBR® Green signal, and therefore the Tm of the target.

Purpose The purpose of viewing the Melt Curve Plot for the example experiment is to review
the melting temperature of the target.

To view and assess 1. From the Experiment menu pane, select Analysis » Melt Curve Plot.
the Melt Curve Note: If no data are displayed, click Analyze.

2. Enter the Plot Settings:

Menu Selection
Plot Derivative Reporter
Target All
Plot Color Target
EI Check (default)

(This is a toggle button. When the
legend is displayed, the button
changes to Hide the plot legend.)
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Melt Curve Plot

Chapter 5 Review Results and Adjust Experiment Parameters
Identify well problems using the Well Table

The Melt Curve for the example experiment looks like this:

Plot Sattings

Plot |Derivative Report... s | Target [All

[] Save current settings as the default

~ | Color [Target -

Derivative Reporter (-Rn’)

Melt Curve Plot

Temperaturs (°C)

Legend
. Target 1

Well Summary: In Pizte: 384

Tips for viewing
melt curves in your
own experiments

Set Up: 39

Analyzed: 39 Fiaggad: 0 Omitted by Analysis: 0 Onitted Manuslly: 0 Samples Used: 1 Targets Used: 1

When you analyze your own Melt Curve experiment, look for wells with multiple
peaks, indicating non-specific amplifications or primer dimer formation.

If your experiment does not amplify properly or indicates non-specific amplification,
troubleshoot by manually adjusting the Melt Curve settings (see “Adjust analysis
settings” on page 35).

Identify well problems using the Well Table

Example
experiment values
and flags

View the well table

26

Review the details of the experiment results in the well table and identify any flagged
wells. The well table displays the assay-specific setup and analysis properties for the
experiment in a tabular format.

For the example experiment, confirm that no wells of the reaction plate triggered
QC flags

1. Select the Well Table tab.

2. Click the Flag column header to sort the data so that the wells that triggered flags
appear at the top of the table.

Confirm the integrity of the controls:

a. From the Group By menu, select Task to organize the table rows by their
function on the reaction plate.
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Identify well problems using the Well Table

b. Confirm that each of the controls do not display flags (. ).

The figure below shows the well table of the example Melt Curve experiment.

»|  Plate Layout

win Table ¥
# Well | Omit Flag Sample ...| Target
H NTC
361 P1 | Sample 1 Target 1
362 P2 1 Sample 1 Target 1
B UNKNOWN
1 Al | Sample 1 Target 1
2 A2 | Sample 1 Target 1
3 A3 | Sample 1 Target 1
25 B1 | Sample 1 Target 1
26 B2 | Sample 1 Target 1
27 B3 | Sample 1 Target 1
49 C1 | Sample 1 Target 1
50 C2 | Sample 1 Target 1
51 C3 | Sample 1 Target 1
73 D1 | Sample 1 Target 1
74 D2 | Sample 1 Target 1
75 D3 | Sample 1 Target 1
97 E1 | Sample 1 Target 1
98 E2 | Sample 1 Target 1
93 E3 | Sample 1 Target 1
121 F1 | Sample 1 Target 1
122 F2 | Sample 1 Target 1
123 F3 | Sample 1 Target 1
145 G1 | Sample 1 Target 1
146 G2 | Sample 1 Target 1
147 G3 | Sample 1 Target 1
169 H1 | Sample 1 Target 1
170 H2 | Sample 1 Target 1
193 11 | Sample 1 Target 1
194 12 | Sample 1 Target 1
217 11 | Sample 1 Target 1
218 12 | Sample 1 Target 1
241 K1 | Sample 1 Target 1
242 K2 | Sample 1 Target 1
265 L1 | Sample 1 Target 1
266 12 | Sample 1 Target 1
289 M1 | Sample 1 Target 1
‘Well Summary: In Plate: 384 Set Up: 30

... | Task

NTC
NTC

UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN
UNKMOWN

Anshyzed: 30

Dyes

SYBR-None
SYBR-Mone

SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None
SYBR-None

Flagged:

Tml

62.140
62.916

79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087
79.087

Expand 2l @

Comme...
~
v
Omitted Manually: () Samples Used: 1 Targsts Used: 1

The table below gives the description of each column in the well table.

Column Description
Well The position of the well on the reaction plate.
Omit A check mark indicates that the well has been

removed from the analysis.

Flag

A indicates that the well triggered the number
of flags listed inside the symbol.

Sample Name

The name of the sample.

Target Name

The name of the target evaluated by the well.

Task The task assigned to the well (Unknown, Negative
Control, or Positive Control).

Dyes The name of the reporter and quencher dyes of the
associated sample for the target evaluated by the
well.

Tm1 The melting temperature of the target.

Tm2 The second melting temperature (for targets with

multiple melting temperatures).

Tm3

The third melting temperature (for targets with
multiple melting temperatures).
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Identify well problems using the Well Table

Column Description
Comments Comments
Tips for viewing When you analyze your own experiment:
well tables your * Review the data for the Unknown samples. For each row that displays * in the
own experiments Flag column, note the data and the flag(s) triggered by the associated well.

* Select areas of the table or wells of a specified type by:

— Left-clicking the mouse and dragging across the area you want to select an
area of the table.

— Selecting Sample, Target, or Task from the Select Items menu in the Well
Table tab, then selecting the sample, target, or task name from the second
Select Items menu to select wells of a specific type using the well-selection
tool.

* Group the rows of the plate layout by selecting an option from the Group By
menu. You can then collapse or expand the lists either by clicking the +/- icon next
to individual lists, or by clicking = callapse &l I Collapse All or

Expand All.

¢ Omit a well from the analysis by selecting the Omit check box for that well. To
include the well in the analysis, deselect the Omit check box.

Note: You must reanalyze the experiment each time you omit or include a well.
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Confirm accurate dye signal using the Multicomponent Plot

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.

Pu rpose In the Melt Curve example experiment, you review the Multicomponent Plot screen

for:

View the 1.

Multicomponent
Plot

ROX™ dye (passive reference)
SYBR® dye (reporter)
Spikes, dips, and/or sudden changes

From the Experiment Menu pane, select Analysis » Multicomponent Plot.
Note: If no data are displayed, click Analyze.
Display the unknown wells in the plate layout to display the corresponding data
in the Multicomponent Plot screen:
a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

From the Plot Color drop-down menu, select Dye.

Click Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Check the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the PCR process; a constant ROX dye signal
indicates typical data.

Check the SYBR® dye signal. In the example experiment, because the PCR run has
already been completed, the SYBR® dye signal shows gradual decrease
throughout the run and a sudden dip in the fluorescence at one point; the sudden
drop in the SYBR® dye signal indicates the melting temperature of the target.
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Multicomponent Plot

Plot Settings

Chapter 5 Review Results and Adjust Experiment Parameters
Determine signal accuracy using the Raw Data Plot

The Multicomponent Plot screen for the example experiment looks like this:

Plot Color [Dye -

[] Save current settings as the defauft

23,000,000
22,000,000
21,000,000
20,000,000
19,000,000
18,000,000
17,000,000
16,000,000
15,000,000
14,000,000
13,000,000
12,000,000
11,000,000
10,000,000
9,000,000
8,000,000
7.000.000
6,000,000
5,000,000
4,000,000
3,000,000
2,000,000

Fluorescence

%
)
iz
i
R

Multicomponent Plot

1,000,000
o
-1.000.000

Cycle

Lega
syer [l ROX

‘Well Summary: In Plate: 384

Tips for confirming

dye accuracy in
your own
experiment

SetUp: 39 Anahyzed: 39 Fiagged: 0

Onitted by Anslysis: 0 Omitted Manually: 0 Samples Used: 1 Targets Used: 1

When you analyze your own Melt Curve experiment, look for:

* Passive reference — The passive reference dye fluorescence level should remain
relatively constant throughout the PCR process.

* Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds. If the Melt Curve is being performed post-PCR, then there
should be a gradual decrease in fluorescence and a sudden dip indicating the
melting temperature of the target.

¢ Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

Determine signal accuracy using the Raw Data Plot

About the example
experiment

View the Raw Data
Plot

30

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.

In the Melt Curve example experiment, you review the Raw Data Plot screen for a
stable increase in signal (no abrupt changes or dips) from the appropriate filter.

1. From the Experiment Menu pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.
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Determine signal accuracy using the Raw Data Plot

2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner

of the plate layout in the Plate Layout tab.

Click |- | Show alegend for the plot (default). The legend displays the color
code for each row of the reaction plate (see the legend in the Raw Data Plot shown
below).

Click and drag the Show Cycle pointer from cycle 1 to cycle 135. In the example
experiment, the signal from filter 1, which corresponds to the SYBR® dye filter, is
stable throughout.

Note: The readings shown below are from the example experiment. Actual
results will vary with individual experiment setup.

Note: The cycle number in the Melt Curve represents the number of data
collection points for that experiment.

The Raw Data plot for the example experiment looks like this:

T
AP Ay iy =
Raw Data Plot
24,000,000
23,000,000
22,000,000
21,000,000
20,000,000
19,000,000
18,000,000
17,000,000
16,000,000
15,000,000
14,000,000
o 13,000,000
2 12,000,000
£ 11.000.000
10,000,000
9,000,000
8,000,000
7.000,000
5,000,000
5,000,000
4,000,000
3,000,000
2,000,000 —
1,000,000 e ———— ==
UJE‘ﬁ—% ess—————
-1.000.000
Filter

.

A HsB c o E MF G H ~
i1 ) M H. Ev Ey Ho Wr 3
Options
Show Cyde 135 0

1 50 100 135
‘Well Summary: In Plate: 384 Set Up: 39 Anatyzed: 30 Flagged: 0 Omitted by Analysis: () Omitted Manually: Samples Used: 1 Targets Used: 1
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Review the flags in the QC Summary

The filters used for the example experiment are:

Run Method

Reaction Volume per Wel 20| L

Graphical View

PCR Filter =

Emission Fitter
ml(520+15) m2(558+11) m3(586x10) m4(623£14) m5(682+14) m6(711£12)

Excitation Filter

Melt Curve Filter a0

Emission Filter

ml(520+15) m2(558+11) m3(586+10) m4(623x14) m5(682+14) m&(711+12)
x1(470£15)
z %2(520+10)
5 ¥3(550£11)
§ x4(580£10)
¥5(640£10)
X6(662+10)
Tips for When you analyze your own Melt Curve experiment, look for the following in each
determining signal  filter:
accuracy in your ¢ Characteristic signal growth
own experiments * No abrupt changes or dips

Review the flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags,
including the flag frequency and location for the open experiment.

View the QC 1. From the Experiment Menu pane, select Analysis » QC Summary.
Summary Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the experiment. If the frequency is >0, the flag appears somewhere in
the experiment; the well position is listed in the Wells column.

In the example experiment, there are no flagged wells.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed
information about the flag. In the example experiment, the Frequency column
displays O for the three flags NOSIGNAL, OFFSCALE, and MTP.
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Review the flags in the QC Summary

4. (Optional) For those flags with frequency >0, click the troubleshooting link to view
information on correcting the flag.

The QC Summary for the example experiment looks like this:

T

lag Details

Flag: Description Frequency Wells

MTP |Multiple Tm peaks o | |
NOSIGNAL |Mo signal in well o

OFFSCALE |Fluorescence is offscale o | |

Flag: MTP—Multiple Tm peaks

Flag Detail: Melt curve analysis shows more than one Tm
peak

Flagged Wells: None
View MTP Troubleshooting Information

Total Wells: 384 | Processed Wells: 39 Manually Omitted Wells: 0 | Targets Used: 1
‘Wells Set Up: 39 Flagged Wells: 0 Analysis Omitted Wells: 0 | Samples Used: 1
Well Summary: In Plate: 384 Set Up: 30 Analyzed: 30 Flagged: [ Omitted by Analysis: () Omitted Manually: () Samples Used: 1 Targsts Used: 1
Possible flags For Melt Curve experiments that do not include amplification, the flags listed below

may be triggered by the experiment data.

Flag Description

Pre-processing flag

OFFSCALE ‘ Fluorescence is offscale

Primary analysis flag

NOSIGNAL ‘ No signal in well

Secondary analysis flag

MTP Multiple Tm peaks

For Melt Curve experiments that include amplification, the flags listed below may be
triggered by the experiment data.

Flag Description

Pre-processing flag

OFFSCALE Fluorescence is offscale
Primary analysis flags
BADROX Bad passive reference signal
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Flag Description

NOAMP No amplification

NOISE Noise higher than others in plate

SPIKE Noise spikes

NOSIGNAL No signal in well

EXPFAIL Exponential algorithm failed

BLFAIL Baseline algorithm failed

THOLDFAIL | Thresholding algorithm failed

CTFAIL | Cy algorithm failed

AMPSCORE . Amplification in the linear region is below a certain

threshold, corresponding to the score set in the
analysis settings

Secondary analysis flags

MTP Multiple Tm peaks

OUTLIERRG Outlier in replicate group

AMPNC Amplification in negative control

HIGHSD High standard deviation in replicate group

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL,
THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in
the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

For more information

For more information on... Refer to... Part number

Publishing data Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 12K Flex 4470050
System Multi-Well Plate and Array Card Experiments
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Adjust analysis settings

Section 5.2 Adjust parameters for re-analysis of your
own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the Melt Curve and
flags.

If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable
for your own experiment, you can change the settings in the Analysis Settings dialog
box, then reanalyze your experiment.

View the analysis 1. From the Experiment Menu pane, select Analysis.

settings 2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab:

Melt Curve Settings

Cr Settings

Flag Settings

Advanced Settings

Note: The Cr Settings and Advanced Settings tabs appear in the Analysis
Settings dialog box only if the Melt Curve experiment you are performing
includes the PCR process.

Note: Select the Include PCR check box on the Experiment Properties screen
to include amplification in your Melt Curve experiment.

The Analysis Settings dialog box for a Melt Curve experiment looks like this:

E ' : x|
Flag Settings
ifferent settings for a target, select the target from the table, deselect Enable
~ Select a Target ~— Multi-Peak Setting for Target 1 —————————
Target Multi-Peak Calling Peak Level (%)
A Enable Mult-Peak Caling
Target 1 Enabled 10.00
Peak level relative to the dominant peak (%) : |10.00
o iy [t s e [ o o s J v
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Adjust analysis settings

Adjust analysis
settings

3.

View and, if necessary, change the analysis settings (see “Adjust analysis settings”
below).

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with QuantStudio™ 12K Flex System
Experiments.

Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to
Default Analysis Settings.

You may change the following settings:

Melt Curve Settings

Use this tab to:

Enable or disable multi-peak calling.

— Select the Enable Multi-Peak Calling check box if you expect to amplify
more than 1 PCR product and you want to determine the Tm for more than
one peak.

— Deselect the Enable Multi-Peak Calling check box if you expect to amplify 1
PCR product and you do not want to determine the Tm for more than one
peak.

Enter a value (in percentage) for the peak level relative to the dominant peak.

Specify a fractional level value as the peak detection threshold. The detected
peaks are measured relative to the height of the tallest peak, which has a perfect
fractional level 100%. The default value is initially set at 10%.

For example, if you set a fractional level detection threshold value at 40, then only
peaks above 40% of the tallest peak are reported and the peaks at lower height are
regarded as noise.

Cr Settings

Data Step Selection

Use this feature to select one stage/step combination for Cy analysis when there is
more than one data collection point in the run method.

Algorithm Settings

You can select the algorithm that determines the Cy values. There are two
algorithms: Baseline Threshold (the default) and Relative Threshold.

The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for quantification.

The Relative Threshold algorithm is a well-based analysis based on the PCR
reaction efficiency and fitted to the Amplification curve. This setting is ideal for a
single sample across genes with no dependence on targets, thereby reducing
variability. It is not necessary to set either a baseline or a threshold when you use
the Relative Threshold algorithm, so any settings for baseline or threshold will
not affect the analysis.

Default Ct Settings
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Use the default Cr settings feature to calculate Cr for the targets that do not have
custom settings. To edit the default settings, click Edit Default Settings.

® Cr Settings for Target
When you manually set the threshold and baseline, Life Technologies

recommends:
Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
¢ Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.

Flag Settings
Use the Flag Settings tab to:

¢ Adjust the sensitivity so that more wells or fewer wells are flagged.

* Change the flags that are applied by the QuantStudio™ 12K Flex Software.
To adjust the flag settings:

1. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of Ct SD. For some flags, analysis results calculated before
the well is rejected are maintained.

4. Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.
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The Flag Settings tab looks like this:

Analysis Settings for 38

Melt Curve Settings

when a flag is raised.

Flag Description Use Attribute Condition Value Reject well
OFFSCALE Fluorescence is offscale |
MTP Muttiple Tm peaks
HOSIGHAL Mo signal in well O

Save to Library Load from Library

Revert to Default Analysis Settings

Apply Analysis Settings [W

38

Advanced Settings
Use the Advanced Settings tab to change baseline settings well-by-well.

Note: The baseline and threshold values do not affect the analysis using the Relative
Threshold setting.

To use custom baseline settings for a well-target combination:
1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target check box.

3. Define the custom baseline settings:

e TFor automatic baseline calculations, select the Automatic Baseline check
box.

¢ To define the baseline, deselect the Automatic Baseline check box, then enter
the baseline start cycle and baseline end cycle.
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For more information

For more information

For more information on... Refer to Part number

Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays 127AP05-03
Application Note.
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Export Analysis Results

1. Open the Melt Curve example experiment file that you analyzed in Chapter 5.
2. In the Experiment Menu, click E,—__ Export.

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

3. Select QuantStudio'" 12K Flex format.

4. Complete the Export dialog box as shown below:

Field or Selection Entry
Select Data to Results

export/ Select

Content

Export Data To One File

Export File Name 384-Well Melt Curve Example_QuantStudio_export

File Type *.txt

Export File Location | <drive>:\Applied Biosystems\QuantStudio 12K Flex
Software\experiments
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Your Export screen should look like this:

[ Auto Export Format : |QuantStudm12KFlex v| Export Data To: (2) One File ) Separate Files Open file(s) when export is complete

Export File Location: |C:\Apphed Biosyste ms\QuantStudio 12K Flex Software\Us Export File Name: |384-Well Melt Curve E)Gmple_QuantStudm_s| File Type: ||‘§] (=txt)

Sample Setup [ Raw Data Amplification [ Multicompenent

Skip Empty s kip Omitted Wells
Select Content Well well Position Sample Name | Target Name Task Reporter Quencher (z!

All Fields - 1A1 Sample 1 Target 1 UNKNOWN SYBR None ~
Wl 2A2 Sample 1 Target 1 UNKMOWN SYBR Mone r

’ 3A3 Sample 1 Target 1 UHKHOWN SYBR None

Wel Position 2581 Sample 1 Target 1 UNKNOWN SYBR lone

2682 Sample 1 Target 1 UNKMOWN SYBR MNone

Sample Name 2783 Sample 1 Target 1 UHKHOWN SYBR MNone

49C1 Sample 1 Target 1 UNKHOWN SYBR MNone

Target Mame 50C2 Sample 1 Target 1 UHKHOWN SYBR None

5183 Sample 1 Target 1 UHKHOWN SYBR MNone

Task 7301 Sample 1 Target 1 UNKNOWI SYBR Nane

Reporter 74D2 Sample 1 Target 1 UNKMOWN SYBR MNone

7503 Sample 1 Target 1 UHKHOWN SYBR MNone

Quencher 97El Sample 1 Target 1 UNKHOWN SYBR MNone

98 E2 Sample 1 Target 1 UNKMOWN SYBR Mone

cT 99E3 Sample 1 Target 1 UHKHOWN SYBR None

CF Mean 121F1 Sample 1 Target 1 UHKHOWN SYBR Mone

122 F2 Sample 1 Target 1 UNKMOWN SYBR MNone

CE 5D 123F3 Sample 1 Target 1 UHKHOWN SYBR MNone

145G1 Sample 1 Target 1 UNKHOWN SYBR MNone

Quantity 146 G2 Sample 1 Target 1 UNKHOWN SYBR MNone

147 G3 Sample 1 Target 1 UHKHOWN SYBR MNone

Quantity Mean 169 H1 Sample 1 Target 1 UNKNOWN SYBR Mone
. 170 H2 Sample 1 Target 1 UNKHOWN SYBR MNone =

Quantity SD 3 19311 sample 1 Target 1 UNKNOWN SYBR None

Automatic Ct Threshold 19412 Sample 1 Target 1 UNKNOWN SYBR lone

21711 Sample 1 Target 1 UNKMOWN SYBR Mone

Ct Threshold 21812 Sample 1 Target 1 UNKHOWN SYBR None

241 K1 Sample 1 Target 1 UHKHOWN SYBR Mone

Automatic Baseline 242 K2 Sample 1 Target 1 UHKHOWN SYBR None
Bassline Start 26511 Samp!e 1 Target 1 UHKHOWN SYBR MNone v

™ | | >

w Save Export Set As Load Export Set Delete Export Set

Your exported file when opened in Notepad should look like this:

B 384-Well Melt Curve Example_Qu udio_export.txt - Notepad
File Edit Format View Help

[* Barcode = NA A
* glock Type = 384-well Block F
calibration Background is expired = No

calibration sackground performed on = 2011-08-05 01:46:18 AM sSGT
calibration FAM is expired = No

calibration Fam performed on = 2011-08-05 02:04:58 AM SGT
calibration ROI is expired = No

calibration rOI performed on = 2011-08-04 11:42:31 AM SGT
calibration rROX is expired = No

calibration roX performed on = 2011-08-05 02:23:30 AM SGT
calibration 5vBR is expired = No

calibration syBrR performed on =
ibration 5vBrR2 is expired = No

ration syBr2 performed on = 2011-09-14 05:58:11 AM SGT

calibration uniformity is expired = No

calibration uniformity performed on = 2011-08-05 01:56:21 AM SGT

calibration VIC is expired = No

calibration vic performed on = 2011-08-05 02:15:08 aAM SGT

Chemistry = SYBR_GREEN

comment = NA

Date Created =

Experiment File Name = C:\Program Files‘\applied Biosystems‘\Quantstudiol2kFlex‘examples'Melt Curve\384-well melt Curve Example.eds
Experiment Name = 384-well MeTt Curve Example

Experiment Run End Time = 2011-09-20 12:30:16 PM SGT

Experiment Type = Melt Curve

Instrument Name = QuantstudiobDemo

Instrument Serial Number = QuantstudiobDemo

Instrument Type = Quantstudio 12K Flex

passive Reference = ROX

quantification cycle method = Ct

signal smoothing on = true

User Name = NA

B

2011-09-15 05:13:56 AM 5GT

G E X H R EEEEH N EEEEXEDHKRLEEEDEND R DA

[sample setup]

well well Position  sSample Name sample Color Biogroup Name Biogroup Color Target Name Target Color Task Reporter
quencher Quantity comments

1 Al sample 1 "rRGB(0,255,0)" Target 1 "RGB(0,0,255)" UNKNOWN SYBR None

2 A2 sample 1 "RGB(0,255,0)" Target 1 "RGB(0,0,255)" UNKNOWN SYBR None

3 A3 sample 1 "rRGB(0, 255,0)" Target 1 "RGB(0,0,255)" UNKNOWN SYBR None

4 Ad

5 A5

6 AG

7 AT

g AB

9 A9

10 AlO

11 A1l

12 Al2

13 Al3

14 Al4

15 Al5

16 Ald

7 AlT ~
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adjusting analysis settings adjusting 35
adjusting parameters, re-analyzing own
experiments 35
Advanced Settings tab 39
Algorithm Settings
Baseline Threshold 37
Relative Threshold 37
amplification efficiency 40
amplification, include PCR 35
amplified products 5
AMPNC flag 34
AMPSCORE flag 34
analysis settings 35, 36
Advanced Settings 35
Cr Settings 35
Flag Settings 35
Melt Curve Settings 35
Analyze 25
Melt Curve Plot 25
Multicomponent Plot 29
QC Summary 32
Raw Data Plot 30
Auto Export 7, 41
Automatic Baseline 39
Automatic Threshold 38

BADROX flag 33
BLFAIL flag 34

C

cocktail mix 14

Cr settings
algorithm settings 37
data step, selecting 37
default 37
target 37

Cr Settings tab 37, 34

D

designing experiment
assigning targets and samples 9
defining experiment properties 7
defining targets and samples 8
setting up run method 10
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dissociation curve 5

dye accuracy
irregularities in the signal 30
passive reference 30
reporter dye 30

E

Enable the Multi-Peak Calling 37
example experiment 6
experiment properties, defining 7
EXPFAIL flag 34

Export 41

extraneous peaks 6

F

Flag Settings tab 38

flags, QC
AMPNC 34
AMPSCORE 34
BADROX 33
BLFAIL 34
CTFAIL 34
EXPFAIL 34
HIGHSD 34
MTP 33, 34
NOAMP 34
NOISE 34
NOSIGNAL 33, 34
OFFSCALE 33
OUTLIERRG 34
SPIKE 34
THOLDFAIL 34

fluorescence peaks 5

H
HIGHSD flag 34

include amplification, Pre-processing flag
OFFSCALE 33

include amplification, Primary analysis flags
AMPSCORE 34
BADROX 33
BLFAIL 34
CTFAIL 34
EXPFAIL 34
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NOAMP 34 OUTLIERRG flag 34
NOISE 34

NOSIGNAL 34 P

SPIKE 34

THOLDFAIL 34 preparing reactions

include amplification, Secondary analysis flags reaction mix 14

AMPNC 34 reaction plate 14
HIGHSD 34 required materials 13
MPT 34 sample dilutions 13

OUTLIERRG 34
Q

M QC Summary 32

melt curve experiments QC Summary, reviewing flags 32

melt curve reactions 5
overview 5 R

Melt Curve Plot 18, 25 ramp increment 10
assessing 25 editing 10
Derivative Reporter 25 method, continuous (default) 10

Normalized Reporter 25 method, step and hold 10
reactions type, negative controls 6 Raw Data Plot 30

reactions type, unknowns 6
. . . raw data plot
tips for analyzing own experiment 26 s
determining signal accuracy 30

viewing 18, 25 . . .
K tips for analyzing own experiments 32
Melt Curve Settings tab 37 D
viewing 30

melt curv i i
elt curve stage 6 reaction mix

components 13
MTP flag 33, 34 preparing reactions 14

multicomponent plot reactions, assembling materials for 13
confirming dye accuracy 29

tips for analyzing own experiment 30
viewing 29

Melting temperature (Tm) 5

review results 25
run
monitoring 17
starting 17

N run method
no PCR, Pre-processing flag reaction volume per well 10
OFFSCALE 33 setting up 10
no PCR, Primary analysis flags thermal profile 10
NOSIGNAL 33 viewing 19
Run Screen

no PCR, Secondary analysis flags
MPT 33 Melt Curve Plot 18

NOAMP flag 34 ?un Method 1119 o
NOISE flag 34 emperature Plot

View Run Data 20
NOSIGNAL flag 33, 34 iew Run Data
Run screen 18

0

OFFSCALE flag 33
omit wells 28

S

sample dilutions, preparing reactions 13
Sample temperature 19
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samples, defining 8
single-stranded DNA 5
SPIKE flag 34

T

target DNA 5
targets and samples
assigning 9
defining 8
targets, defining 8
temperature plot, viewing 19
thermal profile, setting up 10
THOLDFAIL flag 34
touchscreen, running the experiment from
Experiment View 20
Plot View 21
Time View 21
troubleshooting
multiple peaks 26
non-specific amplification 26

w

well table
identifying well problems 27
tips for viewing own experiments 28
viewing 27
well table, column
Dyes 28
Flag 28
Omit 28
Sample Name 28
Target Name 28
Task 28
Tm1l 28
Tm2 28
Tm3 28
Well 27
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Consumables

Calibration and

Ordering Information

This appendix covers:

Consumables. . ... .
Reagents. ... ... ...

General-use materials and consumables. .. .......... .. .. ... .. . . ...

The consumables listed below are required for calibrating the QuantStudio™ 12K Flex
Instrument and for performing experiments with the QuantStudio™ 12K Flex System.

Note: For reagent or consumable shelf-life expiration date, see the package label.

The following table shows the reagents and consumables required to calibrate the

verification QuantStudio™ 12K Flex Instrument.
consumables
384-well sample block
Part Shelf-life at Storage
Consumable environmental conditions
number °
temperature (°C)
384-Well Spectral Calibration Plate with FAM™ Dye 4432271 | Use the -15 to -25°C
384-Well Spectral Calibration Plate with VIC® Dye 4432278 | Consumable by
the expiration
384-Well Spectral Calibration Plate with ROX™ Dye 4432284 | date mentioned
384-Well Spectral Calibration Plate with SYBR® Green Dye 4432290 | O the package
384-Well Spectral Calibration Plate with TAMRA™ Dye 4432296
384-Well Spectral Calibration Plate with NED™ Dye 4432302
384-Well Region of Interest (ROI) and Background Plates 4432320
384-Well Normalization Plates with FAM™/ROX™ and VIC®/ROX™ Dyes | 4432308
TagMan® RNase P Fast 384-Well Instrument Verification Plate 4455280

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card

Experiments - Appendixes



Appendix A Ordering Information
Consumables

96-well (0.2 pL) sample block

Shelf-life at Storage
Part . .
Consumable environmental conditions
number °
temperature (°C)
96-Well Spectral Calibration Plate with FAM™ Dye 4432327 Use the -15 to -25°C
96-Well Spectral Calibration Plate with VIC® Dye 4432334 | consumable by
the expiration
96-Well Spectral Calibration Plate with ROX™ Dye 4432340 date mentioned
96-Well Spectral Calibration Plate with SYBR® Green Dye 432346 | O the package
96-Well Spectral Calibration Plate with TAMRA™ Dye 4432352
96-Well Spectral Calibration Plate with NED™ Dye 4432358
TagMan® RNase P 96-Well Instrument Verification Plate 4432382
96-Well Region of Interest (ROI) and Background Plates 4432364
96-Well Normalization Plates with FAM™/ROX™ and VIC®/ROX™ Dyes = 4432370
TagMan® RNase P 96-Well Instrument Verification Plate 4432382
Fast 96-well (0.1 pL) sample block
Shelf-life at Storage
Part . .
Consumable environmental conditions
number
temperature (°c)
Fast 96-Well Spectral Calibration Plate with FAM™ Dye 4432389 | Use the -15 to -25°C
Fast 96-Well Spectral Calibration Plate with VIC® Dye 4432396 | Consumable by
the expiration
Fast 96-Well Spectral Calibration Plate with ROX™ Dye 4432402 | date mentioned
S . ® on the package
Fast 96-Well Spectral Calibration Plate with SYBR® Green Dye 4432408
Fast 96-Well Spectral Calibration Plate with TAMRA™ Dye 4432414
Fast 96-Well Spectral Calibration Plate with NED™ Dye 4432420
Fast 96-Well Region of Interest (ROI) and Background Plates 4432426
Fast 96-Well Normalization Plates with FAM™/ROX™ and VIC®/ROX™ | 4432432
Dyes
TagMan® RNase P Fast 96-Well Instrument Verification Plate 4351979
Array card sample block
Shelf-life at Storage
Part ) .
Consumable environmental conditions
number °
temperature (°c)
Array Card Spectral Dye Calibration Kit 4432314 Use the -15 to -25°C
Array Card RNase P Instrument Verification Kit 4432265 | consumable by

the expiration
date mentioned
on the package
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Appendix A Ordering Information
Consumables

Experiment The following table shows the reagents and consumables required to perform
consumables experiments with the QuantStudio™ 12K Flex System.
Sh_elf-life at Storage
Consumable Part number environmental conditions
temperature
Array Card Buckets/Clip Set 1st Generation 4337762 Use the Room
2nd Generation 4442571 fﬁgiig}?:tlii:y temperature
TagMan® Array Micro Fluidic Card Sealer 4331770 date mentioned
MicroAmp® Optical 384-Well Reaction Plate | 1000 plates 4343814 on the package
with Barcode 500 plates 4326270
50 plates 4309849
MicroAmp® Optical 384-Well Reaction Plate, 1000 plates 4343370
MicroAmp® Optical 96-Well Reaction Plate 500 plates 4316813
(0.24L) 10 plates N8010560
MicroAmp® Optical 96-Well Reaction Plate 500 plates 4326659
with Barcode (0.2uL 20 plates 4306737
MicroAmp® Fast Optical 96-Well Reaction 10 plates 4346907
Plate (0.1uL)
MicroAmp® Fast Optical 96-Well Reaction 200 plates 4366932
Plate with Barcode (0.1pL) 20 plates 4346906
Centrifuge Buckets, Array Card 1st Generation 4337230
2nd Generation 4442573
Clip, Array Card Centrifuge Adaptor 4334682
MicroAmp® Optical Adhesive Film 100 films 4311971
25 films 4360954
MicroAmp® Multi-Removal Tool (1 tool) 4313950
RT-PCR Grade Water AM9935
MicroAmp® Optical 8-Cap Strip 300 strips 4323032
MicroAmp® Optical 8-Tube Strip (0.2uL) 125 strips 4316567
MicroAmp® Fast 8-Tube Strip (0.1uL) 125 strips 4358293
MicroAmp® Optical Tube without cap (0.2uL) 2000 tubes N8010933
MicroAmp® Fast Reaction Tube with cap 1000 tubes 4358297
(0.1pL)
MicroAmp® 96-Well Tray/Retainer Set (Blue) | 10 pairs 4381850
(for 0.2uL)
MicroAmp® 96-Well Tray (Black] (for 0.1uL) 10 plates 4379983
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Appendix A Ordering Information
Reagents

Shelf-life at Storage
Consumable Part number environmental rag
conditions
temperature
96-Well Plate Adapter (0.2 pL) 1 piece 4459845 Use the Room
Fast 96-Well Plate Adapter 1 piece 4459846 Cﬁ”s“”‘.abl.e by temperature
0.1 uL) the explra_tlon
: date mentioned
96-Well Tube Adapter (0.2 L) 1 piece 4462077 on the package
96-Well Tube Adapter (0.1 L) 1 piece 4462078
384-Well Plate Adapter 1 piece 4457087
Array Card Adapter 1 piece 4454166
MicroAmp® Cap Installing Tool (Handle) (1 tool) 4330015
MicroAmp® Adhesive Film Applicator (5 applicators) 4333183
Reagents

The following table lists the reagents that can be ordered for performing experiments
with the QuantStudio™ 12K Flex System.

Recommended reagent kits

To perform Reagent Part Number
Reverse Transcription SuperScript® VILO™ cDNA Synthesis Kit 4453650
TagMan® PCR TagMan® Fast Advanced Master Mix 4444557
TagMan® GTXpress™ Master Mix 4401892
TagMan® Fast Virus 1-Step Master Mix LALLAZ2
TagMan® Gene Expression Master Mix 4369016
TagMan® Genotyping Master Mix 4371355
TaqMan® Universal Master Mix Il, with UNG 4440038
TagMan® RNA-to-CT™ 1-Step Kit 4392938
SYBR® Green PCR Fast SYBR® Green Master Mix 4385612
Power SYBR® Green PCR Master Mix 4367659
Power SYBR® Green RNA-to-CT™ 1-Step Kit 4389986
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Appendix A Ordering Information
General-use materials and consumables

General-use materials and consumables

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card

Experiments - Appendixes

The following general-use materials and consumables are required to calibrate,

maintain, and perform experiments with the QuantStudio™ 12K Flex System. Unless
indicated otherwise, all materials shown below are available from major laboratory
suppliers (MLS). The materials are applicable to all sample blocks.

Material/Consumable Source
Bleach, 10% solution MLS
Lint-free lab tissues MLS
Cotton or nylon swabs and lint-free cloths MLS
Centrifuge with buckets appropriate for your consumable type MLS
Ethanol, 95% solution MLS
Glasses, safety MLS
Gloves, powder-free MLS
Permanent marker or pen MLS
Pipettors: 100-pL and 200-pL (with pipette tips) MLS
Screwdriver, flathead MLS




A Appendix A Ordering Information
General-use materials and consumables
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Documentation and Support

Related documentation

The following related documents are shipped with the system:

Document PN Description

Applied Biosystems QuantStudio™ 12K Flex Real-Time 4470689 | Explains how to use and maintain the Applied
PCR System Maintenance and Administration Guide Biosystems QuantStudio™ 12K Flex Real-Time
PCR System

Intended for laboratory staff responsible for the
use and maintenance of the QuantStudio™ 12K
Flex Instrument.

Applied Biosystems QuantStudio™ 12K Flex Real-Time 4470050 | Contains five individual booklets that explain how
PCR System Multi-well Plates and Array Card to perform the six different experiments on the
Experiments User Guide QuantStudio™ 12K Flex Instrument

The experiments include Standard Curve, Relative
Standard Curve and Comparative Cy, Genotyping,
Presence/ Absence and Melt Curve. Each Getting
Started Guide booklet functions as both:

e A tutorial, using example experiment data
provided with the QuantStudio™ 12K Flex
Software.

e A guide for your own experiments.
Intended for laboratory staff and principal

investigators who perform experiments using the
QuantStudio™ 12K Flex System.

Applied Biosystems QuantStudio™ 12K Flex Real-Time 4470688 | Explains how to install and maintain the
PCR System Quick Reference Guide QuantStudio™ 12K Flex Instrument

Intended for laboratory staff responsible for the
use and maintenance of the QuantStudio™ 12K
Flex Instrument.

Applied Biosystems QuantStudio™ 12K Flex Real-Time 4470654 | Explains how to prepare your site to receive and
PCR System Site Preparation Guide install the QuantStudio™ 12K Flex Instrument

Intended for personnel who schedule, manage,
and perform the tasks required to prepare your
site for installation of the QuantStudio™ 12K Flex
Instrument.

Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card 1
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Documentation and Support

Other related documents

Document PN Description

QuantStudio™ 12K Flex Software Help NA Explains how to use the QuantStudio™ 12K Flex

Software to:
e Set up, run, and analyze experiments.

¢ Monitor a networked QuantStudio™ 12K Flex
Instrument.

¢ Calibrate the QuantStudio™ 12K Flex
Instrument.

e Verify the performance of QuantStudio™ 12K
Flex Instrument with an RNase P run.

* Intended for:
- Laboratory staff and principal investigators

who perform experiments using the
QuantStudio™ 12K Flex System.

- Laboratory staff responsible for the
installation and maintenance of the
QuantStudio™ 12K Flex Instrument.

Note: For additional documentation, see “How to obtain support” on page 13.

Other related documents

Documents related
to Genotyping
experiments

Documents related
to Presence/
Absence
experiments

12

Document PN

Allelic Discrimination Pre-Developed TagMan® Assay Reagents Quick Reference 4312212
Card

Custom TagMan® Genomic Assays Protocol 4367671
Custom TagMan® SNP Genotyping Assays Protocol 4334431
Ordering TagMan® SNP Genotyping Assays Quick Reference Card 4374204
Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol 4312214
TagMan® Drug Metabolism Genotyping Assays Protocol 4362038
TagMan® SNP Genotyping Assays Protocol 4332856
Document PN

DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, and Buccal Swabs | 4343586

Protocol
NucPrep® Chemistry: Isolation of Genomic DNA from Animal and Plant Tissue 4333959
Protocol
PrepMan® Ultra Sample Preparation Reagent Protocol 4318925
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Documentation and Support
How to obtain support

Documents related

to Relative Document PN
Standard Curve Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05
and Com_p arative Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
Ct experiments
Custom TagMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
Documents related
to Standard Curve Document PN
experiments Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05
Custom TagMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859

How to obtain support

For the latest services and support information for all locations, go to:
www.appliedbiosystems.com

At the Life Technologies web site, you can:

* Access worldwide telephone and fax numbers to contact Life Technologies
Technical Support and Sales facilities.

* Search through frequently asked questions (FAQs).
* Submit a question directly to Technical Support.

¢ Order Applied Biosystems user documents, SDSs, certificates of analysis, and
other related documents.

* Download PDF documents.
¢ Obtain information about customer training.

¢ Download software updates and patches.

Obtaining The QuantStudio™ 12K Flex Software has a Help system that describes how to use
information from each feature of the user interface. Access the Help system by doing one of the
following:

the Help system
e C(Click @ in the toolbar of the QuantStudio™ 12K Flex Software window.

* Select Help » QuantStudio™ 12K Flex Software Help.
® Press F1.
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Documentation and Support
How to obtain support

You can use the Help system to find topics of interest by:
¢ Reviewing the table of contents
¢ Searching for a specific topic

* Searching an alphabetized index

You can also access PDF versions of all documents in the QuantStudio™ 12K Flex
Software document set from the Help system.
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